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Tiltenkt bruk

Tiltenkt bruk
CFX Opus Dx PCR-sanntidssystemTMmed CFX Maestro Dx-programvare, Security EditionTM er ment å
utføre fluorescensbasert PCR for å påvise kvantitative nukleinsyresekvenser. Systemet og programvaren
er beregnet på in vitro-diagnostisk bruk av opplærte laboratorieteknikere. Systemene er beregnet på bruk
med tredjeparts diagnostiske nukleinsyretester som har blitt produsert og merket til diagnostiske formål.

Symbolforklaring

Produsent Partinummer

Brukes innen For in vitro diagnostisk bruk

Temperaturgrense Katalognummer

Se brukerhåndboken Antall tester

For bruk med Serienummer

Bare for bruk som foreskrevet Inneholder lateks
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CE-merking – Forordning
(EU) 2017/746 IVDR

Oversettelser
Produktdokumenter kan leveres på flere språk på elektroniske medier.
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Sikkerhet og overholdelse av krav
CFX Opus 96 Dx, CFX Opus 384 Dx og CFX Opus Deepwell Dx sanntids-PCR-systemer (omtalt i denne
veiledningen som CFX Opus Dx-system) varmes opp veldig raskt under drift. For sikker drift av sanntids
PCR-systemet, anbefaler Bio-Rad på det sterkeste at du følger sikkerhetsspesifikasjonene som er
oppført i denne delen og gjennom hele denne håndboken.

Sikkerhetsmessige advarselsetiketter
Advarselsetiketter på systemene CFX Opus Dx-system og i denne håndboken, advarer deg om kilder til
personskade eller materiell skade. Tabell 1 gir en beskrivelse av hver sikkerhetsmessige advarselsetikett.

Ikon Betydning

Betjening av CFX Opus Dx-system før du leser denne håndboken kan utgjøre
risiko for personskade. Bruk av dette instrumentet på en måte som ikke er
spesifisert i denne håndboken eller av Bio-Rad, kan føre til at
beskyttelsesfunksjonene til instrumentet blir svekket eller deaktivert.

Det er ingen biologiske farer eller radioaktive farer forbundet med CFX Opus Dx-
system i seg selv. Disse farene blir bare et problem når de blir innført i systemet via
prøvene som testes. Når du håndterer biofarlige eller radioaktive prøver, må du
følge anbefalte forholdsregler og retningslinjer som er spesifikke for laboratoriet og
stedet. Disse retningslinjene bør omfatte rengjørings-, overvåkings- og
avhendingsmetoder for farlig(e) materialer du bruker.

I tillegg, som identifisert ovenfor, er det en liten risiko for eksplosjon, eller for
utlekking av væske eller damp fra prøvebeholderne. Når du arbeider med farlige
materialer, er risikoen for personskade fra utlekkede materialer større på grunn av
risikoen for at det farlige materialet selv kan spres i og rundt instrumentet. Brukerne
bør ta passende forholdsregler for en slik situasjon.

Tabell 1. Generelle sikkerhetsadvarsler
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Sikkerhet og overholdelse av krav

Ikon Betydning

CFX Opus Dx-system kører ved temperaturer som er høye nok til å forårsake
alvorlige brannskader. Sørg alltid for at prøveblokken har nådd romtemperatur før
du åpner lokket og fjerner prøver. Selv etter at prøveblokken er avkjølt, kan de
omkringliggende områdene og varmeplaten forbli varme i ganske lang tid. I
situasjoner der det ikke er tilstrekkelig tid til å la instrumentet avkjøles, anbefales
bruk av verneutstyr som termohansker eller "ovnshansker".

Sikkerheten og ytelsen til ethvert system som bruker et CFX Opus Dx-system er
utelukkende ansvaret til den sommonterer systemet.

CFX Opus Dx-system kan bli varmt nok i løpet av normal drift til å føre til at væske i
prøvene koker eller fordamper, ved å trykksette prøvebeholderne. Det er mulighet
for at prøvebeholderne kan bli ødelagte, noe som fører til lekkasje, væskespray
eller eksplosivt brudd og frigjøring av damp eller væske i og rundt instrumentet.

Brukerne bør alltid betjene instrumentet med lukket lokk eller bruke vernebriller,
termohansker og annet personlig verneutstyr under bruk, for å unngå
personskade. Åpning av instrumentet mens prøvene fremdeles er varme, for
eksempel etter at du har avbrutt en kjøring, kan gjøre at beholdere under trykk
begynner å lekke, eller spraye eller sprute ut væske. La prøvene alltid avkjøles før
lokket åpnes.

Brukere skal aldri kjøre en reaksjon med lokk eller tetning som er åpent, løst,
punktert eller på annen måte skadet, da det vil øke sannsynligheten for farlig brudd
eller eksplosjon.

Brukere skal aldri kjøre en reaksjon med flyktige reagenser som kan øke
sannsynligheten for farlig brudd eller eksplosjon.

Tabell 1. Generelle sikkerhetsadvarsler, forts.
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Sikkerhet og overholdelse av krav

Sikkerhetssamsvar
CFX Opus Dx-system har blitt testet og er i samsvar med alle gjeldende krav til følgende sikkerhets- og
elektromagnetiske standarder:

n IEC 61010-1:2010 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – del 1:
Generelle krav

n IEC 61010-2-010:2019 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – del
2-010: Bestemte krav for laboratorieutstyr til oppvarming av materialer

n IEC 61010-2-081:2019 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – del
2-081: Bestemte krav for automatisk og semiautomatisk laboratorieutstyr til analysering og andre
formål

n IEC 61010-2-101:2018 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – del
2-101: Bestemte krav for medisinsk utstyr til in vitro-diagnostikk (IVD)

n CAN/CSA-C22.2 NR. 61010-1-12:2018 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og
laboratoriebruk, del 1: Generelle krav

n CAN/CSA-C22.2 NR. 61010-2-010:19 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og
laboratoriebruk, del 2-010: Bestemte krav for laboratorieutstyr til oppvarming av materialer

n CAN/CSA-C22.2 NR. 61010-2-081:19 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og
laboratoriebruk, del 2-081: Bestemte krav for automatisk og semiautomatisk laboratorieutstyr til
analysering og andre formål

n CSA-C22.2 NR. 61010-2-101:19 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og
laboratoriebruk – del 2-101: Bestemte krav for medisinsk utstyr til in vitro-diagnostikk (IVD)

n IEC 61010-1:2010 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk, del 1:
Generelle krav

n IEC 61010-2-010:2014 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – 2-
010: Bestemte krav for laboratorieutstyr til oppvarming av materialer

n IEC 61010-2-081:2015 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – 2-
081: Bestemte krav for automatisk og semiautomatisk laboratorieutstyr til analysering og andre
formål
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n IEC 61010-2-101:2017 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – 2-
101: Bestemte krav for medisinsk utstyr til in vitro-diagnostikk (IVD)

n UL 61010-1:2012 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – del 1:
Generelle krav

n UL 61010-2-010:2019 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – del 2-
010: Bestemte krav for laboratorieutstyr til oppvarming av materialer

n UL 61010-2-081:2019 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – del 2-
081: Bestemte krav for automatisk og semiautomatisk laboratorieutstyr til analysering og andre
formål

n UL 61010-2-101:19 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – del 2-
101: Bestemte krav for medisinsk utstyr til in vitro-diagnostikk (IVD)

Elektromagnetisk kompatibilitet (EMC)
CFX Opus Dx-system har blitt testet og er i samsvar med alle gjeldende krav til følgende standarder for
elektromagnetisk kompatibilitet:

n IEC 61326-1:2012 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – EMC-
krav – del 1: Generelle krav. Testet som en klasse A-enhet

n IEC 61326-2-6:2012 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – EMC-
krav – del 2-6: Bestemte krav for medisinsk utstyr til in vitro-diagnostikk (IVD)

n EN 61326-1:2013 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – EMC-krav
– del 1: Generelle krav. Testet som en klasse A-enhet

n EN 61326-2:-6:2013 Sikkerhetskrav for elektrisk utstyr til måling, kontroll og laboratoriebruk – EMC-
krav – del 2-6: Bestemte krav for medisinsk utstyr til in vitro-diagnostikk (IVD)

n FCC del 15, underdel B, avsnitt 15.107 og 15.109. Testet som en klasse A digital enhet

n CAN ICES-003v6:2019 Standard for utstyr som forårsaker interferens, informasjonsteknologisk
utstyr (inkludert digitalt apparat) – grenser og målemetoder. Testet til klasse A-grenser

EMC-advarsler og merknader
n Advarsel: Endringer eller modifiseringer på dette apparatet, som ikke er uttrykkelig godkjent av

Bio-Rad, kan oppheve brukerens rett til å bruke utstyret.

n Merknad: Dette utstyret er testet og funnet i samsvar med grensene for digitalt utstyr i klasse A, i
henhold til del 15 i FCC-reglene. Disse grensene er utarbeidet for å gi rimelig beskyttelse mot
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skadelig forstyrrelse når utstyret brukes i et kommersielt miljø. Dette utstyret genererer, bruker og
kan utstråle radiofrekvensenergi og kan, hvis det ikke installeres og brukes i henhold til
instruksjonshåndboken, forårsake skadelige forstyrrelser på radiokommunikasjon. Det er sannsynlig
at dette utstyret vil føre til skadelige forstyrrelser hvis det brukes i boligområder, og hvis dette er
tilfellet, må brukeren korrigere forstyrrelsene for egen kostnad.

n Merknad om FCC-samsvar: Selv om dette utstyret har blitt testet og funnet å være i samsvar med
FCC-reglenes del 15, underavsnitt B, for en digital enhet i klasse A, gjøres det oppmerksom på at
dette samsvaret er frivillig, ettersom instrumentet anses som «unntatt utstyr» ifølge 47 CFR 15.103
(c), i henhold til de gjeldende FCC-reguleringene på produksjonstidspunktet.

n Merknad angående kabler: Dette instrumentet ble testet for EMC-samsvar ved hjelp av
spesialdesignede USB-kabler som følger med instrumentet. Disse kablene, eller autoriserte
tilsvarende kabler godkjent av Bio-Rad, må brukes med dette instrumentet for å sikre fortsatt
samsvar av EMC-utslippsgrensene.
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Krav til omgivelsene
CFX Opus Dx-systemene er designet for å brukes sikkert under omgivelsesforhold som er oppført i
følgende tabell.

Parameter Spesifikasjon

Miljø Kun til innendørs bruk

Driftshøyde Opptil 2 000 meter over havet

Romtemperatur 15–31 °C

Transport og lagringstemperatur –20 °C til 60 °C**
–4 til 140 °F

Relativ luftfuktighet 20 % til 80 % (ikke-kondenserende)

Strømbruk 100–240 VAC ± 10 %, 50/60–850 Hz, 850W
maks.

Variasjoner i nettspenningen ±10 %

Maksimalt strømforbruk < 850 watt

Sikringer 10 A, 250 V, 5 x 20 mm, hurtig (antall 2)

Overspenningskategori II

Forurensningsgrad 2

*Bruk av instrumentet utenfor dette temperaturområdet, gjør kanskje at ytelsesspesifikasjonene ikke
kan oppfylles. En romtemperatur på 5–40 °C anses som trygt.

**Lagre og transporter instrumentet i transportesken for å møte disse temperaturforholdene.

***Bruk av instrumentet ved 4 ⁰C bør begrenses til 18 timer ved disse forholdene. Bruk ved 4 ⁰C kan
gjøres i opptil 72 timer hvis luftfuktigheten er mindre enn 60 % (ikke-kondenserende).

Tabell 2. CFX Opus Dx PCR-sanntidssystem krav til omgivelsene
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Farer
CFX Opus Dx-system er designet for å fungere trygt når de brukes på den måten som er foreskrevet av
produsenten. Hvis systemet eller noen av dets tilknyttede komponenter brukes på en måte som ikke er
spesifisert av produsenten, kan den iboende beskyttelsen som instrumentet gir bli svekket. Bio-Rad er
ikke ansvarlig for materielle skader eller personskader forårsaket av bruk av dette utstyret på noen
uspesifisert måte, eller ved modifikasjoner på instrumentet som ikke er utført av Bio-Rad eller en
autorisert agent. Service på CFX Opus Dx-system skal kun utføres av opplært Bio-Rad-personell.

Biologiske farer
CFX Opus Dx-system er et laboratorieprodukt. Hvis smittefarlige biologiske prøver er til stede, må du
imidlertid følge retningslinjene nedenfor og overholde lokale forskrifter og regler ved laboratoriet.

Merknad: Det genereres ingen smittefarlige biologiske stoffer under normal drift av dette
instrumentet.

Generelle forholdsregler

n Bruk alltid laboratoriefrakk, laboratoriehansker og vernebriller med sideskjerming.

n Hold hendene unna munn, nese og øyne.

n Eventuelle kutt eller skrubbsår må dekkes fullstendig før håndtering av potensielt smittefarlige
materialer.

n Vask hendene grundig med såpe og vann etter håndtering av potensielt smittefarlige materialer, før
du forlater laboratoriet.

n Ta av armbåndsur og smykker før arbeid ved benken.

n Oppbevar alle smittefarlige eller potensielt smittefarlige materialer i uknuselige, lekkasjesikre
beholdere.

n Ta av verneklær før du forlater laboratoriet.

n Mens du har hansker på, må du ikke skrive, ta telefonen, slå på lyset eller berøre noen ting som
andre kan berøre uten hansker.

n Bytt hansker ofte. Ta av hanskene umiddelbart når de blir synlig kontaminert.

n Materialer som ikke kan dekontamineres på riktig vis, må ikke utsettes for potensielt smittefarlige
materialer.

n Ved fullførelse av en operasjon som involverer biologisk farlig materiale, må arbeidsområdet
dekontamineres med et egnet desinfeksjonsmiddel (for eksempel en 1:10-fortynning av
husholdningsklor).
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Dekontaminering av overflater

ADVARSEL! For å unngå elektrisk støt skal instrumentet alltid slås av og kontakten
trekkes ut før du utfører dekontaminering.

Følgende områder kan rengjøres med bakterie-, virus- og soppdrepende desinfiseringsmidler:

n Utvendig lokk og kabinett

n Indre prøveblokkoverflate og prøveblokkbrønner

n Kontrollpanel og skjerm

Se anvisningene fra produsenten for instruksjoner om preparering og bruk av desinfiseringsmiddelet.
Skyll alltid prøveblokken og prøveblokkbrønnene flere ganger med vann etter påføring av
desinfeksjonsmiddel. Tørk av prøveblokken og prøveblokkbrønnene grundig etter skylling med vann.

Viktig: Ikke bruk skurende eller etsende rengjøringsmidler eller sterke alkaliske løsninger. Disse
midlene kan ripe overflatene og skade prøveblokken, noe som fører til tap av presis termisk kontroll.

Kassering av biologisk farlig materiale

Kasser følgende potensielt kontaminerte materialer i henhold til lokale, regionale og nasjonale forskrifter
for laboratorier:

n Kliniske prøver

n Reagenser

n Brukte reaksjonsbeholdere eller andre forbruksartikler som kan være kontaminert

Kjemiske farer
CFX Opus Dx-system inneholder ingen potensielt skadelige kjemiske materialer.

Eksplosjonsfare eller brannfare
CFX Opus Dx-system utgjør ingen uvanlig fare relatert til brennbarhet eller eksplosjon når det brukes på
en riktig måte som spesifisert av Bio-Rad Laboratories.

Elektriske farer
CFX Opus Dx-system utgjør ingen uvanlig elektrisk fare for operatører hvis det er installert og betjent på
riktig måte uten fysiske endringer og koblet til en strømkilde med riktig spesifikasjon.
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Transport

Transport
Før du flytter eller sender CFX Opus Dx-system , må dekontamineringsprosedyrer utføres. Flytt eller send
alltid systemet i en separat beholder i Bio-Rad-levert emballasjemateriale, som beskytter systemet mot
skade.

For informasjon om transport av systemet og for å be om egnet emballasje, kan du ta kontakt med ditt
lokale Bio-Rad-kontor.

Batteri
CFX Opus Dx-system bruker ett 3 V litium-metall knappcellebatteri for å opprettholde tidsinnstillinger ved
strømbrudd. Hvis klokkeslettet ikke forblir innstilt etter at enheten har blitt slått av, kan det tyde på at
batteriene begynner å bli svake.

ADVARSEL! Prøv ikke å bytte batteriene. De kan ikke byttes av brukeren. Kontakt i
stedet Bio-Rad teknisk støtte for assistanse.

Kun for delstaten California i USA

n Perkloratmateriale – Litium-batterier inneholder perkloratmateriale; spesialhåndtering kan kreves. Se
www.dtsc.ca.gov/hazardouswaste/perchlorate.

Kassering
CFX Opus Dx-system inneholder elektriske materialer, og disse skal kasseres som usortert avfall og må
samles inn separat i henhold til EU-direktiv 2012/19/EF, som omhandler elektrisk og elektronisk avfall
(WEEE-direktivet). Kontakt den lokale Bio-Rad-representanten før du kasserer systemet, for å få
instruksjoner som gjelder for ditt land.

Garanti
CFX Opus Dx-system og dets tilhørende tilbehør er dekket av en standard Bio-Rad-garanti. Kontakt din
lokale Bio-Rad-forhandler for å få informasjon om garantien.
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Kapittel 1 Innledning
Bio-Rad sine høytytende PCR-amplifiseringssystemer har de nyeste teknologiske fremskrittene, og gir
større nøyaktighet og reproduserbarhet i nukleinsyreamplifisering for genomiske eksperimenter.

Bio-Rads CFX Maestro Dx-programvare, Security Edition er kompatibel med følgende instrumenter og
har optimaliserte kjøringsfiler for Bio-Rads PrimePCR primer og probeanalyser:

n CFX Opus 96 Dx Real-Time PCR-system (i denne håndboken kalt CFX Opus 96 Dx)

n CFX Opus 384 Dx Real-Time PCR-system (i denne håndboken kalt CFX Opus 384 Dx)

n CFX Opus Deepwell Dx Real-Time PCR-system (i denne håndboken kalt CFX Opus Deepwell Dx)
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Med CFX Maestro Dx-programvare, Security Edition (i denne håndboken kalt CFX Maestro Dx SE) kan
du tolke komplekse data og lage kraftfulle studier for genetisk analyse. Med noen få klikk kan du sette opp
studier og og få mening i genuttrykksstudien ved hjelp av verktøy som for eksempel t-tester, enveis
ANOVA, PrimePCR-kontrollanalyser og verktøyet for valg av referansegen. Deretter kan du klargjøre
resultatene for publikasjoner og posterpresentasjoner med CFX Maestro Dx SEs svært fleksible
datavisualiserings- og merknadsverktøy.

Merknad: Visningen av enkelte skjermer i CFX Maestro kan se annerledes ut enn dem som er vist i
denne brukerveiledningen. Visningen i programvaren er korrekt, og funksjonaliteten er den samme.

Viktig: Cybersikkerhet er beskyttelse av eiendom på nettet som skal hindre cyberangrep.
Cybersikkerhet er Bio-Rads mulighet til å ivareta sikkerheten til mennesker, informasjon, systemer
og omdømme på nettet. Nettet er alltid på og knytter verden teknologisk sammen – det består av
mennesker, organisasjoner, informasjon og teknologi.

Rask reaksjon er viktig når det kommer til problemer på nettet! Hvis du mistenker at det kan være et
problem med cybersikkerheten angående instrumentet ditt, eller at cybersikkerheten har blitt brutt på
stedet ditt, må du kontakte din Bio-Rad-representant for teknisk støtte umiddelbart.
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Hovedtrekk ved CFX Maestro Dx-programvare, Security
Edition

Med CFX Maestro Dx SE kan du gjøre følgende:

n Analysere data ved hjelp av søylediagrammer, klyngediagrammer eller spredningsdiagrammer for
raskt å tolke og forstå resultatene.

n Tilpass datapresentasjonen og eksporter grafer med høy oppløsning for publisering og generering av
rapporter.

n Fastslå RNA-kvalitet og feilsøk eksperimenter med PrimePCR-analysekontroller.

n Velg egnet referansegen og analyser stabiliteten med verktøyet for valg av referansegen.

n Utfør statistiske analyser, inkludert enveis-ANOVA, i genuttrykksanalyser.

Denne brukerveiledningen forklarer disse funksjonene og hvordan de brukes.

Finne ut mer
Etter installasjon av CFX Maestro Dx SE og oppsett av tilhørende Bio-Rad PCR-instrument, kan du få
tilgang til denne veiledningen så vel som detaljerte CFX Maestro Dx SE hjelpeemner fra Help-menyen i
en hvilken som helst visning.

Tips: Klikk på Bio-Rad-logoen øverst til høyre i et vindu i CFX Maestro Dx SE for å åpne Bio-Rad-
nettstedet. Dette nettstedet inkluderer koblinger til tekniske merknader, håndbøker, videoer,
produktinformasjon og teknisk støtte. Dette nettstedet har også mange tekniske ressurser for en lang
rekke metoder og bruksområder knyttet til PCR, sanntids-PCR og genuttrykk.
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Kapittel 2 Installasjon av CFX Maestro Dx-
programvare, Security Edition

Dette kapittelet beskriver hvordan du installerer CFX Maestro Dx-programvare, Security Edition. For
informasjon om hvordan du setter opp sanntids PCR-instrumenter som støttes av Bio-Rad, se den
relevante veiledningen.

CFX Maestro Dx SE kreves for å analysere PCR-data i sanntid fra CFX Opus 96 Dx og CFX Opus 384 Dx
sanntids-PCR. Du kan også bruke denne programvaren til å styre disse systemene i programvarestyrt
modus.

CFX Opus Dx leveres med en USB-kabel i tilbehørsvesken. Bruk USB-kabelen til å koble datamaskinen
som kjører CFX Maestro Dx SE til CFX Opus Dx-system.

Fjern emballasjen og ta vare på den til fremtidig bruk. Kontakt din lokale Bio-Rad-forhandler hvis det
mangler en del eller hvis noe er skadet.
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Systemkrav
Tabell 3 lister opp minimum og anbefalte systemkrav for datamaskinen som kjører CFX Maestro Dx SE.

System Minimum Anbefalt

Operativsystem Microsoft Windows 10 (kun 64-
bit), build 1511 eller nyere, med
de siste
sikkerhetsoppdateringene.

Microsoft Windows 10 (kun 64-bit), build
1511 eller nyere, med de siste
sikkerhetsoppdateringene.

Merknad:Windows 11 støtter også CFX Maestro Dx-programvare, Security Edition.

Viktig: Sikker oppstart må deaktiveres på datamaskiner som kjører CFX Maestro Dx SE.
Datamaskiner som kjører CFX Maestro Dx SE skal konfigureres slik at de ikke starter på nytt
automatisk etter en system- eller sikkerhetsoppdatering hvis en kjøring pågår. Kontakt
systemadministratoren for å få hjelp.

Porter 2 USB 2.0-porter med høy
hastighet

2 USB 2.0-porter med høy hastighet

Plass på harddisken 128 GB 128 GB

Prosessorhastighet 2,4 GHz, Dual Core 2,4 GHz, Quad Core

RAM 4 GB RAM 8 GB RAM

Skjermoppløsning 1024 x 768 med millioner av
farger (true-color)

1280 x 1024 med millioner av farger (true-
color)

PDF-leser Adobe PDF Reader eller Windows PDF
Reader fra en av de støttede Microsoft
Office-pakkene:

n 2016

n 2019

Lokalisering Støttede Microsoft Windows 64-
bit OS på engelsk, kinesisk og
russisk

Støttede Microsoft Windows 64-bit OS på
engelsk, kinesisk og russisk

Tabell 3. Datamaskinkrav for CFX Maestro Dx SE

Merknad: Hvis du planlegger å kjøre CFX Automation Control-programvare på samme datamaskin
som CFX Maestro Dx SE, må skjermoppløsningen angis til 1280 x 1024 med millioner av farger (true-
color).
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Installere CFX Maestro Dx SE-programvaren
Viktig: Før du installerer eller oppgraderer programvaren må du koble fra eventuelle instrumenter
som er koblet til CFX Maestro Dx SE-datamaskinen. Det er ikke nødvendig å slå av instrumentet
under programvareinstallasjonen. Kontroller at du har lagret alle kjøringer, og at ingen eksperimenter
pågår.

Merknad: Kontroller at sikker oppstart er deaktivert før du begynner installasjonsprosedyren.
Forsikre deg om at datamaskinen er konfigurert slik at den ikke starter på nytt automatisk etter en
system- eller sikkerhetsoppdatering hvis en kjøring pågår. Kontakt systemadministratoren for å få
hjelp.

Installere CFX Maestro Dx SE-programvaren

1. Koble fra eventuelle instrumenter som er koblet til datamaskinen.

Finn instrumentets USB-kabel på CFX Maestro Dx SE-datamaskinen, og koble den fra. Kabelenden
som er tilkoblet CFX Opus Dx-system trenger ikke kobles fra.

2. Logg på CFX Maestro Dx SE-datamaskinen som administrator.

3. Sett USB-stasjonen med CFX Maestro Dx SE inn i USB-porten på datamaskinen.

4. ÅpneWindows Utforsker, naviger til USB-stasjonen med CFX Maestro Dx SE og åpne den.

USB-enheten inneholder versjonsmerknader og følgende mapper:

n CFX

n Drivers (Drivere)

n Firmware (Fastvare)

n Quick Start (Hurtigstart)

Sammen med andre filer, inneholder CFX-mappen CFX Maestro Dx SE installasjonsprogram
(CFXMaestroDxSetup.exe).

5. Åpne CFX-mappen og dobbeltklikk på CFXMaestroDxSetup.exe for for å starte installasjonen.

6. Følg installasjonsinstruksjonene på skjermen.

Når den er fullført, vises Bio-Rad CFX Maestro Dx-programvare, Security Edition-ikonet vises på
datamaskinens skrivebord.

Tips: CFXMaestro-installasjonsprogrammet installerer automatisk CFX Maestro Dx-
programvare, Security Edition-brukerveiledningen. For å finne disse veiledningene, naviger til
Help-menyen og velg Open User Guides (Åpne brukerveiledninger).

7. Når installasjonen er ferdig, kan du trygt ta ut USB-enheten med programvaren.
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Detektere tilkoblede instrumenter
Under installasjonen, vil installasjonsprogrammet for CFX Maestro Dx SE automatisk installere
instrumentdriverne på CFX Maestro Dx SE-datamaskinen. CFX Maestro Dx SE detekterer tilkoblede
instrumenter når du starter programvaren.

Slik detekterer du tilkoblede instrumenter

1. Hvis du ikke allerede har gjort det, setter du den firkantede (han)enden av den medfølgende USB B-
kabelen inn i USB B-porten på baksiden av instrumentets sokkel.

2. Sett den andre (port)enden inn i en USB-port på datamaskinen med CFX Maestro Dx SE.

3. Hvis instrumentet ikke allerede kjører, trykker du på strømbryteren på instrumentet for å slå det på.

4. Start CFX Maestro Dx SE.

Programvaren detekterer automatisk det tilkoblede instrumentet og viser instrumentets navn i ruten
Detected Instruments (Detekterte instrumenter) i startvinduet.

Merknad: Hvis instrumentet ikke vises i ruten Detected Instruments (Detekterte instrumenter), må du
kontrollere at USB-kabelen er satt inn riktig. Hvis du vil installere driverne på nytt, velger du Tools >
Reinstall Instrument Drivers (Verktøy > Installer instrumentdrivere på nytt) i startvinduet i
CFX Maestro Dx SE.
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Programvarefiler
Tabell 4 inneholder en liste over filtypene CFX Maestro Dx SE.

Filtype Utvidelse Detaljer

Protokoll .prcl Inneholder detaljer om protokolloppsett for å utføre en PCR-
kjøring.

Plate .pltd Inneholder detaljer om plateoppsett for å utføre en PCR-
kjøring.

Data .pcrd Inneholder resultatene fra en eksperimentkjøring og PCR-
analyse.

PrimePCR-kjøring .csv Inneholder protokoll- og plateoppsett for PrimePCR-plater.

Genstudie .mgxd Inneholder resultater fra flere PCR-kjøringer og
genuttrykksanalyser.

Stand-alone predatafil .zpcr Inneholder fluorescensavlesninger fra stand-alone bruk
som er konvertert til en datafil.

LIMS .plrn Inneholder informasjon om plate- og protokolloppsett som
kreves for å utføre en LIMS-kompatibel kjøring.

JSON .json En skrivebeskyttet fil generert bare av CFX Opus Dx-
systemer. Denne filen inneholder kjøredataene som vises i
detaljruten i filutforskeren når en kjøringsfil er valgt. Denne
filen genereres etter at en kjøring er fullført. Den
eksporteres med .zpcr-filen og lagres med datafilene når
bane til lagring enten er en USB-stasjon eller en delt
nettverksmappe.

Tabell 4. Filtyper for CFX Maestro Dx SE
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Kapittel 3 Administrere brukerkontoer i
CFX Maestro Dx-programvare, Security Edition

I CFX Maestro Dx-programvare, Security Edition logger brukerne seg på medWindows-brukernavn og -
passord. Personen som installerte CFX Maestro Dx SE tilordnes automatisk rollen som Administrator og
kan opprette og administrere brukerkontoer og roller. Alle andre brukere må tilordnes en brukerkonto for å
kunne logge på og bruke programvaren.

Viktig: Hver bruker må ha enWindows-konto og et passord på CFX Maestro Dx SE-datamaskinen
før du kan tilordne en brukerkonto og rolle. Brukere kan være medlemmer av enten Windows Users-
gruppen eller Windows Administrators-gruppen. Medlemmer av Windows Users-gruppen har bare
tilgang til sine egne CFX Maestro Dx SE-filer og mapper. Medlemmer av Windows Administrators-
gruppen har tilgang til filene og mappene til alle brukere på datamaskinen.

Dette kapittelet forklarer hvordan du oppretter Microsoft Windows-brukere for å legge til disse brukerne i
CFX Maestro Dx SE. Denne delen forklarer også hvordan du legger til CFX Maestro Dx SE-brukere og
administrere brukerroller og tillatelser.
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Starte CFX Maestro Dx-programvare, Security Edition
Merknad: Hver bruker må logge på med sitt Windows-brukernavn og passord.

Starte CFX Maestro Dx SE

1. På CFX Maestro Dx SE-datamaskinens skrivebord, dobbeltklikker du på CFX Maestro Dx SE-ikonet
for å starte programmet.

2. Skriv inn Windows-passordet i innloggingsboksen og klikk OK.

CFX Maestro Dx SE åpnes med Home-vinduet. Tittellinjen viser Windows-brukernavnet til den
påloggede brukeren, og menylinjen viser en blå boks som indikerer at programvaren er 21 CFR Part
11-kompatibel, for eksempel:
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Starte CFX Maestro Dx-programvare, Security Edition
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Legge til Microsoft Windows-brukere på CFX Maestro Dx-
programvare, Security Edition-datamaskinen

Alle brukere må logge på CFX Maestro Dx SE-datamaskin medWindows-brukernavn og -passord. For
nøyaktig revisjonssporing kan ikke Windows-brukerkontoer legges til via dialogboksen Start > Settings >
Accounts (Start > Innstillinger > Kontoer). Windows-brukerkontoermå legges til via Computer
Management-konsollen.

Viktig: Endringer som er gjort i Windows-brukeregenskaper (inkludert brukernavn og fullt navn),
etter at du har opprettet den tilknyttede CFX Maestro Dx SE-brukeren, ugyldiggjør CFX Maestro Dx
SE-brukeren. Forsikre deg om at informasjonen er riktig før du lagrer Windows-brukeren og oppretter
den tilknyttede CFX Maestro Dx SE-brukeren.

Tips: Les administrasjonsdokumentasjonen for Microsoft Windows og seWindows-
systemadministratoren for mer informasjon før du oppretter Windows-kontoer.

Legge til Windows-brukerkontoer på CFX Maestro Dx SE-datamaskinen

1. Logg deg på CFX Maestro Dx SE-datamaskinen sommedlem avWindows Administrators-gruppen.

2. Høyreklikk på My Computer (Min datamaskin) på skrivebordet og velg Manage (Administrer) for å
åpne Computer Management-konsollen.

3. I Computer Management-konsollen utvider du Local Users and Groups (Lokale brukere og grupper).

4. Høyreklikk på Users-mappen (Brukere) og velg New User (Ny bruker) for å åpne dialogboksen New
User (Ny bruker).
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Legge til Microsoft Windows-brukere på CFX Maestro Dx-programvare, Security Edition-datamaskinen

5. I dialogboksen New user (Ny bruker) må du fylle ut følgende felt:

n User name (Brukernavn)

n Full name (Fullt navn)

n Password (Passord)

n Confirm password (Bekreft passord)

6. Klikk på Create (Opprett).
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Kapittel 3 Administrere brukerkontoer i CFX Maestro Dx-programvare, Security Edition

Legge til og fjerne brukere i CFX Maestro Dx-programvare,
Security Edition

Tips: Bare brukere med Administrator-rolle i CFX Maestro Dx SE kan opprette og fjerne
CFX Maestro Dx SE-brukerkontoer. Personen som installerte CFX Maestro Dx SE tildeles
automatisk Administrator-rollen. Denne personen kan tilordne Administrator-rollen til andre brukere.

Merknad: I CFX Maestro Dx SE, må minst én bruker tilordnes Administrator-rollen.

Slik legger du til brukerkontoer i CFX Maestro Dx SE

1. Kontroller at hver tiltenkt bruker er medlem av enten Windows Users-gruppen eller Windows-
Administrators-gruppen og har et Windows-passord på CFX Maestro Dx SE-datamaskinen.

2. Start CFX Maestro Dx SE og logg inn som Administrator.

3. I startvinduet velger du User > User Administration (Bruker > Brukeradministrasjon).

Dialogboksen User Administration (Brukeradministrasjon) vises.
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Administrere CFX Maestro Dx-programvare, Security Edition-brukerroller

4. I delen Manage Users (Administrer brukere), oppgi følgende informasjon for hver bruker:

n User name (Brukernavn) – i CFX Maestro Dx SE,må dette være brukerens brukernavn for
Windows-pålogging.

n Full name (Fullt navn) – brukerens fulle navn.

Dette navnet vises i feltet Full User (Full bruker) i revisjonssporet. Dette navnet må være det
samme navnet som ble angitt i feltet Full name (Fullt navn) da Windows-brukeren ble opprettet.

n Role (Rolle) – rollen som skal tilordnes brukeren.

Merknad: Du kan bare velge én rolle fra rullegardinlisten. Se Administrere CFX Maestro
Dx-programvare, Security Edition-brukerroller for mer informasjon.

n Domain (Domene) –Windows-domenet som brukeren får tilgang til programvaren fra.

Kontakt din Windows systemadministrator for mer informasjon.

5. Klikk OK, og klikk deretter Yes (Ja) for å lagre endringene og lukke dialogboksen User Administration
(Brukeradministrasjon).

Fjerne en CFX Maestro Dx SE-brukerkonto

1. Start CFX Maestro Dx SE og logg inn som Administrator.

2. I vinduet Home (Hjem) velger du User > User Administration (Bruker > Brukeradministrasjon) for å
åpne dialogboksen User Administration.

3. I vinduet Manage Users (Administrer brukere) velger du Remove (Fjern) for hver bruker du ønsker å
fjerne.

4. Klikk OK, og klikk deretter Yes (Ja) for å lagre endringene og lukke dialogboksen User Administration
(Brukeradministrasjon).

Administrere CFX Maestro Dx-programvare, Security Edition-
brukerroller

Viktig: CFX Maestro Dx SE krever at minst én bruker er tilordnet administratorrollen. Du kan tilordne
denne rollen til mer enn én bruker.

CFX Maestro Dx SE har fire brukerroller. Hver bruker må tildeles en rolle for å få tilgang til programvaren.
Selv om brukere bare kan tildeles én rolle, kan du når som helst endre en brukers rolle.

Med unntak av administratorrollen kan du endre tillatelsene som er tilordnet hver rolle. Alle brukere som
tilordnes en rolle, får kun tillatelsene til den rollen.

Som standard er rettighetene for hver rolle som følger:
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n Administrator – denne rollen har alle tillatelser, og du kan ikke endre disse tillatelsene.

n Principal – denne rollen har alle tillatelser unntatt å konfigurere e-post.

n Operator – denne rollen har alle tillatelser unntatt å hoppe over sykluser og konfigurere e-post.

n Guest – denne rollen kan bare lese filer.

Når du tilordner roller i CFX Maestro Dx SE, fastslå nøye kravene til hver bruker. For eksempel, uten
tillatelse til å lagre, kan ikke brukere som er tilordnet guest-rollen signere en fil. Uten tillatelse til å opprette
en e-postkonto, vil ingen av rollene motta e-post når en kjøring er fullført.

Endre tillatelsene for en rolle

1. Start CFX Maestro Dx SE og logg inn som Administrator.

2. I vinduet Home (Hjem) velger du User > User Administration (Bruker > Brukeradministrasjon) for å
åpne dialogboksen User Administration.

3. I delen Manage Rights (Administrer rettigheter) fjerner du merket for hver rolle eller merker av for
spesifikke tillatelser etter behov.

4. Klikk OK, og klikk deretter Yes (Ja) for å lagre endringene og lukke dialogboksen User Administration
(Brukeradministrasjon).

Vise din rolle og tillatelser
Tips: Brukere som tilordnes brukerrollene Principal (Hovedbruker), Operator (Operatør) eller Guest
(Gjest), kan bare se sine brukerinnstillinger, tillatelser og roller. Brukere som er tilordnet
administratorrollen, kan se alle brukertillatelser og roller.

Slik kan du se din brukerrolle og tillatelser

u I startvinduet velger du User > User Administration (Bruker > Brukeradministrasjon).

Kontakt CFX Maestro Dx SE-administratoren for å modifisere brukerinnstillinger, tillatelser og roller som
vises i vinduet User Administration (Brukeradministrasjon).
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Kapittel 4 Bruke CFX Maestro Dx-programvare,
Security Edition

Viktig: CFX Maestro Dx-programvare, Security Edition bruker Microsoft Windows-
brukerautentisering for å verifisere tilgang til sikre CFX-datafiler. Kontakt Windows-administratoren
din for å opprette et miljø som oppfyller 21 CFR del 11-krav.

Med CFX Maestro Dx SE kan brukere

n Signere data- og genstudiefiler.

n Passordbeskytte datafiler.

n Se og skrive ut revisjonsspor.

Denne delen forklarer disse funksjonene i detalj.

Sikre filer
Som standard lagrer CFX Maestro Dx SE sikre filer i den innloggede brukerens personlige mappe, som
ligger på

C:\Users\<brukernavn>\Documents\Bio-Rad\CFX_MDX\My qPCR

Du kan lagre og redigere .pcrd-filer i den mappen. Denne mappen inneholder koblinger til andre mapper
(for eksempel mappen Sample Files) som inneholder filer som er skrivebeskyttet. En administrator kan
imidlertid slette innholdet i den mappen.

Tips: Alternativt kan Windows-systemadministratoren opprette en delt mappe og din CFX Maestro
Dx SE-administrator kan programmere programvaren til å lagre alle filene i den mappen.

I CFX Maestro Dx SE er plate-, protokoll-, data- og genstudiefiler merket som sikre når de lagres. Du kan
opprette disse filene i CFX Maestro-programvaren eller i CFX Maestro Dx SE. Etter at de er lagret i
CFX Maestro Dx SE, kan du bare åpne disse filene i CFX Maestro Dx SE.

CFX Maestro Dx SE oppretter et revisjonsspor for alle sikre data- og genstudiefiler (henholdsvis .pcrd- og.
mgxd-filer). Programvaren registrerer all reviderbar aktivitet i filens revisjonsspor. For mer informasjon, se
Revisjonsspor på side 299.
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Kapittel 4 Bruke CFX Maestro Dx-programvare, Security Edition

Signere sikre filer

Etter å ha lagret en fil i CFX Maestro Dx SE, kan brukere legge til en elektronisk signatur. For å signere en
fil, må brukerens rolle ha tillatelse til å lagre en fil. For eksempel har Guest-rollen som standard ikke
tillatelse til å lagre en fil, og derfor kan ikke brukere som er tildelt denne rollen signere en fil.

I CFX Maestro Dx SE, er signerte filer ikke satt som skrivebeskyttet. De kan gjennomgås, endres og
signeres flere ganger. Alle endringer og signaturer blir sporet i filens revisjonsspor. Du kan signere
følgende filtyper:

n Datafiler (.pcrd)

n Genstudiefiler (.mgxd)

Merknad: Filer må lagres før de kan signeres. Hvis du nylig har utført en kjøring i CFX Maestro Dx
SE, må du lagre den resulterende datafilen først.

Signere en fil

1. Logg på CFX Maestro Dx SE medWindows-påloggingsinformasjonen din.

2. Åpne den sikre datafilen eller genstudiefilen for å signere.

3. Velg File > Sign (Fil > Signer). Dialogboksen Electronic Signature (Elektronisk signatur) vises.
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4. Skriv inn Windows-brukernavnet og passordet ditt og årsaken til signeringen av filen.

Brukernavnet og årsaken til signering er inkludert i revisjonssporet (for mer informasjon, se
Revisjonsspor på side 299).

5. Klikk OK for å sende signaturen og lukke dialogboksen.

Endring av sikre filer

I CFX Maestro Dx SE, kan brukere endre sikre filer, inkludert signerte og usignerte data- og genstudiefiler.
Programvaren ber deg om å oppgi en grunn til endringen når du lagrer en modifisert sikker data- eller
genstudiefil. Endringene spores i filens revisjonsspor.

Tips: Siden programvaren ikke oppretter revisjonsspor for plate- eller protokollfiler, blir du ikke bedt
om å oppgi en grunn når du lagrer endringene i disse filene.

Lagre en modifisert data- eller genstudiefil

1. Logg på CFX Maestro Dx SE medWindows-påloggingsinformasjonen din.

2. Åpne og endre en sikker datafil eller genstudiefil.

Tips: For en liste over reviderbare aktiviteter, se Reviderbare hendelser på side 301.

3. Velg File > Save (Fil > Lagre). Dialogboksen Audit Trail Change Reason (Årsak til endring av
revisjonsspor) vises.
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Kapittel 4 Bruke CFX Maestro Dx-programvare, Security Edition

Denne dialogboksen viser følgende informasjon, som er fanget opp i filens revisjonssporoverskrift for
hver endringshendelse:

n Date (Dato) – datoen da endringen skjedde.

n User (Bruker) –Windows-domenet og brukernavnet til den påloggede brukeren.

n Comment (Kommentar) – den siste lagrede kommentaren.

n Signature (Signatur) – den elektroniske signaturen til den siste personen som signerte filen.

n Signature reason (Signaturårsak) – årsaken til signaturen.

n Application (Program) – CFX Maestro Dx SE (vises som BioRadCFXManager.exe, som er
riktig).

n Application version (Programversjon) – den gjeldende versjonen av CFX Maestro Dx SE.

n Full user (Full bruker) – det fulle navnet på den påloggede brukeren.

Merknad: Dette navnet vises i revisjonssporet.

n Machine (Maskin) – datamaskinen der programvaren er installert.
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Endringstabellen viser de reviderbare endringene som skjedde som et resultat av endringen. En kort
beskrivelse av årsaken til endringen kan også vises.

Tips: Du kan legge til eller redigere beskrivelser i kolonnen Reason for Change (Årsak til
endring).

4. Gjennomgå listen over endringer. Oppgi detaljerte årsaker om nødvendig.

5. Gjør ett av følgende:

n Klikk på Save Changes (Lagre endringer) for å lagre endringene i filen, samt eventuelle
endringer du har gjort i tabellen, og lukk dialogboksen.

Endringene i filen og årsakene til endringene vises i filens revisjonsspor.

n Klikk på Cancel Changes (Kanseller endringer) for å tilbakestille filen til sin forrige status og
lukke dialogboksen.

Endringene lagres ikke i filen, og revisjonssporet oppdateres ikke.
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Kapittel 4 Bruke CFX Maestro Dx-programvare, Security Edition

Passordbeskyttelse av filer

Som et ekstra sikkerhetsnivå, lar CFX Maestro Dx SE brukerne angi passord på alle sikre filer. Når du
angir passord på en sikker fil, må du vurdere følgende forhold:

Tilstand Handling

Ingen passord kreves. Alle brukere kan åpne, endre og lagre den sikre filen,
basert på deres tillatelser.

Fil krever lagring av passord. Alle brukere kan åpne den sikre filen, og brukere som vet
passordet kan endre og lagre den sikre filen.

Filen krever åpent passord. Bare brukere som kjenner det åpne passordet, kan
åpne, endre og lagre den sikre filen.

Filen krever både åpne og lagre
passord.

Noen brukere kan åpne den sikre filen, og en
undergruppe av disse brukerne kan endre og lagre filen.

Avhengig av brukerens rolle, kan enhver bruker utføre Save as (Lagre som) for å opprette en ny sikker fil
med et annet navn eller lagre en fil med samme navn et annet sted så lenge ett av følgende stemmer:

n Den sikre filen er ikke passordbeskyttet.

n Brukeren har passordet for å åpne filen.

Tips: Den nye filen lagres uten passordbeskyttelse. Den opprinnelige filen beholder passordene
sine.

Avhengig av hvilken rolle, kan en bruker endre og lagre originalfilen så lenge ett av følgende stemmer:

n Filen er ikke passordbeskyttet.

n Brukeren har passordet for å åpne og passordet for å lagre filen.

Merknad: Brukerens rolle må ha retten til å lagre filer for å angi passord. For eksempel kan brukere
med rollen Guest ikke lagre filer og kan derfor ikke angi passord på en fil.

Viktig: Kun CFX Maestro Dx SE-administratorer kan tilbakestille eller fjerne passord.
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Passordbeskytte en fil

1. Logg på CFX Maestro Dx SE medWindows-legitimasjonen din.

2. Åpne den sikre filen.

3. Velg File > File Passwords (Fil > Filpassord). Dialogboksen File Passwords (Filpassord) vises.

4. Skriv inn passord i boksen Save Password (Lagre passord) og Open Passwords (Åpne passord).

Tips: Passord vises som standard som stjerner når de skrives inn. Velg Show Password (Vis
passord) for å vise passordet mens du skriver det.

Viktig: Passord er følsomme for store og små bokstaver. CFX Maestro Dx SE setter ikke
begrensninger på passord. For beste praksis, se systemadministratoren for krav om passord på
stedet ditt.

5. Klikk på Set Passwords (Angi passord) for å angi passord og lukke dialogboksen.

6. Velg File >Save (Fil > Lagre) for å lagre endringene i filen.
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Fjerne passord

Viktig: Du må være en CFX Maestro Dx SE-administrator for å fjerne passord.

1. I dialogboksen Password Required (Passord kreves) klikker du Remove Passwords (Fjern passord).

CFX Maestro Dx SE-innloggingsdialogboksen vises.

2. Oppgi Windows brukernavn og passord for CFX Maestro Dx SE-administrator og klikk OK.

Den originale datafilen vises.

Viktig: Du må lagre filen for å fjerne passordene.

3. Velg File >Save (Fil > Lagre) for å lagre endringene i filen.
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Endre passord

Viktig: Kun CFX Maestro Dx SE-administratorer kan endre passord.

1. Åpne den sikre filen.

2. Velg File > File Passwords (Fil > Filpassord). Dialogboksen File Passwords (Filpassord) vises.

Tips: Save Password, Open Password og Show Password (Lagre passord, Åpne passord og
Vis passord) er deaktivert.

3. Klikk på Reset Passwords (Tilbakestill passord).

CFX Maestro Dx SE-innloggingsdialogboksen vises.
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4. Oppgi Windows brukernavn og passord for CFX Maestro Dx SE-administrator og klikk OK.

Dialogboksen File Passwords (Filpassord) vises.

5. Gjør ett av følgende:

n For å tilbakestille passordbeskyttelse, skriv inn et nytt passord i passordboksen.

n La passordboksene være tomme for å fjerne passordbeskyttelsen.

6. Klikk på Set Passwords (Angi passord) for å lagre passordendringene og lukke dialogboksen.
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Kapittel 5 Arbeidsområdet
CFX Maestro Dx-programvare, Security Edition har et grensesnitt for å sette opp plater, lage PCR-
protokoller, kjøre dem på CFX Opus Dx Deepwell Dx og analysere data fra PCR-kjøringer.

CFX Maestro Dx SE har fem primære arbeidsområder:

n Startvinduet

n Startup Wizard (Oppstartsveiviser)

n Vinduet Protocol Editor (Protokollredigering)

n Vinduet Plate Editor (Plateredigering)

n Vinduet Data Analysis (Dataanalyse)

Hvert arbeidsområde vises og beskrives kort i dette kapittelet.

Brukerhåndbok | 55



Kapittel 5 Arbeidsområdet

Startvinduet
CFX Maestro Dx SE åpnes i startvinduet og viser Startup Wizard (Oppstartsveiviser), som du kan bruke til
å sette opp et eksperiment, utføre eller gjenta en kjøring, eller analysere en eksisterende kjøring. Fra
startvinduet kan du også vise program- og instrumentlogger, opprette og administrere brukere og få
tilgang til mange nyttige verktøy. Hvis du vil ha mer informasjon, se Kapittel 6, Startvinduet.
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Startup Wizard (Oppstartsveiviser)

Startup Wizard (Oppstartsveiviser)
Bruk Startup Wizard (Oppstartsveiviser) for raskt å sette opp og kjøre brukerdefinerte eksperimenter eller
velge og kjøre et PrimePCR-eksperiment. Du kan også bruke denne veiviseren for å gjenta en kjøring
eller for å analysere kjøredata.
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Kapittel 5 Arbeidsområdet

Vinduet Protocol Editor (Protokollredigering)
I vinduet Protocol Editor (Protokollredigering) kan du opprette, åpne, se gjennom og redigere en protokoll.
Du kan også modifisere lokktemperaturen for den åpne protokollen. Funksjonen Protocol Editor
(Protokollredigering) beskrives nærmere i Kapittel 7, Opprette protokoller.
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Vinduet Plate Editor (Plateredigering)

Vinduet Plate Editor (Plateredigering)
I Plate Editor (Plateredigering) kan du opprette, åpne, gjennomgå og redigere en plate. Funksjonene i
Plate Editor (Plateredigering) er nærmere beskrevet i Kapittel 8, Klargjøre plater.
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Vinduet Data Analysis (Dataanalyse)
I vinduet Data Analysis (Dataanalyse) kan du vise og sammenligne kjøredata, utføre statistiske analyser,
eksportere data og opprette rapporter klare til publisering. Dataanalysefunksjonalitet er beskrevet i
Kapittel 10, Oversikt over dataanalyse og Kapittel 11, Detaljer om dataanalyse.
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Kapittel 6 Startvinduet
CFX Maestro Dx-programvare, Security Edition har et grensesnitt for å utvikle PCR-protokoller, å kjøre
dem fra CFX Dx-systemer og analysere PCR-kjøredata.

Dette kapittelet introduserer CFX Maestro Dx SE og beskriver funksjonene som er tilgjengelige i
startvinduet.
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Kapittel 6 Startvinduet

Startvinduet
CFX Maestro Dx SE åpnes i startvinduet og viser Startup Wizard (Oppstartsveiviser), der du kan sette
opp en kjøring, utføre eller gjenta en kjøring, eller analysere en eksisterende kjøring. Fra startvinduet kan
du også vise program- og instrumentlogger, opprette og administrere brukere og få tilgang til mange
nyttige verktøy.

1. Programvarens tittellinje viser navnet på programvaren og brukeren som er pålogget.

2. Denne menylinjen gir rask tilgang til menykommandoene File (Fil), View (Vis), Users (Brukere),
Run (Kjør), Tools (Verktøy), Window (Vindu) og Help (Hjelp).

3. Kommandoene på verktøylinjen gir rask tilgang til menyalternativer.

4. Venstre rute viser instrumentene som er tilkoblet CFX Maestro Dx SE-datamaskinen, og den
har knapper som kan brukes til å betjene lokket og vise status for instrumentene.

5. Hovedruten viser arbeidsvinduet. Startup Wizard (Oppstartsveiviser) på startskjermbildet er
standard arbeidsvindu.

FORKLARING
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Startvinduet

6. Statuslinjen viser navnet på de tilkoblede instrumentene og brukeren som er pålogget.

Kommandoer i menyen File (Fil)
New (Ny) – åpner en dialogboks der du kan velge å opprette en ny protokoll, plate eller genstudie.

Open (Åpne) – åpner en dialogboks der du kan velge å navigere til og åpne en eksisterende protokoll,
plate, datafil, genstudie, LIMS-fil, kjøring fra et frittstående instrument (stand-alone-kjøring) eller
PrimePCR™-kjørefil.

Recent Data Files (Nylige datafiler) – viser en liste over nylig åpnede PCR-filer.

Repeat a Run (Gjenta en kjøring) – åpner Windows Utforsker til plasseringen med lagrede PCR-filer, der
du kan finne kjøringen som skal gjentas.

Exit (Avslutt) – lukker CFX Maestro Dx SE.

Kommandoer i menyen View (Vis)
Application Log (Applikasjonslogg) – viser en logg over bruken av programvaren, fra første installasjon
til i dag.

Run Reports (Kjøringsrapporter) – viser en liste over kjøringsrapporter.

Startup Wizard (Oppstartsveiviser) – viser Startup Wizard (Oppstartsveiviser) i hovedruten.

Run Setup (Kjøringsoppsett) – viser vinduet Run Setup (Kjøringsoppsett) i hovedruten.

Instrument Summary (Instrumentsammendrag) – viser vinduet Instrument Summary
(Instrumentsammendrag) i hovedruten.

Detected Instruments (Detekterte instrumenter) – viser/skjuler tilkoblede instrumenter i ruten til venstre.
Som standard viser programvaren tilkoblede instrumenter i ruten til venstre.

Toolbar (Verktøylinje) – viser/skjuler verktøylinjen øverst på skjermen. Som standard viser programvaren
verktøylinjen.

Status Bar (Statuslinje) – viser/skjuler statuslinjen nederst på skjermen. Som standard viser
programvaren statuslinjen.

Show (Vis) – åpner en dialogboks hvor du kan

n vise eller blokkere statusloggen

n åpne og vise datamappen for CFX Maestro Dx SE

n åpne og vise brukerens datamappe

n åpne og vise LIMS-filmappen
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n åpne og vise PrimePCR-mappen

n vise kjøringshistorikken

n vise egenskapene for alle tilkoblede instrumenter

Kommandoer i menyen User (Bruker)
Select User (Velg bruker) – åpner skjermbildet Login (Logg på), der du kan velge en bruker fra
rullegardinmenyen User Name (Brukernavn) og logge på programmet.

Change Password (Endre passord) – åpner dialogboksen Change Password (Endre passord), der
brukerne kan endre passordet sitt.

Merknad: Dette alternativet er deaktivert for CFX Maestro Dx SE. Brukere må endre Windows-
passordet for å kunne endre sitt CFX Maestro Dx SE-passord.

User Preferences (Brukerpreferanser) – åpner dialogboksen User Preferences (Brukerpreferanser), der
brukere kan endre standardinnstillingene for

n Sende og motta e-postvarsel ved fullført kjøring

n Lagre datafiler

n Opprette protokoller via Protocol Editor (Protokollredigering) eller Protocol AutoWriter
(Automatisk protokollskriving)

n Opprette plateoppsett

n Analysere data

n Utføre analyse av genuttrykk

n Bestemme datakvaliteten

n Eksportere CFX-instrumentdata

User Administration (Brukeradministrasjon) – åpner dialogboksen User Administration
(Brukeradministrasjon), der administratorer kan opprette brukere, endre rolletillatelser og tilordne roller til
brukere.

Bio-Rad Service Login (Servicepålogging) – kun til bruk av Bio-Rad teknisk servicepersonell. Ikke velg
denne kommandoen.

Kommandoer i menyen Run (Kjøring)
User-defined Run (Brukerdefinert kjøring) – åpner vinduet Run Setup (Kjøringsoppsett) der du kan sette
opp en brukerdefinert protokoll og plate, og deretter kjøre et PCR-eksperiment på valgte instrumenter.
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PrimePCR Run (PrimePCR-kjøring) – åpner fanen Start Run (Start kjøring) i vinduet Run Setup
(Kjøringsoppsett) med standard PrimePCR-protokoll og plateoppsett lastet inn basert på det valgte
instrumentet.

End-Point Only Run (Kjøring med kun endepunkt) – åpner fanen Start Run (Start kjøring) i vinduet
Run Setup (Kjøringsoppsett) med standard endepunktprotokoll og plateoppsett lastet inn basert på det
valgte instrumentet.

Qualification Run (Kvalifikasjonskjøring) – åpner fanen Start Run (Start kjøring) i vinduet Run Setup
(Kjøringsoppsett) med standard Bio-Rad-kvalifikasjonsprotokoll og plateoppsett lastet inn basert på det
valgte instrumentet.

Kommandoer i menyen Tools (Verktøy)
Master Mix Calculator (Mastermiks-kalkulator) – åpner Master Mix Calculator (Mastermiks-kalkulator),
der du kan opprette en reaksjonsmiks og skrive ut beregningene.

Protocol AutoWriter (Automatisk protokollskriving) – åpner dialogboksen Protocol AutoWriter
(Automatisk protokollskriving), der du enkelt kan opprette en ny protokoll.

Ta Calculator (Ta–kalkulator) – åpner Ta Calculator (Ta-kalkulator), der du enkelt kan beregne
hybridiseringstemperaturen til primere.

Dye Calibration Wizard (Veiviser for fargekalibrering) – åpner veiviseren Dye Calibration Wizard
(Veiviser for fargekalibrering), der du kan kalibrere et instrument for en ny fluorofor.

Reinstall Instrument Drivers (Installer instrumentdrivere på nytt) – installerer driverne som styrer
kommunikasjonen med Bio-Rads PCR-sanntidssystemer, på nytt.

Zip Data and Log Files (Komprimer data og loggfiler) – åpner en dialogboks der du kan velge filer du vil
komprimere og lagre i en komprimert fil for å oppbevare den eller sende den i en e-post.

Batch Analysis (Batchanalyse) – åpner dialogboksen Batch Analysis (Batchanalyse), der du kan angi
parametere for analysering av mer enn én datafil om gangen.

Options (Alternativer) – åpner en dialogboks der du kan

n konfigurere innstillinger for e-postserver

n konfigurere eksportinnstillinger for LIMS eller andre datafiler

Tips: Du kan også velge alternativet for automatisk å starte Seegene Viewer ved eksport
hvis du velger å eksportere dataene dine i Seegene-format.

n Endre språket som brukergrensesnittet viser (engelsk, kinesisk, russisk)

Viktig: Du må starte CFX Maestro Dx SE på nytt for å vise det valgte språket.
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Viktig: Operativsystemets språk må samsvare med språket du vil vise i CFX Maestro Dx
SE-grensesnittet.

Kommandoer i menyen Help (Hjelp)
Tips: Menyen Help (Hjelp) er tilgjengelig på menylinjen i alle vinduer i CFX Maestro Dx SE.

Contents (Innhold) – viser fanen Contents (Innhold) i hjelpesystemet i CFX Maestro Dx SE.

Index (Indeks) – viser Index-fanen i CFX Maestro Dx SE hjelpesystemet.

Search (Søk) – viser søkefanen i hjelpesystemet i CFX Maestro Dx SE.

Open User Guide (Åpne brukerhåndbok) – åpner en PDF av denne håndboken.

Additional Documentation (Tilleggsdokumentasjon) – gir tilgang til CFX Opus Dx PCR
sanntidssystemets brukerhåndbok.

Release Notes (Versjonsmerknader) – åpner dokumentet med versjonsmerknader for den installerte
versjonen av CFX Maestro Dx SE.

Video Resources (Videoressurser) – åpner et nettsted hvor du kan finne videoressurser, for eksempel
instruksjonsvideoer for Bio-Rad.

qPCR Applications and Technologies Web Site (Nettsted for qPCR-applikasjoner og -teknologier) –
åpner Bio-Rad-nettstedet for qPCR-applikasjoner og -teknologier, hvor du kan lære mer om sanntids-
PCR (qPCR).

PCR Reagents Web Site (Nettsted for qPCR-reagenser) – åpner Bio-Rad-nettstedet for PCR- og qPCR-
reagenser, hvor du kan bestille PCR-reagenser, supermikser, fargestoffer og kit.

PCR Plastic Consumables Web Site (Nettsted for qPCR-forbruksartikler i plast) – åpner Bio-Rad-
nettstedet for PCR-forbruksartikler i plast, hvor du kan bestille PCR-plater, plateforsegling, rør og lokk, og
annet tilbehør av plast.

Software Web Site (Nettsted for programvare) – åpner Bio-Rad-nettstedet for PCR-
analyseprogramvare, hvor du kan bestille oppdaterte versjoner av Bio-Rads CFX Maestro Dx SE.

About (Om) – viser informasjon om opphavsrett og versjon for CFX Maestro Dx SE.

Kommandoer på verktøylinjen

– åpner Windows Utforsker, der du kan navigere til og åpne en datafil eller en genstudiefil.

– åpner Master Mix Calculator (Mastermiks-kalkulator).
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– åpner vinduet Run Setup (Kjøringsoppsett).

– åpner vinduet Run Setup (Kjøringsoppsett) med standard PrimePCR-protokollen og
plateoppsettet lastet inn basert på det valgte instrumentet.

– åpner Startup Wizard (Oppstartsveiviser).
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Startup Wizard (Oppstartsveiviser)
Når CFX Maestro Dx SE starter, vises Startup Wizard (Oppstartsveiviser) i arbeidsruten. Fra Startup
Wizard (Oppstartsveiviser) kan du

n velge et instrument fra detekterte instrumenter og sette opp en brukerdefinert kjøring eller en
PrimePCR-kjøring

n åpne og gjenta en kjøring

n åpne en datafil for å analysere resultatene fra én enkelt kjøring eller en genstudiefil for resultatene fra
flere kjøringer av genuttrykk

Disse oppgavene forklares nærmere i de følgende kapitlene.

Statuslinje
På venstre side av statuslinjen nederst i programvarens hovedvindu vises gjeldende status for de
detekterte instrumentene. På høyre side av statuslinjen vises navnet på gjeldende bruker samt dato og
klokkeslett.
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Ruten Detected Instruments (Detekterte instrumenter)
Ruten Detected Instruments (Detekterte instrumenter) viser alle instrumenter som er koblet til CFX Maestro Dx
SE-datamaskinen. Som standard vises hvert instrument som et ikon, og instrumentets serienummer vises som
dets navn.

Fra denne ruten kan du

n Vise egenskaper og kalibrerte fargestoffer for et valgt instrument.

Se Vise egenskapene til et instrument på side 72 for mer informasjon om instrumentegenskaper.

n Vise status for et tilkoblet instrument.

n Åpne det motordrevne lokket på det valgte instrumentet.

n Lukke det motordrevne lokket på det valgte instrumentet.

n Vise status for alle tilkoblede instrumenter.

Slik viser du status for et tilkoblet instrument

u Velg ønsket instrument i ruten Detected Instruments (Detekterte instrumenter), og gjør ett av
følgende:

n Klikk på View Status (Vis Status) i delen Selected Instrument (Valgt instrument).

n Høyreklikk og velg View Status (Vis status) på menyen som åpnes.

Dialogboksen Run Details (Kjøringsdetaljer) åpnes og viser fanen Run Status (Kjøringsstatus).
Status for det valgte instrumentet vises under ruten for kjøringsstatus, som for eksempel:
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Slik åpner eller lukker du lokket på et instrument

u Velg ønsket instrument i ruten Detected Instruments (Detekterte instrumenter), og gjør ett av
følgende:

n Klikk på Open Lid (Åpne lokk) eller Close Lid (Lukk lokk) i delen Selected Instrument (Valgt
instrument).

n Høyreklikk og velg ønsket handling på menyen som åpnes.

n Åpne dialogboksen Run Details (Kjøringsdetaljer), velg fanen Run Status (Kjøringsstatus) og
klikk på Open Lid (Åpne lokk) eller Close Lid (Lukk lokk).

Slik viser du status for alle detekterte instrumenter

u Gjør ett av følgende:

n Klikk på View Summary (Vis sammendrag) i delen All Instruments (Alle instrumenter) i ruten
Detected Instruments (Detekterte instrumenter).

n Velg View > Instrument Summary (Vis > Instrumentsammendrag) på menylinjen.

Dialogboksen Instrument Summary (Instrumentsammendrag) åpnes:

Tips: Hvis systemet detekterer kun ett tilkoblet instrument, vises ikke delen All Instruments (Alle
instrumenter) i ruten Detected Instruments (Detekterte instrumenter). Velg View > Instrument
Summary (Vis > Instrumentsammendrag) for å vise instrumentsammendraget for ett enkelt
instrument.
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Kontroller på verktøylinjen Instrument Summary (Instrumentsammendrag)

Tabell 5 viser kontrollene og funksjonene på verktøylinjen Instrument Summary
(Instrumentsammendrag).

Knapp Navn på knapp Funksjon

Create a new Run (Opprett
en ny kjøring)

Oppretter en kjøring for den valgte
blokken ved å åpne vinduet Run Setup
(Kjøringsoppsett).

Stop (Stopp) Stopper den pågående kjøringen på
valgte blokker.

Pause (Sett på pause) Setter den pågående kjøringen på valgte
blokker på pause.

Resume (Gjenoppta) Gjenopptar den pågående kjøringen på
valgte blokker.

Flash Block Indicator
(Blokkindikatorlampe)

Gjør at indikatorlampen på lokket på
valgte blokker blinker.

Open Lid (Åpne lokk) Åpner det motordrevne lokket på den
valgte blokken.

Close Lid (Lukk lokk) Lukker det motordrevne lokket på den
valgte blokken.

Hide Selected Blocks
(Skjul valgte blokker)

Viser de valgte blokkene på listen
Instrument Summary
(Instrumentsammendrag).

Show All Blocks (Vis alle
blokker)

Viser de valgte blokkene på listen
Instrument Summary
(Instrumentsammendrag).

Show (Vis) Velg hvilke blokker som skal vises på
listen. Velg ett av alternativene for å vise
alle detekterte blokker, alle inaktive
blokker, alle blokker som kjører med
gjeldende bruker eller alle blokker som
kjører.

Tabell 5. Kontroller på verktøylinjen Instrument Summary (Instrumentsammendrag)
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Vise egenskapene til et instrument
Fra ruten Detected Instruments (Detekterte instrumenter) kan du vise detaljer om et valgt instrument,
inkludert egenskapene, status for transportskruen (bare CFX Connect og CFX Touch) og en liste over
kalibrerte fargestoffer (fluoroforer).

Slik viser du instrumentegenskaper

u I ruten Detected Instruments (Detekterte instrumenter) høyreklikker du på ønsket instrument og
velger Properties (Egenskaper) i menyen som vises.

Fanen Properties (Egenskaper)

Fanen Properties (Egenskaper) viser tekniske detaljer om det valgte instrumentet, inkludert modellen,
serienummeret til komponentene og fastvareversjoner. Standardnavnet på instrumentet (serienummeret)
vises mange steder, blant annet i ruten Detected Instruments (Detekterte instrumenter) og i tittellinjen i
dialogboksen Instrument Properties (Instrumentegenskaper). Du kan endre navnet på instrumentet for å
gjøre det enklere å identifisere det.

Merknad: Du kan ikke endre navnet på CFX Opus-instrumentet ved å bruke CFX Maestro.

Fanen Calibrated Dyes (Kalibrerte fargestoffer)

Fanen Calibrated Dyes (Kalibrerte fargestoffer) viser de kalibrerte fluoroforene og platene for det valgte
instrumentet.

Hvis du vil ha mer informasjon om en kalibrering, klikker du på knappen Info i kolonnen Detail (Detaljer).
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Før du begynner
Denne delen forklarer oppgaver du kanskje trenger å utføre før du bruker CFX Maestro Dx SE. Dette
inkluderer

n Opprette en reaksjonsmastermiks

n Kalibrere nye fargestoffer

Opprette en reaksjonsmastermiks
Ved hjelp av CFX Maestro Dx SEs Master Mix Calculator (Mastermiks-kalkulator) kan du enkelt beregne
det påkrevde volumet for hver komponent i mastermiksen. Du kan skrive ut tabellen med
mastermiksberegninger på standardskriveren, og lagre beregningene for hvert mål til senere bruk.

Slik oppretter du en reaksjonsmastermiks ved hjelp av Master Mix Calculator (Mastermiks-
kalkulator)

1. Velg én av følgende fremgangsmåter for å åpne Master Mix Calculator (Mastermiks-kalkulator):

n Velg Tools > Master Mix Calculator (Verktøy > Mastermiks-kalkulator).

n Klikk på Master Mix Calculator (Mastermiks-kalkulator) på verktøylinjen.

Master Mix Calculator (Mastermiks-kalkulator) vises.
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2. I delen Reaction (Reaksjon) velger du en påvisningsmetode:

n SYBR®Green/EvaGreen®

n Probes (Prober)

3. Hvis du vil opprette et nytt mål, klikker du på Create New (Opprett ny) i delen Target (Mål). Et nytt
målnavn vises i rullegardinmenyen for mål.

4. (Valgfritt) Slik endrer du standard målnavn:

a. Uthev målets navn i rullegardinmenyen for mål.

b. Skriv inn et nytt målnavn i boksen Target (Mål).

c. Trykk på Enter-tasten.

5. Juster start- og sluttkonsentrasjonen for forward- og reversprimeren og eventuelle prober.

6. I delen Master Mix Setup (Mastermiks-oppsett) justerer du verdiene for:

n Number of reactions (Antall reaksjoner) som skal kjøres
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n Reaction volume per well (Reaksjonsvolum per brønn)

n Template volume (Templatvolum) per brønn

n Supermix concentration (Supermiks-konsentrasjon) per brønn

n Excess reaction volume (Ekstra reaksjonsvolum) per brønn

7. (Valgfritt) Utfør trinn 2–6 for nødvendig antall mål.

8. I delen Choose Target to Calculate (Velg mål som skal beregnes) velger du målet som skal
beregnes.

Tips: Du kan beregne kun ett, flere eller alle mål samtidig.

De beregnede volumene av de påkrevde komponentene for hvert mål som er valgt, vises i
mastermikstabellen.

9. Klikk på Set as Default (Angi som standard) for å angi kvantitetene som er lagt inn i delene Target
(Mål) og Master Mix Setup (Mastermiks-oppsett), som nye standarder.

10. Klikk på OK for å lagre innholdet i dialogboksen Master Mix Calculator (Mastermiks-kalkulator).

Slik skriver du ut tabellen med mastermiksberegninger

u Klikk på Print (Skriv ut) for å skrive ut tabellen med mastermiksberegninger.

Tabellen med beregninger skrives ut på standardskriveren.

Slik lagrer du tabellen med mastermiksberegninger som en PDF

u Endre standardskriveren til en PDF-driver og klikk på Print (Skriv ut) i Master Mix Calculator
(Mastermiks-kalkulator).

Slik sletter du mål

u Velg målet i rullegardinmenyen for mål og klikk på Remove (Fjern).

Viktig: Når du fjerner et mål fra mållisten, fjernes det også fra alle mastermiksberegninger det er
blitt brukt i. Vær forsiktig når du sletter et mål.

Kalibrere nye fargestoffer
CFX Opus 96 Dx og CFX Opus Deepwell Dx er fabrikkalibrert for vanlig brukte fluoroforer i hvite og
gjennomsiktige plater. CFX Opus 384 Dx er bare kalibrert for normalt brukte fluoroforer i hvite plater. Tabell
6 viser fluoroforene og kanalen som hvert instrument er kalibrert for.

Merknad: CFX Opus 96 Dx, CFX Opus 384 Dx og CFX Opus Deepwell Dx inkluderer også en kanal
dedikert til FRET-kjemi. Denne kanalen krever ikke kalibrering for bestemte fargestoffer.
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Viktig: Hvis du utfører en brukerdefinert kalibrering av et fargestoff som var fabrikkalibrert, bruker
instrumentet den brukerdefinerte kalibreringen i stedet for fabrikkalibreringen.

Fluoroforer Kanaler Eksitasjon, nm Deteksjon, nm Instrument

FAM, SYBR®
Green I

1 450–490 515–530 CFX Opus 96
Dx, CFX Opus
384 Dx og CFX
Opus Deepwell
Dx

VIC, HEX, CAL
Fluor Gold 540,
Cal Fluor Orange
560

2 515–535 560–580 CFX Opus 96
Dx, CFX Opus
384 Dx og CFX
Opus Deepwell
Dx

ROX, Texas Red,
CAL Fluor Red
610, TEX 615

3 560–590 610–650 CFX Opus 96
Dx, CFX Opus
384 Dx og CFX
Opus Deepwell
Dx

Cy5, Quasar 670 4 620–650 675–690 CFX Opus 96
Dx, CFX Opus
384 Dx og CFX
Opus Deepwell
Dx

Quasar 705,
Cy5.5

5 672–684 705–730 Kun CFX Opus
96 Dx-systemer

FRET-kjemi (ikke fabrikkalibrert)

Ikke
fabrikkalibrert
farge

FRET 450–490 560–580 CFX Opus 96
Dx, CFX Opus
384 Dx og CFX
Opus Deepwell
Dx

Tabell 6. Fabrikkalibrerte fluoroforer, kanaler og instrumenter
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Slik kalibrerer du nye fargestoffer for CFX-systemene

1. Velg et målinstrument i ruten Detected Instruments (Detekterte instrumenter) i startvinduet.

2. Velg Tools > Calibration Wizard (Kalibreringsveiviser) for å åpne veiviseren for Dye Calibration
(Kalibrering av fargestoff).

Fluoroforer som allerede er kalibrert for målinstrumentet, vises i tabellen Calibrated Fluorophores
(Kalibrerte fluoroforer).

3. Velg fluoroforen du vil kalibrere fra rullegardinmenyen i delen Calibrate New (Kalibrer nytt) eller
Existing Fluorophores (Eksisterende fluoroforer).

Hvis fluorofornavnet ikke står på listen, skriver du det inn i tekstboksen for å legge det til på listen.

Viktig: Vær forsiktig når du navngir tilpassede kalibrerte fluoroforene. Hvis du oppretter en
tilpasset fargekalibrering for en fluorofor med samme navn som en fabrikkalibrert fluorofor, vil
den egendefinerte fluoroforen (ikke den fabrikkalibrerte fluoroforen) være den som brukes av
instrumentet under kjøringen.

4. Velg platetypen for fluoroforen.

Hvis platetypen ikke står på listen, skriver du det inn i tekstboksen for å legge den til på listen.

5. Velg en kanal for fluoroforen.

6. Velg en platekolonne for fluoroforen.
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7. (Valgfritt) Skriv inn en farge som skal knyttes til fluoroforen.

8. Klikk på Add to Plate (Legg til i plate) for å legge til fluoroforen.

9. (Valgfritt) Gjenta trinn 3–8 for å legge til hvert av fluoroforene du skal kalibrere for platen.

10. Når du er ferdig å legge til fluoroforer, klikker du på View Plate (Vis plate) for å åpne vinduet Pure Dye
Plate Display (Visning av ren fargestoffplate).

Bruk dette vinduet som en veiledning for å tilsette fargestoffene i platene.

11. Klargjør en 96-, 384- eller dypbrønnplate for fargestoffkalibrering:

a. Pipetter fargestoffløsning i hver brønn, og følg mønsteret vist i vinduet Pure Dye Plate Display
(Visning av ren fargestoffplate).

b. For hvert fluorofor fyller du 50 µl (96- eller dypbrønn) eller 30 µl (384-brønnplate) 300 nm
fargestoffløsning i fire brønner. Vær oppmerksom på at minst halve platen inneholder blanke
brønner.

c. Forsegle platen ved bruk av forseglingsmetoden du vil bruke i eksperimentet.

12. Sett kalibreringsplaten i blokken og lukk lokket.

13. Klikk på Calibrate (Kalibrer) i veiviseren for Dye Calibration (Kalibrering av fargestoff), og klikk
deretter på OK for å bekrefte at platen er i blokken.

14. Når CFX Maestro Dx-programvare, Security Edition fullfører en kalibreringskjøring, vises en
dialogboks. Klikk på Yes (Ja) for å fullføre kalibreringen og åpne Dye Calibration Viewer
(Visningsprogram for fargestoffkalibrering).

15. Klikk på OK for å lukke vinduet.

Angi brukerpreferanser
Tips: Det er ikke nødvendig å utføre disse handlingene for å kunne bruke CFX Maestro Dx SE. Du
kan trygt hoppe over dette avsnittet eller utføre handlingene når som helst senere.

I CFX Maestro Dx SE kan hver bruker tilpasse sitt arbeidsmiljø. I menyen Users > User Preferences
(Brukere > Brukerpreferanser) kan du for eksempel gjøre følgende:

n Sette opp e-postvarsling av fullførte kjøringer

Merknad: Denne funksjonen er bare tilgjengelig for brukere hvis rolle har fått denne retten. Se
Administrere CFX Maestro Dx-programvare, Security Edition-brukerroller på side 43 for mer
informasjon.

n Endre standardinnstillingene for

o hvor filer skal lagres
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o filene for kjøringsoppsett

o prefiks ved navngiving av fil

n Angi standardparameterne som skal brukes når det opprettes en ny protokoll og plate.

n Angi standardparameterne for dataanalyse og genuttrykk.

n Tilpasse standardparameterne for kvalitetskontroll.

n Tilpasse parametere for dataeksport.

I menyen Tools (Verktøy) kan du gjøre følgende:

n Opprette en mastermiks

n Kalibrere fargestoffer for et bestemt instrument

Merknad: Mastermiksen og fargestoffkalibreringen er tilgjengelig for alle som logger på
programvaren.

Dette avsnittet forklarer hvordan disse oppgavene utføres.

Sette opp e-postvarsling

CFX Maestro Dx SE kan kobles til serveren for utgående e-post for å sende e-postvarslinger om fullførte
kjøringer til en brukerliste. Du kan også velge å legge ved en datafil og en analyserapport til brukerlisten.
For å sette opp forbindelsen mellom CFX Maestro Dx SE og en SMTP-server, kan du se Koble Security
Edition til en SMTP-server på side 81

Merknad: Hvorvidt en bruker kan sette opp e-postfunksjoner avhenger av brukerrollen og
rettighetene tildelt av administrator. For detaljer om administrasjon av brukere og deres roller, se
Administrere CFX Maestro Dx-programvare, Security Edition-brukerroller på side 43.

Slik setter du opp e-postvarslinger

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

Dialogboksen User Preferences (Brukerpreferanser) åpnes, og fanen Email (E-post) vises.
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Merknad: Hvis systemet registrerer at du ikke har satt opp en gyldig SMTP-server for
CFX Maestro Dx SE, får du et varsel om dette. Klikk på Configure Outgoing Email (Konfigurer
utgående e-post) for å åpne dialogboksen Options (Alternativer) og konfigurere SMTP-serveren.
Se Koble Security Edition til en SMTP-server på side 81 for mer informasjon.

2. I tekstboksen To (Til) skriver du inn e-postadressen til alle brukere du ønsker skal få et varsel om
fullført kjøring. Alle mottakere mottar en e-post når kjøringen er fullført.

Merknad: Du må skrive inn hver e-postadresse på en egen linje. Trykk på Enter eller Retur etter
hver adresse.

3. (Valgfritt) I tekstboksen cc (Kopi) skriver du inn e-postadressen til alle brukere du ønsker skal motta
en kopi av varselet om fullført kjøring.

4. (Valgfritt) Som standard mottar alle brukere en kopi av datafilen som vedlegg. Fjern merkingen i
denne avmerkingsboksen hvis du ikke vil legge ved en kopi av datafilen.

5. (Valgfritt) Velg Attach Analysis Report (Legg ved analyserapport) for å legge ved en PDF av
analyserapporten i e-posten.

6. Klikk på OK for å lagre endringene og lukke dialogboksen User Preferences (Brukerpreferanser).

Merknad: Du kan muligens konfigurere systemet til å sende et e-postvarsel til mobiltelefonen din,
avhengig av tjenesteleverandøren din. Kontakt leverandøren av mobiltelefontjenester for spesifikk
informasjon om e-postadressen til mobiltelefonen din. Skriv inn telefonens e-postadresse (for
eksempel 5552221234@din_tjenesteleverandør_e-postdomene.net) i tekstboksen i skjermbildet
User Preferences (Brukerinnstillinger).

Slik redigerer du e-postadressen til en mottaker

u Modifiser e-postadressen etter behov, og klikk på OK.
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Slik fjerner du en e-postmottaker

1. Velg e-postmottakeren og trykk på tasten Delete (Slett).

2. Klikk på OK for å lagre endringene og lukke dialogboksen.

Viktig: Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du klikker på denne knappen.

Koble Security Edition til en SMTP-server

Viktig: Noen kommersielle leverandører av nettposttjenester har økt e-postsikkerheten. Hvis du
bruker disse kontoene, må du aktivere innstillingen Allow less secure apps (Tillat mindre sikre
apper) i kontoinnstillingene for å gjøre det mulig for CFX Maestro Dx SE å sende e-post. Se
sikkerhetsinformasjonen fra leverandøren av din nettbaserte e-posttjeneste for mer informasjon.

Hvis du bruker Google Gmail eller Microsoft Office 365 SMTP-server for å sende e-post, må du aktivere
en tofaktorautentisering og generere et «App-passord» i Gmail- eller Office365-kontoinnstillingene. For
autentisering i Maestro e-postoppsettdialogen, kopierer og limer du inn "App-passord" i Passord-feltet i
stedet for vanlig e-postpassord.

Du må opprette en tilkobling fra CFX Maestro Dx SE til e-postserveren før programvaren kan sende e-
postvarslinger.

Slik kobler du CFX Maestro Dx SE til en e-postserver

1. Gjør ett av følgende:

n Velg User > User Preferences (Bruker > Brukerpreferanser) og klikk på Configure Outgoing
Email (Konfigurer utgående e-post) på fanen Email (E-post).

n Velg Tools > Options (Verktøy > Alternativer).

Dialogboksen Options (Alternativer) vises med fanen Email (E-post).
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2. Oppgi følgende informasjon for institusjonen din:

n SMTP Server Name (SMTP-servernavn) – navnet på serveren for utgående e-post på
institusjonen din.

n Port – portnummeret for SMTP-serveren. Dette er vanligvis 25.

n Use SSL (Bruk SSL) – alternativ for Secure Sockets Layer (SSL). Noen SMTP-servere krever
denne innstillingen. Fjern haken fra avmerkingsboksen hvis det ikke kreves på institusjonen din.

n Use Default “From” Address (Bruk standard Fra-adresse) – navnet på e-postserveren på
institusjonen din. Noen SMTP-servere krever at all e-post som sendes, har en Fra-adresse som
er fra et bestemt domene, for eksempel navn@InstitusjonenDin.com. I så fall fjerner du haken
fra denne avmerkingsboksen og oppgir en gyldig e-postadresse.

n Authentication Required (Autentisering kreves) – hvis institusjonen din krever
kontoautentisering, må du sjekke at denne avmerkingsboksen er merket.

n User Name (Brukernavn) – navnet på den autentiserte kontoen. Dette er påkrevd kun dersom
Authentication Required (Autentisering kreves) er valgt.
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n Password (Passord) – passordet for den autentiserte kontoen. Dette er påkrevd kun dersom
Authentication Required (Autentisering kreves) er valgt.

Viktig: Hvis du bruker Google Gmail eller Microsoft Office 365 SMTP-server for å sende e-post,
må du aktivere en tofaktorautentisering og deretter generere et «App-passord» i Gmail- eller
Office365-kontoinnstillingene. For autentisering i Maestro e-postoppsettdialogen, kopierer og
limer du inn Passord-feltet i CFX Maestro Dx SE i stedet for vanlig e-postpassord.

Skriv inn en gyldig e-postadresse i tekstboksen Test Email Address (Test e-postadresse) og klikk på
Test Email (Test e-post) for å verifisere at SMTP-serverinnstillingene er riktige.

Merknad: Noen SMTP-servere tillater ikke vedlegg, og andre tillater kun vedlegg opptil en
bestemt størrelse. Hvis du planlegger å sende datafiler og/eller rapporter via e-post ved bruk av
CFX Maestro Dx SE, velger du Test Attachment (Test vedlegg) og stiller Attachment Size
(Vedleggsstørrelse) til 5 megabyte (MB) eller mer.

3. Klikk på OK for å lagre endringene og lukke dialogboksen.

Endre standard filinnstillinger

I fanen Files (Filer) i dialogboksen User Preference (Brukerpreferanse) kan du endre

n Standardplasseringen for lagring av CFX Maestro Dx SE-filer

n Standardfilene for kjøringsoppsett

n Standardparameterne for filnavngiving

Slik endrer du standard filinnstillinger

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

2. I dialogboksen User Preferences (Brukerpreferanser) velger du fanen Files (Filer).
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3. I standardmappen for delen File Creation (Filopprettelse) navigerer du til og velger en
standardmappe som du vil lagre nye filer i. Du kan velge forskjellig plassering for hver filtype:

n Protocol (Protokoll)

n Plate

n Data File (Datafil)

n Gene Study (Genstudie)

4. I delen File Selection for Run Setup (Filvalg for kjøringsoppsett) navigerer du til og velger
målprotokollen og platefilene som skal vises når du åpner vinduet Experiment Setup (Oppsett av
eksperiment).

5. I delen Data File (Datafil) definerer du prefiks og/eller suffiks for datafiler. Velg en ny verdi fra
rullegardinlisten for hver del. Du kan også oppgi egendefinerte prefiks- og suffiksverdier i
tekstboksene Prefix (Prefiks) og Suffix (Suffiks).

CFX Maestro Dx SE viser en forhåndvisning av filnavnet under valgboksene.

6. Klikk på OK for å lagre endringene og lukke dialogboksen.

Viktig: Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du klikker på denne knappen.

84 | CFX Maestro Dx SE-programvare



Før du begynner

Angi standardparametere for protokoll

Slik stiller du inn standardparametere for protokoll for Protocol Editor (Protokollredigering)
og Protocol AutoWriter (Automatisk protokollskriving)

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

2. Velg fanen Protocol (Protokoll) i dialogboksen User Preferences (Brukerpreferanser).

3. I delen Protocol Editor (Protokollredigering) spesifiserer du verdier for følgende innstillinger som
vises i Protocol Editor (Protokollredigering):

n Sample volume (Prøvevolum) – volumet av hver prøve i brønnene (i µl).

n Lid Shutoff temperature (Lokk-avstengingstemperatur) – temperaturen i ºC der lokkvarmeren
slås av under en kjøring.

4. I delen Protocol AutoWriter (Automatisk protokollskriver) spesifiserer du verdier for følgende
innstillinger som vises i Protocol AutoWriter (Automatisk protokollskriver):

n Annealing temperature (Hybridiseringstemperatur) – temperaturen i ºC for eksperimenter som
bruker iProof DNA-polymerase, iTaq DNA-polymerase eller andre polymeraser.

n Amplicon length (Amplikonlengde) – lengden av amplikonet i basepar (bp).

5. Klikk på OK for å lagre endringene og lukke dialogboksen.

Viktig: Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du klikker på denne knappen.
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Angi standardparametere for plate

Endringer du gjør i fanen Plate, er tilgjengelig for alle brukere av programvaren. Endringer du gjør under
plateoppsettet, er tilgjengelig for alle brukere etter at du har lagret og lukket platefilen.

I dialogboksen User Preferences (Brukerpreferanser) kan du gjøre følgende:

n Angi standardparametere for plate.

n Legg til nye navn på mål, prøve og biologiske grupper i deres respektive biblioteker.

n Slette navn på mål, prøver og biologiske grupper fra deres respektive biblioteker.

Slik angir du plateparametere

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

2. I dialogboksen User Preferences (Brukerpreferanser) velger du fanen Plate.
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3. Angi verdier for følgende innstillinger for en ny platefil. Disse verdiene vises i vinduet Plate Editor
(Plateredigering):

n Platetype

n Platestørrelse

n Units (Enheter) – konsentrasjonen på start-templatet for brønner som inneholder standarder.

CFX Maestro Dx SE bruker disse enhetene til å opprette en standardkurve i fanen Data Analysis
Quantification (Dataanalyse for kvantifisering).

n Scientific notation (Vitenskapelig notasjon) – når denne er valgt, viser CFX Maestro Dx SE
konsentrasjonsenhetene i vitenskapelig notasjon.

n Scan mode (Skannemodus) – antall eller type kanaler som skal skannes under en kjøring.

n Fluorophores (Fluoroforer) – standardfluoroforene som vises i kontrollene for brønnfylling i
Plate Editor (Plateredigering).

n Libraries (Bibliotek) – navn på mål, prøver og biologiske grupper du vanligvis bruker i
eksperimentene:

o Target names (Målnavn) – navn på målgener og sekvenser.

o Sample names (Prøvenavn) – navn på eksperimentprøver eller identifiserende
egenskaper for prøvene (for eksempel Mouse1, Mouse2, Mouse3).

o Biological group names (Biologiske gruppenavn) – navn på grupper med lignende prøver
som har samme behandlingsstatus eller betingelser (for eksempel 0Hr, 1Hr, 2Hr).

4. Klikk på OK for å lagre endringene og lukke dialogboksen.

Legge til et nytt navn på mål, prøve eller biologisk gruppe

u I den tilsvarende biblioteksboksen skriver du inn navnet for målet, prøven eller den biologiske
gruppen og klikker på OK.

Slette et navn på mål, prøve eller biologisk gruppe

u I den tilsvarende biblioteksboksen velger du navnet, trykker på tasten Delete (Slett) og klikker
deretter på OK.

Viktig: Navn du fjerner fra biblioteket, fjernes fra programvaren og er ikke lenger tilgjengelig for
brukere. Klikk på Restore Default (Gjenopprett standarder) for å gjenopprette standard CFX Maestro
Dx SE-navn. Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du sletter standard CFX Maestro Dx SE-navn og når du
klikker på denne knappen.
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Angi standardparametere for dataanalyse

Slik angir du standardparametere for dataanalyse

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

2. I dialogboksen User Preferences (Brukerpreferanser) velger du fanen Data Analysis (Dataanalyse).

3. I delen Analysis Mode (Analysemodus) velger du modusen du vil bruke til å analysere dataene
(enten Fluorophore (Fluorofor) eller Target (Mål)).

4. I delen PCR Quantification (PCR-kvantifisering) angir du standardparametere for følgende
alternativer:

n Baseline Setting (Baselinjeinnstilling) – baselinjemetoden for analysemodus.

n Cq Determination Mode (Cq-bestemmelsesmodus) – modusen der Cq-verdier beregnes for
hver fluorescenskurve (enten regresjon eller enkel terskel).

n Threshold Calc. Mode (Modus for terskelberegning) – mengden av endepunktmål.

Standardverdien er Auto (Automatisk). Det vil si at programvaren beregner endepunktmålet
automatisk. Når du vil angi en bestemt terskel, fjerner du merkingen i avmerkingsboksen Auto
(Automatisk) og legger inn endepunktmengden, beregnet i relative fluorescensenheter (eller
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RFU). Maksimumsverdien er 65 000,00 RFU. Datafiler for etterfølgende kjøringer vil bruke
denne terskelinnstillingen.

n Baseline Calc. Mode (Modus for baselinjekalkulator) – baselinjeverdien for alle kurver.

Standardverdien er Auto (Automatisk). Det vil si at programvaren beregner baselinjen for alle
kurver automatisk. Når du vil angi en spesifikk baselinjeverdi, fjerner du merkingen i
avmerkingsboksen Auto (Automatisk) og legger inn minimums- og maksimumsverdiene for
syklusområdet (1 til 9999). Datafiler for etterfølgende kjøringer vil bruke dette syklusområdet.

n Log View (Loggvisning) – bestemmer hvordan programvaren viser amplifiseringsdataene:

o On (På) – amplifiseringsdataene vises på en halvlogaritmisk graf.

o Off (Av) – (standard) amplifiseringsdataene vises på en lineær graf.

5. I delen End Point (Endepunkt) velger du antall endesykluser som skal brukes til å finne gjennomsnitt
under beregning av endepunktberegningene:

n PCR – antall endesykluser som skal brukes til å finne gjennomsnitt for kvantifiseringsdata
(standard er 5).

n End Point Only run (Kjøring av kun endepunkt) – antall endesykluser som skal brukes til å
finne endepunktdata (standard er 2).

6. I delen Melt Curve (Smeltekurve) velger du typen topp som skal detekteres (enten positiv eller
negativ).

7. I delen Well Selector (Brønnvelger) velger du hvordan du vil vise brønnetiketter (etter prøvetype,
målnavn eller prøvenavn).

8. Klikk på OK for å lagre endringene og lukke dialogboksen.

Viktig: Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du klikker på denne knappen.
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Angi standardparametere for datafil for genuttrykk

Slik angir du standardparametere for en ny datafil for genuttrykk

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

2. Velg fanen Gene Expression (Genuttrykk) i dialogboksen User Preferences (Brukerpreferanser).

3. Spesifiser verdiene for følgende innstillinger:

n Relative to (I forhold til) – lagrer en graf av genuttrykksdataene i forhold til enten en kontroll
(utgangspunkt 1) eller null:

o Zero (Null) – programvaren ignorerer kontrollen. Dette er standarden når ingen
kontrollprøve er tilordnet i vinduet Experiment Settings (Eksperimentinnstillinger).

o Control (Kontroll) – programvaren beregner dataene i forhold til kontrollprøven tilordnet i
vinduet Experiment Setup (Eksperimentoppsett).

n X-axis (X-akse) – lager en graf av prøven eller målet på x-aksen.

n Y-axis (Y-akse) – lager en graf for lineær, log2- eller log10-skala på y-aksen.

n Scaling (Skalering) – skaleringsalternativet for grafen (standardalternativet er ikke-skalert):

o Highest (Høyest) – programvaren skalerer grafen til det høyeste datapunktet.

o Highest (Lavest) – programvaren skalerer grafen til det laveste datapunktet.

o Unscaled (Ikke-skalert) – programvaren presenterer dataene som ikke er skalert i grafen.

n Mode (Modus) – analysemodusen, enten relativ kvantitet (∆Cq) eller normalisert uttrykk (∆∆Cq).

n Error Bar (Feilsøyle) – datavariabilitet presentert som enten standardavvik (Std. Dev.) eller
standardfeil av gjennomsnitt (Std. Error Mean).

n Error Bar Multiplier (Feillinjemultiplikator) – standardavvikmultiplikatoren som brukes for å lage
en graf av feilsøylene (standard er 1).

Du kan øke multiplikatoren til enten 2 eller 3.

n Sample Types to Exclude (Prøvetyper som skal ekskluderes) – prøvetypene som skal
ekskluderes fra analysen.

Du kan velge én eller flere prøver som skal ekskluderes fra analysen. Du ekskluderer alle
prøvetyper ved å fjerne eventuelle merker i avmerkingsboksene for valgte prøvetyper.

4. Klikk på OK for å lagre endringene og lukke dialogboksen.
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Viktig: Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du klikker på denne knappen.

Tilpasse regler for kvalitetskontroll

I CFX Maestro Dx SE kan du angi kvalitetskontrollregler som skal brukes på data i vinduet Data Analysis
(Dataanalyse). Programvaren validerer dataene basert på reglene du angir.

Merknad: Alle kvalitetskontrollregler er aktivert som standard.

Tips: I vinduet Data Analysis (Dataanalyse) kan du enkelt ekskludere brønner som ikke består en
kvalitetskontrollparameter, fra analysen i QC-modulen.

Slik tilpasser du kvalitetskontrollregler

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

2. Velg fanen QC (Kvalitetskontroll) i dialogboksen User Preferences (Brukerpreferanser).

Der:

n NTC – ikke-templatkontroll
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n NRT – uten revers transkriptasekontroll

n Efficiency (Effektivitet) – reaksjonseffektivitet

n Std Curve R^2 (Standardkurve R^2) – R-kvadratverdien for standardkurven

n Replicate group Cq Std Dev (Replikatgruppe Cq standardavvik) – standardavvik beregnet for
hver replikatgruppe

3. Velg én av følgende fremgangsmåter for hver kvalitetskontrollregel:

n Hvis du vil bruke standardverdien, gjør du ingenting.

n Hvis du vil endre verdien, klikker du i tekstboksen Value (Verdi), skriver inn en ny verdi og trykker
på Enter-tasten.

n Hvis du vil deaktivere regelen, fjerner du merket i avmerkingsboksen Use (Bruk).

4. Klikk på OK for å lagre endringene og lukke dialogboksen.

Viktig: Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du klikker på denne knappen.

Tilpasse parametere for dataeksport

Du kan eksportere CFX Maestro Dx SE-data i følgende format:

n Tekst (.txt)

n CSV (.csv)

n Excel (.xls, .xlsx)

n XML (.xml)

n HTML (.html)

Viktig: Datamaskinen din må ha Microsoft Excel installert for at du skal kunne eksportere data til et
Microsoft Excel-regneark.

Du kan spesifisere hvilken type data du vil eksportere, og tilpasse utdataene for de eksporterte dataene.

Slik egendefinerer du parametere for dataeksport

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

2. I dialogboksen User Preferences (Brukerpreferanser) velger du fanen Custom Export (Tilpasset
eksport).
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3. I rullegardinmenyen Export Format (Eksportformat) velger du hvilket format du vil eksportere dataene
i.

4. I delen Data to Export (Data som skal eksporteres) merker du avmerkingsboksene eller fjerner
merkingen i avmerkingsboksene for datatypen(e) som skal eksporteres. De valgte elementene vises
i listeboksen Exported Columns (Eksporterte kolonner).

Merknad: Kjøringsinformasjonen er som standard inkludert i toppteksten. Fjern merkingen i
denne avmerkingsboksen hvis du ikke vil inkludere kjøringsinformasjonen.

5. Du kan endre rekkefølgen for hvordan de valgte elementene skal vises i eksportfilen.

I listeboksen Exported Columns (Eksporterte kolonner) merker du elementet og klikker deretter på
pilknappene til venstre for listen for å flytte elementet opp eller ned.

6. Du kan også endre kolonnenavnene for de valgte elementene i den eksporterte filen.

a. Klikk på Customize Column Names (Tilpass kolonnenavn).

Dialogboksen Column Name Customizer (Tilpasning av kolonnenavn) åpnes.

b. For hvert standardkolonnenavn du vil endre, skriver du inn det nye navnet i feltet Custom Name
(Egendefinert navn).
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c. Gjør ett av følgende:

n Klikk på OK for å lagre endringene og gå tilbake til fanen Custom Export (Tilpasset eksport).
Det nye navnet vises i parenteser ved siden av standardkolonnenavnet i listeboksen
Exported Columns (Eksporterte kolonner).

n Klikk på Cancel (Avbryt) for å forkaste endringene og gå tilbake til fanen Custom Export
(Tilpasset eksport).

7. Klikk på OK for å lagre endringene og lukke dialogboksen.

Viktig: Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du klikker på denne knappen.
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En protokoll er et sett med trinn som utføres i en bestemt sekvens. I CFX Maestro Dx-programvare,
Security Edition er alle trinnene knyttet til alternativene på instrumentet. For eksempel gir trinnene
instruksjoner til instrumentet om å kontrollere blokk- og lokktemperatur, bruke en temperaturdifferanse
over hele blokken, utføre en plateavlesning eller utføre en smeltekurveanalyse. Hvert alternativ angis for
ulike plate- og kjøringstyper.

CFX Maestro Dx SE har to alternativer for å opprette protokoller: Protocol Editor og Protocol AutoWriter
(Protokollredigering og Protokoll autoskriver).

Protocol Editor (Protokollredigering) har følgende:

n standardprotokoller for rask oppretting av protokoller

n mulighet til raskt å beregne en gradient for valgte antall rader

n mulighet til raskt å beregne kjøretid for valgt platetype

n mulighet til å redigere protokolltrinn

n mulighet til å lagre protokoller for gjenbruk

n mulighet til å skrive ut protokollen på en standardskriver

I henhold til parameterne du angir, genererer Protocol AutoWriter (Automatisk protokollskriving)
automatisk en tilpasset PCR-protokoll med varmestart, innledende denaturering, hybridisering og
forlengelsestrinn. Du kan deretter se en grafisk representasjon av den foreslåtte protokollen og redigere,
kjøre eller lagre protokollen.
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Parametere og områder for protokolltrinn
Bruk informasjonen i Tabell 7 til å endre standardinnstillingene for trinnene i protokollen.

Temperaturtrinn

Måltemperaturen er en verdi på mellom 4 og 100 °C, angitt i tiendedeler av en grad. Systemet stiger til
denne temperaturen og opprettholder verdien i en spesifisert tid (holdetid).

Gradienttrinn

Gradientområdet er forskjellen mellom nedre og øvre temperatur i et gradienttrinn. Maksimalt tillatt
spennvidde er 24 °C. Den lavere temperaturen er en verdi mellom 30 og 99 °C, angitt i tiendedeler av en
grad. Maksimum øvre temperatur er 100 °C. Termosyklusapparatet stiger til måltemperaturgradienten
over blokken og opprettholder temperaturen i en spesifisert holdetid.

Viktig: Instrumentet beregner gradientverdien. Når du skriver inn en verdi i øverste og nederste felt i
gradientkalkulatoren, beregner og tildeler programvaren automatisk temperaturene for de
gjenværende feltene. Når du angir en temperatur i et hvilket som helst felt mellom topp- og
bunnfeltet, beregner instrumentet automatisk de gjenværende feltene. Du kan ikke manuelt angi en
temperaturverdi i hvert felt.

Parameter Område Beskrivelse

Ramp rate
(Rampehastighet)

n For CFX Opus 96 Dx-systemer:
0,1–5 °C per sek.

n For CFX Opus 384 Dx-
systemer:
0,1–2,5 °C per sek

n For CFX Opus Deepwell Dx-
systemer:
0,1–2,5 °C per sek

Instruerer termosyklusapparatet om å
rampe til måltemperaturen med den
spesifiserte hastigheten i det trinnet.

Bare tilgjengelig for temperaturtrinn.

Increment (Økning) Et tall fra –10 til 10 °C per syklus i
tiendedeler av en grad

Instruerer termosyklusapparatet om å
endre måltemperaturen til et trinn med
hver syklus, der et positivt tall øker
temperaturen og et negativt tall senker
temperaturen.

Bare tilgjengelig for temperaturtrinn.

Tabell 7. Parametere og områder for protokolltrinn
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Parameter Område Beskrivelse

Extend (Utvide) En tid fra –60 til 60 sek. per syklus Instruerer termosyklusapparatet om å
utvide holdetiden med hver syklus. Et
positivt tall øker holdetiden, og et negativt
tall reduserer holdetiden.

Tilgjengelig for både temperatur- og
gradienttrinn.

Beep (Pipetone) (Ingen parametere) Instruerer at termosyklusapparatet avgir
en pipetone for å signalisere at
termosyklusapparatet har nådd
måltemperaturen for det trinnet.

Bare tilgjengelig for temperaturtrinn.

Plate read
(Plateavlesing)

(Ingen parametere) Instruerer termosyklusapparatet om å
legge til en plateavlesing til det valgte
trinnet.

Tilgjengelig for både temperatur- og
gradienttrinn.

Tabell 7. Parametere og områder for protokolltrinn, forts.
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Vinduet Protocol Editor (Protokollredigering)
Bruk Protocol Editor (Protokollredigering) til å opprette, åpne, se gjennom og redigere en protokoll. Som
standard viser Protocol Editor (Protokollredigering) en generell 2-trinns sanntidsprotokoll for en plate med
96 brønner.

1. Menylinjen gir hurtigtilgang til menykommandoene File (Fil), Settings (Innstillinger) og Tools
(Verktøy).

2. Verktøylinjen gir hurtigtilgang til funksjoner for når du vil lagre og skrive ut protokollen,
bestemme hvor du skal sette inn et trinn, angi prøvevolum og vise estimert kjøretid for
protokollen.

3. Hovedruten viser en grafisk fremstilling av protokollen.

4. Den nedre ruten viser protokollutkastet.

5. Venstre rute viser protokollkontroller du kan legge til for å tilpasse protokollen.

FORKLARING

Kommandoer i menyen File (Fil)
Save (Lagre) – lagrer den gjeldende protokollen.
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Save As (Lagre som) – lagrer den gjeldende protokollen med et nytt navn eller på en ny plassering.

File Passwords (Filpassord) – gjør det mulig for brukere å angi passord for lagring og filåpning.

Tips: For mer informasjon, se Passordbeskyttelse av filer på side 50.

Close (Lukk) – Lukker Protocol Editor (Protokollredigering).

Kommandoer i menyen Settings (Innstillinger)
Lid Settings (Lokkinnstillinger) – åpner dialogboksen Lid Settings (Lokkinnstillinger), der du kan endre
eller angi lokktemperaturen.

Kommandoer i menyen Tools (Verktøy)
Gradient Calculator (Gradientkalkulator) – åpner en dialogboks, der du kan velge blokktype for et
gradienttrinn. Standard er 96 brønner.

Run time Calculator (Kjøretidskalkulator) – åpner en dialogboks, der du kan velge platetype og
skannemodus for å beregne estimert kjøretid i vinduet Run Setup (Kjøringsoppsett). Standard er 96
brønner, alle kanaler.

Kommandoer på verktøylinjen

– lagrer den gjeldende protokollfilen.

– skriver ut det valgte vinduet.

– bruk denne kommandoen til å velge hvor du vil sette inn trinn i forhold til det
valgte trinnet.

– bruk denne kommandoen for å legge inn et prøvevolum i µl. Prøvevolumene
varierer etter blokktype:

n For en blokk med 96 brønner er området 0–50 µl.

n For en blokk med 384 brønner er området 0–30 µl.

n For en blokk med 96 dype brønner er området 0–125 µl.
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– viser estimert kjøretid basert på protokolltrinnene, rampehastigheten og valgt
blokktype.

– viser informasjon om protokoller.

Kontroller for protokollredigering
Venstre rute i vinduet Protocol Editor (Protokollredigering) består av kontroller du kan bruke til å opprette
protokoller.

Hver kontroll består av et sett parametere som representerer et trinn i protokollen. Du kan modifisere hver
parameter og legge til eller fjerne dem for å tilpasse protokollen. Dette avsnittet beskriver alternativene i
hver av kontrollene.

n Insert Step (Sett inn trinn) – setter inn et trinn før eller etter det valgte
trinnet. Du kan redigere verdiene for temperatur og holdetid, i
protokollens grafiske visning eller i protokollutkastet.

n Insert Gradient (Sett inn gradient) – setter inn et gradienttrinn basert på
typen brønnblokk valgt i gradientkalkulatoren. Du kan redigere
gradientområdet i ruten Gradient, som vises når du setter inn et
gradienttrinn.

n Insert GOTO (Sett inn Gå til) – setter inn et syklustrinn (sløyfe), som
informerer programvaren om å gjenta spesifikke trinn i sekvensen for et
angitt antall sykluser. Gjentakelsene starter når den første syklusen er
fullført. Du kan for eksempel informere programvaren om å utføre 39

gjentakelser av trinn 2–4. Etter den siste gjentakelsen har programvaren utført trinn 2–4 totalt 40
ganger. Du kan redigere gå-tilbake-til (GOTO (Gå til)-trinnet og antall sykluser i protokollens grafiske
visning eller i protokollutkastet.

n Insert Melt Curve (Sett inn smeltekurve) – setter inn et trinn for avlesning av smeltekurve.

n Insert Plate Read to Step (Sett inn plateavlesning i et trinn) – legger til en kommando for
plateavlesning i det valgte trinnet. En plateavlesning måler mengden fluorescens på slutten av en
syklus. Trinnet for plateavlesning er vanligvis det siste trinnet i en GOTO (Gå til)-sløyfe.

Tips: Når du har lagt til en plateavlesningskommando i et trinn, endres knappen til Remove
Plate Read (Fjern plateavlesning) når du velger trinnet.
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n Remove Plate Read (Fjern plateavlesning) – fjerner en kommando for plateavlesning i det valgte
trinnet.

Tips: Når du har fjernet en plateavlesningskommando i et trinn, endres knappen til Add Plate
Read (Legg til plateavlesning) når du velger trinnet.

n Step Options (Trinnalternativer) – åpner dialogboksen Step Options (Trinnalternativer) og viser de
tilgjengelige alternativene for det valgte trinnet. Se Step Options (Trinnalternativer) på side 102 for
detaljert informasjon om trinnalternativene.

Tips: Du kan også åpne Step Options (Trinnalternativer) ved å høyreklikket på trinnet i den
grafiske visningen.

n Delete Step (Slett trinn) – sletter det valgte trinnet fra protokollen.

Brukerhåndbok | 101



Kapittel 7 Opprette protokoller

Step Options (Trinnalternativer)

Åpne dialogboksen Step Options (Trinnalternativer) for å vise alternativene du kan legge til, endre eller
fjerne fra et trinn.

n Plate Read (Plateavlesning) – når dette alternativet er valgt, legges det til en plateavlesning i trinnet.

n Temperature (Temperatur) – angir måltemperaturen for det valgte trinnet.

n Gradient – angir gradientområdet for trinnet. Området er 1–24 °C.

Merknad: En gradient kjøres med lavest temperatur fremst i blokken (i dette bildet, rad H) og
høyest temperatur bakerst i blokken (i dette bildet, rad A).

n Increment (Inkrement) – hvor mye temperaturen skal økes (eller reduseres) med i det valgte trinnet.
Denne verdien legges til måltemperaturen i hver syklus. Området er ±0,1–10 °C.

Merknad: Hvis du vil redusere temperaturen, skriver du inn et minustegn (–) foran den
numeriske verdien (for eksempel –5 °C).

n Ramp Rate (Rampehastighet) – rampehastigheten for det valgte trinnet. Området avhenger av
blokkstørrelsen.

n Time (Tid) – holdetiden for det valgte trinnet.
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n Extend (Utvid) – tidsperioden (i sekunder) som det valgte trinnet skal utvides eller reduseres med.
Dette alternativet legges til holdetiden i hver syklus. Området er ±1–60 sek.

n Beep (Pip) – når dette er valgt, høres et pip i løpet av trinnet.

Tips: Når du legger inn et tall som er utenfor alternativets område, vil programvaren endre tallet
til det nærmeste tallet innenfor området.
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Opprette en protokoll i Protocol Editor (Protokollredigering)
Du kan bruke Protocol Editor (Protokollredigering) til å opprette egendefinerte protokollfiler. Du kan også
redigere og lagre tidligere lagrede protokollfiler eller prøveprotokollfiler som leveres sammen med
CFX Maestro Dx SE.

Du oppretter en ny protokollfil på følgende måte:

n Åpne en protokollfil i Protocol Editor (Protokollredigering).

Tips: Du kan åpne en ny eller eksisterende protokoll i Protocol Editor (Protokollredigering)

n Sett opp den nye protokollen.

n Legg til trinn i protokollen via ruten for protokollkontroller.

n Rediger egenskapene for trinnene.

n Lagre protokollen.

Tips: Se Åpne en eksisterende protokoll i Protocol Editor (Protokollredigering) på side 105 for å
opprette en ny protokoll fra en tidligere lagret protokollfil eller en prøveprotokollfil.

Åpne en ny protokollfil i Protocol Editor (Protokollredigering)
CFX Maestro Dx SE har flere alternativer for å åpne en ny protokollfil:

n Fra File-menyen (Fil) i startvinduet

n Fra dialogboksen Run Setup (Kjøringsoppsett) i startvinduet

n Fra Startup Wizard-dialogboksen (Oppstartsveiviser) i startvinduet

Slik åpner du en ny protokollfil fra File-menyen (Fil)

u I startvinduet velger du File > New > Protocol (Fil > Ny > Protokoll).

Vinduet Protocol Editor (Protokollredigering) åpnes og viser standardprotokollfilen.

Tips: For informasjon om innstilling av standardprotokoll, se Endre standard filinnstillinger på
side 83.

Slik åpner du en ny protokoll fra dialogboksen Run Setup (Kjøringsoppsett)

1. I startvinduet gjør du ett av følgende for å åpne dialogboksen Run Setup (Kjøringsoppsett):

n Velg Run > User-defined Run (Kjøring > Brukerdefinert kjøring).

n Klikk på User-defined Run Setup (Brukerdefinert kjøringsoppsett) på verktøylinjen.
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Dialogboksen Run Setup (Kjøringsoppsett) åpnes og viser fanen Protocol (Protokoll), som viser
standardprotokollfilen.

2. Klikk på Create New (Opprett ny).

Vinduet Protocol Editor (Protokollredigering) åpnes og viser standard sanntidsprotokoll.

Slik åpner du en ny protokollfil fra Startup Wizard (Oppstartsveiviser)

1. Gjør ett av følgende i startvinduet for å åpne Startup Wizard (Oppstartsveiviser) hvis den ikke vises:

n Velg View > Startup Wizard (Vis > Oppstartsveiviser).

n Klikk på Startup Wizard (Oppstartsveiviser) på verktøylinjen.

2. Velg om nødvendig instrumenttypen fra rullegardinmenyen.

3. Klikk på User-defined (Brukerdefinert) som kjøringstypen.

Dialogboksen Run Setup (Kjøringsoppsett) åpnes og viser fanen Protocol (Protokoll), som viser
standardprotokollfilen.

4. Klikk på Create New (Opprett ny).

Vinduet Protocol Editor (Protokollredigering) åpnes og viser standard sanntidsprotokoll.

Åpne en ny protokoll fra Run-menyen (Kjør)

1. I startvinduet gjør du ett av følgende for å åpne dialogboksen Run Setup (Kjøringsoppsett):

n Velg Run > User-defined Run (Kjøring > Brukerdefinert kjøring).

n Klikk på User-defined Run Setup (Brukerdefinert kjøringsoppsett) på verktøylinjen.

Dialogboksen Run Setup (Kjøringsoppsett) åpnes og viser fanen Protocol (Protokoll), som viser
standardprotokollfilen.

2. Klikk på Create New (Opprett ny).

Vinduet Protocol Editor (Protokollredigering) åpnes og viser standard sanntidsprotokoll.

Åpne en eksisterende protokoll i Protocol Editor
(Protokollredigering)
CFX Maestro Dx SE inneholder prøveprotokollfiler som du kan redigere og lagre som nye egendefinerte
protokoller. Du kan også opprette en ny protokoll fra en eksisterende egendefinert protokoll.
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Slik åpner du en prøveprotokollfil

1. Velg File > Open > Protocol (Fil > Åpne > Protokoll) i startvinduet.

Windows Utforsker åpnes som standard i mappen CFX Maestro Dx SE Sample files (Prøvefiler).

2. Åpne mappen Sample files (Prøvefiler). Mappen inneholder følgende undermapper:

n ConventionalProtocols (Konvensjonelle protokoller) – inneholder eksempelprotokollfiler for
tradisjonell PCR-analyse.

n DataFiles (Datafiler) – inneholder eksempeldatafiler som du kan bruke til å utforske
CFX Maestro Dx SEs funksjoner.

n MeltCalibration (Smeltekalibrering) – inneholder eksempelprotokollfiler for bruk med Bio-Rads
Precision Melt Analysis-programvare.

n Plates (Plater) – inneholder eksempelplatefiler.

n RealTimeProtocols (Sanntidsprotokoller) – inneholder eksempelprotokollfiler for sanntids
PCR-analyse.

3. Åpne protokollmappen for kjøringstypen du har tenkt å utføre, dvs. enten ConventionalProtocols
(Konvensjonelle protokoller) eller RealTimeProtocols (Sanntidsprotokoller).

4. Velg protokollen du vil bruke og klikk på Open (Åpne).

Prøveprotokollen åpnes i vinduet Protocol Editor (Protokollredigering).

5. Velg File > Save As (Fil > Lagre som) og lagre protokollen med et nytt navn eller i en annen mappe.

Slik åpner du en eksisterende protokoll

1. Gjør ett av følgende i startvinduet:

n Velg File > Open > Protocol (Fil > Åpne > Protokoll), naviger til og velg ønsket protokoll, og klikk
på Open (Åpne).

n Åpne Startup Wizard (Oppstartsveiviser) og gjør ett av følgende:

o Hvis du vil redigere protokollen som vises, klikker du på Edit Selected (Rediger valgte)

o Hvis du vil redigere en annen eksisterende protokoll, klikker du på Select Existing (Velg
eksisterende) og navigerer til ønsket fil.

Protokollen åpnes i vinduet Protocol Editor (Protokollredigering).

2. Velg File > Save As (Fil > Lagre som) og lagre protokollen med et nytt navn eller i en annen mappe.
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Sette opp en ny protokoll
Tips: Hvis protokollfilen inkluderer de nødvendige parametere (for eksempel hvis du redigerer en
eksisterende platefil), kan du hoppe over denne delen. Fortsett til Legge til trinn i en protokoll på side
109.

Nye protokollfiler krever følgende parametere:

n Block type (Blokktype)

n Scan mode (Skannemodus) for den valgte blokktypen

n Lid temperature (Lokktemperatur)

n Sample volume (Prøvevolum)
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Angi Block Type (Blokktype)

CFX Maestro Dx SE beregner automatisk temperaturøkninger for gradienttrinn basert på blokktypen.

Merknad: Platetypen som angis i Protocol Editor (Protokollredigering), må være den samme som
platen i reaksjonsmodulen.

Slik angir du blokktype

u I vinduet Protocol Editor (Protokollredigering) velger du Tools > Gradient Calculator (Verktøy >
Gradientkalkulator). Velg deretter relevant platetype i rullegardinmenyen som vises.

Velge Scan Mode (Skannemodus) for valgt Block Type (Blokktype)

For å bestemme kjøretiden for protokollen velger du ønsket blokktype og skannemodus.

Slik velger du blokktype og skannemodus

u I vinduet Protocol Editor (Protokollredigering) velger du Tools > Run time Calculator (Verktøy >
Kjøretidskalkulator). Velg deretter relevant platetype og skannemodus i rullegardinmenyen som
vises.

Justere lokktemperaturen

CFX Maestro Dx SE bruker følgende standard lokktemperaturer:

n Instrumenter med 96 brønner og dype brønner – 105 °C

n Instrumenter med 384 brønner – 95 °C

Du kan endre standardinnstillingene eller slå av lokkvarmeren avhengig av hva som kreves av
protokollen.

Slik justerer du lokktemperaturen

1. I vinduet Plate Editor (Plateredigering) velger du Settings > Lid Settings (Innstillinger >
Lokkinnstillinger).

Dialogboksen Lid Settings (Lokkinnstillinger) vises.

2. Gjør ett av følgende:

n Velg User Defined (Brukerdefinert) og legg inn en temperaturverdi i tekstboksen.

n Velg Turn Off Lid Heater (Slå av lokkvarmer).

3. Klikk på OK for å bekrefte endringene og lukke dialogboksen.
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Angi Sample Volume (Prøvevolum)

Som standard angir CFX Maestro Dx SE prøvevolumet for hver brønn til 25 µl. Prøvevolumene varierer
etter blokktype, for eksempel:

n 0–50 µl for en blokk med 96 brønner

n 0–30 µl for en blokk med 384 brønner

Instrumentet bruker én av to moduser for temperaturkontroll for å bestemme når prøven når
måltemperaturen i en protokoll:

n Calculated mode (Beregningsmodus) – når prøvevolumet er satt til et ikke-null-volum som er egnet
for blokken, beregner instrumentet prøvetemperaturen basert på prøvevolumet. Dette er
standardmodusen.

n Block mode (Blokkmodus) – når prøvevolumet er satt til null (0) µl, registrerer instrumentet
prøvetemperaturen som den samme som den målte blokktemperaturen.

Slik angir du prøvevolumet for en spesifikk blokk

u Skriv inn den riktige verdien i tekstboksen Sample volume (Prøvevolum) på verktøylinjen i vinduet
Plate Editor (Plateredigering).

Tips: Du kan endre standard prøvevolum i dialogboksen User Preferences (Brukerpreferanser). Se
Endre standard filinnstillinger på side 83.

Legge til trinn i en protokoll
Slik legger du til et trinn i en protokoll

1. Åpne protokollen i vinduet Protocol Editor (Protokollredigering).

2. Velg hvor det nye trinnet skal settes inn. På verktøylinjen velger du Before (Før) eller After (Etter) i
rullegardinmenyen Step (Trinn).

3. På grafen velger du trinnet før eller etter der du vil sette inn det nye trinnet.

4. Klikk på Insert Step (Sett inn trinn) i ruten til venstre.

5. Hvis du vil endre temperaturen eller holdetiden, klikker du på standardverdien på grafen eller
protokollutkastet og skriver inn en ny verdi.

6. (Valgfritt) Klikk på Step Options (Trinnalternativer) i ruten til venstre for å vise dialogboksen Step
Options (Trinnalternativer), og endre de tilgjengelige alternative for det valgte trinnet.

Tips: Dialogboksen Step Options (Trinnalternativer) er tilgjengelig via høyreklikkmenyen i både
ruten med grafen og ruten med protokollutkastet.

7. Klikk på OK og klikk så på Yes (Ja) for å lagre endringene i protokollen.
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Dialogboksen Save As (Lagre som) vises.

8. Skriv inn et navn på den nye protokollfilen i dialogboksen Save As (Lagre som), og klikk på Save
(Lagre).

Sette inn et gradienttrinn
Slik setter du inn et gradienttrinn

1. Kontroller at platestørrelsen for gradienten er den samme som blokktypen til instrumentet, 96
brønner, 384 brønner eller dype brønner.

2. Hvis du ikke allerede har gjort det, velger du platestørrelsen for gradienten:

Velg Tools > Gradient Calculator (Verktøy > Gradientkalkulator) og velg ønsket brønntype fra
rullegardinmenyen.

3. På verktøylinjen velger du enten Before (Før) eller After (Etter) fra rullegardinmenyen Insert Step
(Sett inn trinn).

4. På grafen eller i utkastruten velger du trinnet før eller etter der du vil sette inn gradienttrinnet.

5. Klikk på Insert Gradient (Sett inn gradient) i ruten til venstre. Det nye gradienttrinnet utheves på
grafen og i utkastruten, for eksempel:
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Temperaturen i hver rad i gradienten vises i tabellen Gradient i høyre rute.

6. Når du vil redigere temperaturområdet for gradienten, velger du én av følgende fremgangsmåter:

n Klikk på standardtemperaturen på grafen eller i utkastruten, og angi en ny temperatur.

n Klikk på Step Options (Trinnalternativer) for å angi gradientområdet i vinduet Step Options
(Trinnalternativer).

n Endre områdeverdien i tabellen Gradient.

7. Når du vil redigere holdetiden, klikker du på standardtiden i grafikk- eller tekstvisningen og angir en
ny tid.

8. Klikk på OK og deretter på Yes (Ja) for å lagre endringene.

Sette inn et GOTO-trinn
Merknad: Du kan ikke sette inn et GOTO-trinn i et GOTO-sett, og du kan ikke opprette nøstede
GOTO-løkker.

Slik setter du inn et GOTO-trinn

1. På verktøylinjen velger du Before (Før) eller After (Etter) i rullegardinmenyen Insert Step (Sett inn
trinn).

2. I grafen velger du trinnet før eller etter der du vil sette inn GOTO-trinnet.

3. Klikk på Insert GOTO (Sett inn GOTO) i ruten til venstre.

4. Hvis du vil redigere GOTO-trinnummeret eller antall GOTO-gjentakelser, velger du standardverdien i
grafen eller disposisjonsruten og legger inn en ny verdi.

5. Klikk på OK og deretter på Yes (Ja) for å lagre endringene.

Sette inn et smeltekurvetrinn
Tips: Du kan ikke sette inn et smeltekurvetrinn i en GOTO-løkke.

Merknad: Smeltekurvetrinnet inneholder en 30 sekunders holdetid i begynnelsen av trinnet som ikke
vises i protokollen.

Slik setter du inn et smeltekurvetrinn

1. På verktøylinjen velger du Before (Før) eller After (Etter) i rullegardinmenyen Insert Step (Sett inn
trinn).

2. I grafen velger du trinnet før eller etter der du vil sette inn smeltekurvetrinnet.
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3. Klikk på Insert Melt Curve (Sett inn smeltekurve) i ruten til venstre. Det nye smeltekurvetrinnet
utheves i grafen og disposisjonsruten, for eksempel:

4. Hvis du vil redigere smeltetemperaturområdet eller intervalltiden, velger du standardverdien i grafen
eller disposisjonsruten og legger inn en ny verdi.

5. Klikk på OK og deretter på Yes (Ja) for å lagre endringene.

112 | CFX Maestro Dx SE-programvare



Opprette en protokoll i Protocol Editor (Protokollredigering)

Legge til eller fjerne et plateavlesningstrinn
Tips: Når du har lagt til en plateavlesningskommando i et trinn, endres knappen til Remove Plate
Read (Fjern plateavlesning) når du velger trinnet.

Slik legger du til en plateavlesning i et trinn

1. På verktøylinjen velger du Before (Før) eller After (Etter) i rullegardinmenyen Insert Step (Sett inn
trinn).

2. På grafen velger du trinnet før eller etter der du har å tenkt å sette inn plateavlesningstrinnet.

3. I venstre rute klikker du på Add Plate Read to Step (Legg til plateavlesning i trinn) for å legge til en
plateavlesning i det valgte trinnet.

4. Klikk på OK og deretter på Yes (Ja) for å lagre endringene.

Slik fjerner du en plateavlesning fra et trinn

u På grafen velger du trinnet som inneholder plateavlesningen, og klikker på Remove Plate Read
(Fjern plateavlesning) i venstre rute.

Endre trinnalternativer
Slik endrer du trinnalternativer for et valgt trinn

1. Velg måltrinnet på grafen eller i utkastruten.

2. Klikk på Step Options (Trinnalternativer) i ruten til venstre for å vise dialogboksen Step Options
(Trinnalternativer).

Du kan også klikke på måltrinnet i enhver rute og velge Step Options (Trinnalternativer) i menyen
som åpnes.

3. Slik kan du legge til, endre eller fjerne alternativer:

n Angi en verdi i den relevante tekstboksen.

n Rediger en verdi i den bestemte tekstboksen.

n Merk eller fjern merkingen i en avmerkingsboks.

4. Klikk på OK for å lagre endringene og lukke dialogboksen Step Options (Trinnalternativer).

5. Klikk på OK og deretter på Yes (Ja) for å lagre protokollen.

Brukerhåndbok | 113



Kapittel 7 Opprette protokoller

Slette et trinn
Viktig: Du kan ikke angre denne funksjonen. Utvis forsiktighet når du sletter trinn.

Slik sletter du et trinn i protokollen

1. Velg et trinn i diagrammet eller disposisjonsruten.

2. I venstre rute klikker du på Delete Step (Slett trinn) for å slette det valgte trinnet.

3. Klikk på OK og deretter på Yes (Ja) for å lagre protokollen.

Kopiere, eksportere eller skrive ut en protokoll
Slik kopierer du en protokoll

u Høyreklikk på protokollutkastet og velg Copy Protocol (Kopier protokoll).

Utkastet kan limes inn i en .txt-, .xls-, .doc- eller .ppt-fil.

Slik eksporterer du en protokoll

1. Høyreklikk på protokollutkastet og velg Export Protocol (Eksporter protokoll).

Dialogboksen Save As (Lagre som) vises.

2. (Valgfritt) ÅpneWindows Utforsker og naviger til mappen du vil lagre protokollfilen i.

3. I File name (Filnavn) skriver du inn navnet på den eksporterte protokollfilen.

4. Klikk på Save (Lagre).

Slik skriver du ut en protokoll

u Høyreklikk på protokollutkastet og velg Print (Skriv ut).

Protokollutkastet kan skrives ut på standardskriveren din.
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Opprette en protokoll med Protocol AutoWriter (Automatisk
protokollskriving)

Viktig: Bio-Rad garanterer ikke at kjøring av en protokoll opprettet med Protocol AutoWriter
(Automatisk protokollskriving) alltid vil resultere i et PCR-produkt.

Protocol AutoWriter (Automatisk protokollskriving) i CFX Maestro Dx SE genererer automatisk
syklusprotokoller basert på de følgende inndataparameterne:

n Amplicon length (Amplikonlengde) – den forventede lengden på PCR-produktet

n Annealing temperature (Hybridiseringstemperatur) – reaksjons-Ta for primerne som brukes

Hvis Ta er ukjent, kan du bruke Ta-kalkulatoren til å beregne den automatisk basert på
primersekvensene.

Merknad: Ta justeres ut fra informasjonen om smeltetemperatur (Tm) for primer, som er basert
på det valgte enzymet og protokollhastigheten.

n Enzyme type (Enzymtype) – DNA-polymeraseenzymet (iTaq, iProof DNA-polymerase eller annet)

Hvis du bruker et annet enzym enn iTaq eller iProof DNA-polymerase, kan du legge inn ytterligere
informasjon, inkludert gradientområde, varmestart-aktiveringstid (i sek) og endelig forlengelsestid (i
sek).

n Run speed (Kjøringshastighet) – reaksjonshastigheten (standard, rask eller ultrarask)

Protocol AutoWriter (Automatisk protokollskriving) optimerer protokollen avhengig av den valgte
hastighetsinnstillingen. Den totale kjøringstiden er avhengig av antallet trinn og sykluser,
inkuberingstiden på hvert trinn og tiden det tar å nå uniformitet ved måltemperaturen.

I henhold til parameterne du angir og standard PCR-retningslinjer genererer Protocol AutoWriter
(Automatisk protokollskriving) automatisk en tilpasset PCR-protokoll med varmestart, innledende
denaturering, hybridisering og forlengelsestrinn. Du kan deretter se en grafisk representasjon av den
foreslåtte protokollen og redigere, kjøre eller lagre protokollen.
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Slik oppretter du en ny protokoll med Protocol AutoWriter (Automatisk protokollskriving) i
CFX Maestro Dx SE

1. I startvinduet velger du Tools > Protocol AutoWriter (Verktøy > Automatisk protokollskriving).

Dialogboksen Protocol AutoWriter (Automatisk protokollskriving) vises.

2. I delen Enter Target Values/Enzyme (Angi målverdier/enzym) gjør du følgende:

n Angi hybridiseringstemperaturen (Ta) for primerne, hvis kjent.

Tips: Se Bruke Ta Calculator (Ta-kalkulator) på side 117 for mer informasjon.

Merknad: For informasjon om beregningene som brukes i Ta-kalkulatoren, se Breslauer et
al. 1986.

n Angi Amplicon length (Amplikonlengde) i basepar (bp).

n Velg en enzymtype fra listen over alternativer (iTaq DNA polymerase (iTaq DNA-polymerase),
iProof DNA polymerase (iProof DNA-polymerase) eller Other (Annet)).

Tips: Hvis du velger Other (Annet) som enzymtypen, aktiveres parameterne i delen
Additional Parameters (Optional) (Ytterligere parametere (valgfritt)).
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3. Hvis du valgte Other (Annet) som enzymtypen, kan du legge til en eller flere av følgende parametere i
protokollen:

n Gradient range (Gradientområde)

n Hot start activation temperature (Varmestart-aktiveringstemperatur)

n Final extension time (Endelig forlengelsestid)

4. I delen Type beveger du glidebryteren for å velge en protokollhastighet (Standard, Fast (Rask) eller
Ultrafast (Ultrarask)). CFX Maestro Dx SE justerer den totale kjøretiden.

5. Velg typen PCR som skal utføres (sanntids-PCR er standardinnstillingen).

Med sanntids-PCR legger CFX Maestro Dx SE til et plateavlesningstrinn for å samle inn
fluorescensdata.

6. Gå gjennom protokollen i delen Preview (Forhåndsvisning). Du kan gjøre endringer ved behov.

7. Gjør ett av følgende:

n Klikk på OK for å lagre den nye protokollen. Etter lagring åpnes protokollen i Startup Wizard
(Oppstartsveiviser). Klikk på Edit Selected (Rediger valgte) for å gjøre endringer i protokollen.
Du kan for eksempel endre lokktemperaturen og prøvevolumet.

n Klikk på Cancel (Avbryt) for å lukke vinduet uten å lagre protokollen.

Bruke Ta Calculator (Ta-kalkulator)
Når hybridiseringstemperaturen for primeren er ukjent, kan du bruke Ta Calculator (Ta-kalkulator) til å
beregne verdien. Du kan bruke verdien i Protocol AutoWriter (Automatisk protokollskriving) eller Protocol
Editor (Protokollredigering) til å opprette protokollen.

Om Ta-kalkulatoren
Ta-kalkulatoren beregner Tm-verdien for hver primer samt Ta-verdien for protokollen ved standard
hastighet.

Ta for protokollen er basert på de gjennomsnittlige Tm-primerverdiene med følgende regler anvendt:

n Hvis forskjellen mellom Tm-primerverdiene er >4 °C, er Ta = (den laveste av de to Tm-primerverdiene
+ 2) – 4 °C

n Hvis forskjellen mellom Tm-verdiene er ≤4 °C, er Ta = (gjennomsnittet av Tm-primerverdiene) – 4 °C
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Metode for telling av basepar

For hver primer bruker Ta Calculator (Ta-kalkulator) metoden for telling av basepar for sekvenser på 14
basepar (bp) eller færre.

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

der w, x, y og z er antallet av henholdsvis basene A, T, G og C i sekvensen.

Nærmeste nabo-metoden

For sekvenser som er lengre enn 14 bp, brukes nærmeste nabo-metoden. Med nærmeste nabo-metoden
er beregningene for smeltetemperatur basert på det termodynamiske forholdet mellom entropi (orden
eller måling av randomiteten til oligonukleotiden), entalpi (varme avgitt eller absorbert av
oligonukleotiden), fri energi og temperatur.

∆H = ∆G + T* ∆S

der:

n ∆H = Entalpiverdi, cal/mol*K

n T = Temperatur, kelvin

n ∆S = Entropiverdi, cal/mol*K

n ∆G = Gibbs fri energi i cal/omol*K

Endringen i entropi og entalpi beregnes direkte ved å legge sammen verdiene for nukleotidparene som
vises i Tabell 8 (Breslauer et al. 1986).

Forholdet mellom fri energi og konsentrasjon av reaktanter og produkter ved likevekt beregnes slik:

∆G = R*T*ln ((DNA * Primer)/(DNA + Primer))

der R er gasskonstanten (1,986 cal/mol*K).

Ved å substituere G i de to ligningene og løse på T får man

T = ∆H/(∆S + R*Ln((DNA * Primer)/(DNA + Primer)))

med forbehold om at konsentrasjonen av DNA og DNA-primer-kompleks er lik.

Det er fastslått empirisk at det er en endring på 5 kcal fri energi (3,4 kcal) (Sugimoto et al. 1996) under
overgangen fra enkeltrådet til B-formet DNA. Dette er antageligvis energien for heliksinitiering. Til slutt
legger man til en justering for salt for å få ligningen som Ta -kalkulatoren bruker:

T = (∆H – 5(kcal/K*mol))/(∆S + (R * ln(1/(primer)))) + 16,6 log10 (Saltmolaritet)
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Ingen justeringskonstant for saltkonsentrasjon trengs, da de ulike parameterne ble bestemt ved 1 M NaCl
og log10 av 1 er null.

De termodynamiske beregningene antar at hybridisering skjer ved pH 7,0. Tm-beregningene antar at
sekvensene ikke er symmetriske og inneholder minst én G eller C.

Oligonukleotidsekvensen skal være minst 14 baser lang for å få rimelige Tm-verdier. Hvis det er mindre
enn 14 baser, brukes metoden for telling av basepar (se Tabell 8 nedenfor).

Interaksjon ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

Tabell 8. Breslauer-interaksjonskonstanter
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Bruke Ta Calculator (Ta-kalkulator)

Slik bruker du Ta Calculator (Ta-kalkulator)

1. Velg én av følgende fremgangsmåter for å åpne Ta Calculator (Ta-kalkulator):

n Klikk på Ta Calculator (Ta-kalkulator) hvis du arbeider i Protocol AutoWriter (Automatisk
protokollskriving).

n Velg Tools (Verktøy) > Ta Calculator (Ta-kalkulator) i startvinduet.

Dialogboksen Ta Calculator (Ta-kalkulator) vises.

2. I tekstboksen Forward Primer (Forward-primer) skriver eller limer du inn forward-primersekvensen.

Tips: Du kan også bruke knappene A, T, G og C på venstre side av dialogboksen til å legge inn
sekvensen.

3. Skriv eller lim inn revers-primersekvensen i tekstboksen Reverse Primer (Revers-primer).

4. Klikk på Calculate (Beregn).
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Ta Calculator (Ta-kalkulator) beregner og viser Tm for hver primer og gjennomsnittlige Tm- og Ta-
verdier, for eksempel:

Hvis primer Tm-verdiene er mer enn 4 °C fra hverandre, bruker Protocol AutoWriter (Automatisk
protokollskriving) den laveste primer Tm-verdien + 2 °C som grunnlag for å beregne Ta-verdien, som
du kan modifisere ytterligere ved å endre enzym og reaksjonshastighet.

Ta Calculator (Ta-kalkulator) genererer en hybridiseringstemperatur for standardhastighet med iTaq
DNA-polymerase. Når du bruker et annet enzym, vil hastighetsinnstillingene automatisk justere Ta.

5. Gjør ett av følgende:

n Hvis du åpnet Ta Calculator (Ta-kalkulator) fra Protocol AutoWriter (Automatisk
protokollskriving), klikker du på OK. Du kommer da tilbake til Protocol AutoWriter (Automatisk
protokollskriving). Hybridiseringstemperaturen endres automatisk.

n Hvis du åpnet Ta Calculator (Ta-kalkulator) fra menyen Tools (Verktøy), registrerer du
beregningene og klikker på Cancel (Avbryt) for å lukke kalkulatoren.
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En platefil inneholder informasjon om kjøringsparametere slik som skannemodus, fluoroforer og
brønninnhold. Etter kjøringen knytter CFX Maestro Dx-programvare, Security Edition innholdet i brønnen
til fluorescensdataene som er innsamlet under kjøringen, og bruker egnet analyse i vinduet Data Analysis
(Datanalyse). Brønner som for eksempel er lastet med standard prøvetype, brukes til å generere en
standardkurve.

CFX Maestro Dx SE har to alternativer for å opprette plater: Plate Editor (Plateredigering) for sanntids
PCR-kjøringen og Setup Wizard (Oppsettsveiviser) for normalisert genuttrykksanalyse.

Plate Editor (Plateredigering) inkluderer følgende funksjoner:

n Standard fluoroforer og prøvetyper for tilordning til platebrønner

n Mulighet til å angi referansemål og kontrollprøve for genuttrykksanalyse

n Mulighet til å redigere plateoppsett før, under eller etter en kjøring

n Mulighet til å lagre platefiler for gjenbruk

n Mulighet til å skrive ut platefilen på en standardskriver

Setup Wizard (Oppsettsveiviser) veileder deg gjennom opprettelse av plateoppsett for analyse av
normalisert genuttrykk. Du kan bruke Setup Wizard (Oppsettsveiviser) før, under eller etter en kjøring.
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Vinduet Plate Editor (Plateredigering)
Du bruker Plate Editor (Plateredigering) til å opprette egendefinerte plater eller endre eksisterende plater.

1. Menylinjen gir rask tilgang til menykommandoene File (Fil) og Settings (Innstillinger) så vel som
verktøy for plateredigering.

2. Verktøylinjen gir rask tilgang til viktige plateinnlastingsfunksjoner.

3. Hovedruten viser platedisposisjonen og platealternativene i henhold til gjeldende valg.

4. Høyre rute viser alternativer du kan bruke for å tilpasse platen.

5. Den nederste ruten viser platetypen og gir rask tilgang til visningsalternativer.

FORKLARING

Kommandoer i menyen File (Fil)
Save (Lagre) – lagrer platedatafilen på plasseringen angitt i fanen File (Fil) i dialogboksen User
Preferences (Brukerpreferanser). Se Endre standard filinnstillinger på side 83 for mer informasjon. Dette
menyelementet er kun tilgjengelig når du oppretter en ny platefil.

Save As (Lagre som) – lagrer den åpne platedatafilen med et nytt navn, som du selv angir. Dette
menyelementet er kun tilgjengelig når du oppretter en ny platefil.

File Passwords (Filpassord) – gjør det mulig for brukere å angi passord for lagring og filåpning.
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Extract Plate (Hent ut platefil) – åpner en dialogboks, der du kan hente ut / lagre platefilen (.pltd). Dette
menyelementet er kun tilgjengelig når du viser eller redigerer en eksisterende platefil.

Print (Skriv ut) – skriver ut den åpne platedatafilen.

Close (Lukk) – lukker Plate Editor (Plateredigering).

Kommandoer i menyen Edit (Rediger)
Undo (Angre) – angrer en endring i en platefil, helt til platefilen lagres.

Redo (Gjør om) – reverserer den siste Angre-kommandoen, med mindre platefilen har blitt lagret.

Kommandoer i menyen Settings (Innstillinger)
Plate Size (Platestørrelse) – åpner en dialogboks der du kan velge en platestørrelse for kjøringen.

Merknad: Platestørrelsen må være den samme som blokkstørrelsen på instrumentet som
kjøringen skal utføres på.

Velg 96-brønn for:

n CFX Opus 96 Dx

n CFX Opus Deepwell Dx

Velg 384-brønn for:

n CFX Opus 384 Dx

Plate Type (Platetype) – brukes til å velge brønntypen i platen som inneholder prøvene, enten BRWhite
(BR hvit) eller BR Clear (BR klar). For å sikre nøyaktig dataanalyse må den valgte platetypen være den
samme som platetypen som brukes i kjøringen.

Merknad: Du må kalibrere nye platetyper. Se Kalibrere nye fargestoffer på side 75 for mer
informasjon.

Number Convention (Tallkonvensjon) – brukes til å aktivere eller deaktivere alternativet for å vise
enheter i vitenskapelig notasjon. Enheter vises i vitenskapelig notasjon som standard.

Units (Enheter) – brukes til å velge enhetene som skal vises i regnearkene når du utfører kvantifisering
av ukjente kontra en standardkurve.

Kommandoer i menyen Editing Tools (Redigeringsverktøy)
Setup Wizard (Oppsettsveiviser) – åpner Setup Wizard (Oppsettsveiviser), der du kan definere oppsett
og analyseparametere for den gjeldende platen. Du kan bruke Setup Wizard (Oppsettsveiviser) før, under
eller etter at en kjøring er fullført.
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Spreadsheet View/Importer (Regnearkvisning/-import) – åpner dialogboksen View (Vis), som viser
plateoppsettet som en mal i regnearkformat. Du kan bruke denne dialogboksen til å eksportere eller
importere platemaldata i .csv-format.

Flip Plate (Snu plate) – snur plateinnholdet 180o.

Kommandoer på verktøylinjen

Omgjør en endring for en plate. CFX Maestro Dx SE støtter opptil ti
angrehandlinger

Omgjør den siste angrehandlingen. CFX Maestro Dx SE støtter opptil ti
gjentakelser.

Lagrer den gjeldende platefilen.

Viser en rullegardinmeny, der du kan øke eller redusere forstørrelsen av
platevisningen.

Viser en rullegardinmeny, der du kan velge en skannemodus som angir
hvilke kanaler instrumentet skal hente fluorescensdata fra under en
kjøring.

Åpner Well Groups Manager (Administrering av brønngrupper), som du
kan bruke til å opprette brønngrupper for den gjeldende platen.

Viser en dialogboks, der du kan velge farger og symboler for
amplifiseringskurvene.

Åpner dialogboksen View (Vis), som viser plateoppsettet som en mal i
regnearkformat. Du kan bruke denne dialogboksen til å eksportere eller
importere platemaldata i .csv-format.

Åpner Setup Wizard (Oppsettsveiviser), der du kan definere oppsett og
analyseparametere for den gjeldende platen. Du kan bruke Setup Wizard
(Oppsettsveiviser) før, under eller etter en kjøring.

Åpner fanen Plate i dialogboksen User Preferences (Brukerpreferanser),
der du kan definere plateoppsettsparametere og opprette eller slette
navn på mål, prøver og biologiske grupper. Endringene du gjør i fanen
Plate, er tilgjengelige neste gang du åpner Plate Editor (Plateredigering).

Viser de nødvendige trinnene for å sette opp en plate og fylle brønnene.
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Opprette en platefil ved hjelp av Plate Editor (Plateredigering)
Du kan bruke Plate Editor (Plateredigering) til å opprette egendefinerte platefiler. Du kan også redigere og
lagre tidligere lagrede platefiler eller prøveplatefiler som leveres sammen med CFX Opus Dx-system.

Du oppretter en ny platefil på følgende måte:

n Åpne en platefil i Plate Editor (Plateredigering).

n Velg Plate type (Platetype).

Merknad: Plate type (Platetype) for platefilen må være den samme som platen i
reaksjonsmodulen.

n Velg Scan mode (Skannemodus) som skal brukes i protokollen.

n Velg Fluorophores (Fluoroforer) som skal brukes i platen.

n Velg Sample type (Prøvetype), Targets (Mål) og Samples (Prøver).

n Velg tekniske replikater, hvis aktuelt.

n Lagre plateoppsettet.

Tips: Se Åpne en eksisterende platefil i Plate Editor (Plateredigering) på side 129 for å opprette en
ny plate fra en tidligere lagret platefil eller en prøveplatefil.

Åpne en ny platefil i Plate Editor (Plateredigering)
CFX Maestro Dx SE har flere alternativer for å åpne en ny platefil:

n Fra startvinduet

n Fra dialogboksen Startup Wizard (Oppstartsveiviser)

n Fra dialogboksen Run Setup (Kjøringsoppsett)

Slik åpner du en ny platefil fra startvinduet

u Velg File > New > Plate (Fil > Ny > Plate).

Vinduet Plate Editor (Plateredigering) åpnes og viser standard platefil for det valgte instrumentet.

Tips: For informasjon om innstilling av standard platefil, se Endre standard filinnstillinger på side
83.
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Slik åpner du en ny platefil fra Startup Wizard (Oppstartsveiviser)

1. Gjør ett av følgende i startvinduet for å åpne Startup Wizard (Oppstartsveiviser) hvis den ikke vises:

n Velg View > Startup Wizard (Vis > Oppstartsveiviser).

n Klikk på Startup Wizard (Oppstartsveiviser) på verktøylinjen.

2. Velg om nødvendig instrumenttypen fra rullegardinmenyen.

3. For å opprette en ny plate velger du User-defined (Brukerdefinert) som kjøringstypen.

Dialogboksen Run Setup (Kjøringsoppsett) åpnes og viser fanen Protocol (Protokoll).

4. Klikk på fanen Plate og klikk på Create New (Opprett ny).

Vinduet Plate Editor (Plateredigering) åpnes og viser standard plateoppsett for det valgte
instrumentet.

Slik åpner du en ny platefil fra dialogboksen Run Setup (Kjøringsoppsett)

1. I startvinduet gjør du ett av følgende for å åpne dialogboksen Run Setup (Kjøringsoppsett):

n Velg Run > User-defined Run (Kjøring > Brukerdefinert kjøring).

n Klikk på User-defined Run Setup (Brukerdefinert kjøringsoppsett) på verktøylinjen.

Dialogboksen Run Setup (Kjøringsoppsett) åpnes og viser fanen Protocol (Protokoll).

2. Hvis du vil opprette en ny plate, klikker du på fanen Plate og deretter på Create New (Opprett ny).

Vinduet Plate Editor (Plateredigering) åpnes og viser standard plateoppsett for det valgte
instrumentet.
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Åpne en eksisterende platefil i Plate Editor (Plateredigering)
CFX Maestro Dx SE gir prøveplatefiler som du kan redigere og lagre som en ny plate. Du kan også
opprette en ny platefil fra en tidligere lagret platefil.

Slik åpner du en prøveplatefil

1. I startvinduet velger du File > Open > Plate (Fil > Åpne > Plate).

Windows Utforsker (Søk) åpnes i plasseringen for CFX Opus Dx-system Sample (Prøve)-filmappen.

2. Åpne Sample (Prøve)-filmappen, og åpne deretter Plates (Plater)-mappen.

3. Velg en platefil og klikk på Open (Åpne).

Prøveplatefilen åpnes i vinduet Plate Editor (Plateredigering).

4. Velg File > Save As (Fil > Lagre som) og lagre platefilen med et nytt navn eller i en annen mappe.

Slik åpner du en tidligere lagret platefil

1. Gjør ett av følgende i startvinduet:

n Velg File > Open > Plate (Fil > Åpne > Plate), naviger til og velg målplaten, og klikk på Open
(Åpne).

n Åpne Startup Wizard (Oppstartsveiviser) og gjør ett av følgende:

o Du redigerer en eksisterende platefil ved å velge Select Existing (Velg eksisterende) og
navigere til målfilen.

o Du redigerer platefilen som vises ved å klikke på Edit Selected (Rediger valgte).

Målplaten åpnes i vinduet Plate Editor (Plateredigering).

2. Velg File > Save As (Fil > Lagre som) og lagre platefilen med et nytt navn eller i en annen mappe.
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Sette opp en ny platefil
Tips: Hvis platefilen inneholder de nødvendige parametrene (hvis du for eksempel redigerer en
prøve eller eksisterende platefil), kan du hoppe over dette avsnittet. Fortsett til Tilordne valgfrie
parametere til platefilen på side 137.

Nye platefiler krever følgende parametere:

n Platestørrelse

n Platetype

n Scan mode (Skannemodus)

n Én fluorofor (fargestoff)

n Én prøvetype

Velge platestørrelse og -type

Viktig: Du må velge en platestørrelse under plateoppsett. Du kan ikke endre platestørrelsen under
eller etter en kjøring.

Programvaren anvender platestørrelsen og -typen på alle brønner under kjøringen. Kontroller at valgt
platestørrelse er den samme som for platen du skal bruke under kjøringen.

Bio-Rad CFX Opus Dx er fabrikkalibrert for mange fluorescerende fargestoffer og platekombinasjoner.
Kalibreringen er spesifikk for instrumentet, fargestoffet og platetypen. Kontroller at fluoroforen du skal
bruke er kalibrert for platetypen du velger.

Tips: Velg Tools > Dye Calibration Wizard (Verktøy > Fargekalibreringsveiviser) for å kalibrere en ny
kombinasjon av fargestoff og platetype på et instrument. Se Kalibrere nye fargestoffer på side 75 for
informasjon om kalibrering av fargestoffer og platetyper.

Velge skannemodus

CFX Opus 96 Dx og CFX Opus Deepwell Dx eksiterer og oppdager fluoroforer i fem kanaler (pluss
FRET). CFX Opus 384 Dx eksiterer og oppdager fluoroforer i fire kanaler (pluss FRET). Alle systemer
bruker flere skannemoduser for datainnhenting for å samle inn fluorescensdata under en kjøring.

CFX Maestro Dx SE har tre skannemoduser:

n All Channels (Alle kanaler)

o Skanner kanal 1 til 5 på CFX Opus 96 Dx og CFX Opus Deepwell Dx

o Skanner kanal 1 til 4 på CFX Opus 384 Dx
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n SYBR®/FAM

o Skanner kun kanal 1

o Kjører en hurtigskanning

n FRET

o Skanner kun FRET-kanalen

o Kjører en hurtigskanning

Velge fluoroforer

Viktig: Før du starter kjøringen, kontrollerer CFX-systemerne at fluoroforene du har angitt i platen, er
kalibrert på det aktuelle instrumentet. Du kan ikke kjøre en plate hvis den inneholder fluoroforer som
ikke er kalibrert på instrumentet.

Du må laste inn minst én fluorofor i plateoppsettet før kjøringen. Du kan legge til så mange fluoroforer som
nødvendig på dette tidspunktet, men platen må inneholde minst én fluorofor. De valgte fluoroforene vises
som alternativer for mål i Target Names (Målnavn).

Du bruker dialogboksen Select Fluorophores (Velg fluoroforer) til å laste inn fluoroforer (eller
platefargestoffer) i brønninnlastingskontrollene i Plate Editor (Plateredigering). Fluoroforene som vises i
dialogboksen Select Fluorophores (Velg fluoroforer), avhenger av skannemodusen du velger:

n All Channels (Alle kanaler)

Alle tilgjengelige fluoroforer vises.

Tips: Du kan legge til så mange fluoroforer som nødvendig, men du kan kun laste inn én
fluorofor per kanal i hver brønn.

n SYBR®/FAM

Kun kanal 1-fluoroforer vises.

n FRET

Kun kanal 6-fluoroforen vises.

Tips: Kanal 6 FRET-fluoroforen vises kun når FRET er den valgte skannemodusen. Den er ikke
tilgjengelig for skannemodusen All Channels (Alle kanaler).

Merknad: Du kan ikke legge til eller fjerne fluoroforer direkte i dialogboksen Select Fluorophores
(Velg fluoroforer). Du må kalibrere nye fluoroforer på et instrument ved hjelp av Dye Calibration
Wizard (Fargestoffkalibreringsveiviseren). Etter kalibrering vil den nye fluoroforen automatisk legges
til i listen. Hvis du vil ha mer informasjon, se Kalibrere nye fargestoffer på side 75.
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Velge prøvetyper

Viktig: Du må velge minst én prøvetype som skal tilordnes platebrønnene før kjøringen.

CFX Maestro Dx SE har seks prøvetyper:

n Unknown (Ukjent)

n Standard

n NTC (ikke-templatkontroll)

n Positive Control (positiv kontroll)

n Negative Control (negativ kontroll)

n NRT (uten revers transkriptase)

Du tilordner prøvetypene til platebrønnene.

Sette opp en ny plate

Slik setter du opp en ny plate

1. Åpne en ny plate i vinduet Plate Editor (Plateredigering).

2. Når du skal angi platestørrelse, velger du Settings > Plate Size (Innstillinger > Platestørrelse) og
deretter velger du ønsket platestørrelse fra rullegardinmenyen.

3. Når du skal angi platetype, velger du Settings > Plate Type (Innstillinger > Platetype) og deretter
velger du BRWhite (BR hvit) eller BR Clear (BR klar) fra rullegardinmenyen.

4. Du kan også endre tallkonvensjonen og visningsenhetene i menyen Settings (Innstillinger):

n Når du skal endre tallkonvensjonen, velger du Settings > Number Convention (Innstillinger >
Tallkonvensjon) og deretter Scientific Notation (Vitenskapelig notasjon).

Tips: Scientific Notation (Vitenskapelig notasjon) er valgt som standard. I dette tilfellet
fjernes standardvalget og tallkonvensjonen angis til standardform når du velger Scientific
Notation (Vitenskapelig notasjon).

n Når du skal endre visningsenheter, velger du Settings > Units (Innstillinger > Enheter) og velger
en ny enhetsverdi.

5. Når du skal angi skannemodus, velger du ønsket skannemodus fra rullegardinmenyen Scan Mode
(Skannemodus) på verktøylinjen i vinduet Plate Editor (Plateredigering).
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6. Velg påkrevde fluoroforer for platen:

a. Klikk på Select Fluorophores (Velg fluoroforer) i høyre rute.

Dialogboksen Select Fluorophores (Velg fluoroforer) åpnes. Du kan se de tilgjengelige
fluoroforene for typen skannemodus du valgte i Trinn 5, for eksempel:

b. Når du skal velge en fluorofor, merker du avmerkingsboksen Selected (Valgt) for denne
fluoroforen.

Tips: Når du skal fjerne en fluorofor fra listen, fjerner du merkingen i avmerkingsboksen
Selected (Valgt) for denne fluoroforen.

c. Når du skal endre visningsfargen på fluoroforen, klikker du på avmerkingsboksen Color (Farge)
for denne fluoroforen.

Merknad: Fargen du velger, representerer fluoroforen både i vinduet Plate Editor
(Plateredigering) og i diagrammet Data Analysis (Dataanalyse).

d. I dialogboksen Color (Farge) velger du ønsket farge, eller klikker på Define Custom Colors
(Definer egendefinerte farger) og oppretter en ny farge som skal representere fluoroforen.

e. Klikk på OK for å lagre endringene og lukke dialogboksen Select Fluorophores (Velg fluoroforer).
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7. Du må velge minst én brønn for fylling av en prøvetype. Brønn A1 velges som standard.

Velg ett av følgende alternativer i plateruten:

n Du kan fylle flere tilstøtende brønner ved å klikke på en brønn og dra den til målbrønnen.

n Du kan fylle flere brønner som ikke er tilstøtende, ved å holde inne Ctrl-tasten og klikke på hver
enkelt brønn.

n Du kan fylle en hel kolonne med den samme prøvetypen ved å klikke på kolonnenummeret.

n Du kan fylle en hel rad ved å klikke på radnummeret.

n Du kan fylle hele platen ved å klikke øverst i venstre hjørne av platen.

For eksempel:

8. Tilordne en prøvetype til den valgte brønnen eller de valgte brønnene fra rullegardinmenyen Sample
Type (Prøvetype).
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9. Tilordne minst én fluorofor til alle brønner som inneholder en prøvetype. Du kan tilordne mer enn én
fluorofor til en brønn eller en brønngruppe.

Merknad: Du kan bare tilordne én fluorofor per kanal. Du kan ikke tilordne mer enn én fluorofor
fra den samme kanalen til den samme brønnen.

Tips: Du kan tilknytte et mål til fluoroforen eller tilordne kun fluoroforen til brønnen på dette
tidspunktet og tilknytte et mål til fluoroforen etter at eksperimentet er kjørt.

n Når du skal tilordne kun én fluorofor til de valgte brønnene, merker du avmerkingsboksen Load
(Last inn) for den spesifikke fluroforen i delen Target Names (Målnavn).

n Når du skal tilknytte et mål til en fluorofor, velger du et målnavn fra rullegardinmenyen for den
spesifikke fluoroforen i delen Target Name (Målnavn). Programvaren merker den tilhørende
avmerkingsboksen Load (Last inn) automatisk.

10. For brønner som inneholder prøvetypen Standard, må du fylle på en konsentrasjon. Hver brønn kan
ha forskjellig konsentrasjonsverdi. Som standard fyller CFX Maestro Dx SE en konsentrasjon på
1,00 E+06 i alle brønner med prøvetypen Standard. Om nødvendig kan du endre verdien.

a. Velg en Standard-brønn eller -brønngruppe i plateruten.

b. Klikk på Load (Last inn) i delen Concentration (Konsentrasjon) for å fylle verdien i de(n) valgte
brønnen(e).

c. (Valgfritt) Når du skal fylle på en annen konsentrasjon, skriver du inn den nye verdien i
tekstboksen Concentration (Konsentrasjon) og trykker på Enter.

d. Utfør dette trinnet for alle brønner med prøvetypen Standard.

Tips: Når du skal fylle på samme konsentrasjon i alle Standard-brønner, må du kontrollere
at <All> (Alle) vises på rullegardinmenyen under verdien Concentration (Konsentrasjon).
Når du skal fylle på samme konsentrasjonsverdi i alle brønner med en spesifikk fluorofor,
klikker du på rullegardinmenyen og velger fluoroforen.

11. Klikk på OK for å lagre den nye platen.
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Høyreklikk på menyelementer for Plate Editor-verktøyet

Tabell 9 viser menyelementene som er tilgjengelige i verktøyet Plate Editor når du høyreklikker på en
brønn i verktøyet. Denne menyen vises også i regnearkvisningen/importen.

Element Funksjon

Copy (Kopier) Kopierer hele regnearket.

Copy as Image (Kopier
som bilde)

Kopierer regnearket som en bildefil.

Print (Skriv ut) Skriver ut regnearket.

Print Selection (Skriv ut
utvalg)

Skriver ut kun de valgte cellene.

Export to Excel
(Eksporter til Excel)

Eksporterer filen til et Excel-regneark.

Export to CSV
(Eksporter til CSV)

Eksporterer filen som en .csv-fil.

Export to Xml
(Eksporter til Xml)

Eksporterer filen som en .xml-fil.

Export to Html
(Eksporter til Html)

Eksporterer filen som en .html-fil.

Find (Søk) Søker etter bestemt tekst.

Sort (Sorter) Sorterer regnearket ved å velge opptil tre datakolonner i vinduet
Sort (Sorter).

Tabell 9. Elementer i høyreklikkmenyen for verktøyet Plate Spreadsheet View/Im-
porter (Plateregnearkvisning/-import)
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Tilordne valgfrie parametere til platefilen
En platefil inneholder informasjon om innholdet i hver brønn som er lastet med prøve for en kjøring. Etter
kjøringen knytter CFX Maestro Dx SE innholdet i brønnen til fluorescensdataene som er innsamlet under
protokollen, og bruker egnet analyse i vinduet Data Analysis (Dataanalyse).

I CFX Maestro Dx SE kan du tilordne parametere til hver brønn i platen før, under eller til og med etter du
kjører eksperimenter. Du kan tilordne parameterne til en eksisterende platefil eller til en ny platefil. Disse
parameterne inkluderer:

n Target names (Målnavn) – interessemålet eller -målene (gener eller sekvenser) i hver lastet brønn.

n Sample names (Prøvenavn) – identifikatoren eller tilstanden som tilsvarer prøven i hver lastet
brønn, for eksempel mouse1, mouse2 eller mouse3.

n Biological groups (Biologiske grupper) – identifikatoren eller tilstanden som tilsvarer en gruppe
med brønner, for eksempel 0Hr, 1Hr eller 2Hr.

Tips: Målnavn, prøvenavn og biologiske grupper må være de sammemellom brønnene for å
sammenligne data i fanen Gene Expression (Genuttrykk) i vinduet Data Analysis (Datanalyse).
Hvert navn må inneholde samme tegnsetting, mellomrom og de samme store og små
bokstavene. For eksempel er "Actin" ikke det samme som "actin", "2Hr" er ikke det samme som
"2 hr", og "Mouse 1" er ikke det samme som "mouse1." For å sikre konsekvent navngivning,
skriver du inn navnene i Libraries-delen i User > User Preferences > Plate (Bruker >
Brukerinnstillinger > Plate) som du finner i startvinduet.

n Technical replicates (Tekniske replikater) – hver brønn som brukes til å analysere samme
kombinasjon av prøve og mål, dvs. repliserte qPCR-reaksjoner.

n Dilution series (Fortynningsserie) – hvor mye konsentrasjonen skal endres for standardprøvetypen i
en replikatgruppe for å opprette standardkurvedata for analyse.

Tilordne et mål til brønner
Tips: Du kan tilordne det sammemålnavnet til én eller flere brønner. Du kan også tilordne flere mål til
samme brønn.

Viktig: Hvis du klikker på OK etter at du tilordnet et mål, blir endringene lagret og Undo (Angre) blir
deaktivert på verktøylinjen Plate Editor (Plateredigering). Utvis forsiktighet når du klikker OK.

Slik tilordner du et mål til en brønn eller en brønngruppe

1. Kontroller i Plate Editor (Plateredigering) at brønnen eller brønngruppen har blitt tilordnet en
prøvetype.

Se Velge prøvetyper på side 132 for informasjon om tilordning av prøvetyper til brønner.
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2. Velg brønnen eller brønngruppen i plateruten:

n Hvis du vil velge en enkelt brønn, klikker du på brønnen.

n Hvis du vil velge flere tilstøtende brønner, klikker du på en brønn og drar markøren til ønsket
brønn.

n Hvis du vil velge flere ikke-tilstøtende brønner, holder du Ctrl-tasten nede og klikker på hver
brønn.

n Hvis du vil velge en hel kolonne med samme prøvetype, klikker du på kolonnenummeret.

n Hvis du vil velge en hel rad, klikker du på radnummeret.

3. I høyre rute velger du et navn i rullegardinmenyen Target Name (Målnavn) for hver valgte fluorofor.

4. Gjenta Trinn 3 for hver brønn eller brønngruppe du må tilordne et mål til.

Tips: Du kan tilordne det samme eller et annet målnavn for hver valgte fluorofor.

5. Klikk på OK for å godta endringene og lagre platen.

Merknad: Hvis du endret platen ved en feil, klikker du på Undo (Angre) på verktøylinjen i Plate
Editor (Plateredigering) før du klikker på OK for å godta endringene.

Slik fjerner du et målnavn

u Hvis du vil fjerne et målnavn fra en valgt brønn eller brønngruppe, fjerner du merket i
avmerkingsboksen Load (Last inn).

Viktig: Hvis du fjerner et målnavn fra en brønn, fjerner du også den tilknyttede fluoroforen. Utvis
forsiktighet når du fjerner et målnavn fra en brønn.

Slik legger du til et målnavn i listen

u Gjør ett av følgende for å legge til et målnavn i rullegardinmenyen:

n Skriv inn et navn i rullegardinmenyen Target Name (Målnavn) og trykk på Enter.

Tips: Målnavn som du legger til i én liste, vises i alle andre mållister.

n Klikk på det grønne pluss-symbolet (+) til høyre for rullegardinmenyen, skriv inn et navn for målet
og trykk på Enter.
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n Klikk på User Preferences (Brukerpreferanser) på verktøylinjen, og legg til navnet i biblioteket
Target Names (Målnavn) i fanen Plate (Plate).

Viktig: Målnavn som legges til i rullegardinmenyen, er kun tilgjengelige for den aktuelle platen,
og bare hvis du tilordner navnet til en brønn og lagrer plateoppsettet. Hvis du ikke tilordner
navnet til en brønn og lagrer plateoppsettet, lagres ikke navnet og er ikke tilgjengelig for fremtidig
bruk. For permanent å legge til et målnavn må navnet også legges til i biblioteket Target Names
(Målnavn) ved bruk av dialogboksen User Preferences (Brukerpreferanser). Navn som legges til
i biblioteket, er tilgjengelige neste gang du åpner Plate Editor (Plateredigering). Se Angi
standardparametere for plate på side 86 for mer informasjon.

Slik sletter du et målnavn fra listen

1. Klikk på User Preferences (Brukerpreferanser) på verktøylinjen.

Dialogboksen User Preferences (Brukerpreferanser) åpnes, og fanen Plate (Plate) vises.

2. Velg navnet du vil slette under fanen Plate (Plate) i biblioteket Target Names (Målnavn), og trykk på
tasten Delete (Slett).

3. Trykk på OK for å lagre endringer og lukke dialogboksen User Preferences (Brukerpreferanser).

Viktig: Du kan ikke slette målnavn som er lagret sammen med en platefil. Egendefinerte navn
du legger til i rullegardinmenyen Target Names (Målnavn), men ikke bruker og lagrer sammen
med platen, fjernes automatisk fra listen. Navn som slettes fra biblioteket Target Names
(Målnavn), fjernes automatisk fra programvaren og er ikke lenger tilgjengelig for brukeren. Utvis
forsiktighet når du sletter målnavn.

Tilordne et prøvenavn til brønner
Merknad: Du tilordner et prøvenavn ved å tilordne minst én fluorofor til de valgte brønnene. Hvis de
valgte brønnene ikke er tilordnet en fluorofor, deaktiveres rullegardinmenyen Sample Names
(Prøvenavn). Se Tilordne et mål til brønner på side 137 for informasjon om tilordning av fluoroforer.

Tips: Du kan kun tilordne ett prøvenavn til hver brønngruppe.

Slik tilordner du et prøvenavn til en brønn eller brønngruppe

1. Kontroller i Plate Editor (Plateredigering) at brønnen eller brønngruppen har blitt tilordnet en fluorofor.

2. Velg brønnen eller brønngruppen i plateruten.

3. I høyre rute velger du et navn i rullegardinmenyen Sample Names (Prøvenavn).

Programvaren merker den tilhørende avmerkingsboksen Load (Last inn) automatisk.
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4. Gjenta Trinn 3 for hver brønn eller brønngruppe du må tilordne et prøvenavn til.

5. Klikk på OK for å godta endringene og lagre platen.

Merknad: Hvis du endret platen ved en feil, klikker du på Undo (Angre) på verktøylinjen i Plate
Editor (Plateredigering) før du klikker på OK for å godta endringene.

Slik fjerner du et prøvenavn

u Hvis du vil fjerne et prøvenavn fra en valgt brønn eller brønngruppe, fjerner du merket i
avmerkingsboksen Load (Last inn).

Slik legger du til et prøvenavn i listen

u Gjør ett av følgende for å legge til et prøvenavn i rullegardinmenyen:

n Skriv inn et navn i rullegardinmenyen Sample Names (Prøvenavn) og trykk på Enter.

n Klikk på det grønne pluss-symbolet (+) til høyre for rullegardinmenyen, og skriv inn et navn for
prøven.

n Klikk på User Preferences (Brukerpreferanser) på verktøylinjen, og legg til navnet i biblioteket
Sample Names (Prøvenavn) i fanen Plate (Plate).

Viktig: Prøvenavn som legges til i rullegardinmenyen, er kun tilgjengelige for den aktuelle
platen, og bare hvis du tilordner navnet til en brønn og lagrer plateoppsettet. Hvis du ikke
tilordner navnet til en brønn og lagrer plateoppsettet, lagres ikke navnet og er ikke tilgjengelig for
fremtidig bruk. For permanent å legge til et prøvenavn må navnet også legges til i biblioteket
Sample Names (Prøvenavn) ved bruk av dialogboksen User Preferences (Brukerpreferanser).
Navn som legges til i biblioteket, er tilgjengelige neste gang du åpner Plate Editor
(Plateredigering). Se Angi standardparametere for plate på side 86 for mer informasjon.

Slik sletter du et prøvenavn fra listen

1. Klikk på User Preferences (Brukerpreferanser) på verktøylinjen.

Dialogboksen User Preferences (Brukerpreferanser) åpnes, og fanen Plate (Plate) vises.

2. Velg navnet du vil slette under fanen Plate (Plate) i biblioteket Sample Names (Prøvenavn), og trykk
på tasten Delete (Slett).
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3. Trykk på OK for å lagre endringer og lukke dialogboksen User Preferences (Brukerpreferanser).

Viktig: Du kan ikke slette prøvenavn som er lagret sammen med en platefil. Egendefinerte navn
du legger til i listen Sample Names (Prøvenavn), men ikke bruker og lagrer sammen med platen,
fjernes automatisk fra rullegardinmenyen. Navn som slettes fra biblioteket Sample Names
(Prøvenavn), fjernes fra programvaren og er ikke lenger tilgjengelig for brukeren. Utvis
forsiktighet når du sletter prøvenavn.

Tilordne biologiske grupper til brønner
Merknad: For å tilordne en biologisk gruppe, må du tilordne de valgte brønnene til minst én fluorofor.
Ved å tilordne en fluorofor aktiveres rullegardinlisten Biological Groups (Biologiske grupper). Se
Tilordne et mål til brønner på side 137 for informasjon om tilordning av fluoroforer.

Tips: Du kan tilordne en biologisk gruppe til hver brønn eller brønngruppe.

Slik tilordner du en biologisk gruppe til en brønn eller brønngruppe

1. Kontroller i Plate Editor (Plateredigering) at brønnen eller brønngruppen har blitt tilordnet en fluorofor.

2. Velg brønnen eller brønngruppen i plateruten.

3. I høyre rute, velg fra rullegardinlisten Biological Group (Biologisk gruppe) .

CFX Maestro Dx SE merker avmerkingsboksen Load (Last inn) automatisk.

4. Gjenta Trinn 3 for hver brønn eller brønngruppe som du må tilordne en biologisk gruppe.

5. Klikk på OK for å godta endringene og lagre platen.

Merknad: Hvis du endret platen ved en feil, klikker du på Undo (Angre) på verktøylinjen i Plate
Editor (Plateredigering) før du klikker på OK for å godta endringene.

Fjerne en biologisk gruppe

u Hvis du vil fjerne en biologisk gruppe fra en valgt brønn eller brønngruppe, fjerner du merket i
avmerkingsboksen Load (Last inn).

Legge til en biologisk gruppe i listen

u Gjør ett av følgende for å legge til en biologisk gruppe i rullegardinlisten:
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n Skriv inn et navn i rullegardinboksen Biological Group (Biologisk gruppe), og trykk på Enter.

n Klikk på det grønne pluss-symbolet (+) til høyre for rullegardinmenyen, og skriv inn et navn for
den biologiske gruppen.

n Klikk på User Preferences (Brukerpreferanser) på verktøylinjen, og legg til navnet i biblioteket
Biological Group Names (Biologiske gruppenavn) i fanen Plate.

Viktig: Navn på biologiske grupper som legges til i rullegardinmenyen, er kun tilgjengelige for
den aktuelle platen, og bare hvis du tilordner navnet til en brønn og lagrer plateoppsettet. Hvis du
ikke tilordner navnet til en brønn og lagrer plateoppsettet, lagres ikke navnet og er ikke
tilgjengelig for fremtidig bruk. For permanent å legge til navnet på en biologisk gruppe må navnet
også legges til i biblioteket Biological Group Names (Biologiske gruppenavn) ved bruk av
dialogboksen User Preferences (Brukerpreferanser). Navn som legges til i biblioteket, er
tilgjengelige neste gang du åpner Plate Editor (Plateredigering). Se Angi standardparametere for
plate på side 86 for mer informasjon.

Slik sletter du navnet på en biologisk gruppe fra listen

1. Klikk på User Preferences (Brukerpreferanser) på verktøylinjen.

Dialogboksen User Preferences (Brukerpreferanser) åpnes, og fanen Plate (Plate) vises.

2. Velg navnet du vil slette under fanen Plate i biblioteket Biological Group Names (Biologiske
gruppenavn), og trykk på tasten Delete (Slett).

3. Trykk på OK for å lagre endringer og lukke dialogboksen User Preferences (Brukerpreferanser).

Viktig: Du kan ikke slette navn på biologiske grupper som er lagret sammen med en platefil.
Egendefinerte navn du legger til i rullegardinmenyen Biological Group Names (Navn på
biologiske grupper), men ikke bruker og lagrer sammen med platen, fjernes automatisk fra listen.
Navn som slettes fra Biological Names Group Library (Bibliotek over biologiske gruppenavn),
fjernes automatisk fra programvaren og er ikke lenger tilgjengelig for brukeren. Utvis forsiktighet
når du sletter biologiske navn.

Slik viser du alle biologiske grupper på platen

u Klikk på Show Biological Groups (Vis biologiske grupper) for å vise alle biologiske grupper på platen.
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Hver gruppe identifiseres av en bestemt farge, og knappen Show Biological Groups (Vis biologiske
grupper) endres til Hide Biological Groups (Skjul biologiske grupper).

Klikk på Hide Biological Groups (Skjul biologiske grupper) for å fjerne fargen i brønnene. Du kan også
klikke på en brønn i platen for å skjule biologiske grupper.

Tilordne tekniske replikatnumre til brønner
Viktig: For å tilordne tekniske replikatnumre må innholdet i de valgte brønnene være identisk. Det vil
si at de valgte brønnene må ha samme prøvetype og fluorofor. Hvis relevant, må de også tilordnes
sammemål- og prøvenavn og samme biologiske gruppe. Hvis de ikke er identiske, aktiverer ikke
CFX Maestro Dx SE dette alternativet.

Slik tilordner du tekniske replikatnumre til en brønngruppe

1. Kontroller i Plate Editor (Plateredigering) at innholdet i brønngruppen er identisk.

2. Velg målgruppen med brønner i plateruten.

3. For å tilordne samme replikatnummer til alle valgte brønner går du til Replicate # (Replikatnr.) i høyre
rute, skriver inn replikatnummeret i boksen og velger Load (Last inn).

4. (Valgfritt) Gjør følgende for å bruke en replikatserie på et sett valgte brønner:

a. Klikk på Technical Replicates (Tekniske replikater). Delen Replicate # (Replikatnr.) endres for å
vise følgende alternativer:

n Replicate size (Replikatstørrelse) – et nummer som representerer antallet brønner i hver
replikatgruppe
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n Starting replicate # (Startreplikatnr.) – det første nummeret i replikatserien for den valgte
replikatgruppen

Merknad: Som standard viser CFX Maestro Dx SE startreplikatnummeret som ett nummer
høyere enn det siste tekniske replikatnummeret tilordnet i platen. For eksempel, hvis det
siste tekniske replikatnummeret i platen er fem, er det neste startnummeret seks. Du kan
endre startnummeret til ethvert nummer som ikke allerede er tilordnet.

n Innlastingsretning (horisontal eller vertikal)

b. Klikk på Apply (Bruk) for å bruke parametrene på serien og returnere til visningen Replicate #
(Replikatnr.).

5. Klikk på OK for å godta endringene og lagre platen.

Merknad: Hvis du endret platen ved en feil, klikker du på Undo (Angre) på verktøylinjen i Plate
Editor (Plateredigering) før du klikker på OK for å godta endringene.

Slik fjerner du en brønn fra en replikatserie

u Velg brønnen eller brønngruppen som skal fjernes, og fjern merket i avmerkingsboksen Replicate #
Load (Last inn replikatnr.).

Alternativt kan du klikke på Clear Replicate # (Fjern replikatnr.) for å fjerne replikatnummeret fra en
valgt brønn eller brønngruppe.

Slik viser du alle tekniske replikater på platen

u Klikk på Show Technical Replicates (Vis tekniske replikater) for å vise alle tekniske replikater på
platen

Hver gruppe identifiseres av en bestemt farge, og knappen Show Technical Replicates (Vis tekniske
replikater) endres til Hide Technical Replicates (Skjul tekniske replikater).

Klikk på Hide Technical Replicates (Skjul tekniske replikater) for å fjerne fargen i brønnene. Du kan
også klikke på enhver brønn i platen for å skjule tekniske replikater.

Tilordne en fortynningsserie til standard prøvetyper
Som tidligere nevnt må alle brønner med prøvetypen Standard være tilordnet en konsentrasjonsverdi. Du
kan tilordne en fortynningsserie til flere brønner med prøvetypen Standard.

Merknad: For å tilordne en fortynningsserie til en gruppe med brønner må brønnene være inkludert i
en teknisk replikatserie. Se Tilordne tekniske replikatnumre til brønner på side 143 for informasjon
om hvordan du legger til brønner i en replikatserie.
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Slik tilordner du en fortynningsserie til en gruppe standard prøvebrønner

1. I Plate Editor (Plateredigering) kontrollerer du at følgende krav er oppfylt:

n Prøvetypen for brønngruppen er Standard.

n Alle brønner i gruppen er tilordnet minst én fluorofor, og alle inneholder de samme fluoroforene.

n Alle brønner i gruppen er inkludert i samme teknisk replikatserie.

Merknad: CFX Maestro Dx SE aktiverer alternativet Dilution Series (Fortynningsserie) kun
når alle valgte brønner oppfyller disse kriteriene.

2. Velg målgruppen med brønner i plateruten.

3. I delen Concentration (Konsentrasjon) i høyre rute klikker du på Dilution Series (Fortynningsserie).
Delen Concentration (Konsentrasjon) endres og viser følgende alternativer:

n Starting concentration (Startkonsentrasjon) – konsentrasjonsverdien som serien starter fra

n Replicates from and to (Replikater fra og til) – replikatene i serien som fortynningsfaktoren vil
bli brukt på

n Dilution factor (Fortynningsfaktor) – mengden som konsentrasjonen skal endres med innenfor
hver replikatgruppe

4. Angi verdiene for alternativene eller godta standardverdiene.

5. Fortynningsserien reduseres med fortynningsfaktoren som standard. Velg Increasing (Stigende) for
å øke fortynningsserien.

6. (Valgfritt) Fortynningsfaktoren brukes på alle fluoroforer i replikatserien som standard. Hvis serien
inneholder mer enn én fluorofor og du vil bruke fortynningen på en enkelt fluorofor, velger du den fra
rullegardinmenyen.

7. Klikk på Apply (Bruk) for å bruke fortynningsserien på brønngruppen og gå tilbake til visningen
Concentration (Konsentrasjon).

8. Klikk på OK for å godta endringene og lagre platen.
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Kopiere brønninnhold til en annen brønn
Du kan kopiere innholdet i en brønn og lime det inn i én eller flere brønner. Du kan imidlertid kun kopiere
innholdet fra én enkelt brønn. Du kan ikke velge flere brønner og kopiere innholdet i disse.

Slik kopierer du innholdet i en brønn til en annen brønn

1. I plateruten velger du brønnen som skal kopieres.

2. Høyreklikk på brønnen og velg Copy Well (Kopier brønn).

3. Velg brønnen eller brønnene som innholdet skal limes inn i:

n Hvis du vil velge en enkelt brønn, klikker du på brønnen.

n Hvis du vil velge flere tilstøtende brønner, klikker du på en brønn og drar markøren til ønsket
brønn.

n Hvis du vil velge flere ikke-tilstøtende brønner, holder du Ctrl-tasten nede og klikker på hver
brønn.

4. Når målbrønnene er valgt, høyreklikker du og velger Paste Well (Lim inn brønn).

CFX Maestro Dx SE limer inn innholdet fra den første brønnen i de valgte brønnene.

Legge til en merknad for en brønn
Du kan legge til en beskrivende merknad for en brønn. Du kan vise brønnmerknadene i fanen
Quantification (Kvantifisering) i vinduet Data Analysis (Dataanalyse).

Slik legger du til en merknad for en brønn

1. I plateruten velger du brønnen eller brønnene du vil legge til en merknad for.

2. I delen View (Visning) i nederste rute velger du Well Note (Brønnmerknad).

Området Well Note (Brønnmerknad) vises i høyre rute.

3. Skriv inn merknaden i tekstboksen og trykk på Enter.

Teksten vises nederst i de valgte brønnene.

Tips: Hvis du allerede har opprettet en brønnmerknad, kan du velge den fra rullegardinmenyen
og bruke den på de valgte brønnene.

146 | CFX Maestro Dx SE-programvare



Tilordne valgfrie parametere til platefilen

Tømme brønner for alt innhold
Du kan tømme en enkelt brønn, en brønngruppe eller hele platen for alt innhold. Tømming av brønner vil
ikke fjerne fluorescensdata som er samlet inn under plateavlesningen.

Viktig: Når du tømmer en brønn, fjernes alt innholdet i brønnen permanent. Hvis du klikker på OK og
lagrer platen etter at du har tømt en brønn, kan du ikke angre handlingen. Utvis forsiktighet når du
tømmer brønner.

Slik tømmer du brønner for alle innstillinger

1. I Plate Editor (Plateredigering) velger du en brønn eller brønngruppe i plateruten:

n Hvis du vil velge en enkelt brønn, klikker du på brønnen.

n Hvis du vil velge flere tilstøtende brønner, klikker du på en brønn og drar markøren til ønsket
brønn.

n Hvis du vil velge flere ikke-tilstøtende brønner, holder du Ctrl-tasten nede og klikker på hver
brønn.

n Hvis du vil velge en hel kolonne med samme prøvetype, klikker du på kolonnenummeret.

n Hvis du vil velge en hel rad, klikker du på radnummeret.

2. Klikk på Clear Wells (Tøm brønner) i høyre rute.

CFX Maestro Dx SE tømmer de valgte brønnene for alle innstillinger.

3. Gjør ett av følgende:

n Hvis du tømte brønnene ved en feil, klikker du på Undo (Angre) på verktøylinjen i Plate Editor
(Plateredigering) før du klikker på OK for å godta endringene.

Viktig: Hvis du klikker på OK før du klikker på Undo (Angre), lagres endringene, og
alternativet Undo (Angre) deaktiveres på verktøylinjen i Plate Editor (Plateredigering).

n Klikk på OK for å godta endringene og lagre platen.
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Endre eksperimentinnstillinger
Bruk dialogboksen Experiment Settings (Eksperimentinnstillinger) til å vise eller endre listen med mål,
prøver eller biologiske grupper, eller til å angi genuttrykksanalyse-prøvegruppen som skal analyseres
hvis du har tilordnet biologiske grupper til brønner i platen.

I dialogboksen Experiment Settings (Eksperimentinnstillinger) viser fanen Targets (Mål) en liste med
målnavn for hver PCR-reaksjon, for eksempel målgenet eller gensekvenser av interesse.

Fanen Samples and Biological Groups (Prøver og biologiske grupper) viser en liste med navn på prøver
og biologiske grupper som angir kilden til målet, for eksempel en prøve tatt etter 1 time (1Hr) eller fra et
bestemt individ (mouse1).

Slik endrer du plateinnstillinger ved hjelp av dialogboksen Experiment Settings
(Eksperimentinnstillinger)

1. Velg én av følgende fremgangsmåter for å åpne dialogboksen Experiment Settings
(Eksperimentinnstillinger):

n Klikk på Experiment Settings (Eksperimentinnstillinger) i høyre rute i Plate Editor
(Plateredigering).

n Klikk på Experiment Settings (Eksperimentinnstillinger) i fanen Gene Expression (Genuttrykk) i
vinduet Data Analysis (Dataanalyse).

Dialogboksen Experiment Settings (Eksperimentinnstillinger) åpnes i fanen Targets (Mål).

2. Hvis du vil legge til et nytt navn på et mål, en prøve eller en biologisk gruppe, går du til den relevante
fanen, skriver inn et navn i tekstboksen New (Ny) og klikker på Add (Legg til).
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3. Hvis du vil fjerne et eller flere navn på et mål, en prøve eller en biologiske gruppe fra listen, går du til
den relevante fanen, velger elementets avmerkingsboks i kolonnen Select to Remove (Velg for å
fjerne) og klikker på Remove checked item(s) (Fjern avmerkede
elementer).

4. CFX Maestro Dx SE ekskluderer prøvetypen NTC (ikke-templatkontroll) fra genuttrykksanalysen.

Hvis du vil inkludere NTC-prøvetyper, fjerner du merket i avmerkingsboksen i delen Exclude the
following sample types (Ekskludere følgende prøvetyper). Du kan velge å ekskludere følgende
prøvetyper ved å merke av i den relevante avmerkingsboksen:

n NRT (uten revers transkriptase)

n Negative Control (negativ kontroll)

n Positive Control (positiv kontroll)

n Standard

5. I fanen Targets (Mål):

a. Hvis du vil velge et mål som referanse for genuttrykksdataanalyse, velger du det i kolonnen
Reference (Referanse).

b. Hvis du vil skjule analyseinnstillinger som vil bli brukt i fanen Gene Expression (Genuttrykk) i
vinduet Analysis Settings (Analyseinnstillinger), fjerner du merket i avmerkingsboksen Show
Analysis Settings (Vis analyseinnstillinger).

Programvaren skjuler følgende kolonner:

n Color (Farge)

n Show Chart (Vis diagram)

n Auto Efficiency (Automatisk effektivitet)

n Efficiency (%) (Effektivitet (%))

c. Hvis du vil endre fargen på målet som vises i diagrammet Gene Expression (Genuttrykk), klikker
du på tilhørende celle i kolonnen Color (Farge), velger en ny farge i dialogboksen Color (Farge)
og klikker på OK.

d. Hvis du vil vise målet i den valgte fargen i diagrammet Gene Expression (Genuttrykk), velger du
tilhørende avmerkingsboks i kolonnen Show Chart (Vis diagram).

e. Som standard beregner CFX Maestro Dx SE automatisk den relative effektiviteten for et mål hvis
dataene inkluderer en standardkurve.

Hvis du vil bruke en tidligere bestemt effektivitetsverdi, skriver du inn verdien i tilhørende celle i
kolonnen Efficiency (%) (Effektivitet (%)) og trykker på Enter-tasten. CFX Maestro Dx SE sletter
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avmerkingsboksen Auto Efficiency (Automatisk effektivitet)

6. I fanen Samples (Prøver) og Biological Groups (Biologiske grupper):

a. Hvis du vil velge en prøve eller biologisk gruppe som kontrollprøve for genuttrykksdataanalyse,
merker du av i avmerkingsboksen i kolonnen Control (Kontroll).

b. Hvis du vil tilordne kontrolltilstanden til en prøve eller biologisk gruppe for en kjøring, klikker du
på avmerkingsboksen i kolonnen Control (Kontroll).

c. Hvis det ikke allerede er valgt, klikker du på Show Analysis Settings (Vis analyseinnstillinger) for
å vise eller endre analyseparametere som vil bli brukt i fanen Gene Expression (Genuttrykk).
Programvaren skjuler kolonnene Color (Farge) og Show Chart (Vis diagram).

7. Klikk på OK for å lagre parametrene i dialogboksen Experiment Settings (Eksperimentinnstillinger)
og gå tilbake til vinduet Plate Editor (Plateredigering).
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Opprette brønngrupper
Brønngrupper deler inn en enkelt plate i delsett med brønner som kan analyseres uavhengig av
hverandre i vinduet Data Analysis (Dataanalyse). Når brønngrupper er satt opp, velger du én i vinduet
Data Analysis (Dataanalyse) for å analysere dataene som en uavhengig gruppe. Du kan for eksempel
sette opp brønngrupper for å analysere flere eksperimenter kjørt på én plate, eller for å analysere hver
brønngruppe med forskjellig standardkurve.

Merknad: Standard brønngruppe er All Wells (Alle brønner).

Slik oppretter du brønngrupper

1. Velg én av følgende fremgangsmåter for å åpneWell Groups Manager (Administrering av
brønngrupper):

n Klikk på Well Groups (Brønngrupper) på verktøylinjen i Plate Editor (Plateredigering).

n Klikk på ManageWell Groups (Administrer brønngrupper) i vinduet Data Analysis
(Dataanalyse).

DialogboksenWell Groups Manager (Administrering av brønngrupper) vises.

2. Klikk på Add (Legg til) for å opprette en ny gruppe. Rullegardinmenyen viser gruppenavnet som
Group 1 (Gruppe 1) for den første gruppen.
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3. Velg brønnene til brønngruppen i platevisningen ved å klikke og dra over gruppen med brønner.
Valgte brønner vises i blått i Manager (Administrering).

4. (Valgfritt) Hvis du vil endre navnet på gruppen, velger du navnet i rullegardinmenyen og skriver inn et
nytt navn.

5. (Valgfritt) Hvis du vil slette en brønngruppe, velger du navnet i rullegardinmenyen og klikker på
Delete (Slett).

6. Klikk på OK for å avslutte og lukke vinduet, eller klikk på Cancel (Avbryt) for å lukke vinduet uten å
gjøre endringer.

Elementer i høyreklikkmenyen for dialogboksen Well Groups Manager
(Administrering av brønngrupper)

Tabell 10 viser menyelementene som er tilgjengelige i Well Groups Manager (Administrering av
brønngrupper) når du høyreklikker på en brønn.

Element Funksjon

Copy (Kopier) Kopierer innholdet i brønnen, som deretter kan limes inn i
en annen brønn eller flere andre brønner.

Copy as Image (Kopier som
bilde)

Kopierer brønnvelgervisningen som et bilde.

Print (Skriv ut) Skriver ut brønnvelgervisningen.

Print Selection (Skriv ut utvalg) Skriver ut kun de valgte cellene.

Export to Excel (Eksporter til
Excel)

Eksporterer dataene til et Excel-regneark.

Export to CSV (Eksporter til
CSV)

Eksporterer dataene som et kommaseparert dokument.

Export to Xml (Eksporter til Xml) Eksporterer dataene som et .xml-dokument.

Export to Html (Eksporter til
Html)

Eksporterer dataene som et .html-dokument.

Tabell 10. Høyreklikk på menyelementene i dialogboksen Plate Editor Well Groups
Manager (Plateredigering brønngruppebehandling)
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Endre kurvestiler
Under plateoppsett og mens en kjøring pågår, kan du endre fargen og stilen på amplifiseringskurvene. Du
kan deretter enkelt vise kurvene i vinduet for sanntidsstatus etter hvert som dataene samles inn.

Slik endrer du kurvestiler

1. Klikk på Trace Styles (Kurvestiler) på verktøylinjen i Plate Editor (Plateredigering).

Dialogboksen Trace Styles (Kurvestiler) vises for den åpne platen, for eksempel:

2. Hvis du vil vise kurvestilene etter en bestemt fluorofor, velger du den fra rullegardinmenyen
Fluorophores (Fluoroforer).

3. Slik endrer du kurvevisningen:

a. Velg kurvetypen fra rullegardinmenyenWells (Brønner).

b. Klikk på fargen i kolonnen Color (Farge).

c. I dialogboksen Color (Farge) som vises, velger du en annen farge for kurven og klikker på OK.

CFX Maestro Dx SE viser fargeendring for brønntypen i rutenettet.

d. (Valgfritt) Velg et symbol for kurven fra rullegardinmenyen Symbols (Symboler).

4. Hvis du vil endre fargesettet raskt, klikker du på det relevante valget i delen Color Quick Set
(Hurtigfargesett).

5. Hvis du vil vise brønnetiketter i rutenettet, velger du etikettypen i delen Well Labels (Brønnetiketter).
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6. Klikk på OK for å lagre endringer, eller på Cancel (Avbryt) for å avbryte endringer.
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Vise, eksportere og importere platen i regnearkformat
Verktøyet Spreadsheet View/Importer (Regnearkvisning/-import) viser innholdet i en plate i
regnearkformat. Visningen gir muligheten til å vise, importere og eksportere brønndata som beskrevet
nedenfor.

Bruke regnearkvisningen til å eksportere og importere platedata

Fra regnearkvisningen kan du eksportere målnavn, prøvenavn, biologisk gruppenavn og brønnnotater
som en mal i et tabulatordelt format til et program somMicrosoft Excel. Du kan også importere disse
dataene fra et tabulatordelt program til en forhåndsdefinert plate fra en eksperimentinformasjonsfil.

Slik bruker du verktøyet Spreadsheet View/Importer (Regnearkvisning/-import)

1. Opprett og lagre en platefil (se Opprette en platefil ved hjelp av Plate Editor (Plateredigering)).

2. På verktøylinjen i Plate Editor (Plateredigering) klikker du på fanen Spreadsheet View/Importer
(Regnearkvisning/-import) for å åpne dialogboksen Plate Spreadsheet View (Visning av
plateregneark).

3. (Valgfritt) Klikk på boksene Show Biological Set Name og ShowWell Note (Vis biologisk settnavn og
Vis brønnnotat) for å vise disse kolonnene i regnearkvisningen og i den eksporterte filen.

4. Klikk på Export Template (Eksporter mal) for å opprette en tommal i en Excel-fil (.csv-format). Den
eksporterte filen vil vise samme layout som platen din.

Tips: Bruk platefilnavnet når du lagrer platefilene dine for å enkelt identifisere filen.

5. Fyll ut cellene i Excel-filen med brønninnholdet.
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Merknad: Du kan bare redigere innholdet i en celle i en kolonne som har en stjerne (*) ved siden
av kolonnenavnet (*Target Name, *Sample Name, *Biological Group Name, *Well Note
(*Målnavn, *Prøvenavn, *Biologisk gruppenavn, *Brønnmerknad).

Merknad: Du kan ikke legge til verdier i kolonnene Standard Curve og Quantity (Standardkurve
og Kvantitet) i den eksporterte Excel-filen. For å endre disse dataene, gå tilbake til Plate Editor
og velg Settings > Units (Innstillinger > Enheter) i menylinjen. Når platekjøringen er fullført, vises
dataene fra disse standardene i diagrammet Standard Curve (Standardkurve) i fanen
Quantification (Kvantifisering) i vinduet Data Analysis (Dataanalyse) med enhetene du har valgt.

6. Importer den utfylte Excel-filen tilbake til Plate Editor ved å klikke på Import-knappen. De importerte
platedataene vises i Plate Spreadsheet View-vinduet (Platearkvisning).

Viktig: Hvis du har flere fluoroforer, må du utføre trinn 3–5 for hver fluorofor ved å bruke
rullegardinmenyen Flours List i platearkvisningen.

7. Klikk på OK-knappen. De nye platedataene vises nå i Plate Editor-vinduet.

Tips: Du kan se menyelementer som er tilgjengelige i regnearkvisningen/importeringsverktøyet når
du høyreklikker på en brønn i verktøyet eller på en av tabelloverskriftene i platearkvisningen.
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Opprette et plateoppsett ved hjelp av Setup Wizard
(Oppsettsveiviser) for plater

Du kan bruke Setup Wizard (Oppsettsveiviser) til å angi plateoppsettinformasjonen som er påkrevd for
analyse av normalisert genuttrykk, inkludert:

n Målnavn

n Prøvenavn

n Plassering av mål og prøve på platen

n Referansegen(er)

n Kontrollprøve

Du kan bruke Setup Wizard (Oppsettsveiviser) før, under eller etter en kjøring.

Bruke Setup Wizard (Oppsettsveiviser) for plater
Dette avsnittet forklarer hvordan du oppretter et plateoppsett ved bruk av Setup Wizard
(Oppsettsveiviser) for plater. For enklere visning av innholdet i hver brønn i platen kan du klikke på Zoom
Plate (Zoom inn plate) øverst i Setup Wizard (Oppsettsveiviser).

Viktig: Plateoppsettet tilbakestilles hvis du går tilbake til fanen Auto layout (Auto-oppsett) mens du
befinner deg i en annen fane i Setup Wizard (Oppsettsveiviser). Utvis forsiktighet når du velger
denne fanen.

Tips: Du kan tilbakestille oppsettet ved å velge Tools > Clear Plate (Verktøy > Tøm plate) i Setup
Wizard (Oppsettsveiviser).

Slik bruker du Setup Wizard (Oppsettsveiviser) for plater

1. Åpne Plate Editor (Plateredigering).

2. Gjør ett av følgende for å åpne oppsettsveiviseren:

n Velg Editing Tools > Setup Wizard (Verktøy > Oppsettsveiviser).

n Klikk på Setup Wizard (Oppsettsveiviser) på verktøylinjen i Plate Editor (Plateredigering).

Setup Wizard (Oppsettsveiviser) åpnes og viser fanen Auto layout (Auto-oppsett).

Brukerhåndbok | 157



Kapittel 8 Klargjøre plater

3. I fanen Auto layout (Auto-oppsett) gjør du følgende:

a. Klikk på en brønn i rutenettet og dra den på tvers og ned for å angi det området på platen du skal
fylle i en prøve.

b. Angi antall mål og prøver som skal fylles i.

Tips: Antall mål og prøver må tilsvare antall valgte celler. Hvis det angitte antallet ikke
passer i det valgte området, må du endre antallet eller utvalgsområdet på platen. Du kan
angi retningen på elementene på platen og på elementenes gruppering.

c. (Valgfritt) Endre plateretningen. Du kan for eksempel angi mål i kolonner og prøver i rader, eller
gruppere etter prøver.

d. Klikk på Next (Neste) for å fortsette til fanen Target names (Målnavn).

Merknad: Hvis plateoppsettet ikke har et jevnt mønster, bruker du fanen Target names
(Målnavn) til manuelt å plassere målene eller fanen Sample names (Prøvenavn) til manuelt å
plassere prøvene, på platen. Klikk og dra for å velge flere brønner.

4. Angi målnavn for målgruppene i fanen Target names (Målnavn):

a. Gjør ett av følgende:

n Angi Select by (Velg etter) til Target (Mål) for å gi målene nytt navn etter gruppe.

n Angi Select by (Velg etter) til Well (Brønn) for å gi målene nytt navn etter brønn.
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b. Velg en målgruppe eller brønn i rutenettet, og skriv inn et navn i rullegardinmenyen Target name
(Målnavn).

Tips: Trykk på tabulatortasten for å velge neste gruppe eller brønn mot høyre, eller trykk på
Enter for å velge neste gruppe eller brønn under. I fanene Target name (Målnavn) og
Sample name (Målnavn) kan du også velge flere ikke-tilstøtende brønner ved å holde inne
Ctrl-tasten på tastaturet og klikke på de brønnene du ønsker.

c. Klikk på Next (Neste) for å fortsette til fanen Sample names (Prøvenavn).

5. Angi prøvenavn for prøvegruppene i fanen Sample names (Prøvenavn).

6. Klikk på Next (Neste) for å fortsette til fanen Reference targets (Referansemål).

7. I fanen Reference targets (Referansemål) velger du ett eller flere mål som skal brukes som
referanser for normalisert genuttrykk. Klikk på Next (Neste) for å gå videre til fanen Control Sample
(Kontrollprøve).

8. I fanen Control sample (Kontrollprøve) velger du én prøve som skal brukes som en kontroll for
beregninger av relativt genuttrykk.

9. Klikk på OK for å lagre plateoppsettet og gå tilbake til Plate Editor (Plateredigering), der du kan angi
flere plateparametere. Se Tilordne valgfrie parametere til platefilen på side 137 for mer informasjon.

Du kan også klikke på Previous (Forrige) for å gå tilbake til en tidligere fane for å gjøre ønskede
endringer.

Merknad: Platen tilbakestilles hvis du går tilbake til fanen Auto layout (Auto-oppsett). Utvis
forsiktighet når du klikker på Previous (Forrige).
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Kapittel 9 Kjøre eksperimenter
Dette kapittelet forklarer hvordan du kjører egendefinerte (brukerdefinerte) eller PrimePCR analyseforsøk
ved hjelp av CFX Maestro Dx-programvare, Security Edition.

En kjøredatafil inneholder protokollen og plateinformasjonen for kjøringen. Filen inneholder også dataene
fra analysene som CFX Maestro Dx SE utfører når kjøringen er fullført.

CFX Maestro Dx SE gjør det lett å sette opp og kjøre brukerdefinerte eller PrimePCR-eksperimenter.
Vinduet Run Setup (Kjøringsoppsett) veileder deg gjennom de vanlige trinnene for å sette opp et
eksperiment, hvilket tar deg til dialogboksen Start Run (Start kjøring), der du starter kjøringen.
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Vinduet Run Setup (Kjøringsoppsett)
Vinduet Run Setup (Kjøringsoppsett) gir rask tilgang til filene og innstillingene som kreves for å sette opp
og kjøre et eksperiment. Når du velger å kjøre et brukerdefinert eksperiment, åpnes vinduet Run Setup
(Kjøringsoppsett) og viser fanen Protocol (Protokoll). Når du velger å kjøre et PrimePCR-eksperiment,
åpnes vinduet Run Setup (Kjøringsoppsett) og viser fanen Start Run (Start kjøring).

Tips: Se Utføre PrimePCR-eksperimenter på side 179 for informasjon om PrimePCR; se Fanen
Start Run (Start kjøring) på side 169 for informasjon om fanen Start Run (Start kjøring).
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1. Faner som gir deg veiledning under oppsett og kjøring av eksperimenter:

n Fanen Protocol (Protokoll) – velg en eksisterende protokoll du vil kjøre eller
redigere, eller opprett en ny protokoll i Protocol Editor (Protokollredigering).

n Fanen Plate – velg en eksisterende plate du vil kjøre eller redigere, eller opprett
en ny plate i Plate Editor (Plateredigering).

n Fanen Start Run (Start kjøring) – vis eksperimentinnstillinger, velg én eller flere
instrumentblokker og start kjøringen.

2. Hovedvinduet viser alternativene for hver fane etter hvert som du bruker dem.

3. Navigeringsknapper fører deg til fanen Start Run (Start kjøring).

FORKLARING

Åpne vinduet Run Setup (Kjøringsoppsett)
Slik åpner du kjøringsoppsettvinduet

u Gjør ett av følgende:

n I fanen Run setup (Kjøringsoppsett) i Startup Wizard (Oppstartsveiviser) klikker du på enten
User-defined (Brukerdefinert) eller PrimePCR .

n På verktøylinjen i startvinduet klikker du på enten User-defined Run Setup (Brukerdefinert
kjøringsoppsett) eller PrimePCR Run Setup (PrimePCR-kjøringsoppsett).

n I startvinduet klikker du på Run > User-defined Run (Kjør > Brukerdefinert kjøring) eller Run >
PrimePCR Run (Kjør > PrimePCR-kjøring).
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Fanen Protocol (Protokoll)
Fanen Protocol (Protokoll) viser en forhåndsvisning av protokollfilen du ønsker å kjøre. En protokollfil
inneholder instruksjoner for trinnene for instrumenttemperatur samt instrumentalternativer som
kontrollerer rampehastigheten, prøvevolumet og lokktemperaturen.

Som standard viser programvaren protokollen som er definert i File Selection (Filutvalg) for delen Run
Setup (Kjøringsoppsett) i fanen Files (Filer) i dialogboksen User > User Preferences (Bruker >
Brukerpreferanser). Du kan endre standardprotokollen i dialogboksen User Preferences
(Brukerpreferanser). Se Endre standard filinnstillinger på side 83 for mer informasjon.

I fanen Protocol (Protokoll) kan du

n opprette en ny protokoll som skal kjøres

n velge en eksisterende protokoll som skal kjøres eller redigeres

Se Kapittel 7, Opprette protokoller for mer informasjon om hvordan du oppretter og modifiserer
protokoller.

Slik oppretter du en ny protokoll

1. Klikk på Create New (Opprett ny) i fanen Protocol (Protokoll).

Protocol Editor (Protokollredigering) åpnes.
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2. Bruk Protocol Editor (Protokollredigering) til å opprette en ny protokoll.

3. Klikk på OK for å lagre protokollen og gå tilbake til fanen Protocol (Protokoll) i Run Setup
(Kjøringsoppsett).

4. Vis protokollinformasjonen, og velg én av følgende fremgangsmåter:

n Hvis informasjonen er riktig, velger du Next (Neste) for å fortsette til fanen Plate.

n Hvis informasjonen er feil, velger du Edit Selected (Rediger valgt) for å gå tilbake til vinduet
Protocol Editor (Protokollredigering). Gjør redigeringer i protokollen, lagre endringene og klikk
deretter på Next (Neste) i fanen Protocol (Protokoll) for å fortsette til fanen Plate.

Slik velger du en eksisterende protokoll

1. I fanen Protocol (Protokoll) velger du én av følgende fremgangsmåter:

n Klikk på Select Existing (Velg eksisterende), og naviger til en eksisterende protokoll.

n Klikk på Express Load (Hurtigfylling), og velg en protokoll fra rullegardinmenyen over protokoller.

Tips: Du kan legge til eller fjerne protokoller fra rullegardinmenyen Express Load
(Hurtigfylling). Se Legge til og fjerne protokoller for hurtiginnlasting for mer informasjon.

2. Vis protokollinformasjonen, og velg én av følgende fremgangsmåter:

n Hvis informasjonen er riktig, velger du Next (Neste) for å fortsette til fanen Plate.

n Hvis informasjonen er feil, velger du Edit Selected (Rediger valgt) for å åpne Protocol Editor
(Protokollredigering). Gjør redigeringer i protokollen, lagre endringene og klikk deretter på Next
(Neste) i fanen Protocol (Protokoll) for å fortsette til fanen Plate.

Legge til og fjerne protokoller for hurtiginnlasting

Du kan endre innholdet i rullegardinmenyen Express Load (Hurtiginnlasting) som vises i Protocol Editor
(Protokollredigering). Protokollene i denne menyen er lagret i følgende mappe:

c:\Users\Public\Public Documents\Bio-Rad\CFX_MDx\Users\<user_name>\ExpressLoad\

Slik endrer du menyen Express Load (Hurtiginnlasting) for protokoller

1. Naviger til mappen ExpressLoad (Hurtiginnlasting), og åpne den.

2. Gå gjennom protokollfilene (.pcrl) i mappen.

3. Gjør ett av følgende:

n Slett protokoller fra mappen for å fjerne dem fra rullegardinmenyen.

n Kopier protokoller til mappen for å legge dem til i rullegardinmenyen.
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Fanen Plate
Merknad: Hvis den valgte protokollen i fanen Protocol (Protokoll) ikke inkluderer et
plateavlesningstrinn for sanntids PCR-analyse, vil fanen Plate være skjult. For å vise fanen Plate må
du legge til minst én plateavlesning i protokollen.

Fanen Plate viser en forhåndsvisning av platefilen du har tenkt å laste inn. I en sanntids PCR-kjøring
inneholder platefilen en beskrivelse av innholdet i hver brønn inkludert fluoroforer, skannemodus og
platetype. CFX Maestro Dx SE bruker disse beskrivelsene for datainnsamling og analyse.

Som standard viser programvaren platen definert i delen File Selection for Run Setup (Filvalg for
kjøringsoppsett) i fanen Files (Filer) i dialogboksen User > User Preferences (Bruker >
Brukerpreferanser). Du kan endre standardplaten i dialogboksen User Preferences (Brukerpreferanser).
Se Endre standard filinnstillinger på side 83 for mer informasjon.

I fanen Plate kan du

n Opprette en ny plate som skal lastes inn

n Velge en eksisterende plate som skal lastes inn eller redigeres

Hvis du vil ha mer informasjon om hvordan du oppretter og endrer plater, se Kapittel 8, Klargjøre plater.
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Slik oppretter du en ny plate

1. Klikk på Create New (Opprett ny) i fanen Plate.

Plate Editor (Plateredigering) vises.

2. Bruk Plate Editor (Plateredigering) til å opprette en ny plate.

3. Klikk på OK for å lagre platen og gå tilbake til fanen Plate i Run Setup (Kjøringsoppsett).

4. Vis detaljene om platen og velg én av følgende fremgangsmåter:

n Hvis detaljene er riktige, klikker du på Next (Neste) for å gå videre til fanen Start Run (Start
kjøring).

n Hvis detaljene ikke er riktige, klikker du på Edit Selected (Rediger valgte) for å gå tilbake til Plate
Editor (Plateredigering). Revider platefilen, lagre endringer og klikk deretter på Next (Neste) i
fanen Plate for å gå videre til fanen Start Run (Start kjøring).

Slike velger du en eksisterende plate

1. Velg én av følgende fremgangsmåter i fanen Plate:

n Klikk på Select Existing (Velg eksisterende) og naviger til en eksisterende platefil.

n Klikk på Express Load (Hurtiginnlasting) og velg en platefil fra rullegardinmenyen.

Tips: Du kan legge til plater i eller fjerne dem fra rullegardinmenyen Express Load
(Hurtiginnlasting). Se Legge til og fjerne platefiler for hurtiginnlasting for mer informasjon.

2. Vis detaljene om platen og velg én av følgende fremgangsmåter:

n Hvis detaljene er riktige, klikker du på Next (Neste) for å gå videre til fanen Start Run (Start
kjøring).

n Hvis detaljene ikke er riktige, klikker du på Edit Selected (Rediger valgte) for å åpne Plate Editor
(Plateredigering). Endre platefilen, lagre endringer og klikk deretter på Next (Neste) for å gå videre
til fanen Start Run (Start kjøring).

Legge til og fjerne platefiler for hurtiginnlasting

Du kan endre innholdet i rullegardinmenyen Express Load (Hurtiginnlasting), som vises i Plate Editor
(Plateredigering). Platene som vises i denne listen, er lagret i følgende mappe:

c:\Users\Public\Documents\Bio-Rad\CFX_MDx\Users\<user_name>\ExpressLoad\

Slik modifiserer du listen over platefiler i Express Load (Hurtiginnlasting)

1. Naviger til mappen ExpressLoad (Hurtiginnlasting), og åpne den.

2. Se gjennom platefilene (.pltd) i mappen.

3. Gjør ett av følgende:

Brukerhåndbok | 167



Kapittel 9 Kjøre eksperimenter

n Slett platefilene fra mappen for å fjerne dem fra rullegardinmenyen.

n Kopier platefilene til mappen for å legge dem til i rullegardinmenyen.
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Fanen Start Run (Start kjøring)
Fanen Start Run (Start kjøring) viser informasjon om eksperimentet som skal kjøres. Den viser også den
tilkoblede instrumentblokken eller blokker du kan kjøre eksperimentet på.

I fanen Start Run (Start kjøring) kan du gjøre følgende:

n vise detaljert kjøringsinformasjon, inkludert valgt protokollfil, platefil og skannemodus

n legge til merknader om kjøringen

n vise informasjon om alle tilkoblede instrumenter, inkludert kjøringsstatus (kjører eller inaktiv),
prøvevolum i µl, lokktemperatur, emuleringsmodus samt eventuell ID og strekkode.

Merknad: Du kan modifisere kolonnene som vises i Start Run (Start kjøring) i tabellen Selected
Blocks (Valgte blokker). Se Endre detaljer i tabellen for valgte blokker på side 170 for
informasjon.

n Velg blokken eller blokkene du vil utføre kjøringen på.

n Fjern-åpne eller -lukke lokket på hvert valgte instrument.

n Start kjøringen.
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Endre detaljer i tabellen for valgte blokker

Du kan endre kolonnene som vises i tabellen Start Run on Selected Block(s) (Start kjøring på valgte
blokker). Du kan også endre verdiene for standard prøvevolum og lokktemperatur i tabellen.
Innstillingsendringene brukes på kjøringen som skal utføres.

Slik legger du til kolonner i tabellen Start Run on Selected Blocks (Start kjøring på valgte
blokker)

u Høyreklikk i tabellen og velg et alternativ i menyen som vises.

Slik fjerner du kolonner i tabellen Start Run on Selected Blocks (Start kjøring på valgte
blokker)

u Høyreklikk i tabellen og deaktiver alternativet i menyen som vises.

Slik redigerer du verdier for prøvevolum eller lokktemperatur for en blokk

u Velg prøvevolum- eller lokktemperaturcellen for målblokken og skriv inn en ny verdi i cellen.

Slik legger du til en kjørings-ID eller strekkode for en blokk

u Velg ID-/strekkodecellen for målblokken og skriv inn en ID eller skann blokken med en
strekkodeleser.

Kjøre et eksperiment
Viktig: Før du kjører et eksperiment, må du se til at datamaskinens antivirusprogram ikke kommer til
å starte en skanning under kjøringen. Se Installere CFX Maestro Dx SE-programvaren på side 33 og
systemadministratoren for mer informasjon.

Slik kjører du et eksperiment

1. I fanen Start Run (Start kjøring) bekrefter du plate- og protokolldetaljene i delen Run Information
(Kjøringsinformasjon).

2. (Valgfritt) Legg til merknader om kjøringen eller eksperimentet i tekstboksen Notes (Merknader).

3. Merk avmerkingsboksen for én eller flere blokker som kjøringen skal utføres på.

Tips: Hvis du vil kjøre eksperimentet på alle blokker, velger du Select All Blocks (Velg alle
blokker) under tabellen Selected Blocks (Valgte blokker).

4. (Valgfritt) Klikk på Flash Block Indicator (Blokkindikatorlampe) for å få indikatorlampen på de valgte
instrumentblokkene til å blinke.

5. Sett eksperimentplater inn i blokken:
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a. Klikk på Open Lid (Åpne lokk). Det motoriserte lokket for hver valgte blokk åpnes.

b. Sett en eksperimentplate inn i hver valgte blokk.

c. Klikk på Close Lid (Lukk lokk).

Tips: På CFX Opus Dx-system, trykk på Open Lid (Åpne lokk) eller Close Lid (Lukk lokk) på
startskjermen.

6. Klikk på Open Lid (Åpne lokk) og Close Lid (Lukk lokk) for å åpne og lukke det motoriserte lokket for
hver valgte instrumentblokk.

7. Vis detaljene om kjøringen og gjør ett av følgende:

n Hvis detaljene er riktige, klikker du på Start Run (Start kjøring).

n Hvis detaljene ikke er riktige:

o Korriger detaljene i tabellen Selected Blocks (Valgte blokker) og klikk på Start Run (Start
kjøring).

o Returner til den korrigerte fanen og foreta relevante endringer, lagre endringene, og klikk
deretter på Next (Neste) for å returnere til fanen Start Run (Start kjøring) og starte kjøringen.

Slik starter du en ny kjøring fra en tidligere kjøring

u Gjør ett av følgende:

n Velg File > Repeat a Run (Fil > Gjenta en kjøring) i programvarens hovedmenylinje, naviger til og
dobbeltklikk på kjøredatafilen som du ønsker å gjenta.

n Velg fanen Repeat Run (Gjenta kjøring) i Startup Wizard (Oppstartsveiviser) og dobbeltklikk på
kjøredatafilen for kjøringen som du ønsker å gjenta.

(Valgfritt) Klikk på Browse (Bla) på fanen Repeat Run (Gjenta kjøring) og dobbeltklikk på
kjøredatafilen som du ønsker å gjenta.
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Dialogboksen Run Details (Kjøringsdetaljer)
Når du klikker på Start Run (Start kjøring), ber CFX Maestro Dx SE deg om å lagre datafilen (.pcrd),
starter kjøringen og åpner dialogboksen Run Details (Kjøringsdetaljer). Dialogboksen Run Details
(Kjøringsdetaljer) består av tre statusfaner:

n Run Status (Kjøringsstatus) – bruk denne fanen for å vise gjeldende status for protokollen, åpne
eller lukke lokket, sette en kjøring på pause, legge til gjentakelser, hoppe over trinn eller stanse
kjøringen.

n Real-time Status (Sanntidsstatus) – bruk denne fanen for å vise PCR-fluorescensdata i sanntid etter
hvert som de samles inn.

n Time Status (Tidsstatus) – bruk denne fanen for å vise en nedteller i fullskjerm for protokollen.

Disse fanene forklares i detalj i de neste avsnittene.

Fanen Run Status (Kjøringsstatus)
Fanen Run Status (Kjøringsstatus) viser gjeldende status for en kjøring som pågår. I denne visningen kan
du også kontrollere lokket og endre kjøringen som pågår.
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1. Ruten Run Status (Kjøringsstatus) – viser gjeldende fremdrift for protokollen.

2. Kontroller for Run Status (Kjøringsstatus) – brukes til å betjene instrumentet eller
avbryte den gjeldende protokollen.

3. Ruten Run Information (Kjøringsinformasjon) – viser kjøringsdetaljer.

FORKLARING

Kommandoer i Run Status (Kjøringsstatus)

Kommandoene i fanen Run Status (Kjøringsstatus) brukes til enten å betjene instrumentet via
programvaren eller endre en kjøring som pågår.

Merknad: Endringer i protokollen under kjøringen, for eksempel tilføyelse av repetisjoner, endrer
ikke protokollfilen som er knyttet til kjøringen. Disse handlingene registreres i Run Log (Kjøringslogg).

– åpner det motoriserte lokket på valgte instrumenter.

Viktig: Hvis lokket åpnes under en kjøring, settes kjøringen på pause i det aktuelle trinnet, og
dataene kan bli påvirket. Kommandoer i Run Status (Kjøringsstatus) på side 173.

– lukker det motoriserte lokket på valgte instrumenter.

– legger til flere repetisjoner i det aktuelle GOTO-trinnet i protokollen. Dette alternativet er kun
tilgjengelig når et GOTO-trinn kjører.

Merknad: Du kan legge til flere repetisjoner mens du er i en GOTO-syklus når protokollen
pågår. CFX Maestro Dx SE gjenkjenner imidlertid den siste endringen i antall repetisjoner. For
eksempel, hvis du legger til 10 ekstra repetisjoner mens du er i en GOTO-syklus, vil
programvaren endre det totale antallet til n + 10. Hvis du deretter legger til ytterligere fem (5)
repetisjoner mens du er i samme syklus, vil CFX Maestro endre det totale antallet repetisjoner til
n + 5. Den første endringen (10 repetisjoner) blir ignorert. For å sikre at programvaren utfører
målantallet repetisjoner, skriv inn totalt antall (i dette tilfellet 15 gjentakelser).

– hopper over det gjeldende trinnet i protokollen.

Merknad: Hvis du hopper over et trinn under et GOTO-trinn, hopper systemet til neste syklus i
GOTO-sløyfen. Hvis GOTO-trinnets siste syklus var i gang på tidspunktet når det ble hoppet
over, hopper systemet over til neste trinn.
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– gjør at LED-en på det valgte instrumentet blinker for å identifisere de valgte blokkene.

– setter protokollen på pause.

Merknad: Denne handlingen registreres i Run Log (Kjøringslogg).

– gjenopptar en protokoll som er satt på pause.

– stopper kjøringen før protokollene avsluttes.

Merknad: Hvis en kjøring stoppes før protokollen avsluttes, kan det påvirke dataene.

Åpne instrumentlokket under en PCR-kjøring

Hvis lokket til et instrument åpnes under en PCR-kjøring, vil CFX Maestro Dx SE vise følgende
dialogboks:

Mens dialogboksen vises, fortsetter instrumentene å kjøre protokollen. OK-knappen stanser kjøringen og
instrumentlokket løsner og åpnes. Avbryt-knappen lukker dialogen og fortsetter kjøringen.
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Fanen Real-time Status (Sanntidsstatus)
Fanen Real-time Status (Sanntidsstatus) viser PCR-data i sanntid som er samlet inn i hver syklus under
kjøringen etter de to første plateavlesningene.

1. Amplification (Amplifisering)-kurverute – viser amplifiseringsdata i sanntid under
kjøringen.

2. Well group (Brønngruppe)-identifikator – hvis brønngrupper ble identifisert i
plateoppsettet, kan brukere velge en spesifikk brønngruppe for å vise dens kurver,
brønner og tabellinformasjon.

Step number (Trinnummer)-identifikator – hvis protokollen samler inn data i mer enn
ett trinn (for eksempel under amplifisering og smeltekurve), kan brukere velge et
spesifikt trinn og vise kurvene som ble samlet inn i dette trinnet.

3. Well selector (Brønnvelger)-rute – viser de aktive, inaktive og tomme brønnene i
platen.

4. Plate setup (Plateoppsett)-tabellrute – viser plateoppsettet i tabellformat.

FORKLARING
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5. Run details (Kjøringsdetaljer)-rute – viser sanntidsstatus for kjøringen, inkludert:

n gjeldende trinn

n gjeldende gjentakelse

n gjeldende temperatur

n gjenværende tid

n prøvetemperatur

n Lokktemperatur

6. Plate Setup (Plateoppsett) – åpner dialogboksen Plate Setup (Plateoppsett), der
brukere kan endre det gjeldende plateoppsettet under en kjøring.

I fanen Real-time Status (Sanntidsstatus) kan du

n vise eller skjule sanntidskurver ved å velge dem i brønnvelger-ruten eller plateoppsett-tabellen

n vise enkle kurver eller kurvegrupper ved å velge dem i brønngruppe-rullegardinmenyen

n redigere platen eller erstatte platefilen

n bruke en PrimePCR-fil til kjøringen

Vise eller skjule sanntidskurver

Alle fylte brønner er aktive og vises i plateoppsettabellen som standard. Aktive brønner vises i blått i
brønnvelgerruten. Skjulte brønner vises i lysegrått, og ubrukte brønner vises i mørkegrått i
brønnvelgerruten.

Du kan skjule spor fra aktive brønner under kjøringen. CFX Maestro Dx SE fortsetter å samle inn data for
alle brønner, når du skjuler brønner, vises ikke dataene deres i tabellen for plateoppsett.

Slik skjuler du sanntidskurver

u I brønnvelgerruten klikker du på de aktive (blå) brønnene du ønsker å skjule.

Slik viser du sanntidskurver

u I brønnvelgerruten klikker du på de skjulte (lysegrå) brønnene du ønsker å vise.

Hvis du vil ha mer informasjon om brønnvelgeren, se Brønnvelger på side 195.
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Redigere et plateoppsett

Slik redigerer du et plateoppsett

u Klikk på Plate Setup (Plateoppsett) og velg deretter View/Edit Plate (Vis/rediger plate).

Vinduet Plate Editor (Plateredigering) vises, der du kan redigere platen mens kjøringen pågår. Hvis
du vil ha mer informasjon om hvordan du redigerer plater, se Kapittel 8, Klargjøre plater.

Merknad: Du kan også redigere kurvestiler fra vinduet Plate Editor (Plateredigering). Endringer
vises i amplifiseringskurvediagrammet i fanen Real-Time Status (Sanntidsstatus).

Erstatte en platefil

Tips: Det kan være nyttig å erstatte en platefil hvis du starter en kjøring med en hurtigplatefil i
ExpressLoad-mappen.

Slik erstatter du en platefil

u Klikk på Plate Setup (Plateoppsett) og velg deretter ett av de følgende alternativene:

n Replace Plate file (Erstatt platefil) – velg den nye platefilen fra listen i filleservinduet

n Apply PrimePCR file (Bruk PrimePCR-fil) – søk etter en kjøringsfil som plateoppsettet skal
hentes fra, ved hjelp av Smart-søk, eller klikk på Browse (Bla gjennom) for å finne en fil som du
lastet ned fra Bio-Rad-nettstedet og som ikke finnes i PrimePCR-mappen

Merknad: CFX Maestro Dx SE kontrollerer skannemodusen og platestørrelsen for platefilen.
Disse må være de samme som kjøringsinnstillingene som kjøringen ble startet med.
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Fanen Time Status (Tidsstatus)
Fanen Time Status (Tidsstatus) viser tiden som gjenstår før den aktuelle kjøringen er fullført.
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Utføre PrimePCR-eksperimenter
PrimePCR-eksperimenter bruker pathway- eller sykdomsspesifikke analyser som Bio-Rad har våtlab-
validert og -optimert, og er tilgjengelig i følgende formater:

n Forhåndsplatede paneler – plater som inneholder analyser som er spesifikke for en biologisk
pathway eller sykdom; inkluderer PrimePCR-kontroller og referansegener.

n Egenkonfigurerte plater – plater som kan settes opp i et brukerkonfigurert oppsett, med alternativ for
å velge analyser for interessemål, kontroller og referanser.

n Individuelle analyser – rør som inneholder individuelle primersett for bruk i sanntidsreaksjoner.

For å redusere total kjøringstid kan du fjerne smeltetrinnet i protokollen. Bio-Rad anbefaler på det
sterkeste at du ikke endrer noe annet i en PrimePCR-kjøringsprotokoll. Standardprotokollen er den som
ble brukt for analysevalidering. Avvik fra denne kan påvirke resultatene. Protokollendringer føres opp i
fanen Run Information (Kjøringsinformasjon) for den resulterende datafilen og i eventuelle rapporter som
opprettes.

Slik starter du en PrimePCR-kjøring

u Gjør ett av følgende for å starte en PrimePCR-kjøring:

n I Startup Wizard (Oppstartsveiviser) velger du PrimePCR i fanen Run setup (Kjøringsoppsett),
og deretter velger du egnet kjemi (SYBER® eller probe).

n Velg en PrimePCR-kjøring på listen Recent Runs (Nylige kjøringer) i fanen Repeat run (Gjenta
kjøring) i Startup Wizard (Oppstartsveiviser).

n Velg File > Open > PrimePCR Run File (Fil > Åpne > PrimePCR-kjøringsfil) i startvinduet.

n Dra og slipp en PrimePCR-kjøringsfil i startvinduet.

Etter at du velger en PrimePCR-kjøring, åpnes vinduet Run Setup (Kjøringsoppsett) og viser fanen Start
Run (Start kjøring) med standard PrimePCR-plateoppsett basert på valgt instrument.

Slik fjerner du smeltetrinnet i protokollen

u I fanen Protocol (Protokoll) fjerner du haken i avmerkingsboksen ved siden av Include Melt Step
(Inkluder smeltetrinn).
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Slik importerer du målinformasjon for PrimePCR-plater til et plateoppsett

1. Gjør ett av følgende:

n I fanen Real-time Status (Sanntidsstatus) i dialogboksen Run Details (Kjøringsdetaljer) velger du
Plate Setup > Apply PrimePCR File (Plateoppsett > Bruk PrimePCR-fil).

n I vinduet Data Analysis (Dataanalyse) velger du Plate Setup > Apply PrimePCR File
(Plateoppsett > Bruk PrimePCR-fil).

2. I dialogboksen PrimePCR run file (PrimePCR-kjøringsfil) klikker du på Browse (Bla gjennom) for å
navigere til riktig PrimePCR-fil (.csv).

3. Velg ønsket PrimePCR-fil og klikk på Open (Åpne).

CFX Opus Dx-system importerer målinformasjonen til plateoppsettet.
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Overføre stand-alone-data for analyse
Viktig: Når du overfører datafiler fra CFX Opus Dx-system til CFX Maestro Dx SE, overføres alle
filene som er lagret på systemet. Kontroller at du har nok diskplass for å sikre trygg overføring av
dataene.

Når kjøringen er fullført, analyserer CFX Maestro Dx SE fluorescensdata. Hvis kjøringen utføres i stand-
alone-modus og lagres på selve CFX Opus Dx-system, må dataene bli overført til CFX Maestro Dx SE-
datamaskinen for analyse.

CFX Opus Dx-system kan lagre opptil 100 PCR-sanntidskjøringer. Når kjøringen er fullført, kan du
overføre stand-alone-datafiler til CFX Maestro Dx SE-datamaskinen via e-post, USB-enhet eller via selve
programvaren.

Dette avsnittet forklarer hvordan man overfører stand-alone-datafiler til CFX Maestro Dx SE-
datamaskinen.

Overføre data via e-post
Slik sender du en datafil med e-post etter endt kjøring

1. Sett opp e-postvarsling for instrumentet.

Se Sette opp e-postvarsling på side 79 eller CFX Opus Dx PCR-sanntidssystem brukerhåndbok.

2. Når du setter opp e-postvarsling, må du kontrollere at Attach Data File (Legg ved datafil) er valgt.

Kjøredataene sendes via-epost som en .pcrd-fil.

Overføring av data fra CFX Opus Dx PCR-sanntidssystem
Ved hjelp av filutforskeren CFX Opus Dx-system, kan du overføre datafiler til en tilkoblet USB-enhet eller
til en delt nettverksmappe. Du kan også overføre CFX Maestro Dx SE-protokollfiler fra en USB-stasjon
eller delt nettverksstasjon til mappen eller den offentlige mappen på CFX Opus Dx-system, og kjøre dem
på CFX Opus Dx-system.

Tips: Denne delen forklarer hvordan du overfører data. For informasjon om hvordan du konfigurerer
en kablet tilkoblingkan du se CFX Opus Dx PCR-sanntidssystem brukerveiledningen som er
tilgjengelig i CFX Maestro Dx SE Hjelp-menyen.

1. Trykk på Files (Filer) i startbildet til CFX Opus Dx-system for å åpne filutforskeren.

2. I filutforskeren navigerer du til filen du vil kopiere, og trykker deretter på filen for å se fildetaljer.

3. Trykk på Options (Alternativer) i fildetaljer og deretter på Copy (Kopier).
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Dialogboksen Select Location (Velg plassering) vises.

4. Gjør ett av følgende i dialogboksen Select Location (Velg plassering):

n Naviger til en eksisterende mappe.

n Naviger til banen for å opprette en mappe der filen skal lagres, og trykk deretter på Create Folder
(Opprett mappe)

( ) for å opprette en ny mappe der.

5. Trykk på Select (Velg) for å kopiere filen til den valgte lokasjonen eller Cancel (Avbryt) for å gå tilbake
til filutforskeren.

Merknad: Hvis det finnes en fil med samme navn på den valgte lokasjonen, vises en melding.
Trykk på Yes (Ja) for å overskrive den eksisterende filen eller No (Nei) for å gå tilbake til
filutforskeren.

CFX Opus Dx-system viser en bekreftelsesmelding når filen er kopiert.
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Overføring av data gjennom CFX Maestro Dx-programvare,
Security Edition
Overføre data gjennom CFX Maestro Dx SE

1. I ruten Detected Instruments (Detekterte instrumenter) i startvinduet høyreklikker du på ønsket
instrument og velger Retrieve Data Files (Hent datafiler).

CFX Maestro Dx SE viser dialogboksen Browse For Folder (Søk etter mappe).

2. I dialogboksen Browse For Folder (Søk etter mappe) blar du til stedet hvor du vil lagre datafilene, og
klikker på OK.

Overføringsprosessen oppretter en mappe kalt Real-Time Data (Sanntidsdata) på det valgte stedet.
Kjøredataene lagres i mappen Real-Time Data (Sanntidsdata) som separate .zpcr-filer.

Overføre data ved bruk av en USB-stasjon
Hvis du setter en USB-stasjon inn i USB-porten på instrumentet, lagres datafilen automatisk i
rotkatalogen på USB-stasjonen når kjøringen er fullført. Du kan også finne datafiler som har blitt lagret
tidligere, og lagre dem på en tilkoblet USB-stasjon.

Overføre datafiler til en USB-stasjon på CFX Opus Dx-system

u I dialogboksen Select Location (Velg plassering) klikker du på USB og navigerer til målmappen der
du vil kopiere filen eller Cancel (Avbryt) for å gå tilbake til filutforskeren.

Merknad: Hvis det finnes en fil med samme navn på den valgte lokasjonen, vises en dialogboks.
Trykk på Yes (Ja) for å overskrive den eksisterende filen eller No (Nei) for å gå tilbake til
filutforskeren.

CFX Opus Dx-system viser en bekreftelsesmelding når filen er kopiert.
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Overføring av data gjennom en delt nettverksstasjon med CFX
Opus Dx PCR-sanntidssystem
Tips: Du kan bare overføre data til og fra en delt nettverksstasjon gjennom CFX Opus Dx-system.

CFX Opus Dx-system lar deg koble til en delt nettverksstasjon ved hjelp av Ethernet. Med en vellykket
tilkobling kan du overføre datafiler til og fra en mappe på den delte nettverksstasjonen.

Overføre data til og fra en delt nettverksstasjon

u I dialogboksen Select Location (Velg plassering) klikker du på Network (Nettverk) og navigerer til
målmappen der du vil kopiere filen eller Cancel (Avbryt) for å gå tilbake til filutforskeren.

Merknad: Hvis det finnes en fil med samme navn på den valgte lokasjonen, vises en dialogboks.
Trykk på Yes (Ja) for å overskrive den eksisterende filen eller No (Nei) for å gå tilbake til
filutforskeren.

CFX Opus Dx-system viser en bekreftelsesmelding når filen er kopiert.

Opprette en datafil
For å analysere data overført fra instrumentet tilCFX Maestro Dx SE-datamaskinen, må den komprimerte
datafilen (.zpcr-filen) konverteres til en datafil (.pcrd-fil). CFX Maestro Dx SE konverterer .zpcr-filen til en
.pcrd-fil og velger deretter en platefil som har samme skannemodus og platestørrelse og bruker den på
.pcrd-filen.

Slik oppretter du en datafil fra en stand-alone-datafil

1. I CFX Maestro Dx SE gjør du ett av følgende:

n Finn .zpcr-målfilen og dra den inn i startvinduet i CFX Maestro Dx SE.

n Velg File > Open > Stand-alone Run (Fil > Åpne > Stand-alone-kjøring) og naviger til og velg
målfilen.

CFX Maestro Dx SE viser dialogboksen Save As (Lagre som).

2. Naviger til mappen der du vil lagre .pcrd-filen, og klikk på Save (Lagre).

Etter at du har lagret .pcrd-filen, åpner CFX Maestro Dx SE vinduet Data Analysis (Dataanalyse) og
viser de resulterende dataene.
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CFX Maestro Dx-programvare, Security Edition prosesserer sanntids PCR-data automatisk på slutten av
hver kjøring og åpner vinduet Data Analysis (Dataanalyse) for å vise disse dataene (.pcrd-filen).

n Dra en datafil (filforlengelse .pcrd) til startvinduet og slippe den

n Velge File > Open > Data File (Fil > Åpne > Datafil) i startvinduet og bla til ønsket .pcrd-fil.

n Velge File > Recent Data Files (Fil > Nylige datafiler) i startvinduet for å velge fra en liste over de 10
siste datafilene som har vært åpnet

n Velge fanen Analyze (Analyser) i Startup Wizard (Oppstartsveiviser) og enten velge fra Recent Files
(Nylige filer) eller klikke på Browse (Søk) for å finne datafilen

Vinduet Data Analysis (Dataanalyse)
Vinduet Data Analysis (Dataanalyse) inneholder flere faner, og hver fane viser de analyserte dataene for
en bestemt analysemetode eller informasjon om en bestemt kjøring. Faner vises kun hvis dataene som er
samlet inn i kjøringen, er tilgjengelige for den aktuelle analysetypen.

Tips: Du velger fanene som skal vises fra rullegardinmenyen View (Visning) i vinduet Data Analysis
(Dataanalyse). Hvis du vil gå tilbake til det opprinnelige faneoppsettet, velger du Settings > Restore
Default Window Layout (Innstillinger > Gjenopprett standard vindusoppsett).
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Verktøylinje i Data Analysis (Dataanalyse)
Verktøylinjen i vinduet Data Analysis (Dataanalyse) gir rask tilgang til viktige dataanalysefunksjoner.

Tabell 11 viser en liste over funksjonene til knappene på verktøylinjen.

Knapp Navn Funksjon

Plateoppsett View/Edit plate (Vis/rediger plate) – åpner
Plate Editor (Plateredigering) der du kan vise
og redigere innholdet i brønnene.

Replace Plate file (Skift platefil) – velger en
platefil for å skifte plateoppsettet.

Apply PrimePCR file (Bruk PrimePCR-fil) –
velger en kjøringsfil for å skifte plateoppsettet
for en PrimePCR-kjøring.

ManageWell
Groups (Administrer
brønngrupper)

Åpner vinduet Well Groups Manager
(Administrering av brønngrupper) der du kan
opprette, redigere og slette brønngrupper.

Well Group
(Brønngruppe)

Velger et eksisterende brønngruppenavn fra
rullegardinmenyen. All Wells (Alle brønner) er
valgt som standard. Denne knappen vises kun
når brønngrupper er opprettet.

Analysis Mode
(Analysemodus)

Analyserer dataene i modusen Fluorophore
(Fluorofor) eller Target (Mål).

Help (Hjelp) Åpner programvarehjelpen der du kan finne
online hjelp og en digital kopi av denne
håndboken i Acrobat PDF-format.

Tabell 11. Verktøylinje i vinduet Data Analysis (Dataanalyse)

186 | CFX Maestro Dx SE-programvare



Vinduet Data Analysis (Dataanalyse)

Menylinje i Data Analysis (Dataanalyse)
Tabell 12 viser elementene på menylinjen i vinduet Data Analysis (Dataanalyse).

Menyelement Kommando Funksjon

Fil (File) Save (Lagre) Lagrer filen.

Save As (Lagre som) Lagrer filen med et nytt navn.

File Passwords (Filpassord) Gjør det mulig for brukere å angi lagre og
åpne passord.

Sign (Signere) Gjør det mulig for brukere å signere
datafilen.

Repeat Run (Gjenta kjøring) Henter ut protokollen og platefilen fra den
pågående kjøringen for å kjøre den på nytt.

Close (Lukk) Lukk vinduet Data Analysis (Dataanalyse)

View (Vis) Run Log (Kjøringslogg) Åpner vinduet Run Log (Kjøringslogg), der
du kan vise kjøringsloggen for den gjeldende
datafilen.

Audit Trail (Revisjonsspor) Åpner revisjonssporet for filen.

Quantification (Kvantifisering),
Melt Curve (Smeltekurve), Gene
Expression (Genuttrykk), End
Point (Endepunkt), Custom Data
View (Tilpasset datavisning), QC
(Kvalitetskontroll), Run
Information (Kjøringsinformasjon)

Viser de analyserte dataene i de valgte
fanene i vinduet Data Analysis
(Dataanalyse). Minst én fane må være valgt.

Tabell 12. Elementer på menylinjen i vinduet Data Analysis (Dataanalyse)
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Menyelement Kommando Funksjon

Settings
(Innstillinger)

Cq Determination Mode (Cq-
bestemmelsesmodus)

Lar deg velge enten Regression (Regresjon)
eller Single Threshold (Enkel terskel) for å
se hvordan Cq-verdiene fastsettes for hver
kurve.

Baseline Setting
(Baselinjeinnstilling)

Lar deg velge metode for
baselinjesubtraksjon for de valgte
brønngruppene.

Analysis Mode (Analysemodus) Lar deg analysere dataene etter
Fluorophore (Fluorofor) eller Target (Mål).

Cycles to Analyze (Sykluser som
skal analyseres)

Lar deg velge syklusene som skal
analyseres.

Baseline Threshold
(Baselinjeterskler)

Åpner vinduet Baseline Threshold
(Baselinjeterskler) for å justere baselinjen
eller terskelen.

Trace Styles (Kurvestiler) Åpner vinduet Trace Styles (Kurvestiler).

Plate Setup (Plateoppsett) Åpner Plate Editor (Plateredigering) for
visning og redigering av platen. Skift ut den
pågående platen med en plate fra en
brukerdefinert platefil eller en PrimePCR-
kjøringsfil.

Include All Excluded Wells
(Inkluder alle ekskluderte brønner)

Inkluderer alle ekskluderte brønner i
analysen.

Mouse Highlighting
(Musemerking)

Slår av eller på samtidig merking av data
med musepekeren.

Tips: Hvis Mouse Highlighting
(Musemerking) er slått av, trykker du på
Control-tasten på tastaturet for å slå
merking på midlertidig.

Restore Default Window Layout
(Gjenopprett standard
vindusoppsett)

Gjenoppretter vindusoppsettet til
standardinnstillingen.

Tabell 12. Elementer på menylinjen i vinduet Data Analysis (Dataanalyse), forts.
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Menyelement Kommando Funksjon

Export (Eksport) Export All Data Sheets
(Eksportere alle dataark)

Lar deg velge om du vil eksportere alle
regnearkvisningene fra hver fane til .csv, .txt.
Excel eller .xml.

Export RDML File (Eksporter
RDML-fil)

Lar deg velge enten versjon 1.1 eller 1.0 av
RDML som du vil eksportere filen til.

Custom Export (Tilpasset eksport) Åpner vinduet Custom Export (Tilpasset
eksport), der du kan angi feltene du vil
eksportere samt filformat for eksportfilen.

Export to LIMS Folder (Eksporter
til LIMS-mappe)

Åpner et vindu der du kan lagre data i LIMS-
mappen i et forhåndsbestemt format.

Manuell eksport Åpner et vindu der du kan identifisere
plasseringen for lagring av data fra alle
regnearkvisninger i Excel-filer som er bygget
opp spesifikt for bruk av Bio-Rad
Laboratories.

Tips: Du kan også starte Seegene
Viewer automatisk ved eksport. Se
Kommandoer i menyen Tools (Verktøy)
på side 65 for mer informasjon.

Tools (Verktøy) Reports (Rapporter) Åpner Report (Rapport) for denne datafilen.

Well Group Reports
(Brønngrupperapporter)

Åpner vinduet Well Group Reports
(Brønngrupperapporter), der du kan
generere rapporter for spesifiserte
brønngrupper.

Import Fluorophore Calibration
(Importer fluoroforkalibrering)

Velg en kalibreringsfil som skal brukes på
den gjeldende datafilen.

qbase+ Åpner qbase+ v2.5 direkte fra den gjeldende
.pcrd-filen, hvis det er installert.

Generer LIMS PLRN-fil Lagrer datafilen som en LIMS-formatert
.plrn-fil.

Tabell 12. Elementer på menylinjen i vinduet Data Analysis (Dataanalyse), forts.
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Informasjon om faner
Hver fane i vinduet Data Analysis (Dataanalyse) viser data i diagrammer og regneark for en bestemt
analysemetode, og inneholder en brønnvelger som brukes til å velge dataene du vil vise. Når vinduet
Data Analysis (Dataanalyse) åpnes, vises fanen Quantification (Kvantifisering) som standard. Du kan
bruke dataene i diagrammet Amplification (Amplifisering) i fanen Quantification (Kvantifisering) til å
bestemme de relevante analyseinnstillingene for kjøringen.

Merknad: Programvaren kobler sammen dataene i rutene i hver fane i vinduet Data Analysis
(Dataanalyse). Hvis du for eksempel uthever en brønn ved å plassere musepekeren over brønnen i
brønnvelgervisningen, utheves dataene i alle de andre rutene.

Velger for trinnummer
CFX Opus Dx-systemene kan samle inn fluorescensdata ved flere protokolltrinn – programvaren
opprettholder dataene som er samlet inn i hvert trinn uavhengig. CFX Maestro Dx SE viser
trinnnummervelgeren under Standard Curve-diagrammet (Standardkurve) i fanen Quantification
(Kvantifisering). Når en protokoll inneholder minst ett datainnsamlingstrinn, viser CFX Maestro Dx SE
dataene fra det første innsamlingstrinnet.

Hvis protokollen inneholder mer enn ett innsamlingstrinn, kan du velge et annet trinn fra
rullegardinmenyen. For eksempel:
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Når du velger et trinn, bruker programvaren dette valget på alle dataene som vises i vinduet Data Analysis
(Dataanalyse).

Vise Well Groups (Brønngrupper) i Data Analysis (Dataanalyse)
Brønner i platen kan grupperes i undersett for uavhengig analyse ved bruk av brønngrupper. Når du
oppretter brønngrupper, vises gruppenavnene i vinduet Data Analysis (Dataanalyse) i rullegardinmenyen
Well Groups (Brønngrupper) på verktøylinjen.

Hvis du opprettet brønngrupper, viser programvaren standardbrønngruppen All Wells (Alle brønner) når
du åpner vinduet Data Analysis (Dataanalyse), og viser dataene i alle brønner med innhold i
diagrammene og regnearkene. Kun brønnene i brønngruppen med det innlastede innholdet vises i
brønnvelgeren, og kun data for disse brønnene er inkludert i dataanalyseberegningene.

Tips: Opprett, rediger og slett brønngrupper ved å klikke på ManageWell Groups (Administrer
brønngrupper) på verktøylinjen.

Merknad: Hvis du ikke opprettet brønngrupper, vises ikke rullegardinmenyenWell Groups
(Brønngrupper) på verktøylinjen.

Endre brønninnhold etter en kjøring
Hvis måten data vises på endres under dataanalyse ved å endre innholdet i brønnene i Plate Editor
(Plateredigering), endres aldri fluorescensdataene som ble samlet inn fra hver brønn under kjøringen. Når
modulen har samlet inn fluorescensdata, kan du ikke slette disse dataene, men du kan velge å fjerne dem
fra visningen og analysen.

Slik endrer du innholdet i brønner etter en kjøring

u I vinduet Data Analysis (Dataanalyse) klikker du på Plate Setup (Plateoppsett) og velger et av
følgende alternativer:

n Edit/View Plate (Rediger/vis plate) – åpner Plate Editor (Plateredigering), der du kan endre
oppsettet manuelt.

n Replace Plate File (Erstatt platefil) – åpner dialogboksen for valg av plate, der du kan navigere
til en tidligere lagret platefil som du vil skal erstatte det gjeldende plateoppsettet.

n Apply PrimePCR file (Bruk PrimePCR-fil) – åpner dialogboksen for valg av PrimePCR-fil, der
du kan navigere til en PrimePCR-kjøringsfil og bruke den i plateoppsettet.

Tips: Du kan legge til eller redigere informasjon om innholdet i brønnen før en kjøring, under en
kjøring eller etter fullføring av en PCR-kjøring. Du må tilordne skannemodus og platestørrelse før
kjøringen. Disse parametrene kan ikke endres etter kjøringen.
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Innstillinger for dataanalyse
Diagramdataene for Amplification (Amplifisering) i fanen Quantification (Kvantifisering) viser den relative
fluorescensenheten (RFU) for hver brønn ved hver syklus. Hver kurve i diagrammet representerer data
fra en fluorofor i én brønn. Disse dataene brukes for å fastslå Cq-verdier for hver brønn per fluorofor.
Programvaren bruker én eller to moduser for å fastslå Cq-verdier:

n Regression (Regresjon) – anvender en multivariabel, ikke-lineær regresjonsmodell på individuelle
brønnkurver og bruker deretter denne modellen til å beregne en optimal Cq-verdi.

n Single Threshold (Enkel terskel) – bruker en enkel terskelverdi til å beregne Cq-verdien basert på
terskelskjæringspunktet til individuelle fluorescenskurver.

Velg Settings > Cq Determination Mode (Innstillinger > Cq-bestemmelsesmodus) for å velge Cq-
bestemmelsesmodusen.

Justere terskelen
I modusen Single Threshold (Enkel terskel) kan du justere terskelen for en fluorofor ved å klikke på
terskellinjen i Amplification Chart (Amplifiseringsdiagram) og bevege musepekeren vertikalt. Alternativt
kan du spesifisere en nøyaktig krysningsterskel for den valgte fluoroforen.

Baselinjeinnstillinger
Programvaren angir automatisk baselinjen individuelt for hver brønn. Baselinjeinnstillingen bestemmer
metoden for baselinjesubtraksjon for alle fluorescenskurver. Programvaren har tre alternativer for
baselinjesubtraksjon:

n No Baseline Subtraction (Ingen baselinjesubtraksjon) – viser dataene som relative
fluorescenskurver. Noen analyser kan ikke utføres i denne analysemodusen, og programvaren viser
derfor ikke fanene Gene Expression (Genuttrykk), End Point (Endepunkt) og Allelic Discrimination
(Allelisk diskriminering).

n Baseline Subtracted (Baselinjesubtrahert) – viser dataene som baselinjesubtraherte kurver for hver
fluorofor i en brønn. Programvaren må baselinjesubtrahere dataene for å bestemme
kvantifiseringssykluser, konstruere standardkurver og bestemme konsentrasjonen av ukjente prøver.
For å generere en baselinjesubtrahert kurve tilpasser programvaren den beste rette linjen gjennom
den registrerte fluorescensen for hver brønn under baselinjesyklusene, og subtraherer deretter de
best tilpassede dataene fra de bakgrunnssubtraherte dataene ved hver syklus.

n Baseline Subtracted Curve Fit (Baselinjesubtrahert kurvetilpasning) – viser dataene som
baselinjesubtraherte kurver, og programvaren jevner ut den baselinjesubtraherte kurven ved hjelp av
et sentrert gjennomsnittsfilter. Denne prosessen utføres slik at hver Cq forblir konstant.
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I tillegg til disse alternativene kan du også velge Apply Fluorescent Drift Correction (Bruk korreksjon mot
fluorescensavvik). For brønner som har unormalt varierende RFU-verdier under de første syklusene i en
kjøring, vil programvaren derivere en estimert baselinje fra tilstøtende brønner som det var mulig å generere
en horisontal baselinje for.

Slik endrer du innstillingen for baselinjesubtraksjon

u Velg Settings > Baseline Setting (Innstillinger > Baselinjeinnstilling).

Analysemodus
Data kan grupperes og analyseres etter enten fluorofor eller målnavn. Når data er gruppert etter fluorofor,
vises datakurver etter fluorofor som angitt i plateoppsettet for den aktuelle kjøringen. Individuelle
fluorofordata vises i amplifiserings- og standardkurvediagrammet (hvis tilgjengelig) når de relevante
avmerkingsboksene for fluorofor, som er plassert under amplifiseringsdiagrammet, er valgt.

Når data er gruppert etter mål, vises datakurver etter målnavn som angitt i plateoppsettet for den aktuelle
kjøringen.

Slik velger du en dataanalysemodus

u Gjør ett av følgende:

n Velg Settings > Analysis Mode (Innstillinger > Analysemodus).

n Velg en modus fra rullegardinmenyen Analysis Mode (Analysemodus) på verktøylinjen.
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Sykluser som skal analyseres
Du kan begrense antall sykluser som skal analyseres. Du kan også analysere data fra et spesifikt sett
med sykluser. Maksimalt antall sykluser du kan analysere, er 50.

Merknad: Fjerning av sykluser fra begynnelsen av en kjøring kan ha en signifikant innvirkning på
baselinjen.

Slik begrenser du dataanalyse til et spesifikt antall sykluser

1. Velg Settings > Cycles to Analyze (Innstillinger > Sykluser som skal analyseres).

Dialogboksen Cycles to Analyze (Sykluser som skal analyseres) vises.

2. Angi start- og sluttsyklusverdiene og klikk på OK.

Klikk på Restore Defaults (Gjenopprett standarder) i dialogboksen Cycles to Analyze (Sykluser som skal
analyseres) for å gjenopprette de opprinnelige syklusene som ble brukt for analysen.
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Brønnvelger
Bruk Well Selector (Brønnvelger) til å vise eller skjule brønndata i diagrammer eller regneark i vinduet
Data Analysis (Dataanalyse). Kun brønner som er lastet med en prøve, kan velges i brønnvelgeren.
Programvaren farger brønnene i Well Selector (Brønnvelger):

n Blå – angir valgte brønner. Data fra valgte brønner vises i vinduet Data Analysis (Dataanalyse).

n Lysegrå – angir ikke-valgte brønner. Data fra ikke-valgte brønner vises ikke i vinduet Data Analysis
(Dataanalyse).

n Mørkegrå – angir tomme brønner.

Slik viser eller skjuler du brønndata

u Velg en av følgende fremgangsmåter i brønnvelgeren:

n Hvis du vil skjule en brønn, klikker du på brønnen. Hvis du vil vise brønnen, klikker du på
brønnen en gang til.

n Hvis du vil skjule flere brønner, drar du markøren over brønnene du vil velge. Hvis du vil vise
brønnene, drar du markøren over brønnene en gang til.

n Klikk øverst til venstre i platen for å skjule alle brønner. Klikk øverst til venstre en gang til for å
vise alle brønner.

n Klikk i starten av en kolonne eller rad for å skjule disse brønnene. Klikk i kolonnen eller raden en
gang til for å vise brønnene.
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Elementer i høyreklikkmenyen for Well Selector (Brønnvelger)
Tabell 13 viser tilgjengelige høyreklikkalternativer i brønnvelgervisningen.

Element Funksjon

Well XX (Brønn XX) Viser kun denne brønnen, fjerner denne brønnen fra visningen, angir
farge for denne brønnen, eller ekskluderer denne brønnen fra
analysen.

Selected Wells (Valgte brønner)
(høyreklikk og dra)

Viser kun disse brønnene, fjerner disse brønnene fra visningen, angir
farge for disse brønnene, eller ekskluderer disse brønnene fra
analysen.

Copy (Kopier) Kopierer innholdet i brønnen til en utklippstavle, inkludert Sample Type
(Prøvetype) og valgfritt Replicate # (Replikatnr.).

Copy as Image (Kopier som
bilde)

Kopierer brønnvelgervisningen som et bilde.

Print (Skriv ut) Skriver ut brønnvelgervisningen.

Print Selection (Skriv ut utvalg) Skriver ut det gjeldende utvalget.

Export to Excel (Eksporter til
Excel)

Eksporterer dataene til et Excel-regneark.

Export to CSV (Eksporter til
CSV)

Eksporterer dataene som et .csv-dokument.

Export to Xml (Eksporter til Xml) Eksporterer dataene som et .xml-dokument.

Well Labels (Brønnetiketter) Endrer brønnetikettene til Sample Type (Prøvetype), Target Name
(Målnavn) eller Sample Name (Prøvenavn).

Tabell 13. Elementer i høyreklikkmenyen for brønnvelgervisning
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Midlertidig ekskludering av brønner fra analyse
Slik ekskluderer du brønner fra en dataanalyse midlertidig

1. Høyreklikk på brønnen i brønnvelgeren, på en fluorescerende kurve eller på et punkt på
standardkurven. Når du skal ekskludere flere brønner, kan du høyreklikke og dra for å merke flere
brønner, kurver eller punkter.

2. Velg ønsket alternativ fra høyreklikkmenyen:

n Well > Exclude Well (Brønn > Ekskluder brønn)

n Selected Wells > Exclude from Analysis (Valgte brønner > Ekskluder fra analyse)

n Selected Traces > Exclude these wells from Analysis (Valgte kurver > Ekskluder disse brønnene
fra analyse)

Du kan også fjerne brønner permanent fra analyse ved å klikke på knappen Clear Wells (Fjern
brønner) for å fjerne innholdet fra brønner i Plate Editor (Plateredigering).

Viktig: Alt innhold som fjernes fra brønnen(e), må legges inn på nytt.

Slik inkluderer du en ekskludert brønn

u Høyreklikk på ønsket brønn i brønnvelgeren, og velg Well > Include Well in Analysis (Brønn >
Inkluder brønn i analyse).
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Diagrammer
Hvert diagram i vinduet Data Analysis (Dataanalyse) viser dataene i forskjellige grafer og inneholder
alternativer som kan brukes til å justere og eksportere data eller diagramgrafikk.

Diagramverktøyene
Tabell 14 viser høyreklikkalternativene som er tilgjengelige i de fleste diagrammer.

Element Funksjon

Copy (Kopier) Kopierer diagrammet til utklippstavlen.

Save Image As... (Lagre bilde
som…)

Lagrer diagrammet som en bildefil. Angi oppløsning og størrelse for
bildet, og velg deretter filtype (PNG, GIF, JPG, TIF eller BMP).

Page Setup... (Sideoppsett …) Velger et sideoppsett for utskrift.

Print... (Skriv ut …) Skriver ut diagrammet.

Set Scale to Default (Angi skala
til standard)

Viser alle data i søylediagrammet. Rullefelter vises hvis det er for
mange datapunkter/prøver å vise innenfor diagrammets ramme.

Chart Settings
(Diagraminnstillinger)

Åpner dialogboksen Chart Settings (Diagraminnstillinger), der du kan
endre diagrammets visningsalternativer, inkludert:

n titler for diagram og akser

n skrift og skriftstørrelse for diagram og akser

n akseskala

n plassering av forklaring

Tabell 14. Elementer i høyreklikkmenyer som finnes i de fleste diagrammer

Diagramverktøyene vises også i hvert av diagrammene i vinduet Data Analysis (Dataanalyse). Alle
diagrammer viser disse verktøyene:

Copy to Clipboard (Kopier til utklippstavle) – kopierer innholdet i diagramvisningen til utklippstavlen.

Chart Settings (Diagraminnstillinger) – åpner dialogboksen Chart Settings (Diagraminnstillinger), der
du kan endre diagrammets visningsalternativer.

Export (Eksport) – åpner dialogboksen Export Options (Eksportalternativer), der du kan endre
oppløsningen og størrelsen på diagrammet og lagre det på ønsket plassering som én av følgende filtyper:

n .bmp

n .jpg
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n .png

Verktøy i søylediagram

I tillegg til diagramverktøyene viser søylediagrammer følgende verktøy:

Sort (Sorter) – sorter målene og prøvene alfabetisk eller i omvendt alfabetisk rekkefølge.

Color Settings (Fargeinnstillinger) – åpner dialogboksen Color Settings (Fargeinnstillinger) hvor du kan
endre fargen på målene og prøvene.

For mer informasjon om disse verktøyene, se Endre og anmerke diagramvisningen på side 260.

Verktøy i amplifiseringsdiagram

I tillegg til de oppført ovenfor, viser amplifiseringsdiagrammene følgende verktøy:

Trace Styles (Kurvestiler) – åpner dialogboksen Trace Styles (Kurvestiler) hvor du kan endre utseendet
til kurvene i amplifiseringsdiagrammet.

Baseline Threshold (Baselinjeterskel) – åpner dialogboksen Baseline Threshold (Baselinjeterskel) hvor
du kan endre standard baselinje for valgte brønner eller endre terskelen for hver fluorescenskurve i
amplifiseringsdiagrammet.

Kopiere diagramdata til utklippstavlen

Du kan kopiere innholdet i diagramvisningen og lime det inn i alle programmer som godtar bitmap-
bildefiler.

Slik kopierer du diagramdata til utklippstavlen

1. Velg ikonet Copy To Clipboard (Kopier til utklippstavle) fra diagramverktøyene.

2. Åpne et program som godtar bitmap-bilder, for eksempel Microsoft Word.

3. Høyreklikk og velg Paste (Lim inn) for å lime inn bitmap-bildet fra utklippstavlen i programmet.

Endre innstillinger for diagramvisning

Bruk dialogboksen Chart Settings (Diagraminnstillinger) til å endre titler, skrifter og størrelser, akseskala
og plassering av forklaringer for det viste diagrammet. Endringene du gjør, gjelder kun for det viste
diagrammet og lagres sammen med diagrammet.

Slik endrer du innstillingene for diagramvisning

1. Klikk på Chart Settings (Diagraminnstillinger) i diagramverktøyene.

Dialogboksen Chart Settings (Diagraminnstillinger) åpnes.
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2. Velg fanen Chart And Axes (Diagram og akser) for å:

n skrive inn en tittel for diagrammet

n skrive inn en ny tittel for X-aksen og vinkle etikettene

n skrive inn en ny tittel for Y-aksen

3. Velg fanen Fonts (Skrifter) for å endre skriften og skriftstørrelsen i diagrammet.

Tips: Som standard skaleres skriftstørrelsen automatisk når størrelsen på diagrammet endres.
Velg Change Font Size (Endre skriftstørrelse) for å angi en statisk skriftstørrelse for hver
etikettype.

4. Velg fanen Axes Scale (Akseskala) for å:

n fjerne automatisk skalering av X- og Y-aksene og angi minimums- og maksimumsverdier for
skalering

n velge å vise rutenettlinjer eller hakemerker i diagrammet

5. Velg fanen Legend (Forklaring) for å:

n velge å skjule diagramforklaringen

n endre standardplasseringen for diagramplasseringen

Merknad: Når forklaringen plasseres til venstre eller høyre for diagrammet, viser den bare de ti
første fluoroforene i diagrammet.
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6. Klikk på Apply (Bruk) når som helst for å vise endringer i diagraminnstillingene uten å lagre
endringene.

7. Klikk på OK for å lagre endringene og gå tilbake til diagrammet.

Eksportere diagrammet

Bruk denne dialogboksen til å endre bredden, høyden og oppløsningen på grafen for å eksportere den i
ett av følgende filformater:

n .bmp

n .jpg

n .png

Du kan deretter bruke den eksporterte grafen til å vise resultatene i posterpresentasjoner, Microsoft
PowerPoint-presentasjoner og fagtidsskrifter.

Merknad: Vær oppmerksom på følgende når du endrer innstillingene:

n Grenser for maksimum og minimum bredde og høyde

o Ved 72 ppt: 0,1–83 tommer

o Ved 96 ppt: 0,1–62 tommer

o Ved 150 ppt: 0,1–40 tommer

o Ved 300 ppt: 0,1–20 tommer

o Ved 600 ppt: 0,1–10 tommer

o I alle oppløsninger: 2–6 000 piksler

n Størrelsesforhold er basert på bredde.

Slik eksporterer du diagrammet

1. Klikk på Export (Eksport) i diagramverktøyene.

Dialogboksen Export Preview (Forhåndsvisning av eksport) vises.
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2. Endre om nødvendig innstillingene for visningen.

3. Klikk på Export (Eksport).

4. Gjør følgende i dialogboksen Export (Eksport):

a. (Valgfritt) Naviger til en mappe som diagramfilen skal lagres i.

b. Skriv inn navnet på filen og velg en filtype fra rullegardinmenyen.

5. Klikk på Save (Lagre) for å lagre diagramfilen.

Endre innstillingene for Baseline Threshold (Baselinjeterskel)

I modusen Single Threshold (Enkel terskel) kan du justere terskelen for en fluorofor ved å klikke på
terskellinjen i Amplification Chart (Amplifiseringsdiagram) og bevege musepekeren vertikalt. Alternativt
kan du spesifisere en nøyaktig krysningsterskel for den valgte fluoroforen.

Tips: Du kan spesifisere et syklusområde for å fastslå baselinjen for alle datafiler i fanen Data
Analysis (Dataanalyse) i User > User Preferences (Bruker > Brukerpreferanser).

Slik justerer du begynnende og avsluttende baselinjesyklus for hver brønn

1. I fanen Quantification (Kvantifisering) velger du en enkelt fluorofor under amplifiseringsdiagrammet.

2. Velg baselinjeterskel fra diagramverktøyene.

Dialogboksen Baseline Threshold (Baselinjeterskel) vises.
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3. Gjør et av følgende i delen Baseline Cycles (Baselinjesykluser):

n Velg én brønn ved å klikke på radnummeret.

n Velg flere tilstøtende brønner ved å klikke på radnummeret til den første brønnen og dra nedover
i kolonnen til den siste brønnen.

n Velg flere ikke-tilstøtende brønner ved å trykke på Ctrl-tasten på tastaturet og klikke på
radnummeret til hver målbrønn.

n Velg alle brønner ved å klikke øverst til venstre i tabellen.

4. Juster syklusen Baseline Begin (Start baselinje) og syklusen Baseline End (Slutt baselinje) for alle
valgte brønner, eller endre syklusnummeret for Begin (Start) og End (Slutt) nederst i regnearket.

Tips: Hvis du vil tilbakestille innstillingene til de sist lagrede verdiene, klikker du på Reset All
User Defined Values (Tilbakestill alle brukerdefinerte verdier).

5. Klikk på OK for å lagre endringene og gå tilbake til diagrammet.

Slik spesifiserer du et syklusområde for alle datafiler

u I startvinduet eller vinduet for plateredigering velger du User > User Preferences (Bruker >
Brukerpreferanser) og velger fanen Data Analysis (Dataanalyse).

Sortere måldata, prøvedata og data om biologisk gruppe

Merknad: Dette alternativet er kun tilgjengelig for genuttrykksdiagrammer.

Som standard vises listene Targets (Mål), Samples (Prøver) og Biological Groups (Biologiske grupper) i
alfabetisk rekkefølge. Bruk dialogboksen Sort (Sorter) for å sortere visningen i omvendt alfabetisk
rekkefølge eller for manuelt å flytte et begrep til en annen plassering på listen.

For å sortere måldata, prøvedata og data om biologisk gruppe

1. Klikk på Sort (Sortere) i diagramverktøyene.

Dialogboksen Gene Expression Chart Sorting (Sortering i genuttrykksdiagram).
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2. Klikk på Z-A i dialogboksen for å sortere listen i omvendt alfabetisk rekkefølge.

3. Hvis du vil flytte et begrep manuelt, velger du begrepet og klikker på den relevante knappen mellom
diagrammene:

n Klikk på pil opp eller pil ned for å flytte det valgte begrepet én posisjon.

n Klikk på pil opp- eller pil ned-rullefeltet for å flytte det valgte begrepet til øverste eller nederste
posisjon på listen.

4. Klikk på OK for å lagre endringene og gå tilbake til fanen Gene Expression (Genuttrykk).
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Endre innstillingene for mål- og prøvefarge

Merknad: Dette alternativet er kun tilgjengelig for genuttrykksdiagrammer.

Bruk dialogen Color Settings (Fargeinnstillinger) for å endre fargen på et mål eller en prøve, eller for å
fjerne elementet fra grafen.

Slik endrer du fargeinnstillinger

1. Velg Color Settings (Fargeinnstillinger) fra diagramverktøyene.

Dialogboksen Color Settings (Fargeinnstillinger) vises.

2. For å endre fargen på et mål eller en prøve må du klikke på den gjeldende fargen i Color (Farge)-
kolonnen.

3. I dialogboksen Color (Farge) som vises, velger du en ny farge og klikker på OK.

4. Du fjerner elementet fra genuttrykksgrafen ved å fjerne merket i den respektive boksen i kolonnen
Show Chart (Vis diagram).

Tips: Du fjerner alle elementer fra genuttrykksgrafen ved å fjerne merket i boksen Show Chart
(Vis diagram) i kolonneoverskriften.

5. (Valgfritt) Som standard vises søylediagrammets farge i gradientform. For å vise fargen i
heldekkende form må du velge Use Solid Colors (Bruk heldekkende farger).

6. Klikk på OK for å lagre endringene og gå tilbake til fanen Gene Expression (Genuttrykk).
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Forstørre et område i diagrammet
Slik forstørrer du et område i diagrammet

u Klikk og dra over diagrammet, og klikk deretter på Zoom. Programvaren endrer størrelsen på
diagrammet og sentrerer det i det valgte området.

Merknad: Bar Chart (Søylediagram) krever ikke at du klikker på popup-kommandoen Zoom.

Slik tilbakestiller du diagrammet til full visning

u Høyreklikk i diagrammet og velg Set Scale to Default (Sett skala til standard).

Kopiere diagrammer til en Microsoft-fil
Du kan kopiere datadiagrammer til Microsoft Word-, Excel- eller PowerPoint-dokumenter.
Bildeoppløsningen er den samme som på skjermen bildet ble hentet fra.

Slik kopierer du diagrammer til en Microsoft-fil

1. I vinduet Data Analysis (Dataanalyse) klikker du på Copy To Clipboard (Kopier til utklippstavlen)
øverst til høyre i diagrammets rute.

2. Åpne en tomMicrosoft-fil og lim inn innholdet fra utklippstavlen.

Vanlige elementer i høyreklikkmenyen for diagrammer
Tabell 15 viser en liste over elementer i høyreklikkmenyen som er tilgjengelige for diagrammer. Noen av
elementene er til stede for alle diagrammer, inkludert elementer for å endre hvordan dataene vises eller
for enkelt å eksportere data fra et diagram.

Element Funksjon

Copy (Kopier) Kopierer diagrammet til utklippstavlen.

Save Image As (Lagre
bilde som)

Lagrer bildet i en spesifisert størrelse, oppløsning og filtype inkludert PNG
(standard), JPG og BMP.

Page Setup (Sideoppsett) Viser alternativene for utskriftsoppsett.

Print (Skriv ut) Skriver ut diagrammet.

Set Scale to Default (Angi
skala til standard)

Gjenoppretter diagrammets standardvisning etter at diagrammet har vært
forstørret.

Tabell 15. Elementer i høyreklikkmenyen for diagrammer
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Element Funksjon

Chart Options
(Diagramalternativer)

Åpner vinduet Chart Options (Diagramalternativer) for å endre diagrammet,
inkludert tittelen, velge grenser for X- og Y-aksene, vise rutenettlinjer og vise
mindre hakemerker på aksene.

Merknad: Menyelementer som gjelder for bestemte diagrammer, er beskrevet i Kapittel 11, Detaljer
om dataanalyse.

Brukerhåndbok | 207



Kapittel 10 Oversikt over dataanalyse

Regneark
Regnearkene som vises i Data Analysis (Dataanalyse), inkluderer alternativer for sortering og overføring
av data. Du kan sortere kolonnene ved hjelp av én av disse metodene:

n Klikk og dra en kolonne til en ny plassering i den valgte tabellen.

n Klikk på kolonneoverskriften for å sortere dataene i stigende eller synkende rekkefølge.

Slik sorterer du opptil tre kolonner med data i vinduet Sort (Sortering)

1. Høyreklikk i regnearket og velg Sort (Sorter).

2. I dialogboksen Sort (Sortering) velger du den første kolonnetittelen som skal sorteres. Sorter dataene
i stigende eller synkende rekkefølge.

3. Velg en andre eller tredje kolonne som skal sorteres, og velg Ascending (Stigende) eller Descending
(Synkende).

4. Klikk på OK for å sortere dataene eller på Cancel (Avbryt) for å stoppe sorteringen.

Tips: Uthev dataene i de tilhørende diagrammene og brønnvelgeren ved å holde musepekeren over
en celle. Klikk på en celle for å kopiere innholdet og lime det inn i et annet program.

Vanlige elementer i høyreklikkmenyen for regneark
Tabell 16 viser de tilgjengelige elementene i høyreklikkmenyen i alle regnearkvisninger.

Element Funksjon

Copy (Kopier) Kopierer innholdet i de valgte brønnene til en utklippstavle, og limer
deretter innholdet inn i et regneark, som f.eks. Excel.

Copy as Image (Kopier som
bilde)

Kopierer regnearkvisningen som en bildefil og limer den inn i en fil
som godtar en bildefil, som f.eks. tekst-, bilde- eller regnearkfiler.

Print (Skriv ut) Skriver ut den gjeldende visningen.

Print Selection (Skriv ut utvalg) Skriver ut det gjeldende utvalget.

Export to Excel (Eksporter til
Excel)

Eksporterer dataene til et Excel-regneark.

Export to Text (Eksporter til
tekst)

Eksporterer dataene til et tekstbehandlingsprogram.

Tabell 16. Elementer i høyreklikkmenyen for regneark
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Element Funksjon

Export to CSV (Eksporter til
CSV)

Eksporterer dataene til en .csv-fil.

Export to Xml (Eksporter til Xml) Eksporterer dataene til en .xml-fil.

Export to Html (Eksporter til
Html)

Eksporterer dataene til en .html-fil.

Find (Søk) Søker etter tekst.

Sort (Sorter) Sorterer dataene i opptil tre kolonner.

Select Columns (Velg kolonner) Velger kolonnene som skal vises i regnearket.

Tabell 16. Elementer i høyreklikkmenyen for regneark, forts.
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Eksport
CFX Maestro Dx SE har fire eksportalternativer i rullegardinmenyen:

n Export All Data Sheets (Eksportere alle dataark)

n Export RDML Files (Eksporter RDML-filer)

n Custom Export (Tilpasset eksport)

n Export to LIMS Folder (Eksporter til LIMS-mappe)

n Manuell eksport

Eksportere alle dataark
Du kan eksportere alle regnearkvisningene fra hver fane i CFX Maestro Dx SE til individuelle filer.

Slik eksporterer du alle dataark

u Velg Export > Export All Data Sheets to Excel (Eksport > Eksporter alle dataark til Excel), og velg
deretter ønsket filtype:

n CSV (*.csv)

n Tekst (*.txt)

n Excel-arbeidsbok (*.xlsx)

Eksporterte analyser lagres i flere Excel-arbeidsbokfiler med ett regnearkfelt for analysedata per
fil. Når en analyse inkluderer flere fluoroforer, eksporteres dataene fra hver fluorofor til en
separat regnearkfane.

n Excel arbeidsbok – kombinert (* .xlsx)

Eksporterte analyser lagres i én Excel-fil som inkluderer flere regnearkfaner, én for hvert
analysedatasett.

n Excel 97–2003 (*.xls)

Viktig: Datamaskinen din må ha Microsoft Excel installert for at du skal kunne eksportere
data til et Microsoft Excel-regneark.

n XML (*.xml)

210 | CFX Maestro Dx SE-programvare



Eksport

Eksportere RDML-filer
RDML er en strukturert og universell datastandard for utveksling av kvantitative PCR (qPCR)-data.
Datastandarden er en tekstfil i formatet Extensible Markup Language (.xml). Se det internasjonale RDML
Consortium-nettstedet (www.rdml.org) for mer informasjon om RDML-datautvekslingsformatet.

Viktig: Eksporterte RDML-filer inkluderer analysedata med baselinjeinnstillingene som du bruker i
Data Analysis-vinduet (Dataanalyse). For mer informasjon om grunnlinjeinnstillinger, se
Baselinjeinnstillinger på side 192.

Merknad: Lagre RDML-filen som versjon 1.1 hvis du bruker versjon 2.3 eller nyere av qbase+-
programvaren.

Slik eksporterer du en RDML-fil

1. Velg Export > Export RDML Files (Eksport > Eksporter RDML-filer) og velg RDML v1.1 eller RDML
v1.0 fra listen som vises.

Dialogboksen Save As (Lagre som) vises.

2. I dialogboksen Save As (Lagre som) angir du et filnavn og et lagringssted for RDML-filen.

3. Klikk på OK for å lagre eksportfilen.
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Opprette en tilpasset eksportfil
Slik oppretter du en tilpasset eksportfil

1. Velg Export > Custom Export (Eksport > Tilpasset eksport). Dialogboksen Custom Export (Tilpasset
eksport) vises.

2. Velg eksportformatet fra rullegardinmenyen som vises.

3. Merk avmerkingsboksene for elementene som skal eksporteres.

4. (Valgfritt) Klikk på Customize Column Names (Tilpass kolonnenavn) for å endre kolonnenavn.

5. Klikk på Export (Eksport). Dialogboksen Save As (Lagre som) vises.

6. I dialogboksen Save As (Lagre som) angir du et filnavn og et lagringssted for den eksporterte filen.

7. Klikk på OK for å lagre eksportfilen.
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Eksportere til en LIMS-mappe
Du kan eksportere data til et LIMS-kompatibelt filformat. Se Vedlegg C, LIMS-integrering for mer
informasjon om oppretting, behandling og bruk av LIMS-filer.

Slik eksporterer du data i LIMS-format

1. Velg Export > Export to LIMS Folder (Eksport > Eksporter til LIMS-mappe).

Dialogboksen Save As (Lagre som) vises.

2. I dialogboksen Save As (Lagre som) angir du et filnavn og et lagringssted for den eksporterte filen.

3. Klikk på OK for å lagre eksportfilen.

Eksportere Seegene-formaterte data
Du kan eksportere dataene fra alle regnearkvisninger til Excel-filer som er strukturert spesielt for bruk
med Seegene, Inc.

Tips: Du kan også starte Seegene Viewer automatisk når eksporten er fullført. Se Kommandoer i
menyen Tools (Verktøy) på side 65 for mer informasjon.

Slik eksporterer du data i et Seegene-spesifikt format

1. Velg Export > Manual Export (Eksport > Manuell eksport)

Dialogboksen Browse For Folder (Søk etter mappe) vises.

2. I dialogboksen Browse For Folder (Søk etter mappe) velger du en mappe der du vil lagre de
eksporterte Seegene-formaterte Excel-filene (.xlsx).

Analysene eksporteres i flere Excel-filer med én regnearkfane for analysedata per fil.

3. Klikk på OK for å lagre eksportfilene.
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Kapittel 11 Detaljer om dataanalyse
CFX Maestro Dx-programvare, Security Edition dataanalysevinduet inneholder flere faner der du kan vise
data. Dette kapitlet forklarer disse fanene i detalj.

Tips: Du kan velge hvilke faner som skal vises i Data Analysis (Dataanalyse)-vinduet ved bruk av
View (Vis)-menyen. Det tilpassede oppsettet lagres med datafilen.
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Fanen Quantification (Kvantifisering)
Bruk dataene i fanen Quantification (Kvantifisering) for å angi betingelsene for dataanalysen, inkludert
baselinjeinnstillinger for individuelle brønner og terskelinnstillinger. Fanen Quantification (Kvantifisering)
viser data i disse fire visningene:

n Amplification chart (Amplifiseringsdiagram) – viser de relative fluorescensenhetene (RFU) for hver
brønn i hver syklus. Hver kurve i diagrammet representerer data fra en fluorofor i én brønn.

n Standard curve (Standardkurve) – vises bare hvis kjøringen inkluderer brønner designert som
prøvetypen standard (Std). Standardkurven viser terskelsyklusen plottet mot logaritmen av
startkvantiteten. Forklaringen viser reaksjonseffektiviteten (E) for hver fluorofor i brønnene med
prøver av typen standard.

n Well Selector (Brønnvelger) – velger brønnene med fluorescensdataene du vil vise.

n Spreadsheet (Regneark) – viser et regneark med dataene samlet inn i de valgte brønnene.

Fluoroforalternativer
Velg målfluoroforet eller -fluoroforene under diagrammet Amplification (Amplifisering) for å vise
fluorofordata i diagrammene og regnearkene i fanen Quantification (Kvantifisering). Hvis du vil skjule
fluorofordataene i vinduet for dataanalyse, fjerner du merkingen i den tilhørende avmerkingsboksen.
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Dialogboksen Trace Styles (Kurvestiler)
Dialogboksen Trace Styles (Kurvestiler) kan brukes til å justere utseendet til kurvene i
amplifiseringsdiagrammet og smeltekurvediagrammet i fanene Quantification (Kvantifisering) og Melt
Curve (Smeltekurve). Deretter kan du forhåndsvise endringene i brønnvelgeren som vises i dialogboksen
Trace Styles (Kurvestiler).

Slik justerer du kurvestiler

1. Velg kun én fluorofor under diagrammet Amplification (Amplifisering).

2. Velg ett av følgende alternativer for å åpne dialogboksen Trace Styles (Kurvestiler):

n Klikk på Trace Styles (Kurvestiler) i diagrammet Amplification (Amplifisering).

n Velg Settings > Trace Styles (Innstillinger > Kurvestiler) på menylinjen Data Analysis
(Dataanalyse).

n Høyreklikk på en kurve, og velg Trace Styles (Kurvestiler).

Dialogboksen Trace Styles (Kurvestiler) åpnes.

3. Velg et spesifikt sett med brønner i brønnvelgeren i nederste rute i dialogboksen Trace Styles
(Kurvestiler). Du kan også velge brønner som inneholder én prøvetype i rullegardinmenyen i
kolonnenWells (Brønner).

4. Velg en av følgende fremgangsmåter:
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n Klikk i boksen i kolonnen Color (Farge) for å velge en farge for de valgte brønnene.

n Velg et symbol fra rullegardinmenyen Symbol for å tilordne et symbol til de valgte brønnene.

n For raskt å farge brønnene etter knappeetikett klikker du på det tilhørende hurtigsettet:

o Random byWell (Tilfeldig etter brønn)

o Random by Replicate (Tilfeldig etter replikat)

o Use Fluor Colors (Bruk fluoroforfarger)

o Use Target Colors (Bruk målfarger)

o Use Sample Colors (Bruk prøvefarger)

n Velg enten Sample Type (Prøvetype), Target Name (Målnavn), Sample Name (Prøvenavn) eller
Symbol for å tilordne brønnetiketter.

Alternativet Log Scale (Log-skala)
Velg Log Scale (Log-skala) under diagrammet Amplification (Amplifisering) for å se fluorescenskurvene i
en semilog-skala:

Tips: Du kan forstørre ethvert område av diagrammet ved å dra over målområdet. Du går tilbake til
full visning ved å høyreklikke på diagrammet og velge Set Scale to Default (Angi skala til standard).
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Standardkurvediagram
Hvis dataene inkluderer prøvetyper definert som Std (Standard) for minst en fluorofor i kjøringen,
oppretter programvaren diagrammet Standard Curve (Standardkurve) i fanen Quantification
(Kvantifisering).

Diagrammet Standard Curve (Standardkurve) viser følgende informasjon:

n Navn på hver kurve (fluoroforen eller målet).

n Fargen på hver fluorofor eller mål.

n Reaksjonseffektivitet (E). Bruk denne statistikken til å optimere en multipleks reaksjon og utjevne
dataene for en standardkurve.

Merknad: Reaksjonseffektiviteten beskriver hvor stor del av målet som produseres for hver
syklus i protokollen. En effektivitet på 100 % indikerer at du dobler målet for hver syklus.

n Bestemmelseskoeffisient, R2 (uttrykt som R^2). Bruk denne statistikken for å bestemme hvor
nøyaktig linjen beskriver dataene (hvor god tilpasningen er).

n Stigningstall

n Y-skjæringspunkt
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Menyalternativer i Amplification Chart (Amplifiseringsdiagram)
I tillegg til de vanlige høyreklikk-menyalternativene for diagrammer (se Vanlige elementer i
høyreklikkmenyen for diagrammer på side 206) viser Tabell 17 menyalternativene som er tilgjengelige for
diagrammet Amplification Chart (Amplifiseringsdiagram).

Menyalternativ Funksjon

Well XX, Fluor Target
(Brønn XX, fluoroformål)

Viser kun denne brønnen, fjerner denne brønnen fra visningen, angir
farge for denne kurven eller ekskluderer denne brønnen fra analysen.

Selected Traces (Valgte
kurver)

Viser kun disse brønnene, fjerner disse brønnene fra visningen, angir
farge for disse kurvene eller ekskluderer disse brønnene fra analysen.

Show Threshold Values
(Vis terskelverdier)

Viser terskelverdien for hver amplifiseringskurve i diagrammet.

Trace Styles (Kurvestiler) Åpner vinduet Trace Styles (Kurvestiler) for å endre stil på kurvene i
fanene Quantification (Kvantifisering) og Melt Curve (Smeltekurve).

Baseline Thresholds
(Baselinjeterskler)

Åpner vinduet Baseline Thresholds (Baselinjeterskler) for å endre
baselinjen eller tersklene for hvert fluorofor (endringene vises i
amplifiseringsdiagrammet i fanen Quantification (Kvantifisering)).

Tabell 17. Elementer i høyre- og venstreklikkmenyen for amplifiseringsdiagrammet

Regneark i fanen Quantification (Kvantifisering)
Tabell 18 definer dataene som vises i regnearket i fanen Quantification (Kvantifisering).

Informasjon Beskrivelse

Well (Brønn) Brønnposisjon i platen

Fluor (Fluorofor) Fluorofor detektert

Target (Mål) Target Name (Målnavn) som er lastet inn i Plate Editor
(Plateredigering)-brønnene

Content (Innhold) En kombinasjon av Sample Type (Prøvetype) (påkrevd) og Replicate #
(Replikatnr.) (valgfritt) som er lastet inn i Plate Editor (Plateredigering)

Tabell 18. Innhold i regneark med fanen Quantification (Kvantifisering)
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Informasjon Beskrivelse

Sample (Prøve) Sample Name (Prøvenavn) som er lastet inn i Plate Editor
(Plateredigering)-brønnene

Cq Kvantifiseringssyklus for hver kurve

Endre data for mål, innhold eller prøve

Du kan endre dataene i kolonnene Target (Mål), Content (Innhold) og Sample (Prøve) ved å redigere
platefilen ved hjelp av Plate Editor (Plateredigering) selv etter at du har kjørt eksperimentet.

Slik endrer du dataene i kolonnene Content (Innhold), Target (Mål) og Sample (Prøve)

u Klikk på Plate Setup (Plateoppsett) og velg View/Edit Plate (Vis/rediger plate) for å åpne Plate Editor
(Plateredigering).
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Fanen Quantification Data (Kvantifiseringsdata)
Fanen Quantification Data (Kvantifiseringsdata) viser kvantifiseringsdataene samlet i hver brønn.
CFX Maestro Dx SE viser dataene i fire forskjellige regnearkvisninger:

n Results (Resultater) – viser et regneark med dataene. Dette er standardvisningen.

n Standard Curve Results (Resultater for standardkurve) – viser et regneark med
standardkurvedataene.

n Plate – viser dataene i hver brønn som et platekart.

n RFU – viser RFU-kvantitetene i hver brønn for hver syklus.

Velg hvert regneark fra rullegardinmenyen som vises under fanen Quantification Data
(Kvantifiseringsdata).

Regnearket Results (Resultater)
Regnearket Results (Resultater) viser data for hver brønn i platen.

Merknad: Alle beregninger av Std. Dev (Standardavvik) gjelder for replikatgruppene tilordnet i
brønnene i vinduet Plate Editor (Plateredigering). Beregningene finner gjennomsnittet av Cq-verdien
for hver brønn i replikatgruppen.

Tabell 19 definerer dataene som vises i regnearket Results (Resultater).
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Informasjon Beskrivelse

Well (Brønn) Brønnposisjon i platen

Fluor (Fluorofor) Fluorofor detektert

Target (Mål) Navn på amplifiseringsmål (gen)

Content (Innhold) Prøvetype og replikatnummer

Sample (Prøve) Prøvebeskrivelse

Biological Set Name (Navn på
biologisk sett)

Navnet på det biologiske settet

Cq Kvantifiseringssyklus

CqMean (Gjennomsnittlig Cq) Gjennomsnittet av kvantifiseringssyklusen for replikatgruppen

Cq Std. Dev (Standardavvik for
replikatgruppe)

Standardavviket til kvantifiseringssyklusen for replikatgruppen

Starting Quantity (SQ)
(Startkvantitet (SQ))

Estimert startkvantitet av målet

Log Starting Quantity
(Logaritmen til startkvantiteten)

Logaritmen til startkvantiteten

SQMean (Gjennomsnittlig SQ) Gjennomsnittlig startkvantitet

SQ Std. Dev (Standardavvik for
startkvantitet)

Standardavviket til startkvantiteten over replikater

Tabell 19. Innhold i regnearket Results (Resultater)
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Regnearket Standard Curve Results (Resultater for standardkurve)
Regnearket Standard Curve Results (Resultater for standardkurve) viser parametrene for beregnet
standardkurve.

Tabell 20 definerer dataene som vises i regnearket Standard Curve Results (Resultater for
standardkurve).

Informasjon Beskrivelse

Fluor (or Target) (Fluor (eller
mål))

Fluorofor (eller mål) påvist

Efficiency % (Effektivitet %) Reaksjonseffektivitet

Slope (Stigningstall) Stigning for standardkurven

Y-intercept (Y-skjæringspunkt) Punkt der kurven skjærer gjennom y-aksen

R^2 Bestemmelseskoeffisient

Tabell 20. Innhold i regnearket Standard Curve Results (Resultater for standardkurve)
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Fanen Quantification Data (Kvantifiseringsdata)

Regnearket Plate
Regnearket Plate viser et platekart med dataene for én fluorofor om gangen.

Slik viser du data for en bestemt fluorofor

u Klikk på tilhørende fane nederst i regnearket.
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RFU-regnearket
RFU-regnearket viser avlesningene av de relative fluorescensenhetene (RFU) for hver brønn innhentetet
i hver syklus av kjøringen. Brønnummeret vises øverst i hver kolonne, og syklusnummeret vises til
venstre for hver rad.
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Fanen Melt Curve (Smeltekurve)

Fanen Melt Curve (Smeltekurve)
Når det gjelder DNA-bindende fargestoffer og ikke-spaltbare hybridiseringsprober, er fluorescensen
sterkest når de to DNA-trådene hybridiseres. Dette betyr at etter hvert som temperaturen øker opp mot
smeltetemperaturen (Tm), synker fluorescensen med en konstant hastighet (konstant helling). Ved Tm er
det en dramatisk reduksjon i fluorescensen, med en merkbar endring i hellingen. Endringshastigheten
bestemmes ved å plotte den negative første regresjonen av fluorescens kontra temperatur (-d(RFU)/dT).
Den største endringshastigheten i fluorescensen resulterer i synlige topper, og den representerer Tm i
dobbelttrådede DNA-komplekser.

CFX Maestro Dx SE plotter RFU-dataene samlet inn under en smeltekurve som en funksjon av
temperatur. For å analysere smeltetoppdataene tildeler programvaren en start- og sluttemperatur til hver
topp ved å flytte på terskelsøylen. Nedre grense for toppområdet angis av posisjonen til terskellinjen for
smelting. En gyldig topp må ha en minmumshøyde som er relativ til distansen mellom terskelsøylen og
høyden på den høyeste toppen.

Fanen Melt Curve (Smeltekurve) viser Tm (smeltetemperatur) for amplifiserte PCR-produkter i fire
visninger:

n Melt Curve (Smeltekurve) – viser sanntidsdata for hver fluorofor som RFU-er per temperatur for hver
brønn.

n Melt Peak (Smeltetopp) – viser den negative regresjonen til RFU-dataene per temperatur for hver
brønn.

n Well selector (Brønnvelger) – viser brønner for å vise eller skjule dataene.

n Regnearket Peak (Topp) – viser dataene samlet inn i den valgte brønnen.

Merknad: Dette regnearket viser opptil to topper for hver kurve. Klikk på fanen Melt Curve Data
(Smeltekurvedata) for å vise flere topper.
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Tabell 21 definerer dataene som vises i regnearket Melt Curve (Smeltekurve).

Informasjon Beskrivelse

Well (Brønn) Brønnposisjon i platen

Fluor (Fluorofor) Fluorofor detektert

Content (Innhold) En kombinasjon av prøvetype og replikatnummer

Sample (Prøve) Navn på prøve som er lastet inn i Plate Editor (Plateredigering)

Melt Temp
(Smeltetemperatur)

Temperaturen for smeltetoppen for hver brønn

Merknad: Kun de to høyeste toppene vises i dette regnearket.

Tabell 21. Innhold i regnearket Melt Curve (Smeltekurve)
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Fanen Melt Curve (Smeltekurve)

Justere smeltekurvedata
Slik justerer du smeltekurvedata

u Velg en av følgende fremgangsmåter:

n Klikk og dra terskelsøylene i diagrammet Melt Peak (Smeltetopp) for å inkludere eller ekskludere
topper i dataanalysen.

n Velg Positive (Positiv) i rullegardinmenyen Peaks (Topper) for å vise regnearkdataene for
toppene som er over terskellinjen for smelting, eller velg Negative (Negativ) for å vise
regnearkdataene for toppene som er under terskellinjen for smelting.

n Åpne vinduet Trace Styles (Kurvestiler) for å endre fargen på kurvene i diagrammene Melt Curve
(Smeltekurve) og Melt Peak (Smeltetopp).

n Velg et tall i velgeren for Step Number (Trinnummer) for å vise dataene for Melt Curve
(Smeltekurve) i et annet trinn i protokollen. Listen viser mer enn ett trinn hvis protokollen
inkluderer plateavlesninger i mer enn ett smeltekurvetrinn.

n Velg brønner i brønnvelgeren for å fokusere på delsett av dataene.

n Velg en brønngruppe for å vise og analysere et delsett av brønnene i platen. Velg hver
brønngruppe etter navn i rullegardinmenyenWell Group (Brønngruppe) på verktøylinjen.
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Fanen Melt Curve Data (Smeltekurvedata)
Fanen Melt Curve Data (Smeltekurvedata) viser dataene fra Melt Curve-fanen i flere regneark som
inkluderer alle smeltetoppene for hvert spor. CFX Maestro Dx SE har fire regnearkalternativer der du kan
se smeltekurvedataene:

n Melt Peaks (Smeltetopper) – viser alle data, inkludert alle smeltetopper, for hver kurve. Dette er
standardvisningen.

n Plate – viser en oversikt over dataene og innholdet i hver brønn i platen.

n RFU – viser RFU-verdiene ved hver temperatur for hver brønn.

n -d(RFU)/dT – viser den negative endringsraten i RFU etter hvert som temperaturen (T) endres. Dette
er et første regresjonsplott for hver brønn i platen.

Velg hvert regneark fra rullegardinmenyen som vises under fanen Melt Curve Data (Smeltekurvedata).

Regnearket Melt Peaks (Smeltetopper)
Regnearket Melt Peaks (Smeltetopper) viser alle smeltekurvedata.

Tabell 22 på side 231 definerer dataene som vises i regnearket Melt Peaks (Smeltetopper).
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Fanen Melt Curve Data (Smeltekurvedata)

Informasjon Beskrivelse

Well (Brønn) Brønnposisjon i platen

Fluor (Fluorofor) Fluorofor detektert

Content (Innhold) Sample Type (Prøvetype) oppført i vinduet Plate Editor
(Plateredigering)

Target (Mål) Amplifiseringsmål (gen)

Sample (Prøve) Sample Name (Prøvenavn) oppført i vinduet Plate Editor
(Plateredigering)

Melt Temperature
(Smeltetemperatur)

Smeltetemperaturen til hvert produkt, oppført som en topp (høyeste)
per rad i regnearket

Peak Height (Topphøyde) Høyde på toppen

Begin Temperature
(Starttemperatur)

Temperatur på begynnelsen av toppen

End Temperature (Sluttemperatur) Temperatur på slutten av toppen

Tabell 22. Innhold i regnearket Melt Peaks (Smeltetopper)

Regnearket Plate
Regnearket Plate viser smeltekurvedata i et plateformat.

Merknad: For å justere toppen som programvaren kaller, justerer du terskellinjen i diagrammet Melt
Peak (Smeltetopp) i fanen Melt Curve (Smeltekurve).

Tabell 23 på side 232 definerer dataene som vises i regnearket Plate.
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Informasjon Beskrivelse

Innhold Kombinasjon av Sample Type (Prøvetype) (påkrevd) og Replicate # (Replikatnr.)
(valgfritt)

Prøve Prøvebeskrivelse

Peak 1 (Topp 1) Første smeltetopp (høyeste)

Peak 2 (Topp 2) Andre smeltetopp (lavere)

Tabell 23. Innhold i regnearket Plate

RFU-regnearket
RFU-regnearket viser fluorescensen for hver brønn ved hver syklus hentet under smeltekurven.

Tabell 24 definerer dataene som vises i regnearket RFU.

Informasjon Beskrivelse

Brønnnummer (A1, A2, A3, A4, A5) Brønnposisjon i platen for brønnene som er
lastet inn

Temperature (Temperatur) Smeltetemperaturen til det amplifiserte målet,
plottet som én brønn per rad og flere brønner for
flere produkter i den samme brønnen

Tabell 24. Innhold i regnearket RFU
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Fanen Melt Curve Data (Smeltekurvedata)

Regnearket -d(RFU)/dT
Regnearket -d(RFU)/dT viser den negative endringshastigheten i RFU etter hvert som temperaturen (T)
endres.

Tabell 25 definerer dataene som vises i regnearket -d(RFU)/dT.

Informasjon Beskrivelse

Brønnnummer (A1, A2, A3, A4, A5) Brønnposisjon i platen for brønnene som er lastet inn

Temperature (Temperatur) -d(RFU)/dT Negativ endringshastighet i RFU etter hvert som
temperaturen (T) endres

Tabell 25. Innhold i regnearket -d(RFU)/dT
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Fanen End Point (Endepunkt)
Åpne fanen End Point (Endepunkt) for å analysere endelige relative fluorescence-enheter (RFU-er) for
prøvebrønnene. Programvaren sammenligner RFU-nivåene for brønner med ukjente prøver med RFU-
nivåene for brønner med negative kontroller og «kaller» den ukjente positiv eller negativ. Positive prøver
har en RFU-verdi som er høyere enn den gjennomsnittlige RFU-verdien til den negative kontrollen pluss
cutoff-verdien.

For å analysere endepunktdataene må platen inneholde negative kontroller, ellers kan ikke programvaren
foreta bestemmelsen.

n Kjør en Quantification (Kvantifisering)-protokoll – sett opp en standardprotokoll. Når kjøringen er
fullført, åpner du vinduet Data Analysis (Dataanalyse), justerer innstillingene for dataanalyse i fanen
Quantification (Kvantifisering) og klikker deretter på fanen End Point (Endepunkt) for å velge en
endepunktsyklus.

n Kjør en End Point Only (Kun endepunkt)-protokoll – last inn protokollen End Point Only (Kun
endepunkt) i fanen Plate i vinduet Run Setup (Kjøringsoppsett), velg eller opprett en plate og start
kjøringen.
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Fanen End Point (Endepunkt)

Fanen End Point (Endepunkt) viser de gjennomsnittlige RFU-verdiene for å bestemme ommålet ble
amplifisert ved den siste (ende)syklusen. Bruk disse dataene til å bestemme om en bestemt målsekvens
er tilstede (positiv) i en prøve. Positive mål har høyere RFU-verdier enn cutoff-nivået du definerer.

Tips: Når du vil opprette en endepunktprotokoll må du åpne fanen Protocol (Protokoll) (vinduet Run
Setup (Kjøringsoppsett)) og velge Run > End Point Only Run (Kjør > Kjøring av kun endepunkt).

Når kjøringen er fullført, åpnes datafilen i fanen End Point (Endepunkt), som består av følgende deler:

n Settings (Innstillinger) – justerer innstillinger for dataanalyse.

n Results (Resultater) – viser resultatene umiddelbart etter at du har justert innstillingene.

n Well Selector (Brønnvelger) – velger brønnene med endepunktdataene du vil vise.

n RFU-regneark – viser ende-RFU innsamlet i de valgte brønnene.

Resultatdata
Delen Results (Resultater) viser følgende data:

n Lowest RFU value (Laveste RFU-verdi) – laveste RFU-verdi i dataene

n Highest RFU value (Høyeste RFU-verdi) – høyeste RFU-verdi i dataene

n Negative Control Average (Gjennomsnitt av negative kontroller) – gjennomsnittlig RFU for brønnene
som inneholder negative kontroller

n Cut Off Value (Cutoff-verdi) – beregnes ved å legge til toleransen (RFU eller Percentage of Range
(Prosent av område) oppført i Settings (Innstillinger)) og gjennomsnittet av de negative kontrollene.
Prøver med RFU-er som er større enn grenseverdien, vil bli kalt "Positive". For å justere cutoff-
verdien, endrer du RFU eller prosent av område

Cutoff-verdien beregnes med denne formelen:

Cutoff-verdi = gjennomsnitt av negative kontroller + toleranse

Velg en toleranse ved hjelp av én av disse metodene:

n RFUs (RFU-er) (standard) – velg denne metoden hvis du vil bruke en absolutt RFU-verdi for
toleransen. Minimum RFU-toleranseverdi er 2. Maksimum er den absolutte verdien av den høyeste
RFU-verdien minus den absolutte verdien av den laveste RFU-verdien. Standard RFU-
toleranseverdi er 10 % av det totale RFU-området.

n Percent of Range (Prosent av område) – velg denne metoden hvis du vil bruke en prosent av RFU-
området for toleransen. Minimum prosent av området er 1 %. Maksimum prosent av området er 99
%. Standard prosent av området er 10 %.
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Justere analysen av endepunktsdata
Slik justerer du dataene i fanen End Point (Endepunkt)

u Velg en av følgende fremgangsmåter:

n Velg en fluorofor fra rullegardinmenyen.

n Velg en verdi for End Cycle to Average (Endesykluser som brukes til å finne gjennomsnitt) for å
angi antall sykluser som skal brukes til å beregne gjennomsnittlig endepunkt-RFU.

n Velg RFU-er for å vise data i relative fluorescerende enheter.

n Velg Percentage of Range (Prosentvist område) for å vise dataene som en prosentandel av
RFU-området.

n Velg brønner i brønnvelgeren for å fokusere på delsett av dataene.

n Velg en brønngruppe for å vise og analysere et delsett av brønnene i platen. Velg hver
brønngruppe etter navn i rullegardinmenyenWell Group (Brønngruppe) på verktøylinjen.

RFU-regneark for endepunktsanalyse
Tabell 26 definerer dataene som vises i RFU-regnearket i fanen End Point (Endepunkt).

Informasjon Beskrivelse

Well (Brønn) Brønnposisjon i platen

Fluor (Fluorofor) Fluorofor detektert

Content (Innhold) Kombinasjon av prøvetype og replikatnummer

End RFU (Ende-RFU) RFU ved endepunktssyklusen

Call (Bestemmelse) Positive (Positiv) eller Negative (Negativ), der positive prøver har en RFU-
verdi som er større enn gjennomsnittlig RFU for de negative kontrollene pluss
Cut Off Value (Cutoff-verdi)

Sample (Prøve) Sample Name (Prøvenavn) som er lastet inn i Plate Editor (Plateredigering)

Tabell 26. Innhold i RFU-regnearket End Point (Endepunkt)
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Fanen Allelic Discrimination (Allelisk diskriminering)

Fanen Allelic Discrimination (Allelisk diskriminering)
Fanen Allelic Discrimination (Allelisk diskriminering) tilordner genotyper til brønner med ukjente prøver.
Bruk disse dataene til å identifisere prøver med ulike genotyper, inkludert Allele 1 (Allel 1), Allele 2 (Allel
2), Heterozygote (Heterozygot), No Call (no amplification) (Ingen bestemmelse (ingen amplifisering) eller
Undetermined (Ubestemt).

Merknad: Dataene for allelisk diskriminering må komme fra multiplex kjøringer med minst to
fluoroforer. Hver fluorofor identifiserer ett allel i alle prøver.

Allelisk diskriminering krever følgende minimale brønninnhold:

n To fluoroforer i hver brønn

n NTC-prøver (ikke-templatkontroll) for optimert dataanalyse

CFX Maestro Dx SE har fire alternativer for visning av data om allelisk diskriminering:

n Diagram over allelisk diskriminering – viser dataene på en graf over RFU for allel 1 / allel 2. Hvert av
punktene på grafen representerer data fra begge fluoroforer i én brønn. Du kan veksle mellom
kartesiske koordinater og polarkoordinater ved å merke eller fjerne merkingen i avmerkingsboksen
Polar Coordinates (Polarkoordinater). Cartesian Coordinates (Kartesiske koordinater) representerer
RFU for allel 1 på x-aksen og RFU for allel 2 på y-aksen. Polarkoordinater representerer vinkelen på
x-aksen og avstanden mellom origo og RFU på y-aksen (medianen til alle NTC-er).

Brukerhåndbok | 237



Kapittel 11 Detaljer om dataanalyse

n Brønnregneark – viser data for allelisk diskriminering, som er samlet inn i hver av brønnene på
platen.

n Brønnvelger – velger brønnene som har de alleliske dataene du vil vise.

n Panelet Selected Fluorophores (Valgte fluoroforer) – endrer etikettene på x- og y-aksene i
diagrammet for allelisk diskriminering, syklusen som skal analyseres og hvorvidt
bestemmelseskartet skal vises.

Justere data for allelisk diskriminering
Programvaren tilordner automatisk en genotype til brønner med ukjente prøver basert på posisjonene til
NTC-ene samt vinkelen og avstanden til de ukjente datapunktene fra NTC-ene.

Slik justerer du data for allelisk diskriminering

u Velg en av følgende fremgangsmåter:

n Hvis du vil vise polarkoordinater, merker du avmerkingsboksen i diagrammet Allelic
Discrimination (Allelisk diskriminering).

n Hvis du vil vise en annen fluorofor, velger du den fra rullegardinmenyen i panelet Selected
Fluorophores (Valgte fluoroforer).

n Hvis du vil endre en bestemmelse, drar du markøren over ett eller flere datapunkter i
diagrammet Allelic Discrimination (Allelisk diskriminering) og velger et alternativ i listen Selected
Wells (Valgte brønner):

o Allele 1 (Allel 1)

o Allele 2 (Allel 2)

o Heterozygote (Heterozygot)

o Undetermined (Ubestemt)

o No Call (Ingen bestemmelse)

o Auto Call (Automatisk bestemmelse)

Tips: Velg Auto Call (Automatisk bestemmelse) for å gå tilbake til standard bestemmelse.
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Fanen Allelic Discrimination (Allelisk diskriminering)

Menyalternativer for diagrammer
I tillegg til de vanlige alternativene i høyreklikkmenyen for diagrammer (se Vanlige elementer i
høyreklikkmenyen for diagrammer på side 206), viser Tabell 27 menyalternativene som er tilgjengelige for
diagrammet Allelic Discrimination (Allelisk diskriminering).

Menyalternativ Funksjon

Zoom Fokuserer diagramvisningen på det valgte området (ved å klikke og
dra markøren i diagrammet).

Tips: Hvis du vil gjenopprette zoomingen for å vise alle
datapunkter, høyreklikker du og velger Set Scale to Default
(Angi skala til standard).

Well (Brønn) Alternativene for den valgte brønnen er: vis kun denne brønnen,
fjern denne brønnen fra visningen, angi farge for denne kurven og
ekskludere denne brønnen fra analysen.

Selected Wells (Valgte brønner) Alternativene for de valgte brønnene (som velges ved å klikke og dra
markøren i diagrammet) er: vis kun disse brønnene, fjern disse
brønnene fra visningen, angi farge for disse kurvene og ekskluder
disse brønnene fra analysen.

Tabell 27. Alternativer i høyre- og venstreklikkmenyen for diagrammet Allelic Discrimination
(Allelisk diskriminering)

Regnearket Allelic Discrimination (Allelisk diskriminering)
Tabell 28 definerer dataene som vises i regnearket Allelic Discrimination (Allelisk diskriminering).

Informasjon Beskrivelse

Well (Brønn) Brønnposisjon i platen

Sample (Prøve) Navn på prøven

Call (Bestemmelse) Identiteten til allelen, inkludert automatisk Allele 1 (Allel 1), Allele 2
(Allel 2), Heterozygote (Heterozygot), No Call (Ingen bestemmelse)
eller Undetermined (Ubestemt)

Tabell 28. Innhold i regnearket for allelisk diskriminering
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Informasjon Beskrivelse

Type Auto (Automatisk) eller Manual (Manuell) beskriver hvordan
bestemmelsen ble gjort. Automatisk betyr at programvaren valgte
bestemmelsen. Manuell betyr at brukeren valgte bestemmelsen.

RFU1 Relative fluorescensenheter for Allele1 (Allel 1)

RFU2 Relative fluorescensenheter for Allelle2 (Allel 2)

Tabell 28. Innhold i regnearket for allelisk diskriminering, forts.
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Fanen Custom Data View (Tilpasset datavisning)
I fanen Custom Data View (Tilpasset datavisning) vises flere ruter i tilpassbart format samtidig.

Rullegardinmenyen Load a Preset View (Last inn en forhåndsinnstilt visning) inneholder et utvalg av
maler for visningsformater. Standardvisningen avhenger av hvilken fil som analyseres. For eksempel,
hvis det finnes data for Melt Curve (Smeltekurve), vises standardvisningen Amp+Melt.
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Opprette en tilpasset datavisning
Slik oppretter du en tilpasset datavisning

u Velg en av følgende fremgangsmåter:

n Velg en forhåndsinnstilt visning fra rullegardinmenyen.

n Velg en annen diagramvisning fra rullegardinmenyen, som du finner øverst i hver rute.

n Endre antall rader og kolonner i fanen.

n Endre størrelse på hver enkelt rute. Trekk i kantene ytterst på hver av rutene.

Klikk på Save as Preset (Lagre som forhåndsinnstilling) for å lagre tilpasningen som en forhåndsinnstilt
mal. Klikk på Manage Presets (Administrer forhåndsinnstillinger) for å slette, endre navn på eller
gjennopprette eksisterende forhåndsinnstilte visinger.
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Fanen QC (Kvalitetskontroll)
Bruk fanen QC (Kvalitetskontroll) til raskt å vurdere kvaliteten på de kjørte dataene basert på reglene i
QC-fanen i vinduet User Preferences (Brukerpreferanser).

CFX Maestro Dx SE har fire alternativer for visning av QC-data (Kvalitetskontroll):

n Amplification chart (Amplifiseringsdiagram) – viser RFU for hver brønn ved hver syklus. Hver kurve
i diagrammet representerer data fra en fluorofor i én brønn.

n QC rules table (Regeltabell for kvalitetskontroll) – viser de tilgjengelige kvalitetskontrollreglene og
innstillingene som definerer hver regel. Anvendte kvalitetskontrollregler angis med en hake.

n Well selector (Brønnvelger) – velger brønnene med fluorescensdataene du vil vise.

n Sammendragsrute for kvalitetskontrollregel – viser den valgte kvalitetskontrollregelen og uthever
brønner som ikke oppfyller regelen.

Endre kvalitetskontrollkriterier
Slik endrer du kvalitetskontrollkriterier

u Merk eller fjern merket i avmerkingsboksen Use (Bruk) for å inkludere eller ekskludere regelen fra
kvalitetskontrollen.
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Ekskludere brønner som ikke består kvalitetskontroll
CFX Maestro Dx SE viser brønner som ikke består kvalitetskontrollkriterier i kolonnen Results
(Resultater) i tabellen med kvalitetskontrollregler og i sammendragsruten.

Slik ekskluderer du brønner som ikke består kvalitetskontrollkriterier

u Velg Exclude Wells (Ekskludere brønner) for hver brønn som skal ekskluderes.
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Fanen Run Information (Kjøringsinformasjon)

Fanen Run Information (Kjøringsinformasjon)
Fanen Run Information (Kjøringsinformasjon) viser protokollen og annen informasjon om hver kjøring.
Bruk denne fanen til å gjøre følgende:

n Vise protokollen.

n Legge inn eller redigere merknader om kjøringen.

n Legge inn eller redigere ID-en eller strekkoden for kjøringen.

n Vise hendelser som kan ha oppstått under kjøringen. Bruk disse meldingene som en hjelp til
feilsøkingen av en kjøring.

Tips: Høyreklikk i protokollen for å kopiere, eksportere eller skrive den ut. Høyreklikk i rutene Notes
(Merknader), ID/Bar Code (ID/strekkode) eller Other (Annet) for å angre, klippe ut, kopiere, lime inn,
slette eller velge teksten.
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Dataanalyserapporter
Dialogboksen for rapporter viser informasjon om gjeldende datafil i vinduet Data Analysis (Dataanalyse).
Velg Tools > Reports (Verktøy > Rapporter) eller klikk på Reports (Rapporter) på verktøylinjen.

Dialogboksen for rapporter består av følgende deler:

n Meny og verktøylinje – inneholder alternativer for å formatere, lagre og skrive ut rapporten eller
malen.

n Alternativliste (øverst til venstre i dialogboksen) – inneholder alternativer som kan vises i rapporten.

n Alternativrute (nederst til venstre i dialogboksen) – viser tekstbokser hvor du kan legge inn
informasjon om et valgt alternativ.

n Forhåndsvisningsrute (høyre side av dialogboksen) – viser en forhåndsvisning av den gjeldende
rapporten.
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Kategorier for dataanalyserapporter
Tabell 29 viser alle alternativene som er tilgjengelige for en dataanalyserapport, avhengig av typen data i
vinduet Data Analysis (Dataanalyse).

Kategori Alternativ Beskrivelse

Overskrift

Tittel, undertittel og logo for
rapporten

Report Information
(Rapportinformasjon)

Kjøringsdato, brukernavn,
datafilnavn, datafilbane og valgt
brønngruppe

Audit Information
(Revisjonsinformasjon)

Tilleggsinformasjon som kreves
for revisjon, inkludert signaturer

Notes (Merknader) Merknader om datarapporten

Run Setup (Kjøringsoppsett)

Run Information
(Kjøringsinformasjon)

Kjøringsdato, brukernavn,
datafilnavn, datafilbane og valgt
brønngruppe

Protocol (Protokoll) Tekstvisning av protokolltrinn og
-alternativer

Plate Display (Platevisning) Platevisning av informasjonen
for hver brønn i platen

Quantification (Kvantifisering)

Analysis Settings
(Analyseinnstillinger)

Nummer på
datainnsamlingstrinn,
analysemodus og metode for
baselinjesubtraksjon

Amplification Chart
(Amplifiseringsdiagram)

Amplifiseringsdiagram for
kjøringer som inkluderer
kvantifiseringsdata

Tabell 29. Kategorier for dataanalyserapporter i listen over alternativer
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Kategori Alternativ Beskrivelse

Standard Curve Chart
(Standardkurvediagram)

Standardkurvediagram

Data Regneark som inneholder
dataene for hver brønn

Gene Expression (Genuttrykk) – Bar Chart (Søylediagram)

Analysis Settings
(Analyseinnstillinger)

Analysemodus, diagramdata,
skaleringsalternativ og
diagramfeil

Chart (Diagram) Kopi av søylediagrammet

Target Names (Målnavn) Diagrammed målnavn

Sample Names (Prøvenavn) Diagrammed prøvenavn

Data Regneark som inneholder
dataene for hver brønn

Target Stability (Målstabilitet) Diagrammed
målstabilitetsverdier

Box-and-Whisker Chart
(Boksdiagram)

Boksdiagram

Dot Plot Chart
(Punktplottdiagram)

Dot Plot Chart
(Punktplottdiagram)

Gene Expression (Genuttrykk) – Clustergram (Klyngediagram) og Scatter Plot
(Spredningsplott)

Analysis Settings
(Analyseinnstillinger)

Innstillinger for hver
diagramtype

Chart (Diagram) Kopi av diagrammet

Data Regneark som lister opp
dataene i hvert mål

Gene Expression (Genuttrykk) – ANOVA Data (ANOVA-data)

Tabell 29. Kategorier for dataanalyserapporter i listen over alternativer, forts.
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Kategori Alternativ Beskrivelse

ANOVA Settings (ANOVA-
innstillinger)

P-verditerskel som brukes i
analysen

ANOVA Results (ANOVA-
resultater)

Tabell med resultater fra
ANOVA og Tukeys HSD post-
hoc-analyse

Melt Curve (Smeltekurve)

Analysis Settings
(Analyseinnstillinger)

Smeltetrinnummer og innstilling
for terskellinje

Melt Curve Chart
(Smeltekurvediagram)

Smeltekurvediagram

Melt Peak Chart
(Smeltetoppdiagram)

Smeltetoppdiagram

Data Regneark som inneholder
dataene for hver brønn

Allelic Discrimination (Allelisk diskriminering)

Analysis Settings
(Analyseinnstillinger)

Viser fluoroforer, syklus og
bestemmelseskart

Allelic Discrimination Chart
(Allelisk
diskrimineringsdiagram)

Kopi av det alleliske
diskrimineringsdiagrammet

Data Regneark som inneholder
dataene for hver brønn

End Point (Endepunkt)

Analysis Settings
(Analyseinnstillinger)

Fluorofor, gjennomsnitt av
angitte sluttsykluser, modus,
laveste RFU-verdi, høyeste
RFU-verdi og cutoff-verdi

Data Regneark som inneholder
dataene for hver brønn

Tabell 29. Kategorier for dataanalyserapporter i listen over alternativer, forts.
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Kategori Alternativ Beskrivelse

QC Parameters
(Kvalitetskontrollparametere)

Data Regneark som inneholder
parametrene for hver
kvalitetskontrollregel

Tabell 29. Kategorier for dataanalyserapporter i listen over alternativer, forts.
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Opprette en dataanalyserapport
Du kan lagre rapportoppsettet som en mal, som du kan bruke om igjen for lignende rapporter.

Slik oppretter du en dataanalyserapport

1. Gjør de siste justeringene i brønninnhold, valgte brønner, diagrammer og regneark i vinduet Data
Analysis (Dataanalyse) før du oppretter rapporten.

2. Velg Tools > Reports (Verktøy > Rapporter) i menylinjen i Data Analysis (Dataanalyse) for å åpne
dialogboksen Report (Rapport).

3. Velg alternativene du vil inkludere i rapporten. Rapporten åpnes med standardalternativene valgt.
Merk av eller fjern merket i avmerkingsboksene for å endre hele kategorier eller individuelle
alternativer i en kategori.

Tabell 29 på side 247 viser de tilgjengelige alternativene.

Merknad: Dataene som vises i rapporten, avhenger av de aktuelle utvalgene i fanene i vinduet
Data Analysis (Dataanalyse). En kvantifiseringskjøring kan for eksempel ikke inneholde en
standardkurve, og disse dataene vil derfor ikke vises i vinduet Data Analysis (Dataanalyse) eller i
datarapporten.

4. Endre rekkefølgen på kategoriene og elementene i en rapport. Dra alternativene til den relative
posisjonen. Rekkefølgen på elementene kan bare endres innenfor kategoriene de tilhører.

5. (Valgfritt) I ruten Report Options (Rapportalternativer) legger du inn informasjon som er relevant for
det valgte alternativet:

n Velg et delsett med informasjon som skal vises i rapporten.

n Velg spesifikke innstillinger for det valgte alternativet.

n Endre teksten som skal vises for det valgte alternativet.

6. Klikk på Update Report (Oppdater rapport) for å oppdatere Report Preview (Forhåndsvisning av
rapport) med eventuelle endringer.

7. Skriv ut eller lagre rapporten:

a. Klikk på knappen Print Report (Skriv ut rapport) på verktøylinjen for å skrive ut den aktuelle
rapporten.

b. Velg File > Save (Fil > Lagre) for å lagre rapporten som PDF (Adobe Acrobat Reader-fil), MHT
(Microsoft-dokument) eller MHTML (Microsoft-dokument) filformat.

c. Velg et sted der filen skal lagres.

d. Velg File > Save As (Fil > Lagre som) for å lagre rapporten med et nytt navn eller på et nytt sted.
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8. (Valgfritt) Opprett en rapportmal med informasjonen du ønsker. Hvis du vil lagre de gjeldende
rapportinnstillingene i en mal, velger du Template > Save (Mal > Lagre) eller Save As (Lagre som).
Deretter laster du inn rapportmalen neste gang du vil lage en ny rapport.
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Opprette Well Group Reports (Brønngrupperapporter)
Slik oppretter du en brønngrupperapport

1. Velg Tools > Well Group Reports (Brønngrupperapporter) i vinduet Data Analysis (Dataanalyse).

2. I dialogboksenWell Group Reports (Brønngrupperapporter) velger du brønngruppene,
amplifiseringstrinnene og smeltetrinnene som skal inkluderes i rapporten.

3. Angi banen eller naviger til målmappen der rapporten skal lagres.

4. (Valgfritt) Velg Choose a Report Template (Velg en rapportmal) og naviger til mappen med malfilen.

5. (Valgfritt) Velg Open Destination Folder (Åpne målmappe) for å åpne mappen og vise rapportene når
de har blitt generert.

6. Klikk på Create Reports (Opprett Rapporter).
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Kapittel 12 Analyse av genuttrykk
Når du bruker grundig kvalifiserte kontroller i reaksjonene, kan du bruke CFX Maestro Dx-programvare,
Security Edition til å utføre en genuttrykkskjøring til å normalisere de relative differansene i en
målkonsentrasjon blant prøver. Uttrykksnivåer for ett eller flere referansegener brukes vanligvis til å
normalisere uttrykksnivåene i et interessegen. Referansegener tar hensyn til innlastingsforskjeller eller
andre variasjoner som finnes i hver prøve, og uttrykksnivåene skal ikke bli påvirket i det biologiske
systemet som undersøkes.

Velg fanen Gene Expression (Genuttrykk) i vinduet Data Analysis (Dataanalyse) for å evaluere relative
differanser mellom PCR-reaksjoner i to eller flere brønner. Du kan for eksempel evaluere relative antall av
virale genomer eller relative antall av transfekterte sekvenser i en PCR-reaksjon. Det vanligste
bruksområdet for studier av genuttrykk er sammenligning av cDNA-konsentrasjon i mer enn én reaksjon
for å estimere nivået av messenger-RNA («budbringer-RNA») i likevektstilstand.

Programvaren beregner det relative uttrykksnivået til et mål med ett av disse scenarioene:

n Relativt uttrykksnivå for en målsekvens (mål 1) i forhold til et annet mål (mål 2), som for eksempel
mengden av ett gen i forhold til et annet gen under samme prøvebehandling.

n Relativt uttrykksnivå for en målsekvens i en prøve sammenlignet med sammemål under forskjellig
prøvebehandling, for eksempel den relative mengden av ett gen i forhold til seg selv under
forskjellige tidsmessige, geografiske eller utviklingsmessige forhold.

Plateoppsett for analyse av genuttrykk
For utføring av analyse av genuttrykk må innholdet i brønnene inneholde følgende:

n To eller flere mål – de to målene som representerer forskjellige amplifiserte gener eller sekvenser i
prøvene.

n Ett eller flere referansemål – minst ett mål må være et referansemål for normalisert uttrykk. Tilordne
alle referansemål i vinduet Experiment Settings (Eksperimentinnstillinger) til å analysere dataene i
modusen Normalized Expression (Normalisert uttrykk) (ΔΔCq). Kjøringer som ikke inneholder en
referanse, må analyseres ved bruk av modusen Relative Expression (Relativt uttrykk) (ΔCq).

n Felles prøver – reaksjonene må inkludere felles prøver (minst to er obligatorisk) for å vise dataene
plottet i fanen Gene Expression (Genuttrykk). Disse prøvene skal representere ulike behandlinger
eller betingelser for hver av målsekvensene. Tilordne en kontrollprøve (valgfritt) i vinduet Experiment
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Settings (Eksperimentinnstillinger). Hvis du ikke velger en kontroll, bruker programvaren den laveste
Cq som kontrollen.

Kravene for oppsett av Gene Expression (Genuttrykk) i Plate Editor (Plateredigering) avhenger av om
reaksjonsinnholdet er enkeltpleks PCR, med én fluorofor i reaksjonene, eller multipleks PCR, med mer
enn én fluorofor i reaksjonene.

Guidet plateoppsett
Hvis plateoppsettet av en datafil ikke inneholder informasjonen som trengs for analyse, og fanen Gene
Expression (Genuttrykk) velges, vil plassen som vanligvis inneholder søylediagrammet, vise instruksjoner
for å legge inn denne informasjonen. Utfør følgende trinn for normalisert genuttrykk:

1. Definer navn på Target (Mål) og Sample (Prøve) ved å bruke ett av følgende:

n Plate Setup (Plateoppsett) – åpner vinduet Plate Editor (Plateredigering).

n Replace Plate File (Erstatt platefil) – åpner dialogboksen for valg av plate, der du kan navigere til
en tidligere lagret platefil som du vil skal erstatte det gjeldende plateoppsettet.

n Replace PrimePCR File (Erstatt PrimePCR-fil) – åpner dialogboksen for valg av PrimePCR-fil,
hvor du kan navigere til en PrimePCR-kjøringsfil og bruke den i plateoppsettet.

2. Velg ett eller flere referansemål og en kontrollprøve via dialogboksen Experiment Settings
(Eksperimentinnstillinger).

Hvis plateoppsettet allerede inneholder informasjon ommål og prøve, behøver du kun utføre det
andre trinnet, og dette er merket i oransje. Dette trinnet må utføres før analyse av normalisert
genuttrykk kan forekomme.

Merknad: Data for spredningsplott og klyngediagram vises kun dersom alle kravene for
normalisert genuttrykk er oppfylt. Disse kravene står oppført under Plate Setup (Plateoppsett)
for Gene Expression Analysis (Genuttrykksanalyse).
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Diagrammer for genuttrykk
CFX Maestro Dx SE viser genuttrykksdata i flere visninger. Tabell 30 viser tilgjengelige
diagramalternativer i programvaren.

Knapp Navn Funksjon

Graphing (Graf) Viser data for normalisert genuttrykk i én av
følgende visninger:

n Bar Chart (Søylediagram) (standard)

n Box andWhisker Chart (Boksdiagram)

n Dot Plot Chart (Punktplottdiagram)

Clustergram (Klyngediagram) Viser dataene for normalisert uttrykk i et hierarki
basert på graden av likhet i uttrykket for ulike
mål og prøver.

Scatter Plot (Spredningsplott) Viser det normaliserte måluttrykket for en
kontroll sammenlignet med en eksperimentell
prøve.

ANOVA Viser resultatene av enveis ANOVA i
genuttrykksdata ved bruk av følgende R-pakker
for å utføre ANOVA og fastslå Tukey-resultater:

n Companion to Applied Regression (car)

n Minste kvadraters metode (lsmeans)

Verktøyet Reference Gene
Selection (Valg av referansegen)

(Tilgjengelig på Study Analysis (Studieanalyse)-
fanen i Gene Study (Genstudie)-vinduet)
Identifiserer de testede referansegenene og
kategoriserer dem som Ideal (Ideelle),
Acceptable (Akseptable) eller Unstable
(Ustabile) basert på stabiliteten deres.

PrimePCR Controls Analysis
(Analyse av PrimePCR-
kontroller)

(Tilgjengelig på Study Analysis (Studieanalyse)-
fanen i Gene Study (Genstudie)-vinduet) Viser
resultatene for de testede prøvene.

Tabell 30. Alternativer for diagrammer for genuttrykk
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Graphing (Graf)

Det relative måluttrykket presenteres i disse to visningene:

n Genuttrykksdiagram – viser PCR-data i sanntid som ett av følgende:

o ΔΔCq – relativt normalisert uttrykk beregnet ved bruk av kontrollprøver og referansemål.

o ΔCq – relativ mengde av målgenet i en prøve sammenlignet med en kontrollprøve.

Se Endre og anmerke diagramvisningen på side 260 for mer informasjon om visning av data.

n Spreadsheet (Regneark) – viser et regneark med genuttrykksdataene.

Tips: Høyreklikk på et diagram eller regneark for alternativer. Velg View/Edit Plate (Vis/rediger
plate) fra rullegardinmenyen Plate Setup (Plateoppsett) for å åpne Plate Editor (Plateredigering)
og endre brønninnholdet i platen.

Tips: Velg Sort (Sorter) fra høyreklikkmenyen for å endre rekkefølgen for Target (Mål)- og
Sample (Prøve)-navn i diagrammet.

Normalisert genuttrykk

Data normaliseres ved å bruke det målte uttrykksnivået til én eller flere referansegener som
normaliseringsfaktor. Referansegener er mål som ikke er regulert i det biologiske systemet som
undersøkes, som f.eks. aktin,GAPDH eller tubulin.
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Slik setter du opp analyse med normalisert genuttrykk (ΔΔCq)

1. Åpne en datafil (av filtypen .pcrd).

2. Se gjennom dataene i fanen Quantification (Kvantifisering) i vinduet Data Analysis (Dataanalyse).
Juster dataene, som f.eks. endre terskel og analysemodus.

3. Lukk fanen Gene Expression (Genuttrykk).

4. Klikk på Experiment Settings (Eksperimentinnstillinger) i fanen Gene Expression (Genuttrykk).

5. I dialogboksen Experiment Settings (Eksperimentinnstillinger) gjør du følgende:

a. Lukk fanen Samples (Prøver), og velg en kontroll. Når en kontroll tilordnes, normaliserer
CFX Maestro Dx SE den relative kvantiteten for alle gener til kontrollkvantiteten, som er satt til 1.

b. Lukk fanen Target (Mål), og velg referansegener. Analyse av genuttrykk krever én referanse
blant målene i prøvene.

6. Velg Normalized Expression (Normalisert uttrykk) (ΔΔCq) hvis det ikke allerede er valgt, og vis
deretter uttrykksnivåene i fanen Gene Expression (Genuttrykk).

Merknad: Du kan også bruke Setup Wizard (Oppsettsveiviser) til å sette opp plateoppsettet for
analyse av normalisert gensett.

Relativ kvantitet

Relative kvantitetsdata (ΔCq) blir per definisjon ikke normalisert. Denne metoden brukes til å kvantitere
prøver som ikke inkluderer noen referansegener (mål). Vanligvis er forskere sikre på én av følgende
vurderinger når de setter opp kjøringen:

n Hver prøve inneholder sammemengde RNA eller cDNA i hver brønn.

n Enhver varians i mengden biologisk prøve som lastes inn, vil bli normalisert etter kjøringen med en
metode i dataanalysen utenfor programvaren. En forsker kan for eksempel velge å dividere den
relative kvantitetsverdien med normaliseringsfaktoren, muligens massen av nukleinsyre lastet inn for
hver prøve, eller antallet celler som nukleinsyren ble isolert fra.

Slik kjører du en relativ kvantitetsanalyse (ΔCq)

u I fanen Gene Expression (Genuttrykk) velger du Relative Quantity (Relativ kvantitet) (ΔCq) fra
rullegardinmenyen Mode (Modus) i høyre rute.

Tips: Hvis du vil sammenligne resultater med data fra andre genuttrykkskjøringer, åpner du en
ny genstudie eller legger til en datafil i en eksisterende genstudie.
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Endre og anmerke diagramvisningen
Ved å bruke kommandoene på diagramverktøylinjen og diagramverktøy for dataanalyse kan du endre
diagramvisningen og kommentere hvert diagram. Diagramverktøylinjen vises mellom diagrammet og
dataanalyseregnearket nederst på skjermen.

Chart Toolbar Tools (Diagramverktøy på verktøylinjen)

Tips: Se Diagrammer på side 198 for informasjon om diagramverktøyene som vises til høyre for
dataanalysediagrammene.

Verktøylinjen under diagrammene gir hurtig tilgang til anmerkningsverktøyer.

Tabell 31 lister opp funksjonene til knappene i diagramverktøylinjen.

Knapp Navn Funksjon

Bar Chart
(Søylediagram)

Viser det relative uttrykket av målene.

Box andWhisker Chart
(Boksdiagram)

Viser data som kvartilområder (se Beregninger for
boksdiagram på side 296 for detaljer om beregninger).

Merknad: Kun tilgjengelig hvis Analyze Using (Analyser
ved hjelp av) er satt til Biological Groups Only (Kun
biologiske grupper).

Dot Plot Chart
(Punktplottdiagram)

Viser de individuelle prøvedatapunktene for hvert mål.
Merk: Kun tilgjengelig hvis Analyze Using (Analyser ved
hjelp av) er satt til Biological Groups Only (Kun biologiske
grupper).

Add Arrow (Legg til pil) Tegner en pil på det aktive diagrammet.

Add Circle (Legg til sirkel) Tegner en sirkel på det aktive diagrammet.

Add Text (Legg til tekst) Setter inn en tekstboks i det aktive diagrammet, der du kan
legge inn tekst for å identifisere interessante elementer i
diagrammet.

Tabell 31. Diagramverktøylinje
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Knapp Navn Funksjon

Undo (Angre) Fjerner eller reverterer den siste anmerkningen utført på
det aktive diagrammet.

Redo (Gjør om) Reverterer den siste Undo (Angre)-handlingen som ble
utført på det aktive diagrammet.

Clear All (Fjern alle) Fjerner alle anmerkninger på det aktive diagrammet.

Tabell 31. Diagramverktøylinje, forts.

Sortere måldata, prøvedata og data om biologisk gruppe

Merknad: Dette alternativet er kun tilgjengelig for genuttrykksdiagrammer.

Som standard vises listene Targets (Mål), Samples (Prøver) og Biological Groups (Biologiske grupper) i
alfabetisk rekkefølge. Bruk dialogboksen Sort (Sorter) for å sortere visningen i omvendt alfabetisk
rekkefølge eller for manuelt å flytte et begrep til en annen plassering på listen.

For å sortere måldata, prøvedata og data om biologisk gruppe

1. Klikk på Sort (Sortere) i diagramverktøyene.

Dialogboksen Gene Expression Chart Sorting (Sortering i genuttrykksdiagram).

2. Klikk på Z-A i dialogboksen for å sortere listen i omvendt alfabetisk rekkefølge.

3. Hvis du vil flytte et begrep manuelt, velger du begrepet og klikker på den relevante knappen mellom
diagrammene:

n Klikk på pil opp eller pil ned for å flytte det valgte begrepet én posisjon.
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n Klikk på pil opp- eller pil ned-rullefeltet for å flytte det valgte begrepet til øverste eller nederste
posisjon på listen.

4. Klikk på OK for å lagre endringene og gå tilbake til fanen Gene Expression (Genuttrykk).
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Endre fargeinnstillinger for mål, prøve og biologisk gruppe

Bruk dialogboksen Color Settings (Fargeinnstillinger) for å endre fargen på et mål, en prøve eller biologisk
gruppe, eller for å fjerne elementet fra grafen.

Slik endrer du fargeinnstillinger for målet

1. Kontroller at Sample (Prøve) vises i X-aksens rullegardinmeny i høyre rute i dialogboksen Gene
Expression (Genuttrykk).

2. Velg Color Settings (Fargeinnstillinger) i Chart Tools (Diagramverktøy).

Dialogboksen Color Settings (Fargeinnstillinger) vises.

3. Hvis du vil endre visningsfargen for et mål, klikk på fargen i kolonnen Color (Farge).

4. I dialogboksen Color (Farge) som vises, velger du en ny farge og klikker på OK.

5. Hvis du vil fjerne et mål fra genuttrykksgrafen, fjerner du merket i avmerkingsboksen i kolonnen Show
Chart (Vis diagram).

Tips: Hvis du vil fjerne alle mål, fjerner du merket i Show Chart (Vis diagram) i
kolonneoverskriften.

6. (Valgfritt) Søylene vises i heldekkende farger som standard. Hvis du vil vise søylene i graderte farger,
fjerner du merket i Use Solid Colors (Bruk heldekkende farger).

7. Klikk på OK for å lagre endringene og gå tilbake til fanen Gene Expression (Genuttrykk).

Slik endrer du fargeinnstillinger for prøven eller den biologiske gruppen

1. Kontroller at Target (Mål) vises i X-aksens rullegardinmeny i høyre rute i dialogboksen Gene
Expression (Genuttrykk).

2. Utfør trinnene i Slik endrer du fargeinnstillinger for målet på side 263.

Endre diagramvisningen

Slik endrer du gjeldende diagramvisning

u Velg menykommandoen for ønsket visning på verktøylinjen.

Merknad: Fanen Gene Expression (Genuttrykk) åpnes alltid med dataene i standard
søyediagramvisning.
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Ekskludere avvikende datapunkter

I punktdiagrammet kan du enkelt vise og ekskludere avvik fra analysen.

Slik ekskluderer du avvikende datapunkter

u Høyreklikk på ønsket avvik i punktdiagrammet, og velg Exclude Well from Analysis (Ekskluder brønn
fra analysen).

Datapunktet fjernes fra punktdiagrammet, og brønnen blir grå i Well Selector (Brønnvelger) i fanen
Quantification (Kvantifisering).

Slik inkluderer du et ekskludert avvikende datapunkt

u I fanen Quantification (Kvantifisering) høyreklikker du på brønnen i Well Selector (Brønnvelger), og
deretter velger du Well > Include in Analysis (Brønn > Inkluder i analysen).

Vise informasjon om datapunkter

Slik viser du informasjon om datapunkter

u Sett markøren på et individuelt datapunkt i bokstegningsdiagrammet eller punktdiagrammet.

Det vises et verktøytips, der du ser prøvenavnet og prøvens uttrykk (relativ kvantitet eller normalisert
uttrykk, avhengig av valgt modus).

Anmerke diagrammer

Du kan legge til piler, sirkler og tekst i hver søylediagramvisning for å kommunisere data tydelig.
Anmerkningene lagres sammen med søylediagrammet, og vises i den eksporterte og trykte filen.
Anmerkninger som gjøres i en diagramvisning, blir imidlertid ikke lagt til i andre diagramvisninger.

Slik tegner du en pil eller sirkel på diagrammet

1. Klikk på ønsket verktøy på verktøylinjen i søylediagrammet.

2. Klikk på søylediagrammet og dra markøren over diagrammet etter behov.
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Slik legger du til tekst i diagrammet

1. Klikk på Add Text (Legg til tekst) på verktøylinjen i søylediagrammet.

2. Klikk på søylediagrammet. En tekstboks vises på stedet.

3. Legg til tekst i tekstboksen.

4. Klikk hvor som helst på diagrammet for å lukke tekstboksen.

Tips: Trykk på Enter for å legge til flere linjer i tekstboksen.

Slik flytter du en anmerkning

1. Hold markøren over anmerkningen. Ikonet endres til en pekefinger, og kantlinjen rundt
anmerkningen utheves.

2. Klikk på anmerkningen og dra den til en annen posisjon.

3. Slipp anmerkningen for å feste den på plass.

Slik angrer du en anmerkning

u Klikk på Undo (Angre).

Anmerkningen som ble lagt til sist, fjernes.

Tips: Du kan angre de ti nyeste anmerkningene, én om gangen.

Slik gjør du om en anmerkning

u Klikk på Redo (Gjør om).

Anmerkningen som ble fjernet sist, kommer tilbake.

Tips: Du kan gjøre om de ti nyeste anmerkningene, én om gangen.

Slik sletter du en anmerkning

u Høyreklikk på anmerkningen og velg Delete (Slett).
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Justere genuttrykksdata
Når du har valgt analysemodus, normalisert uttrykk (∆∆Cq) eller relativ kvantitet (∆Cq), justerer du
dataene som vises i fanen Gene Expression (Genuttrykk) ved å endre innstillingsalternativene til høyre for
diagrammet .

Tips: Du angir standard dataalternativer for Gene Expression (Genuttrykk) i dialogboksen User
Preferences (Brukerpreferanser) (se Angi standardparametere for datafil for genuttrykk på side 90).

Diagramdata

Angi verdien for Y-aksen til Linear (Lineær) skala for å aktivere alternativer for diagramdata. Alternativer
for diagramdata gir deg mulighet til å presentere dataene i diagrammet ved bruk av ett av disse
alternativene:

n Relative to control (Relativ til kontroll) – fremstill dataene grafisk med aksen skalert fra 0 til 1. Hvis du
tilordner en kontroll i kjøringen, velger du dette alternativet for raskt å visualisere opp- og
nedregulering av målet.

n Relative to zero (Relativ til null) – fremstill dataene grafisk med origo på null.

Analyze Using (Analyser ved bruk av)

Bruk rullegardinmenyen for å velge hvordan data blir analysert og plottet. Alternativene er:

n Samples Only (Kun prøver) – data blir analysert og plottet per prøve.

n Biological Groups Only (Kun biologiske grupper) – data blir analysert og plottet for biologiske
grupper. Uttrykket som vises for den biologiske gruppen, er det geometriske gjennomsnittet for
prøvene i den gruppen.

n Sample Biological Group (Prøve, biologisk gruppe) – data blir analysert og plottet per prøve, med den
biologiske gruppen lagt til etter prøvenavnet. De viste P-verdiene blir beregnet ut fra den biologiske
gruppen.

n Biological Group Sample (Biologisk gruppe, prøve) – data blir analysert og plottet per prøve, med den
biologiske gruppen lagt til før prøvenavnet. De viste P-verdiene blir beregnet ut fra den biologiske
gruppen.

Bruk rullegardinmenyen for å velge en prøve som skal brukes til å normalisere relativ kvantitet:

Annotate P-Values (Anmerk P-verdier) og P-Value Threshold (P-verditerskel)

Når Annotate P-Values (Anmerk P-verdier) er valgt, viser programvaren en stjerne (*) på
søylediagrammet over et mål dersommålets P-verdi er under den valgte terskelen. Programvaren
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beregner P-verdien automatisk ved å sammenligne prøvens uttrykksnivå med den valgte kontrollprøvens
uttrykksnivå ved bruk av en standard t-test. Området for P-verditerskelen er 0,000–1,000.

Alternativer for x-akse

Med X-Axis Option (Alternativ for x-akse) kan du velge x-aksedata for diagrammet Gene Expression
(Genuttrykk):

n Target (Mål) – plotter målnavnene på x-aksen.

n Sample (Prøve) – plotter prøvenavnene på x-aksen.

Alternativer for y-akse

Med alternativet for y-akse kan du vise diagrammet Gene Expression (Genuttrykk) i én av disse tre
skalaene:

n Linear (Lineær) – velg dette alternativet for å vise en lineær skala.

Tips: Hvis du setter y-aksen til Linear (Lineær), aktiveres rullegardinmenyen Graph Data
(Grafdata), der du kan velge å vise data i forhold til kontroll eller i forhold til null.

n Log 2 – velg dette alternativet for å evaluere prøver over et stort dynamisk område.

n Log 10 – velg dette alternativet for å evaluere prøver over et svært stort dynamisk område.

Alternativer for skalering

Velg Normalized Gene Expression (Normalisert genuttrykk) (ΔΔCq) og still til None (Ingen) for å aktivere
alternativene for skalering i diagrammet Gene Expression (Genuttrykk). Velg ett av disse
skaleringsalternativene for å beregne og presentere dataene på en måte som best passer til kjøringens
design:

n Unscaled (Ikke skalert) – viser det ikke-skalerte normaliserte genuttrykket.

n Highest (Høyest) – skalerer det normaliserte genuttrykket for hvert mål ved å dele uttrykksnivået til
hver prøve på det høyeste uttrykksnivået i alle prøvene.

Dette skaleringsalternativet bruker skalert-til-høyest-formelen.

n Lowest (Lavest) – skalerer det normaliserte genuttrykket for hvert mål ved å dele uttrykksnivået til
hver prøve på det laveste uttrykksnivået i alle prøvene.

Dette skaleringsalternativet bruker skalert-til-lavest-formelen.

n Average (Gjennomsnitt) – skalerer det normaliserte genuttrykket for hvert mål ved å dele
uttrykksnivået til hver prøve på den geometriske middelverdien til uttrykksnivåene for alle prøvene.

Dette skaleringsalternativet bruker skalert-til-gjennomsnitt-formelen.
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Velg et alternativ for typen feilberegninger (feilsøyler) i Gene Expression (Genuttrykk)-diagrammet:

Multiplikator for feilsøyler i diagram

Velg en multiplikator for feilsøylene i diagrammet Gene Expression (Genuttrykk). Velg ett av disse
heltallene:

n +/- 1 (standard)

n 2

n 3

Typen multiplikator endres når du velger feillinje:

n SEMs for standard error of the mean (SEMs for standardfeil for gjennomsnittet)

n Std Devs for standard deviations (Std Devs for standardavvik)

Eksperimentinnstillinger
Tips: Denne dialogboksen er også tilgjengelig i Plate Editor (Plateredigering). Hvis du vil ha mer
informasjon, se Endre eksperimentinnstillinger på side 148.

I dialogboksen Experiment Settings (Eksperimentinnstillinger) kan du vise eller endre listen med mål,
prøver eller biologiske grupper, velge referansegener, velge kontroller eller angi genuttrykksanalyse-
gruppen som skal analyseres hvis du har lagt til biologiske grupper for brønnene.

Slik åpner du dialogboksen Experiment Settings (Eksperimentinnstillinger)

u I fanen Graphing (Graf) klikker du på Experiment Settings (Eksperimentinnstillinger) nederst i høyre
rute.

Dialogboksen Experiment Settings (Eksperimentinnstillinger) åpnes i fanen Targets (Mål).

Slik justerer du innstillingene for Targets (Mål)

u Velg en av følgende fremgangsmåter i fanen Targets (Mål):

n Hvis du vil velge et mål som en referanse for genuttrykksdataanalyse, velger du navnet i
kolonnen Reference (Referanse).

n Hvis du vil endre målets farge, klikker du på tilhørende celle i kolonnen Color (Farge) og endrer
fargen i dialogboksen Color (Farge) som vises.

Fargeendringen vises i diagrammene Gene Expression (Genuttrykk).
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n Hvis du vil bruke en tidligere bestemt effektivitetsverdi, fjerner du merket i målets
avmerkingsboks i kolonnen Auto Efficiency (Automatisk effektivitet) og legger inn et tall for
effektivitetsprosenten til et mål.

Programvaren beregner den relative effektiviteten for et mål ved hjelp av Auto Efficiency
(Automatisk effektivitet) hvis dataene for et mål inkluderer en standardkurve.

Slik endrer du innstillingene for Sample (Prøve)

u Velg en av følgende fremgangsmåter i fanen Samples (Prøver):

n Hvis du vil velge en prøve som kontroll for genuttrykksdataanalyse, velger du navnet i kolonnen
Control (Kontroll).

n Hvis du vil endre farge på prøvegruppen, klikker du på tilhørende celle i kolonnen Color (Farge)
og endrer fargen i dialogboksen Color (Farge) som vises.

Fargeendringen vises i diagrammene Gene Expression (Genuttrykk).

n Hvis du vil vise prøven i diagrammene Gene Expression (Genuttrykk), velger du den i kolonnen
Show Chart (Vis diagram).

n Hvis du vil fjerne prøven fra diagrammene Gene Expression (Genuttrykk), fjerner du merket i
avmerkingsboksen i kolonnen Show Chart (Vis diagram).

Tips: Data for prøvegruppen blir værende i tabellen Results (Resultater).

Slik ekskluderer du en prøvetype fra analyseberegninger

u Merk tilhørende avmerkingsboks nederst i dialogboksen Experiment Settings
(Eksperimentinnstillinger).

Merknad: Dette vil ekskludere kontroller og/eller standarder fra genuttrykksanalysen.

Alternativer i høyreklikkmenyen
Høyreklikk på genuttrykksdiagrammet for å velge elementene vist i Tabell 32.

Element Funksjon

Copy (Kopier) Kopierer diagrammet til utklippstavlen.

Save Image As (Lagre bilde
som)

Lagrer diagrammet som en bildefil. Angi oppløsning og størrelse for
bildet, og velg deretter filtype (PNG, JPG, eller BMP).

Tabell 32. Elementer på høyreklikkmenyen for genuttrykk
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Element Funksjon

Page Setup (Sideoppsett) Velger et sideoppsett for utskrift.

Print (Skriv ut) Skriver ut diagrammet.

Set Scale to Default (Angi skala
til standard)

Show All (Vis alle) viser alle data i søylediagrammet. Scroll Bar
(Rullefelt) viser et rullefelt hvis det er for mange prøver å vise innenfor
diagrammets ramme og samtidig opprettholde en minimumsbredde på
søylene.

Diagraminnstillinger Åpner vinduet Chart Settings (Diagraminnstillinger) for justering av
grafen.

Sort (Sorter) Sorterer rekkefølgen på prøvene eller målene som vises på
diagrammets X-akse.

Use Corrected Std Devs (Bruk
korrigerte standardavvik)

Beregner feilsøylene ved bruk av den korrigerte formelen for
standardavvik.

Use Solid Bar Colors (Bruk fylte
søyler med farger)

Viser fylte søyler i diagrammet.

X–Axis Labels (Etiketter på X-
akse)

Viser etiketter på X-aksen, enten horisontalt eller vinklet.

Tabell 32. Elementer på høyreklikkmenyen for genuttrykk, forts.
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Dataregneark
Tabell 33 definerer dataene som vises i Gene Expression Data Table (Datatabell for genuttrykk).

Merknad: Verdiene i tabellen er beregnet basert på graftypen og preferansene som er valgt i høyre
rute.

Informasjon Beskrivelse

Target (Mål) Målnavn (amplifisert gen) valgt i vinduet Experiment Settings
(Eksperimentinnstillinger).

Biological Group (Biologisk
gruppe)

Sample Biological Group
(Prøve-biologisk gruppe)

Biological Group Sample
(Biologisk gruppe-prøve)

Prøve og/eller biologisk gruppenavn valgt i vinduet Experiment
Settings (Eksperimentinnstillinger).

Kontroll Kontrollnavn valgt i vinduet Experiment Settings
(Eksperimentinnstillinger). Når Analyze Using (Analyser ved hjelp av)
er satt til Samples Only (Kun prøver), vil Control (Kontroll) være prøven
som er valgt i vinduet Experiment Settings (Eksperimentinnstillinger).
Når enten Biological Groups Only (Kun biologiske grupper), Sample
Biological Group (Prøve-biologisk gruppe) eller Biological Group
Sample (Biologisk gruppe-prøve) er valgt, vil kontroll være den
biologiske gruppen som er valgt i vinduet Experiment Settings
(Eksperimentinnstillinger).

Relative Quantity (Relativ
kvantitet) eller Expression
(Uttrykk)

Relative Quantity (Relativ kvantitet) (ΔCq) eller Normalized Gene
Expression (Normalisert genuttrykk) (ΔΔCq), avhengig av valgt modus.

Relative Quantity (Relativ
kvantitet) eller Expression SEM
(Uttrykk-SEM) (eller SD)

Standardfeil for gjennomsnittet (SEM) eller standardavvik (SD) for den
relative kvantiteten eller det normaliserte uttrykket, avhengig av det
valgte alternativet. Kun tilgjengelig hvis Analyze Using (Analyser ved
hjelp av) er satt til Samples Only (Kun prøver), Sample Biological
Group (Prøve-biologisk gruppe) eller Biological Group Sample
(Biologisk gruppe-prøve).

Tabell 33. Beskrivelse av informasjon i regnearket i fanen
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Informasjon Beskrivelse

Corrected Relative Quantity
(Korrigert relativ kvantitet) eller
Expression SEM (Uttrykk-SEM)
(eller SD)

Beregning av korrigert verdi for SEM eller SD for den relative
kvantiteten eller det normaliserte uttrykket, avhengig av det valgte
alternativet. Kun tilgjengelig hvis Analyze Using (Analyser ved hjelp av)
er satt til Samples Only (Kun prøver), Sample Biological Group (Prøve-
biologisk gruppe) eller Biological Group Sample (Biologisk gruppe-
prøve).

Mean Cq (Gj.sn. Cq) Gjennomsnitt av kvantifiseringssyklusen (vises ikke hvis Analyze
Using (Analyser ved hjelp av) er satt til Biological Groups Only (Kun
biologiske grupper)).

Cq SEM (eller SD) SEM eller SD for kvantifiseringssyklusen, avhengig av det valgte
alternativet (vises ikke hvis Analyze Using (Analyser ved hjelp av) er
satt til Biological Groups Only (Kun biologiske grupper)).

272 | CFX Maestro Dx SE-programvare



Graphing (Graf)

Alternativ for visning av detaljer
Tabell 34 definerer dataene som vises når Show Details (Vis detailer) er valgt fra høyreklikkmenyen i
søylediagram-regnearket.

Informasjon Beskrivelse

Data Set (Datasett) Fluorescensdata fra én fluorofor i datafilen

Relative Quantity (Relativ
kvantitet)

Beregnet relativ kvantitet for prøver

Relative Quantity SD (SD for
relativ kvantitet)

Standardavvik for beregning av relativ kvantitet

Corrected Relative Quantity SD
(Korrigert SD for relativ kvantitet)

Beregnet standardavvik for korrigert relativ kvantitet

Relative Quantity SEM (SEM for
relativ kvantitet)

Standardfeil av gjennomsnitt for beregningen av relativ kvantitet

Corrected Relative Quantity
SEM (Korrigert SEM for relativ
kvantitet)

Beregnet standardfeil av gjennomsnitt for korrigert relativ kvantitet

Relative Quantity (lg) (Relativ
kvantitet (lg))

Log2 for den relative kvantiteten som blir brukt til statistisk analyse

SD RQ (lg) Standardavvik for relativ kvantitet (log2)

SEM Expression (lg) (SEM for
uttrykk (lg))

Standardfeil av gjennomsnitt for uttrykk (log2)

Unscaled Expression (Ikke-
skalert uttrykk)

Beregnet ikke-skalert uttrykk

Unscaled Expression SD (SD for
ikke-skalert uttrykk)

Beregnet standardavvik for ikke-skalert uttrykk

Corrected Unscaled Expression
SD (Korrigert SD for ikke-skalert
uttrykk)

Beregnet standardavvik for korrigert ikke-skalert uttrykk

Tabell 34. Informasjon i søylediagram-regnearket med Show Details (Vis detaljer) valgt
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Informasjon Beskrivelse

Unscaled Expression SEM
(SEM for ikke-skalert uttrykk)

Beregnet standardfeil av gjennomsnitt for ikke-skalert uttrykk

Corrected Unscaled Expression
SEM (Korrigert SEM for ikke-
skalert uttrykk)

Beregnet standardfeil av gjennomsnitt for korrigert ikke-skalert uttrykk

Unscaled Expression (lg) (Ikke-
skalert uttrykk (lg))

Log2 for ikke-skalert uttrykk

SD Unscaled Expression (lg)
(SD for ikke-skalert uttrykk (lg))

Standardavvik for ikke-skalert uttrykk (log2)

SEM Unscaled Expression (lg)
(SEM for ikke-skalert uttrykk (lg))

Standardfeil av gjennomsnitt for ikke-skalert uttrykk (log2)

Expression (Uttrykk) Normalisert genuttrykk

Corrected Expression SD
(Korrigert SD for uttrykk)

Beregnet standardavvik for korrigert uttrykk

Expression SEM (SEM for
uttrykk)

Standardfeil av gjennomsnitt for uttrykk

Corrected Expression SEM
(Korrigert SEM for uttrykk)

Beregnet standardfeil av gjennomsnitt for korrigert uttrykk

Expression (lg) (Uttrykk (lg)) Log2 for uttrykket (normalisert uttrykk) som blir brukt til statistisk
analyse

SD Expression (lg) (SD for
uttrykk (lg))

Standardavvik for uttrykk (log2)

SEM Expression (lg) (SEM for
uttrykk (lg))

Standardfeil av gjennomsnitt for uttrykk (log2)

Mean Cq (Gj.sn. Cq) Gjennomsnitt av kvantifiseringssyklus

Cq SD Standardavvik for kvantifiseringssyklus

Cq SEM Standardfeil av gjennomsnitt for kvantifiseringssyklus

Tabell 34. Informasjon i søylediagram-regnearket med Show Details (Vis detaljer) valgt, forts.
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Klyngediagram
Klyngediagrammet viser dataene i et hierarki basert på graden av likhet i uttrykket for ulike mål og prøver.

Merknad: Du må velge et referansemål for å vise andre dataplott enn relativt uttrykk for
søylediagrammer.

Klyngediagrambildet viser det relative uttrykket for et mål eller en prøve på følgende måte:

n Oppregulering (rød) – høyere uttrykk

n Nedregulering (grønn eller blå) – lavere uttrykk

n Ingen regulering (svart)

n Ingen verdi beregnet (svart med et hvitt kryss)

Dess lysere fargen er, jo høyere er differansen i det relative uttrykket. Hvis det ikke kan beregnes en
normalisert Cq-verdi, er firkanten svart med et hvitt kryss.

På dataplottets ytre kanter er det et trestrukturdiagram, som viser klyngehierarkiet. Mål eller prøver som
har lignende uttrykksmønstre, har tilgrensende grener, mens mål eller prøver med ulike mønstre
plasseres lenger fra hverandre.

Innstillinger
Du kan angi følgende alternativer:

n Cluster By (Grupper etter) – velg mellom Targets (Mål), Samples (Prøver), Both (Begge) eller None
(Ingen).

n Size (Størrelse) – justerer bildestørrelsen og endrer graden av diagramforstørrelse.

n Split Out Replicates (Skill ut replikater) – viser verdier for de individuelle replikatene.

Tips: Du kan endre fargevalget for fra standard rød/grønn til rød/blå ved å velge dette alternativet fra
høyreklikkmenyen i disse diagrammene.

Alternativer i høyreklikkmenyen
Alternativene i høyreklikkmenyen for klyngediagrammet er de samme som de for søylediagrammet. Se
Tabell 32 på side 269 for tilgjengelige alternativer. I tillegg kan du velge Color scheme (Fargevalg) for å
endre nedreguleringsuttrykket fra standard rød/grønn til rød/blå i diagrammet.

Dataregneark
Regnearket viser verdier for målet, prøven og det normaliserte uttrykket.
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Scatter Plot (Spredningsplott)
Spredningsplottet viser det normaliserte måluttrykket for en kontroll sammenlignet med en eksperimentell prøve.
Linjene i plottet angir terskelen for foldendring. Datapunkter mellom linjene angir at forskjellen i uttrykk for det
relevante målet (genet) er ubetydelig mellom prøvene. Datapunkter utenfor linjene overstiger terskelen for
foldendring og kan være av interesse.

Plottbildet viser følgende endringer i måluttrykk basert på terskelen for foldendring.

n Oppregulering (rød sirkel) – relativt høyere uttrykk

n Nedregulering (grønn eller blå sirkel) – relativt lavere uttrykk

n Ingen endring (svart sirkel)

Klikk og dra en terskellinje for å justere terskelverdien for foldendring.

Innstillinger
Du kan angi følgende alternativer:

n Control Sample (Kontrollprøve)

n Experimental Sample (Eksperimentell prøve)

n Fold Change Threshold (Foldendringsterskel). Etter hvert som du øker eller reduserer
foldendringsverdien, flytter terskellinjene i plottet seg tilsvarende.

Alternativer i høyreklikkmenyen
Alternativene i høyreklikkmenyen for spredningsplottet er de samme som de for søylediagrammet. Se
Tabell 32 på side 269 for tilgjengelige alternativer. I tillegg kan du velge Symbol for å endre symbolet som
brukes på plottet, fra standardsirkelen til ett av følgende:

n Triangle (Trekant)

n Cross (Kryss)

n Square (Firkant)

n Diamond (Diamant)

Dataregneark
Regnearket viser verdier for målet og det normaliserte uttrykket for kontrollprøver og eksperimentelle
prøver. Det angir også hvorvidt målene er opp- eller nedregulert sammenlignet med målreguleringen.
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Regneark med resultater
Regnearket med resultater oppsummerer dataene fra alle diagrammene. Tabell 35 definer dataene vist i
Results (Resultater)-regnearket.

Informasjon Beskrivelse

Target (Mål) Målnavn (amplifisert gen)

Sample (Prøve) Prøvenavn

Mean Cq (Gj.sn. Cq) Gjennomsnitt av kvantifiseringssyklusen

Mean Efficiency Corrected Cq
(Gjennomsnittlig
effektivitetskorrigert Cq)

Gjennomsnitt av kvantifiseringssyklusen etter justering for
reaksjonseffektivitet

Normalized Expression
(Normalisert uttrykk)

Måluttrykk normalisert til et referansemål (ΔΔCq)

Relative Normalized Expression
(Relativt normalisert uttrykk)

Normalisert uttrykk i forhold til en kontrollprøve; også kalt foldendring

Regulation (Regulering) Endring i uttrykk i forhold til en kontrollprøve

Compared to Regulation
Threshold (Sammenlignet med
reguleringsterskel)

Opp- eller nedregulering av en eksperimentell prøve basert på
terskelinnstillingen

Tabell 35. Informasjon i Results (Resultater)-fanen

Merknad: Data for replikater finnes kun i regnearkene med dataanalysefanene der Split Out
Replicates (Skill ut replikater) er valgt (dvs. Clustergram (Klyngediagram)). Det kan være et avvik
mellom uttrykksdata i genuttrykksanalyse-regnearkene hvis du velger «none» (ingen) som
kontrollprøven på søylediagrammet.
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Genstudie
Opprett en genstudie for å sammenligne genuttrykksdata fra ett eller flere sanntids-PCR-eksperimenter
ved bruk av en kalibrator mellom kjøringer for å normalisere mellom eksperimentene. Opprett en
genstudie ved å legge til data fra en eller flere datafiler (.pcrd-filtype) i genstudien. Programvaren
grupperer dem i en enkelt fil (.mgxd-filtype).

Merknad: Maksimalt antall prøver du kan analysere i en genstudie, er begrenset av datamaskinens
RAM og virtuelle minne.

Kalibrering mellom kjøringer
Kalibrering mellom kjøringer blir automatisk forsøkt utført i hver genstudie for hvert mål for å normalisere
variasjoner mellom mål som er analysert i separate sanntids PCR-kjøringer (dvs. ulike .pcrd-filer generert
fra ulike plater).

For at programvaren skal gjenkjenne en prøve som en kalibrator mellom kjøringer, må hver plate som
sammenlignes, ha sammemålnavn, prøvenavn og, hvis relevant, biologisk settnavn.

Merknad: Minst én kalibratorprøve mellom kjøringer må være til stede i genstudien for at kalibrering
mellom kjøringer skal skje. Mål uten de riktige kalibratorprøvene mellom kjøringer vil bli prosessert
uten korreksjon i genstudien (anbefales ikke).

Kalibratorer mellom kjøringer kan brukes på to måter:

n Per target (Per mål) – ulike PCR-primere kan ha ulike effektiviteter. Kalibratoren mellom kjøringer
brukes som standard på alle brønnene på samme plate som har sammemålnavn, for eksempel Cq
generert med samme analyse.

n Entire study (Hele studien) – én kalibrator mellom kjøringer velges av brukeren og brukes på hele
genstudien.

278 | CFX Maestro Dx SE-programvare



Genstudie

Dialogboksen Gene Study (Genstudie)

Dialogboksen Gene Study (Genstudie) har to faner:

n Fanen Study Setup (Studieoppsett) – administrerer kjøringene i genstudien.

Viktig: Tilføyelse eller fjerning av datafiler i en genstudie endrer ikke dataene i originalfilen.

n Fanen Study Analysis (Studieanalyse) – viser genuttrykksdataene for de kombinerte kjøringene.

Fanen Study Setup (Studieoppsett)
Tabell 36 definerer dataene som vises i fanen Study Setup (Studieoppsett).

Kolonnetittel Beskrivelse

File Name (Filnavn) Navn på kjøredatafilen (filtype .pcrd)

File Folder (Filmappe) Katalog som inneholder datafilen for hver kjøring i genstudien

Date Created (Dato
opprettet).

Datoen da kjøredataene ble samlet inn

Tabell 36. Fanen Study Setup (Studieoppsett) i dialogboksen Gene Study (Genstudie)
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Kolonnetittel Beskrivelse

Well Group Name
(Brønngruppenavn)

Navn på brønngruppen som ble valgt da filen ble lagt til i genstudien

Tips: For å analysere en brønngruppe i genstudien må du velge
denne brønngruppen i vinduet Data Analysis (Dataanalyse) før du
importerer datafilen til genstudien.

Step (Trinn) Protokolltrinn som inkluderer plateavlesningen for å samle inn sanntids
PCR-data

Run Type (Kjøringstype) Enten brukerdefinert eller PrimePCR-kjøring

Protocol Edited (Protokoll
redigert)

Hvis valgt, angir den at protokollen som er brukt til en PrimePCR-
kjøring, er blitt redigert

View Plate (Vis plate) Åpner et kart over platen med dataene i hver av kjøringene inkludert i
genstudien

Tabell 36. Fanen Study Setup (Studieoppsett) i dialogboksen Gene Study (Genstudie), forts.

Klargjøre en Gene Study (Genstudie)
Slik klargjør du en genstudie

1. Før du importerer data i en genstudie må du gjøre følgende i vinduet Data Analysis (Dataanalyse):

n Bekreft at prøver med det samme innholdet, har samme navn. I en genstudie antar
programvaren at brønner med samme navn på Target (Mål) eller Sample (Prøve) inneholder de
samme prøvene.

n Juster baselinjen og terskelen (Cq) i fanen Quantification (Kvantifisering) for å optimere dataene
i hver kjøring.

n Velg brønngruppen du vil inkludere i genstudien.

Hvis du vil vise data fra én brønngruppe i genstudien, må denne gruppen velges før du
importerer datafilen.

Fanen Study Setup (Studieoppsett) viser en liste over alle kjøringer i genstudien.

2. Velg fanen Study Setup (Studieoppsett) i dialogboksen Gene Study (Genstudie).

3. Klikk på Add Data Files (Legg til datafiler) for å velge en fil fra et nettleservindu.

Tips: Du kan raskt legge til kjøringer i en genstudie ved å dra datafilene (endelsen .pcrd) til
dialogboksen Study Setup (Studieoppsett).

4. CFX Maestro Dx SE utfører genstudieanalysen automatisk når du legger til datafiler. Velg fanen
Study Analysis (Studieanalyse) for å vise resultatene.

280 | CFX Maestro Dx SE-programvare



Genstudie

Slik fjerner du kjøringer fra genstudien

u Velg én eller flere filer fra listen og klikk på Remove (Fjern).

Slik legger du til merknader om genstudien

u Skriv inn merknader om filene og analysen i tekstboksen Notes (Merknader).

Fanen Study Analysis (Studieanalyse)
Fanen Study Analysis (Studieanalyse) viser dataene fra alle kjøringer i genstudien. Alternativene for
analyse av genuttrykksdata er de samme som de for en enkelt datafil med unntak av følgende:

n For søylediagram vises kalibreringsverdier mellom kjøringer (hvis beregnet) når du klikker på Inter-
run Calibration (Kalibrering mellom kjøringer).

Merknad: Kun de følgende prøvetypene kan brukes som en kalibrator mellom kjøringer:

o Unknown (Ukjent)

o Standard

o Positive Control (Positiv kontroll)

Prøvetypene Negative control (Negativ kontroll), NTC (Ikke-templatkontroll) og NRT (Ikke revers
transkriptase-kontroll) kan ikke brukes som kalibrator mellom kjøringer.

n Verktøyet Reference Gene Selection (Valg av referansegen) identifiserer de testede
referansegenene og kategoriserer dem som Ideal (Ideelle), Acceptable (Akseptable) eller Unstable
(Ustabile) basert på stabiliteten deres:

o Ideal (Idelle) referansegener er stabile og representerer minimale variasjoner blant de testede
prøvene.

o Acceptable (Akseptable) referansegener er ikke ideelt stabile og representerer moderat
variasjon blant testede prøver. Bruk disse referansegenene til analyse dersom det ikke finnes
Ideal (Ideelle) referansegener.

o Unstable (Ustabile) referansegener representerer stor variasjon blant testede prøver. Det
anbefales at disse genene ekskluderes fra analyser.

n Verktøyet PrimePCR Analysis Controls (PrimePCR-analysekontroller) viser resultatene av de
testede prøvene i en tabell:

o Fanen Summary (Sammendrag) viser et sammendrag av alle testede prøver. Prøver som
bestod alle kontrollanalysene, vises i grønt. Prøver som ikke bestod en eller flere av
kontrollanalysene, vises i gult.
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o Fanen PCR viser resultatene for den positive PCR-kontrollanalysen. Denne analysen påviser
hemming eller eksperimentproblemer som påvirker genuttrykk.

o Fanen RT viser resultatene av kontrollanalysen for revers transkripsjon. Denne analysen
evaluerer kvalitativt RT-ytelsen og identifiserer prøver der RT-ytelsen sannsynligvis forringer
genuttrykk.

o Fanen gDNA viser resultatene av kontrollanalysen for DNA-kontaminering. Denne analysen
fastslår om genomisk DNA (gDNA) er til stede i prøven på et nivå som kan påvirke qPCR-
resultater.

o Fanen RQ viser resultatene av RNA-kvalitetsanalysene (RQ1 og RQ2). Disse analysene
vurderer kvalitativt hvorvidt RNA-integriteten kan påvirke genuttrykk negativt.

Kategorier for genstudierapport
Bruk dialogboksen Gene Study Report (Genstudierapport) for å organisere genstudiedataene i en
rapport. Tabell 37 lister opp alle alternativene som er tilgjengelige for en genstudierapport.

Kategori Alternativ Beskrivelse

Overskrift

Tittel, undertittel og logo for rapporten

Report Information
(Rapportinformasjon)

Dato, brukernavn, datafilnavn, datafilbane og
valgt brønngruppe

Gene Study File List (Liste
over filer i genstudie)

Liste over alle datafilene i genstudien

Notes (Merknader) Merknader om datarapporten

Study Analysis (Studieanalyse): Søylediagram

Analysis Settings
(Analyseinnstillinger)

Liste over de valgte analyseparametrene

Chart (Diagram) Søylediagram for Gene Expression (Genuttrykk)
som viser dataene

Target Names (Målnavn) Liste over mål i genstudien

Tabell 37. Kategorier for en Gene Study (Genstudie)-rapport
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Kategori Alternativ Beskrivelse

Sample Names
(Prøvenavn)

Liste over prøver i genstudien

Data Regneark som viser dataene

Target Stability
(Målstabilitet)

Data for målstabilitet

Inter-run Calibration
(Kalibrering mellom
kjøringer)

Kalibreringsdata mellom kjøringer

Box-and-Whisker Chart
(Boksdiagram)

Bokstegningsdiagram for genuttrykk

Dot-Plot Chart
(Punktdiagram)

Punktdiagram for genuttrykk

Study Analysis (Studieanalyse): Clustergram (Klyngediagram) og Scatter Plot
(Spredningsplott)

Analysis Settings
(Analyseinnstillinger)

Innstillinger for hver diagramtype

Chart (Diagram) Diagram for genuttrykk som viser dataene

Data Regneark som lister opp dataene i hvert mål

Study Analysis (Studieanalyse): ANOVA
Data

ANOVA Settings (ANOVA-
innstillinger)

P-verditerskel som brukes i analysen

ANOVA Results (ANOVA-
resultater)

Tabell med resultater fra ANOVA og Tukeys HSD
post-hoc-analyse

Shapiro-Wilk Normality
Test (Shapiro-Wilk-
normalitetstest)

Biologisk gruppe, antall, P-verdi og andre feil som
forekommer for hvert mål i analysen.

ANOVA Errors (ANOVA-
feil)

Feil identifisert under ANOVA-beregninger

Tabell 37. Kategorier for en Gene Study (Genstudie)-rapport, forts.
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Opprette en genstudierapport
Slik oppretter du en genstudierapport

1. Juster etter behov dataene og diagrammene for genstudierapporten før en rapport opprettes.

2. Velg Tools > Reports (Verktøy > Rapporter) i menyen Gene Study (Genstudie) for å åpne
dialogboksen Report (Rapport).

3. Velg alternativene du vil inkludere i rapporten. Rapporten åpnes med standardalternativene valgt.
Merk av eller fjern merket i avmerkingsboksene for å endre hele kategorier eller individuelle
alternativer i en kategori.

Kategorier for genstudierapport på side 282 lister opp alternativene som er tilgjengelig for visning.

4. Endre rekkefølgen på kategoriene og elementene i en rapport. Dra alternativene til ønsket posisjon.
Rekkefølgen på elementene kan bare endres innenfor kategoriene de tilhører.

5. Klikk på Update Report (Oppdater rapport) for å oppdatere Report Preview (Forhåndsvisning av
rapport) med eventuelle endringer.

6. Skriv ut eller lagre rapporten. Klikk på knappen Print Report (Skriv ut rapport) på verktøylinjen for å
skrive ut den aktuelle rapporten. Velg File > Save (Fil > Lagre) for å lagre rapporten i PDF-format
(Adobe Acrobat Reader-fil), og velg et lagringssted for filen. Velg File > Save As (Fil > Lagre som) for
å lagre rapporten med et nytt navn eller på et nytt sted.

7. (Valgfritt) Opprett en rapportmal med informasjonen du ønsker. Hvis du vil lagre de gjeldende
rapportinnstillingene i en mal, velger du Template > Save (Mal > Lagre) eller Save As (Lagre som).
Deretter laster du inn rapportmalen neste gang du vil lage en ny rapport.
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Vedlegg A Beregninger for dataanalyse
CFX Maestro Dx-programvare, Security Edition beregner formler automatisk og viser resultatene i fanene
i Data Analysis (Dataanalyse). Dette vedlegget gir en detaljert beskrivelse av hvordan CFX Maestro Dx
SE beregner formler.

Reaksjonseffektivitet
Beviser antyder at bruk av nøyaktige mål på effektivitet for hvert primer- og probesett gir mer nøyaktige
resultater ved analysering av genuttrykksdata. Standardverdien for effektivitet som brukes i beregninger
av genuttrykket, er 100 %. For å evaluere reaksjonseffektiviteten må du generere en standardkurve ved
bruk av en rekke fortynninger av en representativ prøve over et relevant dynamisk område, og deretter
registrere effektiviteten for etterfølgende analyse av genuttrykk. Hvis kjøringen inkluderer en
standardkurve, beregner programvaren automatisk effektiviteten, og viser den under Standard Curve
(Standardkurve) i fanen Quantification (Kvantifisering) når Auto Efficiency (Auto-effektivitet) er merket av i
fanen Targets (Mål) i vinduet Experiment Settings (Eksperimentinnstillinger)

Effektiviteten (E) i effektivitetsformler henviser til «effektivitetene» som beskrevet av Pfaffl (2001) og
Vandesompele et al. (2002). I disse publikasjonene er en effektivitet på 2 (perfekt dobling i hver syklus)
tilsvarende 100 % effektivitet i denne programvaren. Du har muligheten til å konvertere
effektivitetsberegningene til de som brukes i programvaren ved å bruke følgende matematiske forhold:

n E = (% effektivitet * 0,01) + 1

n % effektivitet = (E – 1) * 100

Relativ kvantitet
Formelen for relativ kvantitet (ΔCq) for alle prøver (GOI) er:

Merknad: Denne formelen brukes til å beregne relativ kvantitet når det ikke er definert en
kontrollprøve .

Der:
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n E = Effektivitet av primer og probesett. Denne effektiviteten beregnes med formelen
(% Effektivitet * 0,01) + 1, hvor 100 % effektivitet = 2

n C q (min) = gjennomsnittlig Cq for prøven med det laveste gjennomsnittet Cq for GOI

n C q (prøve) = gjennomsnittlig Cq for prøven

n GOI = interessegen (ett mål)

Relativ kvantitet når en kontroll er valgt
Når en kontrollprøve eller biologisk gruppe er tilordnet, blir den relative kvantiteten (RQ) for en prøve med
et interessegen (GOI) beregnet med denne formelen:

Der:

n E = Effektivitet av primer og probesett. Denne effektiviteten beregnes med formelen
(% Effektivitet * 0,01) + 1, hvor 100 % effektivitet = 2

n Cq (control) = Gjennomsnittlig Cq for kontrollprøven

n Cq (prøve) = Gjennomsnittlig Cq for alle prøver med et GOI

n GOI = interessegen (ett mål)

Standardavvik for relativ kvantitet
Viktig: Beregningen gjelder kun når Analyze Using (Analyser ved bruk av) er stilt til Samples Only
(Kun prøver), Sample Biological Group (Prøve, biologisk gruppe) eller Biological Group Sample
(Biologisk gruppe, prøve).

Formelen for standardavviket til den relative kvantiteten er

Der:

n SD Relative Quantity = standardavviket til den relative kvantiteten

n SA CqGOI prøve = standardavviket til prøvens Cq (GOI)

n Relative Quantity = prøvens relative kvantitet

n E = Effektivitet av primer og probesett. Denne effektiviteten beregnes med formelen
(% Effektivitet * 0,01) + 1, hvor 100 % effektivitet = 2
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Efficiency Corrected Cq (CqE) (Effektivitetskorrigert Cq (CqE))

n GOI = interessegen (ett mål)

Efficiency Corrected Cq (CqE) (Effektivitetskorrigert Cq (CqE))
Formelen for effektivitetskorrigert Cq er

Der:

n E = Effektivitet

Mean Efficiency Corrected Cq (Gjennomsnittlig
effektivitetskorrigert Cq) (MCqE))

Formelen for gjennomsnittlig effektivitetskorrigert Cq er

Der:

n CqE = Effektivitetskorrigert Cq

n n = Antall replikater
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Normalisert uttrykk
Normalisert uttrykk (ΔΔCq) er den relative kvantiteten av målet (gen) normalisert til kvantitetene av
referansemålene (gener eller sekvenser) i det biologiske systemet. For å velge referansemål åpner du
vinduet Experiment Settings (Eksperimentinnstillinger) og klikker på referansekolonnen for hvert mål som
brukes som et referansegen.

Formelen for normalisert uttrykk, som bruker den beregnede relative kvantiteten (RQ), er:

Der:

n RQ = Relativ kvantitet av en prøve

n Ref = Referansemål i en kjøring som inkluderer ett eller flere referansemål i hver prøve

n GOI = interessegen (ett mål)

Gitt at referansemål ikke endrer uttrykksnivået i det biologiske systemet, vil beregningen av normalisert
uttrykk ta høyde for innlastingsforskjeller eller variasjoner i celleantall som er representert i hver av
prøvene.
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Uttrykk og relativ kvantitet for biologiske grupper
Når Analyze Using (Analyser ved hjelp av) er satt til Biological Groups Only (Kun biologiske grupper),
viser programvaren gjennomsnittsuttrykket (normalisert uttrykk eller relativ kvantitet, avhengig av valgt
modus) for prøvene i den biologiske gruppen. Fordi uttrykk vanligvis er log-normalfordelt, blir uttrykket
gjennomsnittsberegnet ved hjelp av det geometriske gjennomsnittet:

Der:

n Exp1 (Uttrykk 1), Exp2 (Uttrykk 2), Expn (Uttrykk n) = Relativ kvantitet eller normalisert uttrykk for
prøvene i den biologiske gruppen

n n = Antall prøver i den biologiske gruppen

Normalisert uttrykk når en kontroll er valgt
Når du velger en kontrollprøve i vinduet Experiment Settings (Eksperimentinnstillinger), setter
programvaren kontrollprøvens uttrykksnivå til 1. I denne situasjonen normaliserer programvaren den
relative kvantiteten av alle måluttrykk (genuttrykk) til kontrollkvantiteten (en verdi på 1). Dette normaliserte
uttrykket tilsvarer analysen av det uskalerte normaliserte uttrykket når en kontroll er valgt.

Merknad: Dette er også kjent som relativt normalisert uttrykk (RNE) og foldendring.
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Standardavvik for det normaliserte uttrykket
Reskalering av den normaliserte uttrykksverdien utføres ved å dividere standardavviket for det
normaliserte uttrykket med den normaliserte uttrykksverdien for det høyeste eller laveste individuelle
uttrykksnivået, avhengig av hvilket skaleringsalternativ du velger. Formelen for standardavvik (SD) i
normaliseringsfaktoren er

Der:

n RQ = Relativ kvantitet av en prøve

n SD = Standardavvik

n NF = Normaliseringsfaktor

n Ref = Referansemål

n n = Antall referansemål

Når en kontrollprøve er tilordnet, er det ikke nødvendig å utføre denne reskaleringsfunksjonen på
standardavviket, som vist i følgende formel:

Der:

n NE = Normalisert uttrykk

n RQ = Relativ kvantitet av en prøve

n SD = Standardavvik

n GOI = interessegen (ett mål)
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Normalisert uttrykk skalert til høyeste uttrykksnivå
Når kjøringen ikke inkluderer kontroller, skalerer du det normaliserte uttrykket (NE) for hvert mål (gen) ved
å dividere uttrykksnivået for hver prøve med det høyeste uttrykksnivået i alle prøver. Programvaren setter
det høyeste uttrykksnivået til en verdi av 1, og reskalerer alle prøveuttrykksnivåene. Formelen for høyeste
skalering er:

Der:

n GOI = Interessegen (mål)

Normalisert uttrykk skalert til laveste uttrykksnivå
Når kjøringen ikke inkluderer kontroller, skalerer du det normaliserte uttrykket (NE) for hvert mål (gen) ved
å dividere uttrykksnivået for hver prøve med det laveste uttrykksnivået i alle prøver. Programvaren setter
det laveste uttrykksnivået til en verdi av 1, og reskalerer alle prøveuttrykksnivåene. Formelen for laveste
skalering er:

Der:

n GOI = Interessegen (mål)

Normalisert uttrykk skalert til gjennomsnittlig uttrykksnivå
Når kjøringen ikke inkluderer kontroller, skalerer du det normaliserte uttrykket (NE) for hvert mål (gen) ved
å dividere uttrykksnivået for hver prøve med det geometriske gjennomsnittsnivået av uttrykk for alle
prøver. Programvaren setter det gjennomsnittlige uttrykksnivået til en verdi av 1, og reskalerer alle
prøveuttrykksnivåene. Formelen for gjennomsnittlig skalering er:

Der:

n GOI = Interessegen (mål)

n GM = Geometrisk gjennomsnitt av normalisert uttrykk for alle prøver
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Standardavvik for det skalerte normaliserte uttrykket
Verdien for det skalerte normaliserte uttrykket (NE) kan skaleres på nytt ved å dele standardavviket (SD)
til det normaliserte uttrykket på verdien for det normaliserte uttrykket for det høyeste (MAX) eller laveste
uttrykksnivået, avhengig av hvilket skaleringsalternativ du velger.

Merknad: Når en kontrollprøve er tilordnet, trenger du ikke å utføre denne funksjonen for ny
skalering på standardavviket.

Beregningen for denne formelen er

Der:

n NE = Normalisert uttrykk

n SD = Standardavvik

n GOI = Interessegen (mål)

n MAX = Høyeste uttrykksnivå

n MIN = Laveste uttrykksnivå
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Feilsøyler for standardavvik (lg) og standardfeil av gjennomsnitt (lg)

Feilsøyler for standardavvik (lg) og standardfeil av
gjennomsnitt (lg)

I tillegg til bruken av konfidensintervaller kan feillinjer vises for biologiske grupper basert på
standardavviket eller standardfeilen av gjennomsnitt for log2 for uttrykket. Feilsøylene beregnes som
følger:

RQ nedre feilsøyle = 2RQ(lg)-SD RQ(lg) eller 2RQ(lg)-SEM RQ(lg)

RQ øvre feilsøyle = 2RQ(lg)+SD RQ(lg) eller 2RQ(lg)+SEM RQ(lg)

Der:

n RQ(lg) = log2 for relativ kvantitet for den biologiske gruppen

n SD RQ(lg) = standardavvik for relativ kvantitet (log2)

n SEM RQ(lg) = standardfeil av gjennomsnitt for relativ kvantitet (log2)

Exp. nedre feilsøyle = 2Exp.(lg)-SD Exp.(lg) eller 2Exp.(lg)-SEM Exp.(lg)

Exp. øvre feilsøyle = 2Exp.(lg)+SD Exp.(lg) eller 2Exp.(lg)+SEM Exp.(lg)

Der:

n Exp.(lg) = log2 av uttrykket (normalisert uttrykk) for den biologiske gruppen

n SD RQ(lg) = standardavvik for uttrykket (log2)

n SEM RQ(lg) = standardfeil av gjennomsnitt for uttrykket (log2)
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Foldendring
Foldendring er et mål på økningen eller reduksjonen i uttrykket til et mål for en eksperimentell prøve
kontra en kontrollprøve eller biologisk gruppe, og bestemmes på følgende måte:

Hvis uttrykk (eksperimentell) > uttrykk (kontroll):

Hvis uttrykk (eksperimentell) < uttrykk (kontroll):

Merknad: For Graphing (Graf) er Expression (Uttrykk) basert på enten den relative kvantiteten eller
det normaliserte uttrykket, avhengig av den valgte modusen (se Graphing (Graf) på side 258). For
Scatter Plot (Varmekart) og Clustergram (Klyngediagram) beregnes imidlertid foldendring alltid fra
det normaliserte uttrykket.
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Formler for korrigerte verdier
Viktig: Disse beregningene kan kun brukes når Analyze Using (Analyser ved hjelp av) er satt til
Samples Only (Kun prøver), Sample Biological Group (Prøve-biologisk gruppe) eller Biological
Group Sample (Biologisk gruppe-prøve).

En forskjell mellom korrigerte verdier og ikke-korrigerte verdier ses kun hvis det opprettes en
standardkurve som del av sanntids PCR-kjøringen. Programvaren bruker tre formler for å bestemme
feiloverføringen:

n Standardfeil

n Standardfeil for normalisert uttrykk

n Standardfeil for normalisert interessegen (mål)

Formelen for standardfeil er

Der:

n n = Antall referansemål (gener)

n SD = Standardavvik

Standardfeilen for normaliseringsfaktoren i formelen for normalisert uttrykk er

Der:

n n = Antall referansemål

n SE = Standardfeil

n NF = Normaliseringsfaktor

n RQ = Relativ kvantitet

Standardfeilen for formelen for normalisert interessegen (GOI) er

Der:

n SE = Standardfeil
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n GOI = interessegen (ett mål)

n NF = Normaliseringsfaktor

n n = Antall referansemål

Beregning av konfidensintervall for analysering av biologisk
gruppe

Når biologiske grupper analyseres (Analyze Using (Analyser ved bruk av) er stilt til Biological Groups Only
(Kun biologiske grupper)), beregnes konfidensintervallene for relativ kvantitet og relativt normalisert
uttrykk.

Konfidensintervallene beregnes i log-skala basert på t-fordeling ved bruk av følgende formel:

Der:

n = Gjennomsnittlig uttrykk av log-skala-uttrykksnivåene for prøvene i den biologiske gruppen

n SD = standardavvik for log-skala-uttrykksnivåene for prøvene i den biologiske gruppen

n n = antallet prøver i den biologiske gruppen

n t = oppnådd fra t-fordelingen basert på graden av frihet og alfanivået

Merknad: Alfanivået kan stilles inn ved bruk av P-verditerskelfeltet i Graphing (Graf)-fanen.

Når konfidensintervallene har blitt beregnet, blir de konvertert til lineær skala og presentert i Gene
Expression (Genuttrykk)-datatabellen og søylediagrammet i Graphing (Graf)-fanen.

Beregninger for boksdiagram
Boksdiagrammet viser fordelingen av uttrykksverdier i en biologisk gruppe ved å plotte dataene som
kvartiler. Første og tredje kvartil representeres av henholdsvis de nedre og øvre grensene av boksen.
Medianen vises som en heltrukken linje på tvers av boksen. De vertikale linjene (whiskers) representerer
de laveste og høyeste ikke-utliggerverdiene i datasettet. Utliggere er verdier som overskrider første og
tredje kvartil med 1,5 ganger interkvartilområdet.

Merknad: Hvis det kun finnes én prøve i den biologiske gruppen, vises det som en enkelt sirkel,
hvilket angir et enkelt datapunkt.

Følgende boksdiagram viser hvordan disse dataene representeres.
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1. Utligger. Verdien til denne utliggeren er > Q3 + (1,5 x [Q3 - Q1]).

Merknad: Plasser markøren over sirkelen for å vise et verktøytips som viser prøvenavnet
og informasjonen om relativ kvantitet eller normalisert uttrykk, avhengig av hvilken modus
som er valgt.

2. Maksimum ikke-utliggeravgrensning

3. Øvre/tredje kvartil (Q3). 75 % av uttrykksverdiene er mindre enn Q3.

4. Medianen, eller den midterste verdien, av de rangerte uttrykksverdiene

5. Nedre/første kvartil (Q1). 25 % av uttrykksverdiene er mindre enn Q1.

6. Minimum ikke-utliggeravgrensning

7. Utligger. Verdien til denne utliggeren er < Q1 - (1,5 x [Q3 - Q1]).

FORKLARING
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Vedlegg B Revisjonsspor
CFX Maestro Dx-programvare, Security Edition oppretter revisjonsspor for data- og genstudiefiler
(henholdsvis .prcd- og .mgxd-filer). Eventuelle endringer i eller handlinger utført på sikre data- og
genstudiefiler blir fanget opp i filens revisjonsspor når filen lagres. CFX Maestro Dx SE oppretter et eget
revisjonsspor for hver fil.

Du kan velge File > Save As (Fil > Lagre som) og lagre sikre signerte eller usignerte data- og
genstudiefiler i en annen mappe eller med et annet navn. Den nye filen arver revisjonssporet fra den
opprinnelige filen. Revisjonssporet for den nye filen inkluderer også Save As-aktiviteten (Lagre som).
Endringer i eller handlinger utført på den nye filen er registrert i sitt eget revisjonsspor. Den opprinnelige
filen opprettholder revisjonssporet, der ytterligere aktivitet fanges opp.

Reviderbare hendelser på side 301 viser de reviderbare hendelsene som programvaren registrerer.

Vise revisjonsspor
Hvert revisjonsspor viser følgende informasjon:

n Revisjonsoverskriftdetaljer

o File versjon (Filversjon) – den lagrede versjonen av filen

o Date (Dato) – datoen for den aktuelle reviderbare hendelsen

o User (Bruker) – Windows-domenet og brukernavnet til den påloggede brukeren

o Comment (Kommentar) – den siste lagrede kommentaren

o Signature (Signatur) – den elektroniske signaturen til den siste personen som signerte filen

o Signature reason (Signaturårsak) – årsaken til signaturen

o Application (Program) – CFX Maestro Dx SE

o Application version (Programversjon) – den gjeldende versjonen av CFX Maestro Dx SE

o Full user (Full bruker) – det fulle navnet på den påloggede brukeren

o Machine (Maskin) – datamaskinen der CFX Maestro Dx SE er installert

n Audit change detail (Revisjonsendringsdetaljer)

o Object (Objekt) – elementet som ble endret (det reviderte elementet)
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o Old value (Gammel verdi) – den forrige verdien

o New value (Ny verdi) – den nye verdien

o Description (Beskrivelse) – beskrivelsen av endringen

Se revisjonssporet

u I den åpne data- eller genstudiefilen velger du View > Audit Trail (Vis > Revisjonsspor). Filens
revisjonsspor vises.

Som standard sorteres dataene etter dato og klokkeslett, og alle hendelser vises i den utvidede
visningen. Du kan filtrere visningen etter brukernavn og objekt, og skjule den utvidede visningen for å
enkelt sortere etter hvilket som helst overskriftsfelt. Du kan også se revisjonssporet som en html-
rapport.

Sortere etter brukernavn

u Velg målbruker fra rullegardinlisten User Name (Brukernavn).

Sortere etter objekt

u Velg målet fra rullegardinlisten Object (Objekt).

Skjule den fulle beskrivelsen av hendelser

u Klikk på Collapse All (Skjul alt).

Sortere data i endringsdetaljtabellen

u Klikk på diamantsymbolet i datakolonneoverskriften for å utføre en stigende sortering (A til Å, det
minste tallet til det største eller det tidligste til det siste).
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Skrive ut revisjonssporet

1. Klikk på HTML Report (HTML-rapport) for å vise revisjonssporet i en nettleser.

2. Gjør ett av følgende i nettleservinduet:

n Velg File > Print (Fil > Skriv ut).

n Høyreklikk rapporten og velg Print (Skriv ut).

Reviderbare hendelser
CFX Maestro Dx SE fanger opp følgende reviderbare hendelser i data- og genstudiefiler.

Reviderbare hendelser under kjøring

n Kjøringens starttid

n Kjøringens tidsplateredigeringer

n Kjøringens tidsprotokollredigeringer

n Kjøringens sluttid

Reviderbare hendelser når en datafil opprettes

n Datafil opprettet

n Interpolerte platelesinger lagt til av systemet

Reviderbare hendelser når en datafil lagres

n Generelt

o Navn

o Signering

o Plateoppsett

o Vis brønner

o Analyserte fluoroforer

o Plateredigeringer

o Analysemodus

o PCR aktiv brønngruppe
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n Fanen Quantification (Kvantifisering)

o Active step (Aktivt trinn)

o Settings— Cq Determination mode (Innstillinger – C q påvisningsmodus)

o Settings— Baseline Setting (Innstillinger – baselinjeinnstilling)

o Drift correction applied (Driftkorreksjon brukt)

o Settings— Cycles to Analyze (Innstillinger – sykluser som skal analyseres)

o Settings— Analysis Mode (Innstillinger – analysemodus)

o Settings— Baseline Threshold (Innstillinger – baselinjeterskel)

n Fanen Melt Curve (Smeltekurve)

o Active step (Aktivt trinn)

o Peak type displayed (Peak-type vist)

o Peak analysis threshold (Peak-analyseterskel)

n Fanen End Point (Endepunkt)

o Active fluorophore/target (Aktiv fluorofor/mål)

o End cycles to average (Endesykluser som brukes til å finne gjennomsnitt)

o Tolerance calculation method (Toleranseberegningsmetode)

o Percentage of range (Prosent av område)

n Fanen Allelic Discrimination (Allelisk diskriminering)

o X- og Y-akse fluorophore (fluorofor)

o Select cycle number (Velg syklusnummer)

o View call map (Vis bestemmelseskart)

n Fanen Gene Expression— All plots (Genuttryk – alle plott)

o Experiment Settings— Target reference (Eksperimentinnstillinger – målreferanse)

o Experiment Settings— Sample control (Eksperimentinnstillinger – prøvekontroll)

o Experiment Settings— Auto efficiency (Eksperimentinnstillinger – auto effektivitet)

o Experiment Settings— Efficiency (Eksperimentinnstillinger – effektivitet)
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n Gene Expression tab—Graphing (Genuttrykk – graf)

o Analysemodus

o Graph data (Diagramdata)

o X-akse

o Y-akse

o Alternativ for skalering

o Feillinje

o Multiplikator for feillinje

o P-Value threshold (P-verditerskel)

n Fanen Expression— Clustergram (Genuttrykk – clustergram)

o Cluster By (Klynge etter)

o Split out replicates (Del op replikater)

n Fanen Gene Expression— Scatter Plot (Genuttrykk – spredningsplott)

o Control Biological Group (Kontroll biologisk gruppe)

o Experimental Biological Group (Eksperimentell biologisk gruppe)

o Fold Change Threshold (Foldendringsterskel)

n Fanen Gene Expression— ANOVA (Genuttrykk – ANOVA)

o P-Value threshold (P-verditerskel)

n Plate Setup— View/Edit Plate (Plateoppsett – vis/rediger plate)

o Settings— PlateType (Innstillinger – platetype)

o Settings— Units (Innstillinger – enheter)

o Editing Tools — Flip Plate (Redigeringsverktøy – Speilvend plate)

o Well groups (Brønngrupper)

o Plate fluorophores (Platefluoroforer)

n Plate Setup— Replace Plate and Apply PrimePCR File (Plateoppsett – erstatt plate og bruk
PrimePCR-fil)

o Plate Setup Import (Import av plateoppsett)
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Audit Changes for Gene Study Files (Revisjonsendringer for genstudiefiler)

Generelt

n Navn

n Fanen Study Setup (Studieoppsett)

o Add/Remove data files (Legg til/fjern datafiler)

n Fanen Study Analysis (Studieanalyse)
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Vedlegg C LIMS-integrering
Du kan konfigurere CFX Maestro Dx-programvare, Security Edition for bruk med et
informasjonsbehandlingssystem for laboratorier (LIMS). For LIMS-integrering krever CFX Maestro Dx SE
informasjon om plateoppsett generert av LIMS-plattformen (en LIMS-fil, *.plrn), en protokollfil opprettet
med CFX Maestro Dx SE (*.prcl), en definert plassering for dataeksport og et definert eksportformat.

Etter at kjøringen er ferdig, genererer CFX Maestro Dx SE en datafil (.pcrd) og lagrer den på et angitt sted
for dataeksportmappe. CFX Maestro Dx SE kan også opprette en LIMS-kompatibel datafil i .csv-format og
lagre den på samme sted.

Opprette LIMS-kompatible datafiler
Dette tillegget forklarer hvordan du setter opp CFX Maestro Dx SE for å opprette, lagre og eksportere
LIMS-kompatible datafiler.

Sette opp LIMS-mappe og alternativer for dataeksport
Som standard lagrer CFX Maestro Dx SE LIMS-protokoller, filer dataeksportfiler i denne mappen:
C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

Du kan konfigurere CFX Maestro Dx SE slik at systemet lagrer filene i en annen mappe, og endre
eksportalternativene for LIMS-data.

Slik setter du opp en LIMS-mappe og alternativer for dataeksport

1. Velg Tools > Options ( Verktøy > Alternativer) i startvinduet.

2. Velg Data Export Settings (Innstillinger for dataeksport) i dialogboksen Options (Alternativer).
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3. (Valgfritt) Velg Automatically export LIMS data at end of run (Eksporter LIMS-data automatisk etter
fullført kjøring).

Programvaren vil automatisk eksportere LIMS-data etter hver kjøring og lagre dem på angitt sted.

4. Hvis du vil endre standard eksportalternativer for LIMS-data, klikker du på LIMS Data Export Settings
(Innstillinger for eksport av LIMS-data).

Viktig: Kun LIMS-data som eksporteres som en .csv-fil, kan importeres tilbake til CFX Maestro
Dx SE.

5. I dialogboksen LIMS Data Export Format Settings (Innstillinger for eksportformat for LIMS-data)
velger du de påkrevde eksportalternativene og klikker på OK.

6. I dialogboksen Options (Alternativer) navigerer du til og velger en standardmappe der du vil lagre
LIMS-datafilene. Du kan velge forskjellig plassering for hver filtype:

n Protocol (Protokoll)

n LIMS file (LIMS-fil)

n Data export (Dataeksport)

7. Klikk på OK for å lagre endringene og lukke dialogboksen Options (Alternativer).
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Opprette en LIMS-protokoll
Når du vil starte en LIMS-kjøring, må du opprette en CFX Maestro Dx SE-protokollfil (*.prcl) og lagre den
på plasseringen for den tilordnede LIMS-protokollmappen.

Se Kapittel 7, Opprette protokoller for mer informasjon.

Opprette en LIMS-fil
En LIMS-fil (*.plrn) inneholder detaljer om plateoppsettet og navnet på protokollfilen. Denne filen
genereres av ditt interne LIMS. CFX Maestro Dx SE bruker LIMS-filen til å lage en platefil som skal brukes
med en protokollfil.

CFX Maestro Dx SE har plateimportmalfiler som du kan redigere for å opprette egendefinerte LIMS-
platefiler.

Tips: Denne oppgaven skal utføres av en LIMS-spesialist.

Slik oppretter du en LIMS-fil

1. I startvinduet velger du View > Show > LIMS File Folder (Visning > Vis > LIMS-filmappe).

2. Åpne mappen LIMS Templates (LIMS-maler) og velg en .csv-fil som skal importeres til ditt interne
LIMS.

3. Du kan redigere malfilen ved å fylle ut de påkrevde feltene oppført i Tabell 38.

4. Gjør ett av følgende:

n For å lagre endringene dine for fremtidig bruk, lagre filen som en .csv-fil.

n For å lagre endringene og bruke filen umiddelbart, lagre filen som en .plrn-fil.

n Lagre malen med filtypen .plrn i LIMS-filmappen.

Viktig: CFX Maestro Dx SE kan kun åpne .plrn-filen. Du må lagre .csv-filen som .plrn for å kunne
starte LIMS-kjøringen.

Kolonne Rad Beskrivelse Innhold Formål

A 1 Plate Header
(Plateoverskrift)

Skal ikke redigeres Forhåndsdefinert

A,B,C (2) Field/Data/Instruction
(Felt/data/instruksjon)

Skal ikke redigeres Forhåndsdefinert

Tabell 38. Definisjon av innhold i LIMS .csv-filen
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Kolonne Rad Beskrivelse Innhold Formål

B 3 Version (Versjon) Skal ikke redigeres Forhåndsdefinert

B 4 Plate Size
(Platestørrelse)

Skal ikke redigeres Forhåndsdefinert

B 5 Plate Type (Platetype) Legg inn “BRWhite”
(BR hvit), “BR Clear”
(BR klar) eller en
annen kalibrert
platetype

Påkrevd

B 6 Scan Mode
(Skannemodus)

Legg inn “SYBR/FAM
Only:” (Kun
SYBR/FAM:), “All
Channels” (Alle
kanaler) eller “FRET”

Påkrevd

Tabell 38. Definisjon av innhold i LIMS .csv-filen, forts.
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Kolonne Rad Beskrivelse Innhold Formål

B 7 Units (Enheter) Legg inn ett av
følgende alternativer:
“copy number”
(kopitall), “fold dilution”
(foldfortynning),
“micromoles”
(mikromol),
“nanomoles”
(nanomol),
“picomoles” (pikomol),
“femtomoles”
(femtomol),
“attomoles” (attomol),
“milligrams”
(milligram),
“micrograms”
(mikrogram),
“nanograms”
(nanogram),
“picograms”
(pikogram),
“femtograms”
(femtogram),
“attograms” (attogram)
eller “percent”
(prosent)

Påkrevd

B 8 Run ID (Kjørings-ID) Legg inn en kort
beskrivelse eller
strekkode som
identifiserer denne
kjøringen (maks. 30
tegn, komma ikke
tillatt)

Valgfritt

B 9 Kjøringsmerknader Legg inn
kjøringsbekrivelse

Valgfritt

Tabell 38. Definisjon av innhold i LIMS .csv-filen, forts.
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Kolonne Rad Beskrivelse Innhold Formål

B 10 Run Protocol
(Kjøringsprotokoll)

Legg inn
protokollfilnavn
nøyaktig som oppført.

Påkrevd

A 11 Data File (Datafil) Legg inn datafilnavn Valgfritt

A 12–15 TBD/Empty (TBD/tom) Skal ikke redigeres Forhåndsdefinert

A 16 Plate Data (Platedata) Skal ikke redigeres Forhåndsdefinert

A 17–113 Well Position
(Brønnposisjon)

Skal ikke redigeres Forhåndsdefinert

B–G Ch1 Dye (Kanal1
fargestoff), Ch2 Dye
(Kanal2 fargestoff), Ch3
Dye (Kanal3 fargestoff),
Ch4 Dye (Kanal4
fargestoff), Ch5 Dye
(Kanal5 fargestoff),
FRET

Legg inn ett kalibrert
fargestoffnavn (for
eksempel “FAM”) for
hver kanal som brukes

Påkrevd

H Sample Type
(Prøvetype)

Legg inn én av
følgende prøvetyper:
“Unknown” (Ukjent),
“Standard”, “Positive
Control” (Positiv
kontroll), “Negative
Control” (Negativ
kontroll), “NTC” (Ikke-
templatkontroll) eller
“NRT” (Uten revers
transkriptase)

Påkrevd

I Sample Name
(Prøvenavn)

Legg inn prøvenavn Valgfritt

Tabell 38. Definisjon av innhold i LIMS .csv-filen, forts.
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Kolonne Rad Beskrivelse Innhold Formål

J–O CH1 Target (Kanal1
mål), CH2 Target
(Kanal2 mål), CH3
Target (Kanal3 mål),
CH4 Target (Kanal4
mål), CH5 Target
(Kanal5 mål), FRET
Target (FRET mål)

Legg inn målnavn for
hver kanal som brukes

Valgfritt

P Collection Name
(Samlingsnavn)

Legg inn navn på
biologisk sett

Valgfritt

Q Replicate (Replikat) Legg inn et positivt
heltall for hvert sett
med replikater.
Verdien kan ikke være
null.

Valgfritt

R–W CH1 Quantity (Kanal1
kvantitet), CH2 Quantity
(Kanal2 kvantitet), CH3
Quantity (Kanal3
kvantitet), CH4 Quantity
(Kanal4 kvantitet), CH5
Quantity (Kanal5
kvantitet, FRET Quantity
(FRET kvantitet)

Legg inn
kvantitetsverdier for
alle standarder. Legg
inn konsentrasjon i
desimalform.

Påkrevd for alle
standarder

Tabell 38. Definisjon av innhold i LIMS .csv-filen, forts.

Brukerhåndbok | 311



Vedlegg C LIMS-integrering

Kolonne Rad Beskrivelse Innhold Formål

X Well Note
(Brønnmerknad)

Legg inn
brønnmerknad (maks.
20 tegn)

Merknad: Selv
om CFX Maestro
Dx SE har en
grense på 20 tegn
når du skriver inn
merknader i Well
Note via
programvaren,
kan feltet Well
Note inneholde
opptil 500 tegn
hvis det er
inkludert i en
importert .plrn-fil.
CFX Maestro Dx
SE viser imidlertid
bare de første 20
tegnene. Den
eksporterte .pcrd-
filen inneholder
alt i Well Note-
feltet, ingen data
går tapt.

Valgfritt

Y–AD Ch1Well Color (Kanal1
brønnfarge), Ch2Well
Color (Kanal2
brønnfarge), Ch3Well
Color (Kanal3
brønnfarge), Ch4Well
Color (Kanal4
brønnfarge), Ch5Well
Color (Kanal5
brønnfarge), FRETWell
Color (FRET brønnfarge)

Legg inn enhver
brukerdefinert farge for
kurvestil i et 32-bits
integer (argb)
desimalformat

Valgfritt

Tabell 38. Definisjon av innhold i LIMS .csv-filen, forts.
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Starte en LIMS-kjøring
Slik starter du en LIMS-kjøring

1. Gjør ett av følgende for å åpne en LIMS .plrn-fil:

n I startvinduet velger du View > Show > LIMS File Folder (Visning > Vis > LIMS-filmappe) og
åpner .plrn-målfilen.

n I startvinduet velger du File > Open > LIMS File (Fil > Åpne >LIMS-fil) og åpner .plrn-målfilen.

Filen åpnes i fanen Start Run (Start kjøring) i veiviseren Run Setup (Kjøringsoppsett). Fanen Start
Run (Start kjøring) viser informasjon om eksperimentet som skal kjøres. Den viser også den
tilkoblede instrumentblokken eller blokker du kan kjøre eksperimentet på.

2. I fanen Start Run (Start kjøring) velger du et instrument og klikker på Start Run (Start kjøring).

Eksportere data til et LIMS
Etter at kjøringen er fullført, genererer CFX Maestro Dx SE en datafil (.pcrd) og lagrer den på den
definerte mappeplasseringen for dataeksport.

Slik eksporterer du datafilen til et LIMS

u Åpne .pcrd-filen, og velg Export > Export to LIMS Folder (Eksport > Eksporter til LIMS-mappe).
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Tips: Hvis du velger Automatically Export Data after Run (Eksporter data automatisk etter kjøring) i
LIMS Options (Alternativer for LIMS), oppretter CFX Maestro Dx SE en LIMS-kompatibel datafil i .csv
format og lagrer den i den sammemappen.
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programvare, Security Edition

Dette tillegget gir forslag til feilsøking av problemer du kan støte på når du oppgraderer eller kjører
CFX Maestro Dx-programvare, Security Edition.

Hviteliste CFX Maestro Dx-programvare, Security Edition filer
og mapper

For å beskytte mot virus og skadelig programvare, kan IT-avdelingen din ha implementert svært strenge
programvaresikkerhetstiltak. Disse tiltakene kan påvirke tiden for oppgradering eller kjøring av
CFX Maestro Dx SE.

For å forbedre ytelsen til CFX Maestro Dx SE, anbefaler Bio-Rad at IT-avdelingen godkjenner følgende
filer og mapper i brannmurinnstillingene i antivirusprogramvaren som er installert på CFX Maestro Dx SE-
datamaskinen:

Mapper

n C:\Program Files (x86)\Bio-Rad\CFX_MDx

n C:\ProgramData\Bio-Rad\CFX_MDx

n C:\Users\Public\Documents\Bio-Rad\CFX_MDx

Filer

n Alle .exe-filer i mappen C:\Program Files (x86)\Bio-Rad\CFX_MDx

n R.exe og Rscript.exe (i mappen C:\Program Files (x86)\Bio-Rad\CFX_MDx\ R\
R-3.3.1\bin)
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Programvarelogg
Før CFX Opus Dx starter en ny kjøring, starter systemet en selvdiagnostisk test for å bekrefte at det kjører
innenfor spesifikasjonene. Programvaren registrerer resultatene av denne testen i filene Run Log
(Kjøringslogg) og Application Log (Programvarelogg). Hvis du oppdager et problem i ett eller flere
eksperimenter, må du åpne kjørings- og programvareloggene for å finne ut når problemene startet.

CFX Maestro Dx SE Dx sporer informasjon om tilstanden til et instrument under en kjøring i Application
Log (Programvarelogg). Bruk disse loggene til å spore hendelser som inntreffer på instrumentene og i
programvaren samt for feilsøking.

Slik åpner du programvareloggen

u I startvinduet velger du View > Application Log (Vis > Programvarelogg).

For å vise programloggen som en HTML-fil, klikk på HTML Report-knappen.
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Hente programvare- og firmware-loggfiler
Programvare- og firmware-loggene inneholder informasjon som beskriver handlinger utført under bruk av
programvaren og ytelsen til kjøringer. Disse loggene registrerer også programvare- eller firmware-feil
som oppstår under bruk av programvaren eller instrumentet.

Slik får du tilgang til loggfilene for programmet og firmware:

1. Høyreklikk på instrumentet i ruten Detected Instruments (Oppdagede instrumenter).

2. Velg Retrieve Log Files (Hent loggfiler).

3. I dialogboksen Browse for Folder (Søk etter mappe) velger du målmappen på nettverket eller en lokal
stasjon som du vil lagre loggfilene i.

Merknad: Mappen har tittelen "Logs".

4. Klikk OK for å lagre filene.

Viktig: Lagring av en loggfil med samme filnavn som en eksisterende loggfil, vil overskrive den
eksisterende loggfilen.

Feilsøking
Du kan vanligvis løse problemer med programvare- og instrumentkommunikasjon ved å starte
datamaskinen og systemet på nytt. Det er viktig at du lagrer eventuelt pågående arbeid før du starter på
nytt.

Merknad: Kontroller at datamaskinen har nok RAM og ledig diskplass. Minimum RAM er 4 GB og
minimum ledig diskplass er 128 GB.

Strømbrudd
Ved et strømbrudd stenges instrumentet og datamaskinen ned. Hvis strømbruddet er kortvarig, vil
instrumentet gjenoppta kjøringen av en protokoll, men strømbruddet blir registrert i Application Log
(Applikasjonslogg). Avhengig av datamaskinens innstillinger og lengden på strømbruddet, vil
instrumentet og programvaren prøve å fortsette kjøringen, avhengig av protokolltrinnet:

n Hvis protokollen er i et trinn som ikke inneholder plateavlesning, fortsetter protokollen å kjøre straks
instrumentet forsynes med strøm igjen.

n Hvis protokollen er i et trinn som inneholder plateavlesning, venter instrumentet på at programvaren
skal startes på nytt og gjenopptar kommunikasjonen for innsamling av data. I denne situasjonen
fortsetter protokollen kun hvis programvaren ikke er stengt ned av datamaskinen. Protokollen
fortsetter når datamaskinen og programvaren starter opp på nytt.
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Overføre filer til CFX Maestro Dx SE-datamaskinen
Du kan overføre data og loggfiler som ligger på instrumentet til harddisken til en tilkoblet CFX Maestro Dx
SE-datamaskin.

Tips: Alle filer i mappen for sanntidsdata på instrumentbasen overføres til datamaskinen.

Merknad: Fra CFX Opus Dx-instrumenter kan du bare overføre loggfiler. Alle loggfiler på
instrumentet overføres til datamaskinen.

Slik henter du ut filer fra instrumentet

1. Høyreklikk på målinstrumentet i ruten Detected Instruments (Detekterte instrumenter) i startvinduet,
og velg Retrieve Log Files.

2. Velg en mappe der du vil lagre filene.

3. Klikk på OK.

Installere CFX Maestro Dx-programvare, Security Edition manuelt
Slik installerer du CFX Maestro Dx SE manuelt

1. Koble fra eventuelle instrumenter som er koblet til datamaskinen.

Finn instrumentets USB-kabel på CFX Maestro Dx SE-datamaskinen, og koble den fra. Kabelenden
som er tilkoblet instrumentet, trenger ikke kobles fra.

2. Logg på CFX Maestro Dx SE-datamaskinen som administrator.

3. Sett USB-stasjonen med CFX Maestro Dx SE inn i USB-porten på datamaskinen.

4. ÅpneWindows Utforsker, naviger til USB-stasjonen med CFX Maestro Dx SE og åpne den.

5. Åpne CFX-mappen og dobbeltklikk på CFXMaestroDxSetup.exe for å installere CFX Maestro Dx SE.

6. Følg instruksjonene på skjermen for å installere programvaren.

Når installeringen er ferdig, vises Bio-Rad CFX Maestro Dx-programvare, Security Edition-
velkomstskjermbildet på dataskjermen og Bio-Rad CFX Maestro Dx-programvare, Security Edition-
ikonet vises på skrivebordet.

7. Løs trygt ut programvarens USB-enhet og start CFX Maestro Dx SE.
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Installere driverne på nytt
Slik installerer du instrumentdriverne på nytt

u I startvinduet velger du Tools > Reinstall Instrument Drivers (Verktøy > Installer instrumentdrivere på
nytt).

Merknad: Hvis programvaren har problemer med å kommunisere med et sanntidssystem etter at du
har installert driverne på nytt og sjekket USB-tilkoblingen, må du kontakte teknisk støtte hos Bio-Rad.
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for PCR Products

This document includes licensing information relating to free, open-source, and public-source software
and data (together, the “MATERIALS”) included with or used to develop Bio-Rad products and services.
The terms of the applicable free, open-source, and public-source licenses (each an “OPEN LICENSE”)
govern Bio-Rad’s distribution and your use of the MATERIALS. Bio-Rad and the third-party authors,
licensors, and distributors of the MATERIALS disclaim all warranties and liability arising from all use and
distribution of the MATERIALS. To the extent the OSS is provided under an agreement with Bio-Rad that
differs from the applicable OSS LICENSE, those terms are offered by Bio-Rad alone.

Bio-Rad has reproduced below copyright and other licensing notices appearing within the MATERIALS.
While Bio-Rad seeks to provide complete and accurate copyright and licensing information for all
MATERIALS, Bio-Rad does not represent or warrant that the following information is complete, correct, or
error-free. MATERIALS recipients are encouraged to (a) investigate the identified MATERIALS to confirm
the accuracy of the licensing information provided and (b) notify Bio-Rad of any inaccuracies or errors
found in this document so that Bio-Rad may update this document accordingly.

Certain OPEN LICENSES (such as the Affero General Public Licenses, Common Development and
Distribution Licenses, Common Public License, Creative Commons Share-Alike License, Eclipse Public
License, Mozilla Public Licenses, GNU General Public Licenses, GNU Library/Lesser General Public
Licenses, and Open Data Commons Open Database License) require that the source materials be made
available to recipients or other requestors under the terms of the same OPEN LICENSE.

The corresponding open source software is available for download from the links in the section that
follows.
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Software Notices

ZedGraph
Project homepage/download site:

https://sourceforge.net/projects/zedgraph/

Bio-Rad source code site:

https://github.com/bio-rad-lsg-open-source/ZedGraph-5.0.1

External source code site:

https://github.com/ZedGraph/ZedGraph

Project licensing notices:

/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

/sources/ZedGraph/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

Standard Open License Text

LGPL-2.1
GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 59 Temple
Place, Suite 330, Boston, MA 02111-1307 USA Everyone is permitted to
copy and distribute verbatim copies of this license document, but
changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.]
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Preamble

The licenses for most software are designed to take away your freedom
to share and change it. By contrast, the GNU General Public Licenses
are intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some
specially designated software packages--typically libraries--of the
Free Software Foundation and other authors who decide to use it. You
can use it too, but we suggest you first think carefully about
whether this license or the ordinary General Public License is the
better strategy to use in any particular case, based on the
explanations below.

When we speak of free software, we are referring to freedom of use,
not price. Our General Public Licenses are designed to make sure that
you have the freedom to distribute copies of free software (and
charge for this service if you wish); that you receive source code or
can get it if you want it; that you can change the software and use
pieces of it in new free programs; and that you are informed that you
can do these things.

To protect your rights, we need to make restrictions that forbid
distributors to deny you these rights or to ask you to surrender
these rights. These restrictions translate to certain
responsibilities for you if you distribute copies of the library or
if you modify it.

For example, if you distribute copies of the library, whether gratis
or for a fee, you must give the recipients all the rights that we
gave you. You must make sure that they, too, receive or can get the
source code. If you link other code with the library, you must
provide complete object files to the recipients, so that they can
relink them with the library after making changes to the library and
recompiling it. And you must show them these terms so they know their
rights.

We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there
is no warranty for the free library. Also, if the library is modified
by someone else and passed on, the recipients should know that what
they have is not the original version, so that the original author's
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reputation will not be affected by problems that might be introduced
by others.

Finally, software patents pose a constant threat to the existence of
any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be
consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the
ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and
is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those
libraries into non-free programs.

When a program is linked with a library, whether statically or using
a shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General
Public License permits more lax criteria for linking other code with
the library.

We call this license the "Lesser" General Public License because it
does Less to protect the user's freedom than the ordinary General
Public License. It also provides other free software developers Less
of an advantage over competing non-free programs. These disadvantages
are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain
special circumstances.

For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it
becomes a de-facto standard. To achieve this, non-free programs must
be allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this
case, there is little to gain by limiting the free library to free
software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free
programs enables a greater number of people to use a large body of
free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU
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operating system, as well as its variant, the GNU/Linux operating
system.

Although the Lesser General Public License is Less protective of the
users' freedom, it does ensure that the user of a program that is
linked with the Library has the freedom and the wherewithal to run
that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a
"work based on the library" and a "work that uses the library". The
former contains code derived from the library, whereas the latter
must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms
of this Lesser General Public License (also called "this License").
Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work
which has been distributed under these terms. A "work based on the
Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or
translated straightforwardly into another language. (Hereinafter,
translation is included without limitation in the term
"modification".)

"Source code" for a work means the preferred form of the work for
making modifications to it. For a library, complete source code means
all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control
compilation and installation of the library.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output
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from such a program is covered only if its contents constitute a work
based on the Library (independent of the use of the Library in a tool
for writing it). Whether that is true depends on what the Library
does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's
complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the
Library. You may charge a fee for the physical act of transferring a
copy, and you may at your option offer warranty protection in
exchange for a fee.

2. You may modify your copy or copies of the Library or any portion
of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge
to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a
table of data to be supplied by an application program that uses the
facility, other than as an argument passed when the facility is
invoked, then you must make a good faith effort to ensure that, in
the event an application does not supply such function or table, the
facility still operates, and performs whatever part of its purpose
remains meaningful. (For example, a function in a library to compute
square roots has a purpose that is entirely well-defined independent
of the application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function must be
optional: if the application does not supply it, the squareroot
function must still compute square roots.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
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distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Library.

In addition, mere aggregation of another work not based on the
Library with the Library (or with a work based on the Library) on a
volume of a storage or distribution medium does not bring the other
work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do
this, you must alter all the notices that refer to this License, so
that they refer to the ordinary GNU General Public License, version
2, instead of to this License. (If a newer version than version 2 of
the ordinary GNU General Public License has appeared, then you can
specify that version instead if you wish.) Do not make any other
change in these notices. Once this change is made in a given copy, it
is irreversible for that copy, so the ordinary GNU General Public
License applies to all subsequent copies and derivative works made
from that copy. This option is useful when you wish to copy part of
the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or
derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany
it with the complete corresponding machine- readable source code,
which must be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange. If
distribution of object code is made by offering access to copy from a
designated place, then offering equivalent access to copy the source
code from the same place satisfies the requirement to distribute the
source code, even though third parties are not compelled to copy the
source along with the object code.

5. A program that contains no derivative of any portion of the
Library, but is designed to work with the Library by being compiled
or linked with it, is called a "work that uses the Library". Such a
work, in isolation, is not a derivative work of the Library, and
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therefore falls outside the scope of this License. However, linking a
"work that uses the Library" with the Library creates an executable
that is a derivative of the Library (because it contains portions of
the Library), rather than a "work that uses the library". The
executable is therefore covered by this License. Section 6 states
terms for distribution of such executables. When a "work that uses
the Library" uses material from a header file that is part of the
Library, the object code for the work may be a derivative work of the
Library even though the source code is not. Whether this is true is
especially significant if the work can be linked without the Library,
or if the work is itself a library. The threshold for this to be true
is not precisely defined by law. If such an object file uses only
numerical parameters, data structure layouts and accessors, and small
macros and small inline functions (ten lines or less in length), then
the use of the object file is unrestricted, regardless of whether it
is legally a derivative work. (Executables containing this object
code plus portions of the Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may
distribute the object code for the work under the terms of Section 6.
Any executables containing that work also fall under Section 6,
whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or
link a "work that uses the Library" with the Library to produce a
work containing portions of the Library, and distribute that work
under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse
engineering for debugging such modifications. You must give prominent
notice with each copy of the work that the Library is used in it and
that the Library and its use are covered by this License. You must
supply a copy of this License. If the work during execution displays
copyright notices, you must include the copyright notice for the
Library among them, as well as a reference directing the user to the
copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-
readable source code for the Library including whatever changes were
used in the work (which must be distributed under Sections 1 and 2
above); and, if the work is an executable linked with the Library,
with the complete machine-readable "work that uses the Library", as
object code and/or source code, so that the user can modify the
Library and then relink to produce a modified executable containing
the modified Library. (It is understood that the user who changes the
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contents of definitions files in the Library will not necessarily be
able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (1) uses at run time a copy
of the library already present on the user's computer system, rather
than copying library functions into the executable, and (2) will
operate properly with a modified version of the library, if the user
installs one, as long as the modified version is interface-compatible
with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three
years, to give the same user the materials specified in Subsection
6a, above, for a charge no more than the cost of performing this
distribution.

d) If distribution of the work is made by offering access to copy
from a designated place, offer equivalent access to copy the above
specified materials from the same place.

e) Verify that the user has already received a copy of these
materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the
Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
the executable.

It may happen that this requirement contradicts the license
restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot
use both them and the Library together in an executable that you
distribute.

7. You may place library facilities that are a work based on the
Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a
combined library, provided that the separate distribution of the work
based on the Library and of the other library facilities is otherwise
permitted, and provided that you do these two things:
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a) Accompany the combined library with a copy of the same work based
on the Library, uncombined with any other library facilities. This
must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that
part of it is a work based on the Library, and explaining where to
find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the
Library except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense, link with, or distribute the
Library is void, and will automatically terminate your rights under
this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated
so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are

prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the
Library subject to these terms and conditions. You may not impose any
further restrictions on the recipients' exercise of the rights
granted herein. You are not responsible for enforcing compliance by
third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do
not excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under
this License and any other pertinent obligations, then as a
consequence you may not distribute the Library at all. For example,
if a patent license would not permit royalty-free redistribution of
the Library by all those who receive copies directly or indirectly
through you, then the only way you could satisfy both it and this
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License would be to refrain entirely from distribution of the
Library.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended
to apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a
licensee cannot impose that choice. This section is intended to make
thoroughly clear what is believed to be a consequence of the rest of
this License.

12. If the distribution and/or use of the Library is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time. Such
new versions will be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library
specifies a version number of this License which applies to it and
"any later version", you have the option of following the terms and
conditions either of that version or of any later version published
by the Free Software Foundation. If the Library does not specify a
license version number, you may choose any version ever published by
the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free
programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is
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copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free
status of all derivatives of our free software and of promoting the
sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER MATERIALS), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest
possible use to the public, we recommend making it free software that
everyone can redistribute and change. You can do so by permitting
redistribution under these terms (or, alternatively, under the terms
of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It
is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should
have at least the "copyright" line and a pointer to where the full
notice is found.
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Standard Open License Text

<one line to give the library's name and a brief idea of what it
does.>

Copyright (C) <year> <name of author>

This library is free software; you can redistribute it and/or modify
it under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is
distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public
License for more details.

You should have received a copy of the GNU Lesser General Public
License along with this library; if not, write to the Free Software
Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307
USA

Also add information on how to contact you by electronic and paper
mail. You should also get your employer (if you work as a programmer)
or your school, if any, to sign a "copyright disclaimer" for the
library, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the
library `Frob' (a library for tweaking knobs) written by James Random
Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

That's all there is to it!
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Merknad om opphavsrett, Minpack (1999) University of Chicago. Med enerett

Redistribuering og bruk i kildeformer og binære former, med eller uten modifisering, er tillatt, forutsatt at
følgende betingelser er oppfylt:

1. Ved redistribuering av kildekoden må den ovennevnte merknaden om opphavsrett, denne listen over
betingelser og følgende forbehold også distribueres.

2. Redistribueringer i binær form må reprodusere den ovennevnte merknaden om opphavsrett, denne
listen over betingelser og følgende forbehold i dokumentasjonen og/eller andre materialer som
medfølger distribueringen.

3. Eventuell sluttbrukerdokumentasjon sommedfølger redistribueringen må inneholde følgende tekst:

«Dette produktet inneholder programvare utviklet av University of Chicago, som eier av Argonne National
Laboratory.»
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